
SIMOTION

SIMOTION D410-2

Commissioning and Hardware Installation Manual

Valid for
SIMOTION D410-2 DP and D410-2 DP/PN
as of version 5.3

04/2019
A5E33446807B

Preface

Safety instructions 1

Description 2

Installing 3

Connecting 4

Commissioning (hardware) 5
Parameter assignment / 
addressing 6

Commissioning (software) 7

Service and maintenance 8

Diagnostics 9
Configuring drive-related 
I/Os (without symbolic 
assignment)

A

Standards and approvals B

ESD guidelines C



Legal information
Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent 
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert 
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are 
graded according to the degree of danger.

DANGER
indicates that death or severe personal injury will result if proper precautions are not taken.

WARNING
indicates that death or severe personal injury may result if proper precautions are not taken.

CAUTION
indicates that minor personal injury can result if proper precautions are not taken.

NOTICE
indicates that property damage can result if proper precautions are not taken.
If more than one degree of danger is present, the warning notice representing the highest degree of danger will be 
used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property 
damage.

Qualified Personnel
The product/system described in this documentation may be operated only by personnel qualified for the specific 
task in accordance with the relevant documentation, in particular its warning notices and safety instructions. Qualified 
personnel are those who, based on their training and experience, are capable of identifying risks and avoiding 
potential hazards when working with these products/systems.

Proper use of Siemens products
Note the following:

WARNING
Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended or 
approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and 
maintenance are required to ensure that the products operate safely and without any problems. The permissible 
ambient conditions must be complied with. The information in the relevant documentation must be observed.

Trademarks
All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication 
may be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability
We have reviewed the contents of this publication to ensure consistency with the hardware and software described. 
Since variance cannot be precluded entirely, we cannot guarantee full consistency.  However, the information in this 
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Preface

Contents of the Commissioning and Hardware Installation Manual
This document is part of the SIMOTION D documentation package.

Scope
The SIMOTION D410‑2 Commissioning and Hardware Installation Manual describes the 
commissioning and installation of the SIMOTION D410‑2 DP and SIMOTION D410‑2 DP/PN 
control units. A separate SIMOTION D410 Commissioning Manual is available for the 
SIMOTION D410 DP and SIMOTION D410 PN Control Units. 

The software configuration is described in this manual based on SIMOTION SCOUT and 
SIMATIC STEP 7 Version V5.x.
Information of configuration of the SIMOTION D Control Units in the Engineering Framework 
Totally Integrated Automation Portal (SCOUT in the TIA Portal), you will find in the configuration 
manual SIMOTION SCOUT TIA. The TIA Portal requires at least SIMOTION SCOUT V4.4 and 
SIMOTION D4xx‑2 Control Units as of firmware V4.3.

Standards
The SIMOTION system was developed in accordance with ISO 9001 quality guidelines.

Sections in this manual
The following is a description of the purpose and use of this Commissioning and Hardware 
Installation Manual:

● Description
This section describes the SIMOTION system and its integration into the information 
landscape.

● Installing
This section provides information on the the various installation options for the device.

● Connecting
This section provides information about connecting and cabling the various devices, and 
about the communication interfaces.

● Commissioning (hardware)
This section describes how to start up the device and what you must take into account.

● Parameter assignment / addressing
This section describes how to integrate the SIMOTION D410‑2 cm a project and how to 
configure the interfaces.

● Commissioning (software)
This section describes how to configure a system and how to test the configured drives and 
axes.
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● Service and maintenance
This section describes how to replace a module, how to run updates, and how to modify 
settings.

● Diagnostics
This section provides information on the service and diagnostics options, as well as LED 
states.

● Appendices with factual information for reference (for example, Standards and Approvals, 
ESD guidelines, etc.)

● Index for locating information.

SIMOTION Documentation
An overview of the SIMOTION documentation can be found in the SIMOTION Documentation 
Overview document.   

This documentation is included as electronic documentation in the scope of delivery of 
SIMOTION SCOUT. It comprises ten documentation packages. 

The following documentation packages are available for SIMOTION product version V5.3:

● SIMOTION Engineering System Handling

● SIMOTION System and Function Descriptions

● SIMOTION Service and Diagnostics

● SIMOTION IT

● SIMOTION Programming

● SIMOTION Programming - References

● SIMOTION C

● SIMOTION P

● SIMOTION D

● SIMOTION Supplementary Documentation

Hotline and Internet addresses

SIMOTION at a glance
We have compiled an overview page from our range of information about SIMOTION with the 
most important information on frequently asked topics - which can be opened with only one 
click.

Whether beginner or experienced SIMOTION user – the most important downloads, manuals, 
tutorials, FAQs, application examples, etc. can be found at

https://support.industry.siemens.com/cs/ww/en/view/109480700

Preface
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Additional information
Click the following link to find information on the following topics:

● Documentation overview

● Additional links to download documents

● Using documentation online (find and search manuals/information)

https://support.industry.siemens.com/cs/ww/en/view/109479653

My Documentation Manager
Click the following link for information on how to compile documentation individually on the 
basis of Siemens content and how to adapt it for the purpose of your own machine 
documentation:

https://support.industry.siemens.com/My/ww/en/documentation

Training
Click the following link for information on SITRAIN - Siemens training courses for automation 
products, systems and solutions:

http://www.siemens.com/sitrain

FAQs
Frequently Asked Questions can be found in SIMOTION Utilities & Applications, which are 
included in the scope of delivery of SIMOTION SCOUT, and in the Service&Support pages 
in Product Support:

https://support.industry.siemens.com/cs/de/en/ps/14505/faq

Technical support
Country-specific telephone numbers for technical support are provided on the Internet 
under Contact:

https://support.industry.siemens.com/cs/ww/en/sc/2090

Disposal and recycling
SIMOTION D410-2 is an environmentally friendly product! It includes the following features: 

● In spite of its excellent resistance to fire, the flame-resistant agent in the plastic used for the 
housing does not contain halogens.

● Identification of plastic materials in accordance with ISO 11469.

● Less material used because the unit is smaller and with fewer components thanks to 
integration in ASICs.

The disposal of the products described in this manual should be performed in compliance with 
the valid national regulations.

Preface
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The products can be largely recycled owing to their low pollutant content. For environmentally 
friendly recycling and disposal of your old device, please contact a company certified for the 
disposal of electronic waste and dispose of the device in accordance with the regulations in 
your country.

If you have any further questions about disposal and recycling, please contact your local 
Siemens representative. Contact details can be found in our contacts database on the Internet 
at:

http://www.automation.siemens.com/partner

Further information / FAQs
You can find further information on this manual at the following FAQ:

https://support.industry.siemens.com/cs/ww/de/view/27585482

The following information sources are also available:

● SIMOTION Utilities & Applications: SIMOTION Utilities & Applications will be included in the 
SIMOTION SCOUT scope of delivery and, along with FAQs, also contain free utilities (e.g. 
calculation tools, optimization tools, etc.) as well as application examples (ready-to-apply 
solutions such as winders, cross cutters or handling)

● The latest SIMOTION FAQs at https://support.industry.siemens.com/cs/ww/de/ps/
14505/faq

● SIMOTION SCOUT online help

● For additional documentation, see the Overview of SIMOTION documentation (separate 
document).

Preface
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Safety instructions 1
1.1 Fundamental safety instructions

1.1.1 Safety instructions for electromagnetic fields (EMF)

WARNING

Danger to life from electromagnetic fields

Electromagnetic fields (EMF) are generated by the operation of electrical power equipment 
such as transformers, converters or motors.

People with pacemakers or implants are at a special risk in the immediate vicinity of these 
devices/systems.
● Ensure that the persons involved are the necessary distance away (minimum 2 m). 

1.1.2 Handling electrostatic sensitive devices (ESD)
Electrostatic sensitive devices (ESD) are individual components, integrated circuits, modules 
or devices that may be damaged by either electric fields or electrostatic discharge.

NOTICE

Damage through electric fields or electrostatic discharge

Electric fields or electrostatic discharge can cause malfunctions through damaged individual 
components, integrated circuits, modules or devices.
● Only pack, store, transport and send electronic components, modules or devices in their 

original packaging or in other suitable materials, e.g conductive foam rubber of aluminum 
foil.

● Only touch components, modules and devices when you are grounded by one of the 
following methods:
– Wearing an ESD wrist strap
– Wearing ESD shoes or ESD grounding straps in ESD areas with conductive flooring

● Only place electronic components, modules or devices on conductive surfaces (table with 
ESD surface, conductive ESD foam, ESD packaging, ESD transport container).
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1.1.3 Security information
Siemens provides products and solutions with industrial security functions that support the 
secure operation of plants, systems, machines and networks.

In order to protect plants, systems, machines and networks against cyber threats, it is 
necessary to implement – and continuously maintain – a holistic, state-of-the-art industrial 
security concept. Siemens’ products and solutions constitute one element of such a concept.

Customers are responsible for preventing unauthorized access to their plants, systems, 
machines and networks. Such systems, machines and components should only be connected 
to an enterprise network or the internet if and to the extent such a connection is necessary and 
only when appropriate security measures (e.g. firewalls and/or network segmentation) are in 
place. 

For additional information on industrial security measures that can be implemented, please visit 
(https://www.siemens.com/industrialsecurity).

Siemens' products and solutions undergo continuous development to make them more secure. 
Siemens strongly recommends that product updates are applied as soon as they are available 
and that the latest product versions are used. Use of product versions that are no longer 
supported, and failure to apply the latest updates may increase customers' exposure to cyber 
threats. 

To stay informed about product updates, subscribe to the Siemens Industrial Security RSS 
Feed visit (https://www.siemens.com/industrialsecurity).

1.1.4 Note regarding the general data protection regulation
Siemens observes the principles of data protection, in particular the principle of data 
minimization (privacy by design). For this product this means:

The product does not process / store any personal data, only technical functional data (e.g. time 
stamp). If the user links this data with other data (e.g. shift plans) or stores personal data on the 
same medium (e.g. hard disk) and thus establishes a personal reference, the user must ensure 
compliance with data protection regulations.

1.1.5 Danger to life due to software manipulation when using removable storage media

WARNING

Danger to life due to software manipulation when using removable storage media

The storage of files on removable storage media involves a high risk of infection, e.g. via 
viruses or malware. Incorrect parameter assignment can cause machines to malfunction, 
which can lead to injuries or death.
● Protect the files on removable storage media against harmful software through appropriate 

protective measures, e.g. virus scanners.

Safety instructions
1.1 Fundamental safety instructions
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1.1.6 Residual risks of power drive systems
When performing the risk assessment for a machine or plant in accordance with the respective 
local regulations (e.g. EC Machinery Directive), the machine manufacturer or plant constructor 
must take into account the following residual risks associated with the control and drive 
components of a drive system:

1. Unintentional movements of driven machine or system components during commissioning, 
operation, maintenance and repairs caused by, for example:

– Hardware and/or software errors in the sensors, control system, actuators, and cables 
and connections

– Response times of the control system and of the drive

– Operation and/or environmental conditions outside the specification

– Condensation/conductive contamination

– Parameterization, programming, cabling, and installation errors

– Use of wireless devices / mobile phones in the immediate vicinity of electronic 
components

– External influences/damage

– X-rays, ionizing radiation and cosmic radiation

2. Unusually high temperatures, including open flames, as well as emissions of light, noise, 
particles, gases, etc., can occur inside and outside the components under fault conditions 
caused by, for example:

– Component failure

– Software errors

– Operation and/or environmental conditions outside the specification

– External influences/damage

3. Hazardous shock voltages caused by, for example:

– Component failure

– Influence during electrostatic charging

– Induction of voltages in moving motors

– Operation and/or environmental conditions outside the specification

– Condensation/conductive contamination

– External influences/damage

4. Electrical, magnetic and electromagnetic fields generated in operation that can pose a risk 
to people with a pacemaker, implants or metal replacement joints, etc., if they are too close

5. Release of environmental pollutants or emissions as a result of improper operation of the 
system and/or failure to dispose of components safely and correctly

For more information about the residual risks of the drive system components, see the relevant 
sections in the technical user documentation.

Safety instructions
1.1 Fundamental safety instructions
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1.2 Specific safety information for SIMOTION D410-2
Observe the following safety information when working with SIMOTION D410-2 and its 
components!

WARNING

Danger to life from hazardous voltage when connecting an unsuitable power supply

Only safety extra low voltage in accordance with EN/IEC 609501 may be connected at all 
connectors and terminals.

WARNING

Danger to life from unexpected movement of machines on automatic restart

An automatic restart can be programmed for SIMOTION controllers. When the power returns, 
the axes start automatically.

Make sure this presents no hazard to personnel or property.

NOTICE

Damage to the CompactFlash card from electrical fields or electrostatic discharge

The CompactFlash card is an ESD-sensitive component.

De-energize the SIMOTION D410‑2 device before inserting or removing the CompactFlash 
card. The SIMOTION D410‑2 is in a de-energized state when all the LEDs are OFF.

Comply with the ESD rules.

NOTICE

Overheating if ventilation clearances are too small

Insufficient ventilation clearances result in overheating and therefore in more failures and a 
shortened life of systems / devices.

Make sure the ventilation clearances of 50 mm are provided above and below the 
components. The ventilation openings may not be covered by connecting cables.

Safety instructions
1.2 Specific safety information for SIMOTION D410-2
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Description 2
2.1 System overview

SIMOTION D
SIMOTION D is a drive-based version of SIMOTION based on the SINAMICS S120 drive 
family.

With SIMOTION D, the SIMOTION PLC and motion control functionalities as well as the 
SINAMICS S120 drive software run on shared control hardware.

SIMOTION D is available in two versions:

● SIMOTION D410-2 is a compact Control Unit predestined for single-axis applications.

● SIMOTION D4x5-2 is a Control Unit for multi-axis applications in the SINAMICS S120 
booksize format.
The following performance variants of the SIMOTION D4x5-2 Control Units are offered:

Control Unit Performance variant Range of applications
SIMOTION D425-2 BASIC performance For up to 16 axes
SIMOTION D435-2 STANDARD performance For up to 32 axes
SIMOTION D445-2 HIGH performance For up to 64 axes
SIMOTION D455-2 ULTRA-HIGH performance For up to 128 axes or applications with very 

short control cycles

Note

The SIMOTION D410-2 is described in this manual.

Separate manuals are available for the SIMOTION D4x5-2 and the SIMOTION D4x5 and 
SIMOTION D410 predecessor modules.

SIMOTION D is an integral part of the Totally Integrated Automation (TIA) concept. TIA is 
characterized by integrated data management, configuration, and communication for all 
products and systems. Thus, an extensive toolbox of automation modules is also available for 
the SIMOTION D410-2.

Note

In order to cover all variants of SIMOTION D in blocksize format, the product will be referred to 
as "D410-2". Specific product designations will be used for information that applies only to one 
product version, e.g. D410-2 DP/PN.

SIMOTION D410-2
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SIMOTION D410-2

Figure 2-1 SIMOTION D410-2 DP (pictured on left), SIMOTION D410-2 DP/PN (pictured on right)

SIMOTION D410-2 is a compact Control Unit for single-axis applications.

The Control Unit is snapped directly on to the SINAMICS Power Module in blocksize format and 
has an integrated drive control for either one servo, one vector or one V/f axis.

SIMOTION D410-2 can be extended with additional SINAMICS S110/S120 control units (e.g. 
CU310‑2) and so can also be used for smaller multi-axis applications (e.g. with 2 - 3 axes).

Description
2.1 System overview
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Example of a single-axis application

Figure 2-2 Application example with one axis

The example shows a single-axis application, consisting of a SIMOTION D410-2 (Control 
Unit) ① that is snapped directly on to the SINAMICS Power Module in blocksize format ②. The 
motors are supplied with power via the Power Module. The encoder is connected by means of 
DRIVE-CLiQ.

Example of a multi-axis application

Figure 2-3 Application example with 3 axes

Description
2.1 System overview
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The example shows an application with 3 axes, consisting of:

● One SIMOTION D410-2 DP (Control Unit) ①, snapped on to the Power Module in blocksize 
format ③
The SIMOTION D410-2 DP is snapped directly on to the SINAMICS Power Module. The 
motors are supplied with power via the Power Module. The encoder is connected by means 
of DRIVE-CLiQ.

● Two SINAMICS S120 CU310‑2 DP ②, snapped onto a Power Module in 
blocksize format ③
The Control Units are connected to the SIMOTION D410-2 DP via PROFIBUS DP. The two 
SINAMICS S120 CU310‑2 DP are snapped directly on to the SINAMICS Power Module. 
The motors are supplied with power via the Power Modules. The encoders are connected 
by means of DRIVE-CLiQ.

Note

Path interpolation is supported as of V4.4.

Application
Combining a Power Module with SIMOTION D410-2 forms a compact single drive for machine 
and plant engineering.   

Applications include:

● Machine concepts with central drive (e.g. presses, printing and packaging machines, etc.)

● Modular machine concepts where the machine modules were broken down into single axes

● Single drives with high accuracy, stability and concentricity requirements (compared with 
standard drives) in machine and industrial plant engineering

● Single drives for transport tasks (conveying, raising, lowering)

● Single drives with integrated PLC functionality and expanded motion control functionality 
such as output cams or cams

● Drives without power recovery (wire drawing, extruding)

● Drive connections with high availability requirements (incoming supply failure may not 
cause all axes to fail)

● Small multi-axis groupings (typically 2 to 3 axes) based on SINAMICS S110/120 blocksize.

Hardware components
As central hardware the SIMOTION D410-2 Control Unit is made up of the SIMOTION runtime 
system and the SINAMICS drive control.   

A range of additional SINAMICS S120 components, such as SMx encoder systems or Terminal 
Modules can be connected via DRIVE‑CLiQ.

With a few exceptions (e.g. no BOP20 Basic Operator Panel, etc.), the drive control integrated 
in SIMOTION D410-2 has the same control properties and performance features as the 
SINAMICS S120 CU310-2 Control Unit.

Description
2.1 System overview
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Extension of the drive computing performance
To fully utilize the motion control performance of a SIMOTION D410-2 when required, the drive-
side computing performance can be extended by connecting additional SINAMICS S/G Control 
Units (e.g. CU305, CU310‑2, CU320‑2, CU250S‑2, etc.) via PROFIBUS or PROFINET to the 
SIMOTION D410‑2.

Software components
The basic functionality of SIMOTION D is supplied on a CompactFlash card containing the 
following:   

● The SIMOTION runtime system with the following functions:

– Freely programmable runtime system (IEC 61131)

– Various runtime levels (tasks)

– PLC and arithmetic functionality

– Motion control functions

– Communication functions

● The SINAMICS S120 drive control with the following functions:

– Closed-loop current and torque control

– Closed-loop speed control

2.2 System components

Overview
SIMOTION D410-2 communicates with the components of the automation landscape via the 
following interfaces:

● PROFIBUS DP (D410-2 DP and D410-2 DP/PN)

● PROFINET IO (D410-2 DP/PN only)

● Ethernet

● DRIVE-CLiQ (DRIVE Component Link with IQ)

● Power Module interface (PM-IF)

SIMOTION D features a SINAMICS Integrated drive element. Communication with the 
SINAMICS Integrated is via PROFIBUS mechanisms (DP Integrated), via PROFIdrive 
telegrams.

Shorter cycle times and greater numbers of addresses for each node are achieved with the 
"DP Integrated" compared to the "external PROFIBUS DP."

Description
2.2 System components
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The most important components of the system and their functions are shown below.

Table 2-1 System components

Component Function
SIMOTION D410‑2 … is the central motion control module.

The module contains the programmable SIMOTION runtime of SIMO‐
TION D410‑2 and the SINAMICS S120 drive runtime software.
You can use the integrated high-speed I/Os (onboard I/Os) as:
● User-addressable process I/Os
● Homing inputs
● Fail-safe digital inputs
● Fail-safe digital output
● Inputs for measuring inputs
● Outputs for fast output cams
● Analog input
The measuring sockets can output any analog signals.
The DRIVE-CLiQ interface permits a fast connection to the SINAMICS drive 
components.

System software The basic functionality of SIMOTION D410‑2 is supplied separately on a 
CompactFlash Card containing the following:
● SIMOTION runtime (kernel)
● Drive software of SINAMICS S120
The CompactFlash card is not included in the scope of delivery.

Power supply (PS) … provides the electronic power supply for SIMOTION D410‑2 (e.g. SITOP 
power supply).

PROFIBUS DP
SIMOTION D410-2 can communicate with the following components via the PROFIBUS DP 
interface.     

Table 2-2 Components on PROFIBUS DP

Component Function
Programming device (PG/PC) … configures, assigns parameters, programs, and tests using the SIMOTION SCOUT En‐

gineering System (ES).
SIMATIC HMI device ... is used for operating and monitoring functions. This is not an essential requirement for the 

operation of the SIMOTION D410-2.
Other controllers (e.g. SIMO‐
TION or SIMATIC)

… e.g. higher-level controller (plant controller); modular machine concepts with multiple 
controllers, distributed across individual machine modules.

Distributed I/O systems
SIMATIC ET 200MP Modular I/O system for cabinet installation and high channel densities in the SIMAT‐

IC S7‑1500 packaging system. SIMATIC ET 200MP permits the shortest bus cycle times 
and fastest response time even with large volumes of data.

SIMATIC ET 200M Modular I/O system for cabinet installation and high channel densities in the SIMAT‐
IC S7‑300 packaging system.

Description
2.2 System components
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Component Function
SIMATIC ET 200SP Finely scalable I/O system for cabinet installation; ET 200SP features a single-cable and 

multi-cable connection with push‑in terminals, compact dimensions, high performance, and 
low part variety. 

SIMATIC ET 200S Finely scalable I/O system for cabinet installation and particularly time-critical applications; 
including motor starters, safety technology and individual grouping of load groups.

SIMATIC ET 200AL Modular, distributed I/O system with compact I/O modules in IP65/67; simple installation in 
all mounting positions even in small spaces; front and transverse screw fastenings on flat 
surfaces or on aluminum supporting channels; flexible connection to PROFINET or PRO‐
FIBUS or simple integration in SIMATIC ET 200SP.

SIMATIC ET 200pro Modular I/O system with IP65/IP67 degree of protection for machine-related applications 
with no cabinet; with features such as more compact designs, integrated PROFIsafe safety 
technology, PROFINET connection, and live module replacement.

SIMATIC ET 200eco I/O system with IP65/IP67 degree of protection for machine-related applications with no 
cabinet, with a flexible and fast connection system in ECOFAST or M12.

Other PROFIBUS I/O
Gateways ● DP/AS-Interface Link 20E and DP/AS-Interface Link Advanced for the PROFIBUS DP 

gateway to AS-Interface
● DP/DP coupler for connecting two PROFIBUS DP networks

Drive interfaces ● ADI4 (Analog Drive Interface for 4 axes) for the connection of drives with analog ±10 V 
setpoint interface or for external encoders

● IM 174 (Interface Module for 4 axes) for the connection of drives with analog ±10 V 
setpoint interface, external encoders or the connection of stepper drives with pulse/
direction interface

Drive units with PROFI‐
BUS DP interface 
(e.g. CU310-2 DP)

... convert speed setpoints into signals for controlling the motor and supply the power re‐
quired to operate the motors.
Can also be operated as an isochronous slave on the PROFIBUS DP.

Teleservice adapter Remote diagnostics

PROFINET IO
The SIMOTION D410‑2 DP/PN can communicate with the following components via the 
onboard PROFINET IO interface.     

Table 2-3 Components on the PROFINET IO

Component Function   
Programming device (PG/PC) … configures, assigns parameters, programs, and tests using the SIMO‐

TION SCOUT Engineering System (ES).
SIMATIC HMI device ... is used for operating and monitoring functions. This is not an essential require‐

ment for the operation of a Control Unit.
Other controllers (e.g. SIMOTION or SI‐
MATIC)

… e.g. higher-level controller (plant controller); modular machine concepts with 
multiple controllers, distributed across individual machine modules.

Master computer … communicates with other devices via UDP, TCP/IP.
Distributed I/O systems
SIMATIC ET 200MP Modular I/O system for cabinet installation and high channel densities in the SI‐

MATIC S7‑1500 packaging system. SIMATIC ET 200MP permits the shortest bus 
cycle times and fastest response time even with large volumes of data. With the 
time-based I/O, signals can be recorded or output to the precise µs. 

Description
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Component Function   
SIMATIC ET 200M Modular I/O system for cabinet installation and high channel densities in the SI‐

MATIC S7-300 packaging system.
SIMATIC ET 200SP Finely scalable I/O system for cabinet installation; ET 200SP features a single-

cable and multi-cable connection with push‑in terminals, compact dimensions, high 
performance, and low part variety. With the time-based I/O, signals can be recor‐
ded or output to the precise µs. 

SIMATIC ET 200S Finely scalable I/O system for cabinet configuration and particularly time-critical 
applications; including motor starters, safety technology and individual grouping of 
load groups.

SIMATIC ET 200AL Modular, distributed I/O system with compact I/O modules in IP65/67; simple in‐
stallation in all mounting positions even in small spaces; front and transverse screw 
fastenings on flat surfaces or on aluminum supporting channels; flexible connec‐
tion to PROFINET or PROFIBUS or simple integration in SIMATIC ET 200SP.

SIMATIC ET 200pro Modular I/O system with IP65/67 degree of protection for machine-related appli‐
cations with no cabinet; with features such as compact designs, integrated PRO‐
FIsafe safety technology, PROFINET IO connection and live module replacement.

SIMATIC ET 200eco PN Compact block I/O with IP65/66/67 degree of protection for cabinet-free usage in 
machines with M12 connection method. Very rugged and resistant encapsulated 
metal enclosure.

Other PROFINET IO I/O devices
Drive units with PROFINET IO interface ... convert speed setpoints into signals for controlling the motor and supply the 

power required to operate the motors.
Gateways ● IE/AS-Interface link PN IO for the PROFINET IO gateway to AS-Interface

● PN/PN coupler for connecting two PROFINET IO networks

Ethernet
The Control Unit can communicate with the following components via the Ethernet interfaces 
or be embedded in an automation environment:   

Table 2-4 Components on the Ethernet

Component Function
Programming device (PG/PC) … configures, assigns parameters, programs, and tests using the SIMOTION SCOUT En‐

gineering System (ES).
Master computer … communicates with other devices via UDP, TCP/IP.
SIMATIC HMI device ... is used for operating and monitoring functions. This is not an essential requirement for the 

operation of the SIMOTION D410‑2.

Description
2.2 System components

SIMOTION D410-2
24 Commissioning and Hardware Installation Manual, 04/2019, A5E33446807B



DRIVE-CLiQ
SIMOTION D410-2 can communicate via the DRIVE-CLiQ interface with the following 
components:   

Table 2-5 Components on DRIVE-CLiQ

Component Function
SINAMICS S120 AC DRIVE 
drive units 
(with CUA31/CUA32)

... convert speed setpoints into signals for controlling the motor and supply the power re‐
quired to operate the motors. The Power Module is connected via CUA31/CUA32. No more 
than one Power Module can be connected. The chassis Power Module is connected via 
DRIVE-CLiQ.
Note:
Components in booksize format are not supported!

TM15, TM17 High Feature Ter‐
minal Modules

The Terminal Modules TM15 and TM17 High Feature are used to implement measuring 
inputs inputs and output cam outputs. In addition, these Terminal Modules provide drive-
related digital I/Os with short signal delay times.

TM31 Terminal Module … enables terminal expansion via DRIVE-CLiQ (additional analog and digital I/Os).
TM41 Terminal Module … enables terminal expansion (analog and digital I/Os) and encoder simulation via DRIVE-

CLiQ. The TM41 can be connected to a real axis.
TM54F Terminal Module … enables terminal expansion (fail-safe digital inputs/outputs) for controlling the safe motion 

monitoring functions of the integrated drive. A TM54F is not usually necessary because the 
SIMOTION D410‑2 has 3 F‑DI and 1 F‑DO.

TM120 Terminal Module Four temperature sensors (KTY84‑130 or PTC) can be evaluated via the TM120 Terminal 
Module. The temperature sensor inputs are safely electrically separated from the evaluation 
electronics in the TM120 Temperature Module and are suitable for evaluating the temper‐
ature of special motors, e.g. 1FN linear motors and 1FW6 built-in torque motors.

TM150 Terminal Module The TM150 Terminal Module can be used to evaluate temperature sensors (KTY, PT100, 
PT1000, PTC, and bimetal normally closed contact). This means, for example, that other 
temperatures from the process can be measured in addition to the motor temperature. 
Temperature sensors can be evaluated using a 2, 3 or 4‑wire system. Twelve temperature 
sensors can be evaluated with 2‑wire evaluation and six temperature sensors with 3 and 
4‑wire evaluation. 

SMx Sensor Modules ... enable acquisition of encoder data from connected motors via DRIVE-CLiQ.
Motors with 
DRIVE-CLiQ interface

… allow simplified commissioning and diagnostics, as the motor and encoder type are iden‐
tified automatically.

DMC20/DME20 
DRIVE-CLiQ hub

… enables the number of DRIVE-CLiQ interfaces to be increased and the creation of a point-
to-point topology.

Note

Please note that SIMOTION D410‑2 components in booksize format (Controller Extension, 
Motor Modules, Line Modules, etc.) are not supported.

SIMOTION D410‑2 can only be used with the following Power Modules:
● PM340
● PM240-2 as of SIMOTION V4.4/SINAMICS V4.7

Other Power Modules are not supported by SINAMICS G120 (e.g. PM230).

Description
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Note

You will find detailed information on components in the SINAMICS S110/S120 family of 
products in the SINAMICS S110/S120 manuals.

It is possible that older DRIVE‑CLiQ components can no longer be used with SIMOTION 
D410‑2. You will find detailed information on this in the SIMOTION D410‑2 Commissioning and 
Hardware Installation Manual in Section "Migration of SIMOTION D410 to SIMOTION D410‑2" 
under "Permissible combinations".

See also
Permissible combinations (Page 233)

2.3 I/O integration

Note

Note that not all modules in the ET 200 I/O family are approved for SIMOTION. Moreover, 
system-related functional differences can come into play when these I/Os or I/O systems are 
used on SIMOTION vs. on SIMATIC. For example, special process-control functions (e.g. 
HART modules, etc.) are not supported by SIMOTION for the ET 200M distributed I/O system.

A detailed, regularly updated list of the I/O modules approved for use with SIMOTION, as well 
as notes on their use, can be found at Internet address (https://support.industry.siemens.com/
cs/ww/en/view/11886029) 

In addition to the I/O modules enabled for SIMOTION, in principle all certified standard 
PROFIBUS slaves (DP-V0/DP-V1/DP-V2) and PROFINET IO devices with RT and IRT real-
time classes may be connected to SIMOTION D410-2. These modules are integrated using the 
GSD file (PROFIBUS) or GSDML file (PROFINET) provided by the relevant device 
manufacturer.

Note

Please note that in isolated cases, additional boundary conditions must be fulfilled in order to 
integrate a module into SIMOTION. Thus, a few modules require "driver blocks" , e.g. in the 
form of function blocks, that permit (or simplify) integration.

For modules enabled for SIMOTION (e.g. SIMATIC S7‑300 module FM 350‑1, etc.), these 
driver blocks are part of the SIMOTION SCOUT engineering system command library.

Description
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2.4 Commissioning software

Requirement
To create and edit projects on your PG/PC, you need the SIMOTION SCOUT commissioning 
and configuration tool.

For information on how to install SIMOTION SCOUT, see the SIMOTION SCOUT 
Configuration Manual.   

Note

SIMOTION SCOUT contains the functionality of STARTER and SIMATIC S7-Technology. 

Simultaneous operation of SIMOTION SCOUT, STARTER and SIMATIC S7-Technology as a 
single installation on one PG/PC is not possible.

Integrated STARTER
You can insert a standalone drive (e.g. SINAMICS S120) with the "Insert single drive unit" 
element in the project navigator. It is commissioned using wizards in the working area of the 
workbench that contains the STARTER functionality.

SINAMICS Support Package (SSP)
The following SSPs are relevant for SIMOTION SCOUT:

● SSP "SINAMICS" for single drive units (e.g. CU3xx)

● "SIMOTION SINAMICS Integrated" SSP for the SINAMICS drive integrated into 
SIMOTION D410‑2.

You will find detailed information on the SSPs in the readme files and in the software 
compatibility list at Internet address (https://support.industry.siemens.com/cs/ww/en/view/
18857317).

Upgrading SIMOTION D410‑2 projects and hardware
Projects that you have created for one SIMOTION D410‑2 firmware version can also be 
converted for other firmware versions. See, for example, Section Service and maintenance 
(Page 239).

SIMOTION IT web server
The SIMOTION D410‑2 features an integrated web server.

The web server supports the display of diagnostics and system data in standard Internet 
browsers, even in the absence of an engineering system, and the carrying out of project/
firmware updates.

Description
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Additional references
You will find detailed information on working with projects in the SIMOTION SCOUT 
Configuration Manual.

You will find detailed information on SIMOTION IT web server in the SIMOTION IT Diagnostics 
and Configuration Diagnostics Manual.

Description
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Installing 3
3.1 General requirements

Mounting options
SIMOTION D410‑2 comes in two designs:

● Mounting on the Power Module in blocksize format (mounted use).

● Mounting on a mounting plate (detached use).

Open components
SIMOTION D410‑2 is an open device! This means, you can only install the modules in 
housings, cabinets or electrical equipment rooms. These may only be accessible via key or 
tool. Housings, cabinets, or electrical equipment rooms may only be accessed by trained or 
authorized personnel. An external fire protection casing is required.

DANGER

Danger to life from energized parts

Death or serious injury will result if energized parts are touched.

Turn off and lock out all power supplying this device before working on this device.

Note

The components must be protected against conductive contamination, e.g. by installing them 
in a control cabinet with degree of protection IP54 according to IEC 60529 or NEMA 12.

If conductive contamination can be excluded at the installation site, a lower degree of cabinet 
protection may be permitted.

SIMOTION D410-2
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3.2 Mounting the SIMOTION D410-2 on the power module

Overview
A SIMOTION D410-2 can be snapped directly on to a SINAMICS S120 Power Module in 
blocksize format via the PM-IF interface. Power Modules PM340 and PM240‑2 (PM240‑2 as of 
SIMOTION V4.4/SINAMICS V4.7) can be used. Operation with SINAMICS G120 PM2x0 
Power Modules or booksize Motor Modules is not possible.

Note

You can connect a Power Module in blocksize format to the DRIVE-CLiQ interface of 
SIMOTION D410-2 using the CUA31/CUA32 adapter module. Power modules in chassis 
format AC/AC are connected to SIMOTION D410-2 via the DRIVE-CLiQ interface of the Power 
Module.

Requirement
As soon as the Power Module is properly installed, you can mount the SIMOTION D410-2 on 
the Power Module.     

Note

Note the information in the SINAMICS S120 AC DriveManual when commissioning the Power 
Module.

Installing
3.2 Mounting the SIMOTION D410-2 on the power module
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Mounting on the Power Module

Snapping the SIMOTION D410-2 on to the Power 
Module (example PM340)

PM340 Power Module with SIMOTION D410-2 
(example PM340)

Disassembling the SIMOTION D410-2
To remove the SIMOTION D410-2 from the Power Module, the blue release, as shown in the 
figure, must be pressed down and SIMOTION D410-2 tilted forward.   

Installing
3.2 Mounting the SIMOTION D410-2 on the power module
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Figure 3-1 Removing the SIMOTION D410-2 from the Power Module

3.3 Mounting the SIMOTION D410-2 on the mounting plate

Overview
Using a mounting plate, SIMOTION D410-2 can be operated separately, which means it is not 
mounted directly on the Power Module.     

Application examples:

● Offset installation using CUA31/CUA32 Control Unit Adapter (e.g. for reducing the mounting 
depth or in order to use additional interfaces on the CUA).
The SIMOTION D410-2 is snapped on to the mounting plate and connected to the Power 
Module in blocksize format via DRIVE-CLiQ using CUA31/CUA32. No more than one 
Control Unit Adapter can be connected to the SIMOTION D410-2.

● Using SIMOTION D410-2 without a Power Module.
A SIMOTION D410-2 mounted on the mounting plate is operated without the Power Module 
(e.g. for hydraulic applications).

Requirements
You must order the mounting plate for the SIMOTION D410-2 separately. For the article 
number, see Section "Spare parts and accessories" in the SIMOTION D410-2 Manual.

Installing
3.3 Mounting the SIMOTION D410-2 on the mounting plate
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Mounting on mounting plate
1. The mounting plate is attached to the control cabinet.

2. The SIMOTION D410-2 is snapped on to the mounting plate.

Figure 3-2 Mounting the SIMOTION D410-2 on the mounting plate

Note

When operating away from the Power Module, generally the power supply must be realized via 
the power supply connection (X124).

It is also not possible to use the Safety Integrated Extended and Advanced Functions via the 
onboard terminals (F-DI, F-DO) in distributed operation.

Observe the information on control cabinet installation in the SINAMICS S120 AC Drive 
Manual.

Installing
3.3 Mounting the SIMOTION D410-2 on the mounting plate
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3.4 Mounting the SIMOTION D410-2 in the power module chassis

Figure 3-3 Mounting the CU310, for example, in the power module chassis, FX frame size

The DRIVE-CLiQ cable and the cable for the 24 V supply must be correctly routed so that the 
front flap can close.

Note

For the power module, a connecting cable is also supplied for the power supply of the 
SIMOTION D410-2. This cable must be connected to the SIMOTION D410-2.

Installing
3.4 Mounting the SIMOTION D410-2 in the power module chassis
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Connecting 4
4.1 General Overview

Overview
The SIMOTION D410‑2 has a number of interfaces that can be used for connecting the power 
supply and for communication with the other components of the system.

● The different SINAMICS components are interconnected via DRIVE‑CLiQ.

● Actuators and sensors can be connected to the inputs/outputs.

● The SIMOTION D410‑2 can be connected to PROFIBUS DP, MPI, Ethernet, and 
PROFINET (D410-2 DP/PN only) for communication purposes.
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Arrangement of the interfaces on the device

Figure 4-1 SIMOTION D410-2 DP, arrangement of the interfaces on the device   

  

Connecting
4.1 General Overview
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Figure 4-2 SIMOTION D410-2 DP/PN, arrangement of the interfaces on the device   

Connecting
4.1 General Overview
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Overview of connections
The following overview shows examples of the various interfaces and their connection 
possibilities.     

Figure 4-3 SIMOTION D410-2 connection possibilities

4.2 General rules for operating the SIMOTION D410-2
When integrating the SIMOTION D410-2 into a system, you must observe the following general 
rules.

System startup after certain events
Observe the following rules when starting up a system following certain events:

● During startup after a voltage dip or power failure, no dangerous operating states may 
result. If necessary, force an EMERGENCY STOP.

● At startup, after unlocking the EMERGENCY STOP apparatus, there must not be an 
uncontrolled or undefined startup.

Connecting
4.2 General rules for operating the SIMOTION D410-2
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Supply voltage
Observe the following rules for the supply voltage:

● For stationary installations or systems that do not have all-pole line disconnect switches, the 
building installation must include a line side switch or a fuse.

● For load power supplies and power supply modules, the rated voltage range set must 
correspond to the local line voltage.

● For all electrical circuits, the fluctuation/deviation of the line voltage from the rated value 
must be within the permitted tolerance (refer to the technical data of the used components)

24 V DC supply voltage
Observe the following rules for the 24 V supply:

● Provide lightning protection (e.g. lightning protection devices):

– External lightning protection is required for buildings.

– An internal lightning protection must be provided for for 24 V DC supply cables and signal 
cables.

● Ensure safe (electrical) isolation of the extra-low voltage for the 24 V supply.

WARNING

Danger to life from hazardous voltage when connecting an unsuitable power supply

Implement the 24 V DC supply with protective separation as protective extra-low voltage.

Protection against external electrical interference
Observe the following rules for protection against electric effects or faults:

● For all plants or systems, in which SIMOTION is installed, the plant or system must be 
connected to a protective conductor for the discharge of electromagnetic interference.

● The wiring arrangement and installation must comply with EMC regulations for the supply, 
signal and bus cables.

● A cable or wire break cannot lead to undefined states in the plant or system for signal or bus 
cables.

Connecting
4.2 General rules for operating the SIMOTION D410-2
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Rules for current consumption and power loss in an installation
The power loss of all components used in a cabinet must not exceed the maximum amount that 
can be dissipated from the cabinet.

Note

When designing the control cabinet, ensure that the temperature inside the cabinet does not 
exceed the permitted ambient temperature for the components even at high external 
temperatures.

Additional references
The same installation instructions apply for the SIMOTION D410-2 control unit as for the 
SINAMICS S120 CU310-2 control unit with regard to EMC.

Refer to SINAMICS S120 for AC Drives Manual.

4.3 Electromagnetic compatibility

4.3.1 General
Electromagnetic compatibility (EMC) means that the devices function satisfactorily, without 
interfering with other devices and without being disrupted by other devices. The EMC 
requirements for variable-speed drive systems (PDS, Power Drive System) are described in 
the product standard IEC/EN 61800-3.
A variable-speed drive system consists of the Control Unit and Power Module as well as the 
relevant electric motors and encoders, including connecting cables. The driven machine is not 
part of the drive system.

Note
PDS as component of machines or systems

For the integration of PDS into machines or systems, additional measures may be required so 
that the product standards of these machines or systems are complied with. The machine or 
system builder is responsible for taking these measures.

4.3.2 Environments and categories
The EMC environments and categories are defined in the EMC Product Standard EN 61800-3, 
as follows:

Connecting
4.3 Electromagnetic compatibility
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Environments
IEC/EN 61800-3 differentiates between the first and second environments - and defines 
different requirements for these environments.

First environment
Residential buildings or locations at which the drive system is directly connected to a public low-
voltage line supply without intermediate transformer.

Second environment
All locations outside residential areas. These are basically industrial areas which are supplied 
from the medium-voltage line supply via their own transformers.

Categories
IEC/EN 61800-3 differentiates between four drive system categories:

Category C1
Drive systems for rated voltages < 1000 V for unrestricted use in the first environment.

Category C2
Stationary drive systems for rated voltages < 1000 V for operation in the second environment.
The drive system must be installed by appropriately qualified and trained personnel. Additional 
measures are required for operation in the first environment.

Category C3
Drive systems for rated voltages < 1000 V, only for operation in the second environment.

Category C4
Drive systems for IT line supplies for operation in complex systems in the second environment. 
An EMC plan must be drawn up.

SIMOTION
SIMOTION D is designed for industrial use in accordance with Category C2.

Interference immunity
SIMOTION D and SINAMICS S120 are suitable for operation in the second environment. With 
regard to interference immunity, SIMOTION D and SINAMICS S120 can be used in the first and 
second environments.

Emitted interference
With regard to interference emission, to comply with the limit values in accordance with IEC/EN 
61800-3 second environment, Category C2; in particular for the drive system, certain measures 
must be observed (EMC-conform installation by appropriately qualified and trained personnel, 
possibly required radio interference suppression filters, etc.) Observe the information on 
electromagnetic compatibility (EMC).

Connecting
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EMC notes

Note

Further information can be found in chapter "Control cabinet installation and EMC" in the 
SINAMICS S120 AC-Drive Equipment Manual.

Note

Requirements for implementing EMC are listed in EN 61000-6-2, EN 61000-6-4, EN 61800-3, 
EN 60204-1 and in the "EMC Installation Guidelines" Configuration Manual. (https://
support.industry.siemens.com/cs/ww/de/view/60612658)

Note

Conformance with the EMC Directive of the EC is ensured by following the measures described 
in the "EMC Installation Guideline" Configuration Manual.

4.4 Protective conductor connection and potential equalization

Requirement
You have mounted the Control Unit in the control cabinet.

The SIMOTION D410-2 control unit has a protective conductor connection (M4 screw, Torx 
T20). This connection is also for the connection of an equipotential bonding conductor.

Note

Requirements for functional safety for machines and systems; reliability and EMC are only 
guaranteed with original SIEMENS cables.

DANGER

Danger to life from energized parts

Death or serious injury will result if energized parts are touched.

Turn off and lock out all power supplying this device before working on this device.

Protective conductor connection
SIMOTION D and the SINAMICS S120 drive system are designed for use in cabinets with a 
protective conductor connection. 

All system components and machine parts must be incorporated in the protection concept. 

Connecting
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The drive line-up must be arranged on a common bright mounting plate ① in order to comply 
with the EMC limit values. The connection ② establishes a low-impedance connection to the 
mounting plate.

The mounting plate must be connected to the protective conductor connection of the control 
cabinet. For this purpose, a connection ③ must be established to the protective conductor bar 
④. The protective conductor bar ④ must be connected to the protective conductor ⑤.

The protective connection (PE connection) that is used for the motors ⑥ must be established 
through the motor cable.

For EMC reasons, the motor cable shield must be laid flat at both the Motor Module (MM) / 
Power Module (PM) and motor.

A protective connection ⑧ must also be established for components that are not connected 
with low impedance (e.g. control cabinet door via hinges ⑦).

Example: Booksize axis grouping comprising Control Unit (CU), Line Module (LM), and Motor 
Modules (MM) as well as drive in blocksize format comprising a Power Module (PM) with 
snapped on Control Unit (CU)

Figure 4-4 Protective conductor connection, cabinet with mounting plate / equipotential bonding 
surface

Connecting
4.4 Protective conductor connection and potential equalization
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The protective conductor connections must be dimensioned as follows:

Table 4-1 Conductor cross-section for copper protective connections

Line supply cable in mm² Copper protective connections in mm²
Up to 16 mm² The same as the line supply cable
From 16 mm² to 35 mm² 16 mm²
From 35 mm² 0.5 x line supply cable

For materials other than copper, the cross-section should be increased so that as a minimum, 
the same conductivity is attained.

Equipotential bonding
A mounting plate serves simultaneously as an equipotential bonding surface. This means that 
no additional equipotential bonding is required within the drive line-up. If a common bright 
mounting plate is not available, then equally good equipotential bonding ⑨ must be 
established using cable cross-sections as listed in the table above or, as a minimum, with the 
same conductivity.

Figure 4-5 Protective conductor connection, cabinet without equipotential bonding surface

Connecting
4.4 Protective conductor connection and potential equalization
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Note

Ground potential and housing (PE) for the SIMOTION D410-2 are connected internally with low 
impedance.

Communication links
Within the same control cabinet, no equipotential bonding conductor is required for fieldbus 
components if they installed as described above.

You have to ensure equipotential bonding for communication connections between remote 
components in a system (e.g. devices in different control cabinets) as well as between buildings 
or building sections.

If, for example, data cables (PROFIBUS, PROFINET, Ethernet or DRIVE‑CLiQ) are routed 
through several control cabinets, equipotential bonding must be established with an 
equipotential bonding conductor. Install the equipotential bonding conductor together with the 
data cable.

The following minimum cross-sections are required according to IEC 60364-5-54:

● For copper, at least 6 mm²

● For aluminum, at least 16 mm²

● For steel, at least 50 mm²

NOTICE

Fault of the data link or device defect with missing equipotential bonding

Considerable leakage currents can flow via the data cable if equipotential bonding is not 
provided. Disturbance of the data link or device faults may result.

Install an equipotential bonding conductor together with the data cable.

Due to the maximum length of 100 m for PROFIBUS copper cable at 12 Mbit/s or for 
PROFINET copper cable and due to the electrical isolation, EMC protection and equipotential 
bonding aspects, it is recommended that fiber-optic cables be used for connections between 
buildings.

Additional information
Further information on the protective connection and equipotential bonding can be found in the 
following references:

● SINAMICS drive system: See the SINAMICS manuals

● PROFIBUS and PROFINET: See the following Internet address (http://www.profibus.com) 
(at Downloads)

Connecting
4.4 Protective conductor connection and potential equalization
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4.5 Connecting the power supply

4.5.1 Safety rules
Because of the wide range of possible applications, only the basic rules for electrical installation 
are described in this section. At a minimum, you must comply with these basic rules to ensure 
problem-free operation.

Rules for safe operation
In order to ensure safe operation of your equipment, implement the following measures and 
adapt them to suit your particular conditions:   

● An EMERGENCY-OFF concept based on applicable technical specifications
(e.g. European Standards EN 60204, EN 418 and associated standards).

● Additional measures to limit the travel of axes
(e.g. hardware limit switch).

● Equipment and measures to protect motors and power electronics according to the 
SINAMICS Installation Guidelines.

In order to identify hazards, we also recommend that a risk analysis be conducted on the entire 
system in accordance with the basic safety requirements set out in Appendix 1 of the EU 
machinery directive.

Additional references
● Guidelines on Handling Electrostatic Sensitive Devices (ESD), see Appendix ESD 

guidelines (Page 303) in this manual.

● For installing a system with SIMATIC ET 200 I/O (e.g. ET 200SP, ET 200 MP, etc.), see the 
manuals for the relevant ET 200 I/O systems.

● For further information on EMC, we recommend the EMC Installation Guidelines / Basic 
System Requirements Configuration Manual
Download: https://support.industry.siemens.com/cs/ww/en/view/60612658

Standards and regulations
You must comply with the applicable VDE guidelines when wiring the SIMOTION D410‑2, in 
particular VDE 0100 and VDE 0113 for disconnecting devices, short-circuit and overload 
protection.

4.5.2 Wiring the power supply
If no digital outputs are used or if the SIMOTION D410‑2 is being operated on a mounting plate, 
the SIMOTION D410-2 can be supplied by the Power Module via the PM-IF interface.

Connecting
4.5 Connecting the power supply
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If digital outputs are used, a 24 V load power supply must be connected to the X124 screw-type 
terminal block.       

Note

If a digital output is parameterized and the 24 V load power supply is not connected (or the level 
is too low), alarm A03506 is issued on the SINAMICS side (can also be parameterized as a 
fault).

WARNING

Danger to life from hazardous voltage when connecting an unsuitable power supply

Implement the 24 V DC supply with protective separation as protective extra-low voltage.

Wiring the screw-type terminal block

DANGER

Danger to life from energized parts

Death or serious injury will result if energized parts are touched.

Turn off and lock out all power supplying this device before working on this device.

Use flexible cables with a cross-section of at least 1 mm² when you wire the power supply.

Wire-end sleeves are required if you wire several cables per connection.

1. Strip the cable ends.

2. Put on the wire-end sleeve if applicable.

3. Plug the cable end (with wire-end sleeve) into the screw-type terminal connection.

4. Tighten the mounting screw.

5. Plug the screw-type terminal with cables into the X124 connection.

6. Tighten the screw-type terminal block with a flat-bladed screwdriver.

Reverse polarity protection
The LED "RDY" lights up green when the power supply is connected correctly and switched on.

Note

The control does not run if the polarity is reversed. However, integrated reverse polarity 
protection protects the electronics from damage.

Connecting
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Fuse
If the control is defective, an internal fuse protects the electronics from consequential damage 
(e.g. fire). In this case, the module must be replaced.

4.6 Connecting DRIVE-CLiQ components

Overview
DRIVE-CLiQ connects the components in the SINAMICS S120 drive family as well as 
SIMOTION D410-2. DRIVE-CLiQ is a communications system, which enables 
SIMOTION D410-2 to automatically detect connected components. DRIVE-CLiQ provides a 
wiring tree, the topology of which can be visualized in SIMOTION SCOUT.

Information on the components that can be connected to DRIVE-CLiQ can be found in 
Section"DRIVE-CLiQ interface" of the SIMOTION D410-2 Manual.

Rules for wiring DRIVE-CLiQ
The following rules must be followed for wiring DRIVE-CLiQ:   

● Ring wiring is not permitted.

● Components must not be double-wired.

You will find detailed information about DRIVE-CLiQ wiring in the SINAMICS S120 Control 
Units and Additional System Components Manual.

Procedure
Connect the SIMOTION D410-2 X100 socket to the corresponding sockets on the drive 
components using the DRIVE-CLiQ signal cable (motor with DRIVE-CLiQ interface, TM and 
SMx modules).   

Note

Please note that SIMOTION D410-2 components in booksize format (controller extension, 
motor modules, line modules, etc.) are not supported.

4.7 Connecting I/Os

Connecting cables
For the input/output wiring (X120, X121, X130, X131), use rigid or flexible cables with a 
conductor cross-section as stated in the manual. 

Connecting
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See SIMOTION D410-2 Manual, Section "Digital inputs/outputs / temperature sensor / analog 
input."

Note

To achieve optimum interference immunity, shielded cables must be used for connecting 
analog signals, measuring inputs or external zero marks.

Tools required
Screwdriver 0.4 x 2.0 mm

Wiring inputs/outputs
1. Strip 10 mm off the cable ends and press on a ferrule if required.

2. Wire:

– The digital inputs for connection of sensors.

– The digital outputs for the connection of actuators.

– The analog input

3. Insert the cable into the corresponding spring-loaded terminals of the interfaces. Pressure 
can be applied to the spring with the tool to facilitate insertion.

Switching the analog input
For the use of the analog input (X131 connector) as analog voltage or current input, DIP switch 
S5.0 must be switched accordingly:

Table 4-2 S5.0 switch positions

Position Function
U (left) The analog input is used as voltage input.
I (right) The analog input is used as current input.

Additional references
The connection examples for the wiring of the inputs/outputs can be found in 
the SIMOTION D410-2 Manual, Section "Digital inputs/outputs / temperature sensor / analog 
input".

Connecting
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4.8 Creating a shield connection

Using shielded cables
The following options are available for the shield connection when using shielded cables:

● A shield connection using a shielding bus supplied separately

● Shield connection via the M3 screw-on shield connecting element on the housing of the 
SIMOTION D410-2

Using a shielding bus
If a shielding bus is used, proceed as follows:

1. Attach the cable shield to a grounded shielding bus after the cable entry point in the cabinet. 
Strip the insulation off the cable first.

2. Continue routing the shielded cable as far as the module, but do not make a connection to 
the shield there.

Using a shield connection on the SIMOTION D410-2   
1. Unscrew the holding clamp of the M3 shield connection (Torx screwdriver T10) at the top of 

the SIMOTION D410-2 until there is a space below the clamp.

2. Insert the cable. The cable shield must first be exposed.

3. Tighten the fixing bracket so that the cable shield and cable are pressed against the shield 
connection (tightening torque 0.8 Nm).

The following figure shows how to connect the cable shield. 

Figure 4-6 Shield connection using the SIMOTION D410-2 DP as an example

Connecting
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4.9 Connecting PROFIBUS/MPI

4.9.1 PROFIBUS connection components

Connection components
Individual nodes are connected by means of bus connectors and PROFIBUS cable. 
Remember to provide a bus connector with a programming port at the ends of the subnet. This 
will give you the option of expanding the subnet if required (for example, for a PG or SIMATIC 
HMI device).   

Use RS 485 repeaters for the connection between segments and to extend the cable.

Segments
A segment is a bus cable between two terminating resistors. A segment can contain up to 32 
nodes. In addition, a segment is limited by the permissible cable length, which varies according 
to the transmission rate.   

Terminating resistor
A cable must be terminated with its own surge impedance to prevent line disturbances caused 
by reflections. Activate the terminating resistor at the first and last node of a subnet or segment.

Make sure that the nodes to which the terminating resistor is connected are always supplied 
with voltage during power-up and operation.     

4.9.2 PROFIBUS cables and connectors

Properties of PROFIBUS cables
The PROFIBUS cable is a two-core, twisted and shielded cable with defined properties:   

Table 4-3 Properties of PROFIBUS cables

Characteristics Values
Characteristic impedance Approximately 135 to 160 Ω (f = 3 to 20 MHz)
Loop resistance ≤ 115 Ω/km
Effective capacitance 30 nF/km
Damping 0.9 dB/100 m (f = 200 kHz)
Permissible conductor cross-section 0.3 mm2 to 0.5 mm2

Permissible cable diameter 8 mm + 0.5 mm
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Connector features
The bus connector is used to connect the PROFIBUS cable to the PROFIBUS DP interfaces. 
thus establishing a connection to additional nodes.   

Table 4-4 SIMOTION D410-2 PROFIBUS interfaces 

 D410-2 DP D410-2 DP/PN
PROFIBUS DP/MPI interface X21 X21
PROFIBUS DP interface X24 –

You will find an overview of the bus connectors available for order in the SIMOTION D410-2 
Manual, Section "Spare parts and accessories".

4.9.3 Length of PROFIBUS cables

Cable lengths and baud rate
The baud rate determines the cable length of a subnet segment.   

Table 4-5 Permitted cable length of a subnet segment for specific baud rates

Baud rate Max. cable length of a segment (in m)
19.6 to 187.5 kbit/s 1000 1)

500 kbit/s 400
1.5 Mbit/s 200
3 to 12 Mbit/s 100

1) With isolated interface

Longer cable lengths
If you must implement longer cable lengths than permitted in one segment, you must use 
RS 485 repeaters. The maximum possible cable lengths between two RS 485 repeaters 
correspond to the cable length of a segment. You can connect up to nine RS 485 repeaters in 
series.

Note that an RS 485 repeater must be counted as a subnet node when determining the total 
number of nodes to be connected, even if it does not have its own PROFIBUS address.

Connecting
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4.9.4 Rules for the laying of PROFIBUS cables

Laying of bus cable
During laying of the PROFIBUS cable, you must:   

● Not twist the cable

● Not stretch the cable

● Not squeeze the cable

Supplementary conditions
In addition, when laying a bus cable for indoor use, you must take into account the following 
supplementary conditions (dA = external cable diameter):

Table 4-6 Supplementary conditions for the laying of PROFIBUS cables

Characteristics Supplementary conditions
Bending radius for a single bend 80 mm (10xdA)
Bending radius for multiple bends 160 mm (20xdA)
Permissible temperature range for cable routing -5° C to +50° C
Temperature range for storage and stationary operation -30° C to +65° C

Additional references
Length codes for prefabricated cables can be found in:

● SIMOTION PM 21, SIMOTION Motion Control Catalog

● IK PI Industrial Communication Catalog

4.9.5 Connecting PROFIBUS DP (interface X21 and X24)
PROFIBUS cables are connected to the corresponding interface via a bus connector.   

Table 4-7 SIMOTION D410-2 PROFIBUS interfaces 

 D410-2 DP D410-2 DP/PN
PROFIBUS DP/MPI interface X21 X21
PROFIBUS DP interface X24 –

Connecting
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Connecting the bus connector
Proceed as follows to connect the bus connector:   

1. Plug the bus connector into the corresponding interface of the control unit.

2. Screw the bus connector into place.
If the control unit is located at the start or end of a segment, you must switch on the 
terminating resistor ("ON" switch setting).

Figure 4-7 Terminating resistor "switched on" or "switched off"

Note

Make sure that the nodes at which the terminating resistor is located are always supplied 
with voltage during startup and operation.

Removing the bus connector
You can remove the bus connector with a looped-through bus cable from the PROFIBUS DP 
interface at any time without interrupting data traffic on the bus.   

NOTICE

Data communication disturbed because bus terminator missing

A bus segment must be terminated at both ends with a terminating resistor. This is not the 
case if the last bus connector node is de-energized, for example. Because the bus connector 
takes its voltage from the station, this terminating resistor is ineffective.

Make sure that the stations at which the terminating resistor is connected are always 
energized.

4.9.6 Connection rules in the PROFIBUS subnet

Introduction
There are a number of rules for configuring and installing cables for PROFIBUS networks to 
ensure seamless communication over PROFIBUS. These rules apply to both configuring and 
cabling as well as address assignment for the different network nodes.

Connecting
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Connection rules
● Before you interconnect individual nodes in a subnet, you must assign a unique PROFIBUS 

address to each node.  

● Narrow down the number of nodes by limiting the PROFIBUS addresses to the highest 
address in the network.
Tip: Mark the address on the housing of all nodes in a subnet. Then you can always see 
which address is assigned to which node in your system. 

● Connect all nodes in a subnet "in series". No spur lines may be routed to the PROFIBUS DP.
In addition, integrate the PGs and SIMATIC HMI devices for commissioning or servicing in 
the subnet in series.

● If you operate more than 32 nodes on a subnet, you must use RS 485 repeaters to connect 
the bus segments. More detailed information can be found in the description of the RS 485 
repeater, see the S7‑300 Automation Systems, Module Data Manual.
In a PROFIBUS subnet, all segments combined must have at least one DP master and one 
DP slave.

● Use RS 485 repeaters to connect ungrounded bus segments and grounded bus segments.

● The maximum number of nodes per bus segment decreases with each RS 485 repeater. 
This means that when a bus segment contains an RS 485 repeater, the bus segment can 
contain no more than 31 additional nodes. However, the number of RS 485 repeaters does 
not affect the maximum number of nodes on the bus.

● Up to 10 segments can be connected in a row (max. 9 repeaters).

● At least one terminator must be supplied with 5 V.
To accomplish this, the PROFIBUS DP connector with an activated terminating resistor 
must be connected to a device that is switched on.

● Before inserting a new node on the subnet, you must switch off its supply voltage.
The station must be inserted first and then switched on.
When a station is disconnected, the connection must first be deactivated and then the 
connector withdrawn.

● The bus line of a segment must be terminated at both ends. This is achieved by switching 
on the terminating resistor in the PROFIBUS DP connector at the first and last node and 
switching off the other terminating resistors.
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Example
This illustration below shows an example configuration of a subnet with SIMOTION D410-2 DP.

Figure 4-8 Networking example of SIMOTION D410-2 DP

4.9.7 Operating interface X21 as an MPI

Applications
The X21 interface can also be operated as an MPI interface instead of a PROFIBUS DP 
interface. The typical (default) baud rate is 187.5 Kbaud. A baud rate of up to 12 MBaud can be 
set for communication with other CPUs. It should be noted, however, that a rate of 12 MBaud 
is not supported by all CPUs (e.g. smaller SIMATIC S7 CPUs).

The following list provides examples of when using MPI (multi-point interface) may prove 
effective:

● If a PC/PG is being used with an MPI interface

● If an OP/TP only has an MPI interface
(newer devices have PROFIBUS or PROFINET interfaces)

● If SIMOTION and SIMATIC CPUs are coupled via XSEND/XRECEIVE

Connecting
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When communicating with XSEND/XRECEIVE, there is no need to configure the connection in 
NetPro. XSEND/XRECEIVE can be used via PROFIBUS or MPI.

● Via PROFIBUS: For communication between SIMOTION devices

● Via MPI: For communication between SIMOTION and SIMATIC S7 devices
The SIMOTION interface must be connected to the MPI interface of the SIMATIC S7 
devices. Connection via PROFIBUS is not possible.
The baud rate of the SIMATIC S7 device must be set at the SIMOTION interface (see 
documentation for the relevant SIMATIC S7 devices).

Operate MPI like PROFIBUS
The information on wiring the connector (terminating resistors) and the rules for routing of 
cables for PROFIBUS apply to this interface as well. When carrying out this procedure, consult 
the relevant references.

Connector features
The bus connector is used to connect the MPI bus cable to the MPI interface (X21). This 
enables you to establish connections to additional nodes (e.g. PG or SIMATIC S7-CPU).     

You will find an overview of the bus connectors available for order in the SIMOTION D410-2 
Manual, Chapter "Spare parts and accessories".

MPI bus cable
The PROFIBUS cable specifications apply here as well; 

Please note the relevant information on setting up an MPI network.

Setting up an MPI network
Keep in mind the following basic rules when setting up an MPI network:   

● When using interface X21 as an MPI interface, it is not possible to arrange additional control 
for a drive in isochronous mode or to connect distributed I/Os to this interface.

● An MPI bus line must be terminated at both ends. This is achieved by activating the 
terminating resistor in the MPI connector in the first and last station and deactivating the 
other terminating resistors.

● At least one terminator must be supplied with 5 V.
This means that an MPI connector with an activated terminating resistor must be connected 
to a device that is switched on.

● Spur lines (cables leading from the bus segment to the station) should be as short as 
possible, that is, < 5 m in length. Unused spur lines should be removed wherever possible.
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● Every MPI station must be connected to the bus first and then activated.
To disconnect the station, it must first be deactivated. Then, the station can be removed 
from the bus.

● Maximum cable lengths:

– 200 m per bus segment

– 2,000 m total length with RS 485 repeaters

Note

You can also use intelligent DP slave functionality for PROFIBUS communication between 
CPUs.

4.10 Connecting PROFINET IO components (D410-2 DP/PN only)

4.10.1 Wiring PROFINET

Procedure
As standard, a SIMOTION D410-2 DP/PN has a PROFINET IO interface with two ports.     

Suitable PROFINET cables and connectors must be used for the PROFINET connection. The 
autocrossing functionality of the PROFINET interface means crossed as well as uncrossed 
cables can be used. 

Mixed operation of IRT and RT
For mixed operation of IRT and RT, note that the IRT-capable devices must form a so-called 
IRT domain, i.e. there must not be any non-IRT devices on the data transmission link between 
the IRT devices.

Figure 4-9 Mixed operation of IRT and RT
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4.10.2 PROFINET cables and connectors

Cable and connector types   

Note

For connecting PROFINET IO to D410‑2, a connector with a 180° cable outlet is recommended 
(IE FC RJ45 plug 180).

Figure 4-10 RJ45 PN connector with a 180° cable outlet

Table 4-8 Connector types for PROFINET     

Connectors Designation Article number
IE FC RJ45 plug 180 RJ45 FastConnect connector for Indus‐

trial Ethernet/PROFINET with 180° ca‐
ble outlet  
1 pack = 1 unit 6GK1901-1BB10-2AA0
1 pack = 10 units 6GK1901-1BB10-2AB0

Table 4-9 Cable types for PROFINET

Cable Designation Article number
IE FC Cable GP 2x2 (Type A) 4-wire, shielded TP installation cable for 

IE FC RJ45
6XV1840-2AH10

IE FC Flexible Cable GP 2x2 
(Type B)

4‑wire, shielded flexible TP installation 
cable for IE FC RJ45

6XV1870-2B

IE FC Trailing Cable GP 2x2 
(Type C)

4‑wire TP installation cable for trailing 
cable use 

6XV1870-2D

IE FC Trailing Cable 2x2 
(Type C)

4-wire, shielded TP installation cable for 
connection to FC OUTLET RJ45, for trail‐
ing cable use 

6XV1840-3AH10

IE FC Marine Cable 2x2 4‑wire, shielded marine-certified TP in‐
stallation cable for connection to 
FC OUTLET RJ45

6XV1840-4AH10
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Table 4-10 Stripping tool for Industrial Ethernet / PROFINET

Tool Designation Article number
IE FC Stripping Tool Stripping tool for Industrial Ethernet / 

PROFINET
6GK1901-1GA00

Additional references
For further information about the cables, connectors, and stripping tool, see 

● Section "Spare parts and accessories" in the SIMOTION D410-2 Manual

● IK PI, Industrial Communication Catalog

4.11 Connecting Ethernet

Wiring Ethernet
An Industrial Ethernet can be connected to the 8-pin RJ45 socket X127 P1.

The interface supports a transmission rate of 10/100 Mbit/s. Suitable Ethernet cables and 
connectors must be used for the Ethernet connection.

A shielded twisted pair cable is used for the networking.

Note

The Ethernet interface supports PROFINET basic services and therefore has the designation 
PN/IE. These PROFINET basic services (e.g. DCP, LLDP, SNMP) provide uniform functions 
for the address assignment and diagnostics, but do not provide PROFINET IO communication 
for the connection of drives, I/O modules, etc.

Recommended connecting cables
The following cables are available:

● SIMATIC NET, Industrial Ethernet TP XP CORD RJ45/RJ45

– TP cable prefabricated with 2xRJ45 connectors

– Crossed send and receive cable

– Article number: 6XV1870-3R☐☐☐ (☐☐☐ ‑ length code)

● SIMATIC NET, Industrial Ethernet TP CORD RJ45/RJ45

– TP cable prefabricated with 2xRJ45 connectors

– Uncrossed send and receive cable

– Article No.: 6XV1870-3Q☐☐☐ (☐☐☐ ‑ length code)

Connecting
4.11 Connecting Ethernet

SIMOTION D410-2
60 Commissioning and Hardware Installation Manual, 04/2019, A5E33446807B



The autocrossing functionality of the Ethernet interface means crossed as well as uncrossed 
cables can be used.

Autocrossing
Per default, the Ethernet interface is set to "Automatic setting" in HW Config, so that 
autocrossing is available. The settings can be found in the port properties (X127 P1) in the 
module rack of HW Config.

Autocrossing is deactivated with "Manual setting". As the Ethernet interface of the D410-2 is 
wired as Ethernet terminal, in this case you must use crossed cables for the networking with a 
PG/PC or another D410-2. 

If the communication peer has autocrossing (e.g. PC, switch or hub), crossed and uncrossed 
cables can be used.

Additional references
For further information about the cables and connectors, see 
the Industrial Communication IK PI Catalog.

4.12 Routing
Routing describes the cross-network transfer of information from Network x to Network y.

4.12.1 Routing on SIMOTION D

Routing between the different interfaces
SIMOTION D410‑2 supports S7 routing between the following interfaces:

● Between Ethernet interface X127 and PROFIBUS interfaces X21 and X24 (X24 only 
available on D410‑2 DP)

● Between Ethernet interface X127 and PROFINET interface X150 (only available on 
D410‑2 DP/PN)

● Between PROFINET interface X150 and PROFIBUS interface X21 (only available on 
D410‑2 DP/PN)

Each combination of Ethernet interface X127 and PROFINET interface X150 represents a 
separate IP subnet.

All ports of the X150 PROFINET interface belong to the same IP subnet.

IP routing from IP subnet to IP subnet is not supported. You can use an external IP router for 
this.

Below is a list of the options available for connecting a PG/PC or HMI device to a SIMOTION D 
using S7 routing.
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Engineering System/HMI on PROFIBUS (example: D410‑2 DP)

Figure 4-11 Example of PG/PC to PROFIBUS interface (X21)

● S7 routing to the other (master) PROFIBUS interfaces (only if configured)

● S7 routing to the PROFIBUS Integrated

● S7 routing to the Ethernet interface (X127 P1)
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Engineering System/HMI on PROFINET (example: D410‑2 DP/PN)

Figure 4-12 Example of PG/PC to PROFINET interface (PNxIO, X150)

● S7 routing to the (master) PROFIBUS interface (only if configured)

● S7 routing to the PROFIBUS Integrated

● S7 routing to Ethernet interface PN/IE (X127 P1)

● Access to the components on the same subnet via the switch functionality of the 
PROFINET IO interface

Connecting
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Engineering System/HMI on Ethernet (example: D410‑2 DP)

Figure 4-13 Example of PG/PC to Ethernet interface (X127 P1)

● S7 routing to the other (master) PROFIBUS interfaces (only if configured)

● S7 routing to the PROFIBUS Integrated

4.12.2 Routing on SIMOTION D (SINAMICS integrated)

S7 routing to the internal PROFIBUS on SINAMICS Integrated
All SIMOTION D have an integrated SINAMICS drive control. In order to be able to access drive 
parameters, the message frames must be routed from the external SIMOTION D interfaces to 
the internal PROFIBUS DP. S7 routing can be used to access the integrated PROFIBUS. Here, 
the internal PROFIBUS DP forms a separate subnet. This must be especially taken into 
account for the communication to several routing nodes.

Additional references
Further information about routing and the differences between IP and S7 routing can be found 
in the SIMOTION Communication System Manual.
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4.13 Connecting an external encoder

Connecting the connecting cable
Use only shielded cables to connect an external encoder to the encoder interface (X23). The 
shielding must be connected with the metallic or metallized connector housing.

We recommend that bipolar encoders are used. When using unipolar encoders, the unused 
negative track signals can either be connected or connected to ground. This results in different 
switching thresholds.
See SIMOTION D410-2 Manual, Section "Encoder interface (HTL/TTL/SSI)".

The pre-assembled connecting cables offer optimal noise immunity as well as sufficiently 
measured cross-sections for the supply voltage of the external encoder. 

The connecting cables are available in various lengths, see NC 60 Catalog.

Procedure for connecting encoders
To connect an external encoder (HTL, TTL or SSI encoder), proceed as follows:   

1. Connect the connecting cable to the encoder.

2. Plug the D-Sub connector (15-pin) to the socket X23.

3. Lock the connector using the finger screws.

NOTICE

Destruction of the encoder electronics

Operation of a 5 V encoder on the 24 V encoder supply may result in the destruction of its 
electronic components!

Make sure that you can operate the connected encoder on a 24 V power supply (e.g. HTL 
encoder). This setting can be set in the expert list of the drive in parameter p0400 and in the 
following parameters.
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Commissioning (hardware) 5
5.1 Overview

Requirements   
The following requirements must be satisfied for the first commissioning of the 
SIMOTION D410‑2:

● Your system with SIMOTION D410‑2 has been installed and wired.

● Your PG/PC is connected to the SIMOTION D410‑2 via the PROFIBUS DP, Ethernet, or 
PROFINET (D410-2 DP/PN only) interface.

Commissioning steps
Commissioning the hardware involves the following steps:

1. Inserting the CompactFlash card (Page 67)

2. Checking the system (Page 69)

3. Switching on the power supply (Page 69).

Additional references
For information on installing/mounting and commissioning the SINAMICS S120 components, 
refer to the SINAMICS S120 Commissioning Manual.

5.2 Inserting the CompactFlash card

Characteristics of the CF card
The CF card is mandatory for operation of the SIMOTION D410‑2. The SIMOTION Kernel 
(SIMOTION D firmware) and the software used to control the drives (SINAMICS firmware) are 
on the CF card.   
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To load the SIMOTION Kernel, the CF card must be inserted when the SIMOTION D410‑2 is 
powered up.

NOTICE

Damage to the CompactFlash card from electrical fields or electrostatic discharge

The CompactFlash card is an ESD-sensitive component.

De-energize the SIMOTION D410‑2 device before inserting or removing the CompactFlash 
card. The SIMOTION D410‑2 is in a de-energized state when all the LEDs are OFF.

Comply with the ESD rules.

Procedure   
To insert the CF card, perform the following steps:

1. The direction of insertion of the CF card is indicated by an arrow located on both the plug-in 
slot and the CF card. Align the CF card with the arrows.

2. Gently insert the CF card into the empty plug-in slot of the SIMOTION D410‑2 until it clicks 
into place.
If correctly inserted, the CF card is flush with the housing.
 

Figure 5-1 Inserting the CF card
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5.3 Checking the system

Procedure
Check the final installed and wired system one more time before it is switched on, Observe the 
safety-relevant items of the following checklist.

Checklist ✓
Have you observed all ESD measures when handling the components?  
Have all screws been tightened to their specified torque?  
Have all connectors been properly inserted and locked/screwed?  
Are all components grounded and have all shields been attached?  
Have you taken the load capacity of the central power supply into consideration?  

5.4 Switching on the power supply

Switching on the external power supply
Power is supplied to the SIMOTION D410‑2 via an external power supply unit, e.g. via a SITOP 
power supply. In exceptional cases, the SIMOTION D410-2 can also be supplied via the Power 
Module in blocksize format, see Section "Power supply" in the SIMOTION D410-2 Manual.

Switch on this power supply.   

NOTICE

SIMOTION D410‑2 shuts down if the power supply is interrupted

It is essential to ensure that the external 24 VDC power supply to the SIMOTION D410‑2 is not 
interrupted for longer than 3 ms. After a longer interruption, the SIMOTION D410‑2 shuts 
down and can only be restarted with OFF/ON.

You will find further information in Section Properties of the user memory (Page 72).

Power-up of Control Unit   
Once the power supply has been switched on, the SIMOTION D410‑2 begins to power up:

1. At the start of the power-up, all LEDs are briefly illuminated in yellow for a short LED test. 
The LEDs on the SIMOTION D410‑2 enable you to track the progress of the power-up. Any 
errors are displayed.

2. Startup of the SIMOTION Kernel.

Commissioning (hardware)
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3. All DRIVE-CLiQ connections (with SINAMICS Power Module, for example) are identified 
automatically.

Note

As long as the RDY LED continues to flicker, power-up is not complete and it is not possible 
to go online.

During commissioning the firmware of the components is upgraded or downgraded 
automatically based on the FW version on the CF card and the FW version on the 
SINAMICS components (DRIVE‑CLiQ components, Power Modules, etc.). 

The update can take several minutes and its progress is tracked by corresponding 
messages appearing in the alarm window of SIMOTION SCOUT. 

SIMOTION D410‑2 / DRIVE‑CLiQ components:

A FW update on the SIMOTION D410-2 is indicated by yellow flashing and for DRIVE-CLiQ 
components by red-green flashing of the RDY LED:
● FW update running: RDY LED flashes slowly (0.5 Hz)
● FW update complete: RDY LED flashes quickly (2 Hz), POWER ON required

Components requiring POWER ON following a firmware update signal this by means of the 
fast flashing RDY LED. Go offline with SCOUT and switch the 24 V supply to the relevant 
components off/on (POWER ON) to initialize.

4. The first time it is switched on, the SIMOTION D410‑2 goes into STOP state following power-
up.

Following power-up, the SIMOTION D410‑2 is in a state in which it can be configured.

Fan
SIMOTION D410-2 has an integrated fan. This fan is always required for operation.

Fan faults as well as overtemperature of the module are signaled by a system variable, 
PeripheralFaultTask and a diagnostic buffer entry .

5.5 Performing a reset
The RESET button is located behind the blanking cover on the SIMOTION D410‑2.

The entire system is reset when the RESET button is pressed and a new power-up of the 
system forced. This operation is comparable with a "Power on Reset" but does not require the 
disconnection of the 24 V power supply.
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5.6 User memory concept

5.6.1 SIMOTION D410-2 memory model
The following figure provides an overview of the memory model of SIMOTION D410‑2.       

Figure 5-2 SIMOTION D410-2 memory model

The SIMOTION Kernel (SIMOTION D firmware, including SINAMICS Integrated Firmware) 
contains the functions required for virtually all applications, and essentially acts as a PLC with 
the command set in accordance with IEC 61131-3 as well as system functions for controlling 
various components, such as inputs and outputs.

The SIMOTION Kernel can be expanded by loading technology packages (TPs), e.g. for 
motion control or temperature controllers.

In the following sections, you will find information about the user memories and the steps 
involved in certain operations. 

Commissioning (hardware)
5.6 User memory concept

SIMOTION D410-2
Commissioning and Hardware Installation Manual, 04/2019, A5E33446807B 71



5.6.2 Properties of the user memory

Non‑volatile data   
Non‑volatile data makes it possible to retain relevant data for the user and the system even 
when the SIMOTION D410‑2 has been switched off. Information about the area which can be 
used for non-volatile data is available in the SIMOTION D410‑2 Manual, section "Technical 
Data".

A SIMOTION device has the following non‑volatile data:

Table 5-1 Non‑volatile data contents

Non-volatile data Content
Kernel data ● Last operating state

● IP parameters (IP address, subnet mask, router address)
● DP parameters (PROFIBUS DP address, baud rate)
● Diagnostic data (diagnostics buffer,...)

Retain variables ● Variables in the interface or implementation section of a unit declared with 
VAR_GLOBAL RETAIN

● Global device variables with the "RETAIN" attribute
Retain TO Absolute encoder offset
DCC blocks SAV blocks and user-defined blocks with retain behavior ("SAV = SAVE", 

blocks for the non-volatile data backup).
NVRAM (SINAMICS) For the SINAMICS Integrated and for the SINAMICS S120 CU310-2/

CU320-2, data protected against loss at power failure is called NVRAM data 
or non-volatile data.

Note

DCC SIMOTION blocks with retain behavior act like retain variables in terms of copying RAM 
to ROM, resetting memory, downloading, backing up non‑volatile SIMOTION data 
(_savePersistentMemoryData) and backing up data.

With DCC SINAMICS blocks, data buffering is only via NVRAM. SINAMICS data is not saved 
with _savePersistentMemoryData. The non-volatile SINAMICS data (NVRAM data) is backed 
up by setting the CU parameter p7775 to 1.

For further information on DCC, see the DCC Programming Programming Manual.
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The non-volatile data of the SIMOTION D410‑2 has the following properties:

Table 5-2 Non-volatile data and real-time clock properties

Properties Non‑volatile data Real-time clock (RTC)
Location Non-volatile data is located in the NVRAM 

of the SIMOTION D410-2.
The real-time clock is backed up 
maintenance-free via a SuperCap.

Back-up battery No No
Backup time There is no maximum backup time At least 5 days

If the buffer time is exceeded on the real-time clock, the time is reset. 

CF card
With the _savePersistentMemoryData system function, the user program can back up the 
contents of the non‑volatile SIMOTION data to the CF card. This ensures that the retain 
variables and the absolute encoder position are backed up in the event that a spare part is 
used.   

For the SINAMICS Integrated and SINAMICS S120 CU310-2/CU320-2, the non-volatile 
SINAMICS data (NVRAM data) is backed up by setting the CU parameter p7775 to 1.

Note
IP and DP parameters in the non-volatile data

If the CF card contains a configuration, the IP and DP parameters are loaded from the CF card 
during ramp-up and used by the SIMOTION device. The SIMOTION D410‑2 uses the 
addresses defined in these parameters to go online. During ramp-up, the IP and DP 
parameters on the CF card are also written to the non‑volatile data. If the SIMOTION device is 
then powered up with a CF card with no configuration, the IP and DP parameters are retained 
in the non‑volatile data and are used by the device. Thus, the SIMOTION device can continue 
to go online if a configuration was loaded with SIMOTION SCOUT at least once or if the 
SIMOTION device is powered up with a CF card containing a configuration.

The CF card contains the following data:   

● SIMOTION Kernel (SIMOTION D firmware)

● Technology packages (TP)

● User data (units, configuration data, parameter settings, task configuration)

● IP parameters (IP address, subnet mask, router address)

● DP parameters (PROFIBUS DP address, baud rate)

It may also contain:

● User data saved with _savePersistentMemoryData and _export/_saveUnitDataSet

● Non-volatile SINAMICS data (NVRAM data) of the SINAMICS Integrated backed up with 
CU parameter p7775 = 1
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● Data from SIMOTION IT

● Archived SCOUT project

Volatile SIMOTION data (RAM / current data RAM)   
The volatile SIMOTION data is defined by the following properties:   

● The volatile SIMOTION data is located in the RAM memory of the SIMOTION device.

● The download data of SIMOTION SCOUT is written to this memory.

● This data is lost when the SIMOTION D410‑2 is switched off.

● The "volatile SIMOTION data" area contains the following data:

– SIMOTION Kernel (D410‑2 firmware)

– Technology packages (TP)

– User data (programs, configuration data, parameter settings)

Figure 5-3 Configuration data and system variables in the volatile memory (memory concept, principle)

You can find additional information about memory management in SIMOTION in the 
SIMOTION Runtime Basic Functions Function Manual.

5.6.3 Operations and their effect on the user memory
The operator actions and their effects on the user memory are described below. These operator 
actions are marked with arrows in the following displays:

● Figure 5-2 SIMOTION D410-2 memory model (Page 71)

● Figure 5-3 Configuration data and system variables in the volatile memory (memory 
concept, principle) (Page 74)
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SIMOTION SCOUT download
The following data is transferred with "Load project to target system" or "Load CPU / drive unit 
to target device" from the engineering system to the "volatile SIMOTION data" area:

● User data (units, configuration data, parameter settings, task configuration)

● Technology packages (TPs)

In addition, the IP and DP parameters are saved to the "non-volatile SIMOTION data" area. The 
retain variables are set to their initial values, but this depends on the settings in SIMOTION 
SCOUT. If the SIMOTION D410‑2 is switched off following the download, the volatile 
SIMOTION data is lost.

Copy RAM to ROM
The Copy RAM to ROM menu command saves the following data via the engineering system 
to the CF card:

● Technology packages and user data (units, configuration data, parameter assignments, 
task configuration) from the "volatile SIMOTION data" area.

● Current values are copied to the "volatile SIMOTION data" area, depending on the settings 
in SIMOTION SCOUT.

Note

The "Copy RAM to ROM" menu command does not save the current values of the retain 
variables to the CF card. Use the system function "_savePersistentMemoryData" for this.

Note

The "Copy RAM to ROM" function is also available for drive units and saves the volatile 
SINAMICS data to the non-volatile memory (CF card).

Current RAM
If you change the system variable values, these take immediate effect in the current RAM. New 
configuration data values are initially stored in the Next memory. Configuration data that take 
immediate effect are automatically transferred to the current RAM. Configuration data that will 
only become active following a RESTART on the technology object (set the restartactivation 
system variable to the ACTIVATE_RESTART value) is not written to the current RAM until after 
the RESTART.

To save the configuration data changed online to the offline project, you must first transfer the 
content of the current data RAM to the RAM using the menu command "Target system" > "Copy 
current data to RAM". 

Once you have done this, the configuration in SCOUT will no longer be consistent with the 
configuration in the target device, as a consistency check is performed on the RAM data. Read 
the data from the RAM using the menu command "Target system" > "Load" > "Load CPU / drive 
unit to PG" (for the configuration data only) to re-establish a consistent system state. 

Commissioning (hardware)
5.6 User memory concept

SIMOTION D410-2
Commissioning and Hardware Installation Manual, 04/2019, A5E33446807B 75



Use the "Target system" > "Copy RAM to ROM" menu command to save the configuration to 
the non-volatile memory on the CF card. 

Note

The "Copy current data to RAM" command does not transfer the values of the system variables 
to the RAM memory. This means that "Save to memory card (Copy RAM to ROM)" or "Save in 
the engineering project (Load CPU / drive unit to PG)" is not possible.

In order to ensure that system variable values can also be saved to the engineering project and 
memory card, the system variable values must be changed OFFLINE and then downloaded to 
the target device and saved.

SIMOTION D410‑2 power-up
During power-up of the SIMOTION D410‑2, the SIMOTION Kernel is loaded from the CF card 
to the "volatile SIMOTION data" area.

When the SIMOTION D410‑2 is switched off, the contents of the "volatile SIMOTION data" area 
are lost. When the unit is powered up again, the following data is loaded from the CF card:

● Technology packages and user data to the "volatile SIMOTION data" area.

● IP and DP parameters to the "non-volatile SIMOTION data" area.

Backing up non-volatile SIMOTION data   
You have the following options for backing up non-volatile SIMOTION data on the CF card:

● In the user program:
With the "_savePersistentMemoryData" system function, the user program can back up the 
non-volatile SIMOTION data content to the CF card. This ensures that the retain variables 
and the absolute encoder position are backed up in the event that a spare part is used. The 
contents are saved to the "PMEMORY.XML" backup file in the "USER\SIMOTION" 
directory.

● Via switch/button (service selector switch or DIAG button of the SIMOTION D410‑2) or 
SIMOTION IT web server. See Section Diagnostic data and non-volatile SIMOTION data 
(Page 282). The contents are saved to the "PMEMORY.XML" backup file in the "USER
\SIMOTION\HMI\SYSLOG\DIAG" directory.

On the system side, this system function ensures that a consistent overall image of the non-
volatile SIMOTION data is always available the next time the unit is switched on, even if there 
is a power failure during backup. An already existing backup file is renamed to 
"PMEMORY.BAK" before a new backup file is generated. If the save operation to the new 
backup file fails (e.g. because the capacity of the CF card is insufficient), this backup copy of 
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the backup file is used the next time an attempt is made to restore the non-volatile SIMOTION 
data content.   

NOTICE

Loss of data due to failure to make backup copies

Non-backed-up non-volatile SIMOTION data can be lost on hardware replacement (module 
defect), for example, if the current value of the retain variables have not been backed up and 
replaced by their initial values again.

Back up the non-volatile SIMOTION data on the CF card.

NOTICE

Repeat referencing necessary after absolute encoder overflow

If an absolute encoder overflow occurs after _savePersistentMemoryData, the actual position 
value is no longer correct after the non-volatile SIMOTION data is restored. 

In this case, homing (absolute encoder adjustment) must be repeated.

With the SCOUT functions "Save variables" and "Restore variables," you also have the option 
of backing up to your PC and restoring data that was changed during operation and only stored 
in the runtime system. 

Reloading non‑volatile SIMOTION data
SIMOTION data backed up on the CF card with _savePersistentMemoryData is reloaded in the 
following scenarios:   

1. After a module replacement, see Section Replacing modules in the spare part scenario 
(Page 81)

2. After a memory reset, see Section SIMOTION D410-2 memory reset (Page 215)

3. Via switch position, see Section Delete/restore non-volatile SIMOTION data (Page 288)

Reloading non‑volatile SINAMICS data   
For the SINAMICS Integrated and SINAMICS S120 CU310-2/CU320-2, as of SINAMICS FW 
version V4.5, the non-volatile SINAMICS data (NVRAM data) is backed up by setting the CU 
parameter p7775 to 1.

Restoring

● Is performed automatically in the event of a module replacement
A module replacement is detected on the basis of the serial number.

● Can be performed manually
Restoring can be initiated manually by setting the CU parameter p7775 to 2.

For further information, see Section Backing up / restoring / deleting SINAMICS NVRAM data 
(Page 159).
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Power failure
If a power failure occurs, the real-time clock is buffered by means of an internal SuperCap.

The non-volatile data is backed up on the D410‑2 permanently and maintenance-free in an 
NVRAM. In this way, the Control Unit is immediately ready for operation without data loss after 
a power failure.   

Power-up and non-volatile SIMOTION data
The table below lists the cases that can arise during power-up in conjunction with the non-
volatile data and explains how they are handled.   

Table 5-3 Power‑up scenarios for non‑volatile SIMOTION data

Cas
e

Initial condition Result

1 The non-volatile SIMOTION data is valid. SIMOTION D410‑2 powers up with the non-volatile SI‐
MOTION data, i.e. with the PROFIBUS address in the 
non-volatile data.

2 The non-volatile SIMOTION data is invalid and there is no 
backup file (PMEMORY.XML) and no backup copy of the 
backup file (PMEMORY.BAK).

SIMOTION D410‑2 copies the default settings to the 
non-volatile SIMOTION data and powers up with this 
data. In this case, for example, the default PROFIBUS 
address is used.

3 The non-volatile SIMOTION data is invalid and backup file 
(PMEMORY.XML) exists and is valid.

SIMOTION D410‑2 copies the backup file contents to 
the non-volatile SIMOTION data and powers up with this 
data.

4 The non-volatile SIMOTION data is invalid, the backup file 
is invalid and there is no backup copy of the backup file 
(PMEMORY.BAK).

SIMOTION D410‑2 copies the default settings to the 
non-volatile SIMOTION data and powers up with this 
data, in which case, for example, the default PROFIBUS 
address is used.

5 The non-volatile SIMOTION data is invalid; a backup file 
exists, but it is invalid; a backup copy of the backup file 
exists and is valid.

SIMOTION D410‑2 copies the backup file contents to 
the non-volatile SIMOTION data and powers up with this 
data.

Non-volatile SIMOTION data diagnostics
The user can determine the state of the non-volatile SIMOTION data using the diagnostic 
buffer, system variables, and PeripheralFaultTask.     
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Evaluating via the diagnostic buffer
When they are issued, the following messages are entered once in the diagnostic buffer:

Table 5-4 Messages of the diagnostic buffer

Entry Meaning Remedy
Non-volatile data loaded from a file
(Persistent Data File Loading done)

Non-volatile SIMOTION data has been 
successfully restored from the backup 
file on the CF card.

-

Non-volatile data loaded from the backup file
(Persistent Data Backup File Loading done)

Non-volatile SIMOTION data has been 
successfully restored from the backup 
copy of the backup file on the CF card.

-

Error while loading non-volatile data from a file
(Persistent Data File Loading Failure)

Backup file or backup copy could not be 
loaded.
Possible causes:
● Backup file or backup copy not 

available
● Invalid data in backup file

Use the "_savePersistentMemor‐
yData" system function to gener‐
ate a valid backup file.

Module replacement detected - NVRAM has 
been initialized

A module replacement was detected on 
the basis of the serial number. The non-
volatile SIMOTION data on the controller 
is deleted and the data from the CF card 
transferred to the controller.

 

Module replacement not detected - NVRAM 
has not been initialized

An error has occurred. The non-volatile 
SIMOTION data on the controller has not 
been deleted.

Possible causes:
● Incorrect controller type
● File system of the CF card 

defective

Refer to the SIMOTION SCOUT Configuration Manual for how to read out the contents of the 
diagnostic buffer.

Evaluating via system variables
The system variables in the device.persistentDataPowerMonitoring structure indicate the state 
of the non-volatile SIMOTION data.

Table 5-5 State of the non-volatile SIMOTION data

System variable Designation State Updating
rtcFailure Indicates that the clock con‐

tents (RTC) are invalid (clock 
must be set again)

NO (91)
YES (173)

The status is updated once during power-up; the 
status must be reset to "NO" via the application; 
the status is retained even after power off/on.

retainDataFailure Indicates a checksum error of 
the non-volatile SIMOTION da‐
ta; can be an indication of de‐
fective hardware

NO (91)
YES (173)

The status is updated once during power-up; the 
status must be reset to "NO" via the application; 
the status is retained even after power off/on.

persistentDataState Reading the persistent data See the table be‐
low

The status is updated during power-up.
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A data loss of the real-time clock is signaled via the system variable 
device.persistentDataPowerMonitoring.rtcFailure = YES.

The system variable device.persistentDataPowerMonitoring.persistentDataState shows the 
state of the non-volatile SIMOTION data after power-up.

Table 5-6 State of the non-volatile SIMOTION data after power-up (persistentDataState system 
variable)

State Meaning
FROM_RAM (1) Non-volatile SIMOTION data in the SIMOTION device is used
FROM_FILE (2) Non-volatile SIMOTION data is restored from the backup file
FROM_BACKUP (3) Non-volatile SIMOTION data is restored from the backup copy of the backup file
INVALID (4) Data in the non-volatile SIMOTION data and in the backup file / backup copy of 

backup file is invalid or non-existent/deleted.
The SIMOTION device has copied the default settings to the non-volatile SI‐
MOTION data and used this data to power up.

Requirement/availability of the battery
System variables can be used to evaluate: 

● Whether a battery is required for the operation of the device (or not)

● Whether a battery is available (or not)

SIMOTION D410-2 has no battery.

Table 5-7 System variable batterynecessary/batteryexisting

System variable 
on the device

States Description

fanbattery of data type StructDeviceFanBattery (the system variables are of the data type EnumFanBattery)
.batterynecessary MANDATORY Battery is required for the backup of the non-volatile data and the real-time clock 

(RTC) of the device. .batteryexisting can be used to query whether a battery is 
installed. 

OPTIONAL The non-volatile data and the real-time clock (RTC) are backed up via Super‐
Cap. A battery can be used as an option to extend the backup time. .batteryex‐
isting can be used to query whether a battery is installed. 
Example: D4x5

OPTIONAL_RTC 1) A battery is not required for backing up the non-volatile data.
Only the real-time clock (RTC) is backed up via SuperCap. A battery can be used 
as an option to extend the backup time of the real-time clock. .batteryexisting can 
be used to query whether a battery is installed. 
Example: D4x5‑2

NOT_MANDATORY 
1)

A battery is not required for backing up the non-volatile data. The real-time clock 
(RTC) is backed up via SuperCap. 
Example: D410-2
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System variable 
on the device

States Description

.batteryexisting EXISTING EXISTING is only displayed when .batterynecessary is set to:
● MANDATORY or
● OPTIONAL or
● OPTIONAL_RTC
and a battery is installed.

NOT_EXISTING Battery is not available.
State is statically set for D410-2.

1) If the SuperCap is discharged, the contents of the real-time clock (RTC) are lost.

5.6.4 Replacing modules in the spare part scenario

SIMOTION module replacement   
During a module replacement, a CF card that contains the non-volatile SIMOTION data backed-
up with _savePersistentMemoryData, is inserted in a new device of the same type.

A module replacement is detected by the SIMOTION D410-2 on the basis of the serial number. 
The data backed up on the CF card with _savePersistentMemoryData are then automatically 
transferred to the new device.

Note

As an additional option, you can back up the non-volatile data by switching the service selector 
switch, with the DIAG button, or via SIMOTION IT web server. For details, see 
Section Diagnostic data and non-volatile SIMOTION data (Page 282).

Initial power-up with the CF card
This requires a CF card on which no device serial number is stored.

If the SIMOTION D410-2 powers up successfully with a new CF card, the serial number of the 
device is stored on the CF card. In this case, a module replacement cannot be detected.

Note

The serial number stored on the CF card remains unaffected by the following actions:
● Copy RAM to ROM
● Project download
● Writing the CF card via the SCOUT function "Load to file system"
● FW/project update via device update tool

If the CF card contents are copied to another CF card, the serial number is also copied. A serial 
number stored on the CF card can only by removed by deleting the CF card contents.
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SIMOTION D410-2 power-up with the CF card (no module replacement)
Prerequisite is that the same CF card and the same device are used.

If the SIMOTION device powers up successfully, the serial number stored on the CF card is 
compared with the serial number of the device.

If the serial numbers are identical, there has been no module replacement.

The device powers up. In the non-volatile data present in the device is valid, this will be used 
(for details, see Table 5-3 Power‑up scenarios for non‑volatile SIMOTION data (Page 78)).

SIMOTION D410-2 power-up with the CF card (module replacement)
Prerequisite is that the same CF card and a different device (e.g. replacement because of a 
defect) are used.

If the device powers up successfully, the serial number stored on the CF card is compared with 
the serial number of the device.

If the serial numbers are not identical, there has been a module replacement.

This means:

● The serial number of the new module is stored on the CF card.

● The non-volatile SIMOTION data are deleted in the device.

● A diagnostic buffer entry is issued which signals that a module has been replaced.

● The non-volatile SIMOTION data stored on the CF card is transferred to the device (for 
details, see Table 5-3 Power‑up scenarios for non‑volatile SIMOTION data (Page 78)).

NOTICE

Irrevocable data deletion due to incorrect CF card with stored device serial number

A module replacement is detected only on the basis of the changed serial number.

Inserting the wrong CF card with saved device serial number has the following consequences:
● The non-volatile data on the device is permanently deleted.
● The IP/DP address set in the device is deleted. You can no longer go online via the IP/DP 

address set originally.

Make sure that the correct CF card is inserted into the SIMOTION D410‑2.

Error scenarios
In the event of an error, a diagnostic buffer entry signals that it was not possible to determine 
whether a module has been replaced. This may have the following reasons:

● The serial number of the device cannot be determined.

● The serial number saved on the CF card cannot be determined (e.g. due to a corrupt file 
system).

● The controller has not powered up.

● The new serial number could not be transferred to the CF card (e.g. due to a corrupt file 
system).
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Restart after reloading
The system variable device.startupData.operationMode is used to define whether the 
SIMOTION D410-2 Control Unit goes into the RUN state or the last operating state after a 
power-on/restart.

Possible values of device.startupData.operationMode: 

● LAST_OPERATION_MODE [0] (default setting)
The module remains in the STOP operating state after reloading the non-volatile SIMOTION 
data and must be switched manually to the RUN state with SCOUT, the web server, or the 
mode switch .

● RUN [1]
The module goes automatically into the RUN state after reloading.

SINAMICS module replacement   
A module replacement is detected as of SINAMICS V4.5.

For the SINAMICS Integrated and SINAMICS S120 CU310-2/CU320-2, a module replacement 
is also identified via the serial number.

Non-volatile SINAMICS data (NVRAM data) backed up previously via the CU parameter p7775 
= 1 on the CF card, is then automatically transferred to the Control Unit.

5.7 Fan

5.7.1 Cooling the SIMOTION D410-2

Overview
A fan is always required for operation of the SIMOTION D410-2. This is included in the scope 
of delivery of the D410-2 control unit. The fan operates temperature-controlled and is switched 
on depending on the air intake temperature and the CPU load.

Fan faults
Fan faults are indicated as follows:

● Entry in diagnostic buffer

● Indicated via system variable

● Calling the PeripheralFaultTask

If a fan fault occurs or the fan is unplugged, the module continues to run. The controller goes 
into FAULT state when overtemperature occurs (temperature threshold 2 exceeded), whereby 
all LEDs flicker red. The state can only exited through power off/on

For further information on the evaluation of fan faults, see Section Overview of fan states 
(Page 84).
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5.7.2 Overview of fan states

Evaluation of fan faults
SIMOTION D410-2 has a single fan.

Fan faults are detected through a cyclic fan test or when a malfunction is determined when the 
fan is activated (fan does not rotate or fan rotates at too low a speed).

Fan faults are signaled by the following diagnostic buffer entry:
Fan on the module is defective.

The states that can occur during operation are described in the following.

Table 5-8 Overview of fan states

State PeripheralFaultTask System variable 1)

_cpuDataRW.fanWarning
The fan fails in the STOP operat‐
ing state, then RUN

PeripheralFaultTask: 
Is not called

=YES

The fan fails in the RUN operat‐
ing state

PeripheralFaultTask: 
TSI#InterruptId = _SC_PC_INTERNAL_FAILURE (= 205)
TSI#details = 16#00000080

=YES

1) The "YES" value must be reset to "NO" by the application.

Requirement for/presence of a fan
System variables can be used to evaluate:

● Whether a fan is required for the operation of the device (or not)

● Whether a fan is installed (or not)

Table 5-9 System variable fannecessary/fanexisting         

System variable 
on the device

States Description

fanbattery of data type StructDeviceFanBattery (the system variables are of the data type EnumFanBattery)
.fannecessary 1) MANDATORY Fan is required for operation of the device. .fanexisting can be used to query 

whether a fan is installed.
Examples: D410-2, D445-2, D455‑2

OPTIONAL Fan can be used optionally. .fanexisting can be used to query whether a fan is 
installed.
Examples: D425, D435

NOT_MANDATORY Fan is not required for operation of the device.
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System variable 
on the device

States Description

.fanexisting 1) SINGLE A single fan is installed 
Examples: D410-2

REDUNDANT Double fan is installed.
Examples: D445‑2, D455‑2

NOT_EXISTING No fan is installed. 
Example: D425 and D435 without optional fan.

1) Value is statically set to MANDATORY/SINGLE in the SIMOTION D410-2.

SIMOTION D410-2 only detects an unplugged fan indirectly.
The system variable fanexisting has statically the state SINGLE for the SIMOTION D410-2 . If 
the module temperature increases to impermissible values due to a fan having been 
unplugged, the module signals overtemperature.

The fan speed is available in system variable _cpuData.fanRpm as of V4.4.

Additional references
You will find detailed information on setting up Taskstartinfo (#TSI) in the SIMOTION Runtime 
Basic Functions Function Manual.

5.7.3 Response to overtemperature
Operation at overtemperature reduces the module service life and can result in damage to the 
module. 

Causes
Cause of problems in the heat dissipation of the module can be, for example:

● Violation of the maximum permissible air intake temperature

● Free convection is not ensured (clearances are not maintained, pollution, convection is 
prevented by cables)

● Impermissible mounting position of the module

Temperature thresholds
The internal module temperature is monitored via two module-specific temperature thresholds:

● Overtemperature is signaled when the first (lower) temperature threshold is exceeded.

● When the temperature falls below the first temperature threshold again (minus a hysteresis 
of approx. 5° C), "Normal temperature" is signaled.

● When the second (higher) temperature threshold is exceeded, the module goes into the 
FAULT state to protect itself.
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The internal module temperature is available in system variable _cpuData.moduletemperature 
as of V4.4.

Response to overtemperature

Table 5-10 Response of the temperature monitoring 

Temperature... Response
... exceeds the 1st temperature 
threshold (overtemperature)

Call of the PeripheralFaultTask: 
● TSI#InterruptI = _SC_PC_INTERNAL_FAILURE (= 205)
● TSI#details = 16#00000002
Diagnostic buffer entry: 
"Temperature exceeded in the housing"

... falls below the 1st temperature 
threshold minus a hysteresis of ap‐
prox. 5° C

Call of the PeripheralFaultTask:
● TSI#InterruptId = _SC_PC_INTERNAL_FAILURE (= 205)
● TSI#details = 16#00000004
Diagnostic buffer entry: 
"Temperature in the housing has returned to normal"

... exceeds the 2nd temperature 
threshold 

Module goes into the FAULT state to protect itself (all LEDs flicker 
red)
Diagnostic buffer entry: "Temperature in the housing too high, self-
protection function of the module activated"

Behavior of SINAMICS Integrated
If the internal temperature of the SIMOTION D410‑2 exceeds the permissible limit value, the 
following warning message is displayed:

A1009: CU warning: Control unit overtemperature

The warning message will be cleared as soon as the fault is rectified and the temperature falls 
below the maximum permissible limit.

The behavior for overtemperatures in the power unit as well as possible STOP responses for 
the SIMOTION D410‑2 corresponds to the behavior for a SINAMICS S120 CU310‑2.
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Parameter assignment / addressing 6
6.1 Software requirements

Engineering
The following requirements must be satisfied for the commissioning of the SIMOTION D410‑2 
Control Units:

● SIMOTION D410‑2 DP: at least SCOUT V4.3 SP1 HF1 and firmware V4.3 SP1 HF2

● SIMOTION D410‑2 DP/PN: at least SCOUT V4.3 SP1 HF3 and firmware V4.3 SP1 HF3

Please note the information on the latest SIMOTION SCOUT DVD.

For information on how to install SIMOTION SCOUT on your PG/PC, see the 
SIMOTION SCOUT Configuration Manual.

Note

The software configuration is described in this manual based on SIMOTION SCOUT and 
SIMATIC STEP 7 Version V5.x. 

Information of configuration of the SIMOTION D Control Units in the Engineering Framework 
Totally Integrated Automation Portal (SCOUT in the TIA Portal), you will find in the configuration 
manual SIMOTION SCOUT TIA.

The TIA Portal requires at least SIMOTION SCOUT V4.4 and SIMOTION D4xx‑2 Control Units 
as of firmware V4.3.

6.2 Creating a project and configuring the communication

6.2.1 Creating a SIMOTION project and inserting a SIMOTION D410-2

Procedure
Proceed as follows to create a new project in SIMOTION SCOUT and insert a 
SIMOTION D410-2:   

1. Select the Project > New... menu command.  

2. Enter a name for your project in the "New Project" dialog box and confirm your entry with 
"OK".
A new folder with the name of the project will be created in the project navigator.
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3. In the project navigator, double-click "Insert SIMOTION device". The "Insert SIMOTION 
Device" dialog box is opened:

Figure 6-1 Inserting a SIMOTION device

4. In the "Insert SIMOTION Device" dialog box, select the device, its version and the 
SIMOTION version.

5. If required, make further settings:

– SINAMICS: For SIMOTION D410-2 always set "SINAMICS S120 Integrated".

– SINAMICS version: Select the SINAMICS Integrated version if several drive versions are 
available for a SIMOTION version.

6. The "Open HW Config" option allows you to select whether HW Config is opened in the next 
step (e.g. to configure the bus interfaces).

7. Confirm the "Insert SIMOTION Device" dialog with "OK".
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SINAMICS Integrated type
For SIMOTION D410‑2, the type is always SINAMICS S120 Integrated.

Version of the SINAMICS Integrated
Depending on the selected SIMOTION version, several versions are available for the 
SINAMICS Integrated. Please note that separate SIMOTION D firmware is available for each 
version of the SINAMICS Integrated. 

Configuring the PROFINET interface
After you have acknowledged the "Insert SIMOTION Device" dialog with "OK", the "Properties 
- Ethernet Interface" dialog box opens in the case of a D410‑2 DP/PN.

If you are using the PROFINET interface, set the interface properties in the "Properties - 
Ethernet Interface" dialog box. 

To this end, proceed as follows:

1. Click the "New" button. 
The "New Subnet Industrial Ethernet" dialog box opens. Rename the new subnet, or accept 
the default name by clicking "OK".

2. Select the new Ethernet subnet, which is now displayed in the "Properties - Ethernet 
Interface" dialog box.

3. Enter the required addresses in the "IP address" and "Subnet mask" fields of the "Properties 
- Ethernet Interface" dialog box. Under "Gateway", define whether you are going to use a 
router and, if yes, enter the router address. Confirm with "OK".

Result
If you have not yet configured a PG/PC in your project, you can select the interface for the PG/
PC connection now.

6.2.2 Configuring the PROFIBUS PG/PC interface

Requirements
The following requirements must be satisfied in order to configure the PG/PC interface:     

● You have completed the "Insert SIMOTION Device" dialog box with "OK"

● A PG/PC has not yet been configured in the project.

If these requirements have been satisfied, you can configure the interface for the PG/PC 
connection in the "Interface Selection ‑ D410" dialog box.
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Procedure
Proceed as follows to configure the PROFIBUS DP interface:     

1. In the "Interface Selection - D410" dialog box, select the entry "PROFIBUS DP/MPI (X21)" 
(in the case of the D410-2 DP, the following alternative is also available: PROFIBUS DP 
(X24)).

Figure 6-2 Selecting a PROFIBUS interface

2. Select the interface parameter assignment that you would like to use to go online, and 
confirm with "OK".

The dialog box is closed, the SIMOTION D410-2 is created in the project navigator and HW 
Config is started automatically (if parameterized).

A PROFIBUS subnet with factory settings (1.5 Mbit/s transmission rate) is created 
automatically.

Result
The PG/PC is now connected to the SIMOTION D410-2 via PROFIBUS. You can configure and 
parameterize your system.

Note

If you do not use the factory settings, you must configure the PROFIBUS interfaces in HW 
Config.

Please make sure that the S7 online access has been activated (PG/PC connection must be 
yellow and bold in NetPro).
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Inserting a further SIMOTION device
If you insert a further SIMOTION device using "Insert SIMOTION device", the PG/PC interface 
selection dialog box is not displayed. Any further SIMOTION device is automatically connected 
to the PG/PC via PROFIBUS and a new unique DP address (address 4, 5 ... up to 125) is 
calculated.   

Additional references
Further information on the topic of "Going online" can be found

● In the online help via the "Contents" tab at

– "Diagnostics" > "Overview of service and diagnostics options" > "Part III" > "Go online"

– "Insert device and connect to target system" > "Go online/offline"

● On the Internet at Internet address (https://support.industry.siemens.com/cs/ww/en/view/
22016709)

● In SIMOTION Utilities & Applications, FAQ "Online connections to SIMOTION devices".

SIMOTION Utilities & Applications is part of the scope of delivery of SIMOTION SCOUT.

6.2.3 Configuring the Ethernet PG/PC interface

Requirements
The following requirements must be satisfied in order to configure the PG/PC interface:         

● You have completed the "Insert SIMOTION Device" dialog box with "OK".

● A PG/PC has not yet been configured in the project.

If these prerequisites have been satisfied, you can configure the interface for the PG/PC 
connection in the "Interface selection ‑ D410" dialog box. 

Proceed as follows to configure the Ethernet interface:
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Procedure
1. In the "Interface Selection - D410" dialog box, select the entry "Ethernet PNxIE (X127)".

Figure 6-3 Selecting the Ethernet interface

2. Select the interface parameter assignment that you would like to use to go online, and 
confirm with "OK".

The dialog box is closed, the SIMOTION D410-2 is created in the project navigator and HW 
Config is started automatically (if parameterized).

An Ethernet subnet with factory settings is created automatically. For factory settings, see 
Section General information about communication via Ethernet (Page 117).

Result
The PG/PC is now connected to the SIMOTION D410-2 via Ethernet.

You can configure and parameterize your system.

Note

If you want to change the default settings for IP addresses and the transmission rate, you must 
configure the Ethernet interfaces in HW Config and NetPro.

Make sure that the PG/PC and SIMOTION D410-2 are located in the same subnet and that 
S7Online access has been activated (the PG/PC connection must appear yellow and bold 
in NetPro).
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Inserting a further SIMOTION device
If you insert a further SIMOTION device using "Insert SIMOTION device", the PG/PC interface 
selection dialog box is not displayed. The second SIMOTION device is automatically 
connected to the PG/PC via Ethernet and a new unique IP address (last digit + 1 up to 255) is 
calculated.

Additional references
Further information on the topic of "Going online" can be found

● In the online help via the "Contents" tab at

– "Diagnostics" > "Overview of service and diagnostics options" > "Part III" > "Go online"

– "Insert device and connect to target system" > "Go online/offline"

● On the Internet at Internet address (https://support.industry.siemens.com/cs/ww/en/view/
22016709)

● In SIMOTION Utilities & Applications, FAQ "Online connections to SIMOTION devices".

SIMOTION Utilities & Applications is part of the scope of delivery of SIMOTION SCOUT.

6.2.4 Display of the SIMOTION D410-2 in HW Config
Once you have created a project and inserted a SIMOTION D410‑2 as module, HW Config 
opens automatically (if parameterized).

In HW Config, the SIMOTION D410‑2 is displayed with the SINAMICS Integrated and the 
interfaces.
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Figure 6-4 Display of a SIMOTION D410-2 in HW Config

Note

According to the DNS conventions, "/" is a permissible character. For this reason, the Ethernet 
and PROFINET interfaces have a different name in the engineering software than on the 
module lettering ("/" is replaced by "x").

Example: PN/IE (lettering on module) → PNxIE (as shown in SCOUT, HW Config, NetPro)

6.3 Configuring PROFIBUS DP

6.3.1 General information about PROFIBUS DP communication

Definition of PROFIBUS DP
PROFIBUS DP is an international, open field bus standard specified in the European field bus 
Standard EN 50170 Part 2. PROFIBUS DP is optimized for high-speed, time-sensitive data 
transfer at field level.     
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Components communicating on PROFIBUS DP are classified as master and slave 
components.

● Master (active bus device)
Components that represent a master on the bus define data transfer along the bus, and are 
therefore known as active bus nodes.
Masters components are divided into two classes:

– DP master class 1 (DPMC1):
Central master devices are thus designated, which exchange information with the slaves 
in specified message cycles.
Examples: SIMOTION D410-2 DP, C240, P350, SIMATIC S7, etc.

– DP master class 2 (DPMC2):
These are devices for configuration, commissioning, and operator control and 
monitoring while the bus is in operation.
Examples: Programming devices, operator control/monitoring devices

● Slaves (passive bus nodes):
These devices may only receive, acknowledge and transfer messages to a master when so 
requested.
Examples: SINAMICS drives, I/O modules

Functions on PROFIBUS DP
The functional scope can differ between DP masters and DP slaves. The functional scope is 
different for DP-V0, DP-V1 and DP-V2.

These functions on the PROFIBUS DP are characterized by:

● Configurable, equidistant, isochronous PROFIBUS DP cycle

● Synchronization of slaves by the master by means of a global control message frame in 
each cycle clock

● Independent maintenance of the isochronous cycle clock by the slaves in the event of a 
short-term communication failure.

Additional references
You will find additional information about PROFIBUS DP in the SIMOTION Communication 
System Manual.
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6.3.2 Operating SIMOTION D410-2 on PROFIBUS DP

PROFIBUS DP interfaces (X21, X24)
For connection to PROFIBUS DP, the SIMOTION D410‑2 DP has two interfaces (X21 and X24) 
and the SIMOTION D410‑2 DP/PN has one interface (X21).

Table 6-1 SIMOTION D410-2 PROFIBUS interfaces 

 D410-2 DP D410-2 DP/PN
PROFIBUS DP/MPI interface X21 X21
PROFIBUS DP interface X24 –

Transmission rates up to 12 Mbits/s are possible. Interfaces X21 and X24 can both be operated 
isochronously.     

Alternatively, the X21 interface can be used as an MPI interface with a transmission rate of 19.2 
kbit/s up to 12 Mbit/s, see Section Configuring the MPI bus (Page 106).   

In the delivery condition, PROFIBUS DP interfaces X21 and X24 are both preset as a master 
with address 2 and a transmission rate of 1.5 Mbit/s. The PROFIBUS DP network is 
automatically detected and generated for this setting.

However, other settings can also be configured. This requires that you configure the network 
manually using HW Config and NetPro.

Note

Communication with the SINAMICS Integrated of a SIMOTION D410-2 is always equidistant. 
Here, the SIMOTION D410-2 is the master and the SINAMICS Integrated drive is the slave.

SIMOTION D410‑2 DP master-slave configuration
Master-slave configurations can be used, for example, to establish hierarchical PROFIBUS 
networks that can be used to implement a modular machine concept.

Table 6-2 SIMOTION D410‑2 DP master-slave configuration

X21
DP/MPI

X24
DP

Remark Actions in the application

DP master, iso‐
chronous

DP slave, iso‐
chronous

Application synchronized to DP master (X21), application 
controls synchronization to DP slave (X24)
Internal drive is synchronous with external cycle clock
Cycle clock X21 = cycle clock DP Integrated

DP master / DP slave 
synchronization mecha‐
nisms

DP slave, iso‐
chronous

DP master, iso‐
chronous

Application synchronized to DP master (X24), application 
controls synchronization to DP slave (X21)
Internal drive is synchronous with external cycle clock
Cycle clock X24 = cycle clock DP Integrated

DP master / DP slave 
synchronization mecha‐
nisms
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X21
DP/MPI

X24
DP

Remark Actions in the application

DP master, not 
isochronous

DP slave, iso‐
chronous

Application synchronized to DP slave (X24)
(can be monitored by the application)
Internal drive is synchronous with X24

DP slave synchroniza‐
tion mechanisms

DP slave, iso‐
chronous

DP master, not 
isochronous

Application synchronized to DP slave (X21)
(can be monitored by the application) 
Internal drive is synchronous with X21

DP slave synchroniza‐
tion mechanisms

DP master, iso‐
chronous

DP master, iso‐
chronous

Application synchronized to DP master (X24, X21)
Internal drive is synchronous with external cycle clock
Cycle clock X24 = cycle clock X21 = cycle clock DP Inte‐
grated 

None

DP master, not 
isochronous

DP master, iso‐
chronous

Application synchronized to DP master (X24)
Internal drive is synchronous with X24
Cycle clock X24 = cycle clock DP Integrated

None

DP slave, not 
isochronous

DP master, iso‐
chronous

Application synchronized to DP master (X24)
Internal drive is synchronous with X24
Cycle clock X24 = cycle clock DP Integrated

None

DP master, iso‐
chronous

DP master, not 
isochronous

Application synchronized to DP master (X21)
Internal drive is synchronous with X21
Cycle clock X21 = cycle clock DP Integrated

None

DP master, iso‐
chronous

DP slave, not 
isochronous

Application synchronized to DP master (X21)
Internal drive is synchronous with X21
Cycle clock X21 = cycle clock DP Integrated

None

DP master, not 
isochronous

DP master, not 
isochronous

Application synchronized to internal drive cycle clock None

DP master, not 
isochronous

DP slave, not 
isochronous

Application synchronized to internal drive cycle clock None

DP slave, not 
isochronous

DP master, not 
isochronous

Application synchronized to internal drive cycle clock None

DP slave, not 
isochronous

DP slave, not 
isochronous

Application synchronized to internal drive cycle clock None

DP slave, not 
isochronous

DP slave, iso‐
chronous

Application synchronized to DP slave (X24) (can be moni‐
tored by the application)
Internal drive is synchronous with X24

DP slave synchroniza‐
tion mechanisms

DP slave, iso‐
chronous

DP slave, not 
isochronous

Application synchronized to DP slave (X21) 
(can be monitored by the application) 
Internal drive is synchronous with X21

DP slave synchroniza‐
tion mechanisms

For detailed information about controlling synchronization across the application, see the Basic 
Functions for Modular Machines Description of Functions.
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6.3.3 Assigning PROFIBUS addresses in HW Config

Assigning PROFIBUS addresses
Assign a PROFIBUS address to all devices before you start networking these in order to enable 
intercommunication.   

Note

Before you assign any PROFIBUS addresses, please remember that all addresses must be 
unique on the PROFIBUS subnet.

Define the PROFIBUS address separately for each device with the PG/PC in HW Config. 
Certain PROFIBUS DP slaves are equipped with an address switch.

Note

The PROFIBUS addresses set at the devices using these switches must correspond with the 
address settings in HW Config.

Recommendation for PROFIBUS addresses
Reserve PROFIBUS address "0" for a service PG and "1" for a service HMI device which are 
connected to the subnet as required.

Recommended PROFIBUS address setting for SIMOTION D410-2 in case of replacement or 
service:

Reserve address "2" for a SIMOTION D410-2. This prevents duplicate addresses when 
installing a SIMOTION D410-2 with a default setting on the subnet (e.g. when a 
SIMOTION D410-2 is replaced). Assign addresses higher than "2" to any additional devices on 
the subnet.

6.3.4 Setting the DP cycle and system cycle clocks

Adapting the DP cycle of SINAMICS Integrated
SINAMICS Integrated serves as the basis for all cycle clocks of a SIMOTION D410‑2 under the 
following circumstances:

● SIMOTION D410‑2 DP: Always

● SIMOTION D410‑2 DP/PN: Only if no synchronized data exchange takes place via the 
PROFINET interface (see also Section Setting a send cycle clock and system cycle clocks 
(Page 111)).      
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To set the DP cycle of the SINAMICS Integrated, double-click the SINAMICS drive on the 
integrated PROFIBUS. The "DP Slave Properties" dialog box opens. You can synchronize the 
DP cycle of SINAMICS Integrated in the "Isochronous mode" tab.

Table 6-3 SIMOTION D410-2 value range 

DP cycle ≥ 0.5 ms (DP internal
)≥ 1 ms (DP external)

Grid 0.125 ms
(the use of a clock grid ≥ 0.250 ms is recommended)

External DP interfaces can only be operated with a DP cycle of ≥ 1 ms.

SINAMICS Integrated always runs in isochronous mode. The cyclic tasks of SIMOTION are 
therefore always in synchronism with SINAMICS Integrated.

The set DP cycle of SINAMICS Integrated is displayed as "Bus data cycle" in the "System Cycle 
Clocks - D410" dialog box in SIMOTION SCOUT. Select the SIMOTION D410‑2 in the project 
tree, and then select the "Set system cycle clocks" option in the "Target system" > "Expert" 
menu.

The table below shows the ratios you can set for the system cycle clocks of SIMOTION D410‑2 
based on the bus cycle clock.   

Table 6-4 Ratios of system cycle clocks

Servo cycle clock1) : Bus cycle 
clock

IPO cycle clock: Servo cycle clock IPO2 cycle clock: IPO cycle 
clock

1 ... 4, 8 1 … 6 2 … 64
1) When using the TO axis and the integrated drive control, the minimum servo cycle clock is 1 ms.

Note

The following statements relate to a SIMOTION D410‑2 DP with 2 DP interfaces (X21/X24). 
The statements are equally applicable to a SIMOTION D410‑2 DP/PN with only one DP 
interface (X21).

In addition, if the DP interfaces (X21/X24) are configured as equidistant master interfaces, you 
must set both DP cycles equal to the bus cycle clock of the SINAMICS Integrated in HW Config.

If the DP interfaces (X21/X24) are operated as the master, the system cycle clocks are obtained 
from an internal cycle clock of the module. 

Of the two DP interfaces (X21/X24), no more than one can also be operated as an isochronous 
slave interface. In this case, the system cycle clocks are obtained from the cycle clock of the 
slave interface. As a result, the task system of SIMOTION and SINAMICS Integrated runs 
synchronously to the slave cycle clock. This assumes that a slave cycle clock exists and 
synchronization with the slave cycle clock has been achieved. If this is not the case, the system 
cycle clocks are acquired from an internal replacement cycle clock.

When the project is downloaded, the cycle clock configuration is downloaded to the 
SIMOTION D410‑2 and automatically set according to the specifications.
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Also observe the cycle clock setting rules in Section Rules for cycle clock settings with 
SIMOTION D410-2 DP (Page 100).

6.3.5 Rules for cycle clock settings with SIMOTION D410-2 DP
The rules for making SIMOTION D410‑2 DP cycle clock settings are described below. 

For SIMOTION D410‑2 DP/PN, see Section Rules for cycle clock settings with SIMOTION 
D410-2 DP/PN (Page 115).

Rules for adjusting system cycle clocks in the case of SIMOTION D410‑2 DP
You must conform to the following rules when setting the DP cycle and SINAMICS Integrated 
cycle clocks:         

1. The DP cycle must be an integer multiple of the current controller cycle.

2. The master application cycle (Tmapc), which corresponds to the servo cycle, must be an 
integer multiple of the speed controller cycle. The smallest-possible Tmapc thus results from 
the smallest common multiple of the DP cycle and the speed controller cycle.
If the master application cycle = 1, it follows that the DP cycle is also an integer multiple of 
the speed controller cycle.

3. The DP cycle must be an integer multiple of the basic cycles r0110[x] (DRIVE-CLiQ basic 
sampling rates).
You can determine parameter r0110[x] using the expert list in SIMOTION SCOUT (select 
the "Control_Unit" from "SINAMICS_Integrated" in the project navigator, and then open the 
"Expert list" by selecting the "Expert" command from the shortcut menu).

Note

An overview of errors reported by the SINAMICS Integrated is provided in the SINAMICS S 
List Manual.

Dependencies of SINAMICS cycle clocks
The general rule for SIMOTION D410‑2 DP is that the DP cycle serves as the basic cycle clock 
for the task system. All SIMOTION clock cycles (servo, IPO, IPO_2, etc.) longer than this basic 
cycle clock must be an integer multiple of the basic cycle clock.

This rule also applies to SINAMICS Integrated cycle clocks, if one of the successive cycle 
clocks is longer than the basic cycle clock:

● Speed controller p0115[1] (drive)

● Flow controller p0115[2] (drive)

● Setpoint channel p0115[3] (drive)

● Position controller p0115[4] (drive)

● Positioning p0115[5] (drive)

● Technology controller p0115[6] (drive)
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● Onboard I/O p0799[0…2] (Control Unit)

● Terminal module I/O p4099

The corresponding cycle must be an integer multiple of the basic clock (DP cycle).

If any change to the DP cycle violates this rule you must also change the SINAMICS cycle 
clocks. In order to change the cycles in the Expert list of SIMOTION SCOUT, select the 
"Control_Unit" or the "Drive" from "SINAMICS_Integrated" in the Project Navigator, and then 
open the "Expert List" by selecting the "Expert" command from the shortcut menu.

If p0115 sampling times are required which cannot be set using p0112 > 1, then you can directly 
set the sampling times using p0115. This requires that p0112 must be set to "0" (expert).
If p0115 is changed online, the values of the higher indices are adapted automatically.

Note

At the SINAMICS end, there are further rules for setting the sampling times. You will find these 
described in the SINAMICS S120 Function Manual, Section Rules for setting the sampling time.

Example
A default value of 4 ms is set for the SINAMICS Integrated setpoint channel p0115[3]. If the DP 
cycle is to be set to 3 ms, the fact that an integer multiple value is required means that you will 
need to set 3 ms or 6 ms (for example) for the setpoint channel.

Incorrect cycle clock setting
If the SINAMICS cycle clocks are not set correctly, this can be seen by the following messages:

● A01223 CU: Sampling time inconsistent and/or

● A01902 PB/PN isochronous operation parameterization impermissible and/or

● F01043 severe error downloading project

● F01951 CU SYNC: Synchronization application cycle clock missing

In this case, check the cycle clock settings on all drive objects signaling this error. For F01951, 
check the DP cycle. In this case, use a DP cycle that is a multiple of 0.25 ms or 0.5 ms.

Note

An overview of errors reported by the SINAMICS Integrated is provided in the SINAMICS S List 
Manual.
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Current controller cycle clock
With the SIMOTION D410-2, the following current controller cycle clocks p0115[0] can be 
configured for the SINAMICS Integrated:

● for servo: 125 μs (default) or 250 μs

● For vector and vector V/f:

– For blocksize Power Modules: 250 μs or 500 μs (default)

– For chassis Power Modules: 375 μs.

See also
Using vector drives  (Page 153)

6.3.6 Cycle clock scaling of external PROFIBUS interface to internal PROFIBUS 
interface

Definition
Cycle clock scaling means that an external PROFIBUS interface of the SIMOTION D410‑2 DP 
(X21/X24) or SIMOTION D410‑2 DP/PN (X21) can be operated in an integer multiple of the 
internal PROFIBUS interface. This reduces the CPU load, thereby allowing you to operate 
more axes, for example. The settings of the scaled cycle clocks for the external DP interfaces 
are made in HW Config.   

Supplementary conditions
The following supplementary conditions are applicable to cycle clock scaling:

● An external DP interface of the D410‑2 is used as an isochronous slave interface. Only in 
this case can an integer cycle clock scaling of isochronous external DP slave interface to 
internal interface be specified. This is checked during compilation and an error message is 
output in the event of noncompliance. If the external DP interfaces are configured as 
equidistant interfaces but none are configured as slaves and cycle clock scaling is specified 
for these interfaces, an error is output during compilation.

● For SERVO, IPO, and IPO2, settings can also be made for all permissible cycle clocks. 
Master and slave axes can run in different IPO levels. Different cycle clocks and phase 
offsets are tolerated by the system.

Note

The IPO cycle clock of the IPO in which the synchronous operation technology object runs 
must be set equal to the cycle clock of the isochronous external DP slave interface.
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● The second external DP interface of a SIMOTION D410‑2 DP can be operated as an 
isochronous master (while the other is an isochronous slave) in order to operate external 
drives, for example. In this case, the cycle clock must be the same as the cycle clock of the 
internal PROFIBUS DP. If this condition is not satisfied, an error message is output during 
compilation.

● One or both external DP interfaces can also be operated as non-isochronous, free-running 
interfaces. In this case, there is no effect on the cycle clock settings.

Application example
The system consists of a synchronous master (DP master) and at least one 
SIMOTION D410‑2 DP synchronous slave (DP slave). The synchronous master contains the 
master axis; the synchronous slave contains the following axes:

● The axes in the SINAMICS Integrated of the D410‑2 DP synchronous slave must exhibit 
high performance with a servo cycle clock of 1.5 ms and an internal DP cycle of 1.5 ms. This 
requires that the internal fast PROFIBUS DP be decoupled from the slower external 
PROFIBUS DP.

● The PROFIBUS DP has, for example, a cycle time of 6 ms due to the quantity framework on 
the bus; in all cases, its cycle time exceeds that of the cycle clock of the internal DP interface.

● The master values are transmitted via the DP bus. Further nodes can also be connected to 
the DP bus, e.g. DP drives, distributed I/O, etc.

Figure 6-5 Example of a cycle clock scaling for PROFIBUS DP
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6.3.7 Creating a new PROFIBUS DP subnet
SIMOTION SCOUT is used to network the SIMOTION D410‑2. Set up your user-specific bus 
parameters for the PROFIBUS DP interfaces when you configure the network.     

Note

If a hardware configuration is loaded without a PROFIBUS network being configured on the 
CPU, a new PROFIBUS address that was previously set in HW Config or NetPro will not be 
accepted by the CPU.

Requirement
You have created a project and have inserted a SIMOTION D410‑2.

Note

The actions outlined below only need to be taken if you have not selected an interface when 
integrating the SIMOTION D410-2 into the project (see Section Creating a project and 
configuring the communication (Page 87)).

Next the connection to the PG/PC must be established via NetPro, refer to:
● Section Configuring the PROFIBUS PG/PC interface (Page 89)
● Section Configuring the Ethernet PG/PC interface (Page 91).

Procedure
To create a new PROFIBUS subnet, proceed as follows:

1. Double-click the "D410-2" entry in the project navigator in order to open HW Config.

2. In the SIMOTION D410‑2 representation, double-click the DP interface for which you want 
to create a PROFIBUS subnet.
The "Properties - DP/MPI" dialog box opens. 

3. Click "Properties" in the "General" tab to open the "PROFIBUS Interface DP/MPI" dialog 
box.

4. Click "New" to open the "Properties - New PROFIBUS Subnet" dialog box.

5. Name the new subnet and enter the properties of the new subnet, e.g. transmission rate, on 
the "Network settings" tab.

6. If the PROFIBUS interface is to be operated isochronously, click "Options". Activate the 
"Activate isochronous bus cycle" option in the opened dialog box and set the DP cycle. 
Confirm the settings with "OK" to exit the "Options" dialog box.

7. Accept the settings in the "Properties - New PROFIBUS Subnet" dialog box with "OK".
The new subnet is now displayed in the "Properties - PROFIBUS Interface DP/MPI" dialog 
box. You can now connect the new subnet to the corresponding PROFIBUS interface.
Follow the same steps to configure the second PROFIBUS interface for a SIMOTION 
D410‑2 DP.

8. Save and compile the changes.
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The PROFIBUS subnet you created is displayed as a graphic object in HW Config.

Note

PROFIBUS DP functionality is both equidistant and isochronous in nature. As such, it can 
guarantee that bus cycles will have exactly the same length and ensures deterministic behavior.

Applications: Connecting drives or synchronized I/O devices.

Additional references
For further information, see the SIMOTION Runtime Basic Functions Function Manual, Section 
"Isochronous I/O processing on fieldbus systems".

6.3.8 Establishing a PG/PC assignment

Introduction
A PG/PC is required to create projects for a SIMOTION D410‑2 and download them to the 
target device. The interface via which the PG/PC can be connected is polled during the 
automatic communication configuration. If you change these settings, you must reestablish the 
active designation of the PG/PC in NetPro (the PG/PC connection must appear yellow and bold 
in NetPro).     

Procedure 
1. Open the project in SIMOTION SCOUT.

2. Click the "Open NetPro"  button.
NetPro is accessed, and the configured network is graphically displayed. The PG/PC 
connection to the configured network is shown in bold in a color other than yellow.

3. Double-click the PG/PC you would like to configure.
The "Properties - PG/PC" dialog will be displayed with the "Assignment" tab in foreground.

4. Select the interface in the "Assigned" field and activate S7ONLINE access by clicking the 
appropriate checkbox.

5. Click "OK" to accept the settings.
The PG/PC connection to the configured network is displayed again in bold and yellow.

6. Save and compile the changes and download them to the SIMOTION D410‑2.

Now you can go online again via the PG/PC.

Alternatively, you can make the assignment in SIMOTION SCOUT by clicking the  "Assign 
PG/PC" button. This calls the properties window for PG/PC assignment, where you can modify 
the assignment and "activate" it (S7ONLINE access).
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6.4 Configuring the MPI bus

6.4.1 Operating interface X21 as an MPI
The X21 interface can also be operated as an MPI interface.

The typical (default) baud rate is 187.5 Kbaud. A baud rate of up to 12 MBaud can be set for 
communication with other CPUs. It should be noted, however, that a rate of 12 MBaud is not 
supported by all CPUs (e.g. smaller SIMATIC S7 CPUs).         

The following list provides examples of when using MPI (Multi Point Interface) may prove 
effective:

● If a PC/PG is being used with an MPI interface

● If an OP/TP only has an MPI interface (newer devices have PROFIBUS or PROFINET 
interfaces)

● If SIMOTION and SIMATIC CPUs are coupled via XSEND/XRECEIVE

Note

When the X21 interface is used as an MPI bus, additional activation of a drive on this interface 
is not possible.

Additional references
For general information on MPI, see the SIMOTION Communication System Manual.

6.4.2 MPI parameters

MPI bus addresses and data transmission rate
Every node on the MPI bus must have a bus address in the range 0 to 31.

The data transmission rate on the MPI bus can be set to any value for the SIMOTION D410‑2.   

Communication attempt unsuccessful
If communication cannot be established at all, or if it cannot be established with individual 
nodes on the MPI bus, check the following:

● Is the transmission rate setting for the SIMOTION D410‑2 used for all nodes?

● Are there any loose plug connections?

● Are all bus segments terminated properly?
Bus segments that are not terminated properly will disrupt communication on the MPI bus. 
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6.5 Configuring PROFINET IO

6.5.1 General information about communication via PROFINET IO

Communication cycle
In PROFINET, the communication cycle is subdivided into different, time-specific intervals. The 
first interval is used for isochronous real‑time communication (IRT), followed by real‑time 
communication (RT) and standard TCP/IP communication. The bandwidth reservation for IRT 
ensures that RT communication and standard communication have no effect on the 
transmission of IRT telegrams, which are important for motion control applications.     

The following figure shows how the PROFINET communication cycle is divided into 
isochronous real-time communication (IRT), real-time communication (RT), and standard TCP/
IP communication.

Figure 6-6 PROFINET communication cycle

Isochronous real-time Ethernet
STEP 7 can be used to configure PROFINET devices supporting data exchange via 
isochronous real-time Ethernet (IRT). IRT telegrams are transferred deterministically via 
planned communication paths in a defined sequence to achieve the best possible synchronism 
and performance. 

IRT requires special network components supporting a planned data transfer. 

Isochronous operation and mode
Equidistant mode and isochronous mode function similarly in PROFINET IO to the way they 
function in PROFIBUS DP.

For PROFIBUS DP, in isochronous operation all nodes are synchronized using a Global 
Control Signal created by the DP master. 
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In PROFINET IO with IRT, a sync master generates a signal to which sync slaves synchronize 
themselves. Sync master and sync slaves belong to a sync domain which is assigned a name 
via configuration. The role of the sync master can in principle be played by an I/O controller as 
well as an I/O device. A sync domain has exactly one sync master. 

Context: Sync domain and I/O systems
An important fact is that sync domains do not need to be limited to one PROFINET IO system: 
The devices of several I/O systems can be synchronized by a single sync master, provided they 
are connected to the same Ethernet subnet. 

The following applies the other way around: An I/O system must only belong to a single sync 
domain. 

Signal propagation delays not negligible
For the extremely exact synchronization interval, line lengths, namely the associated delay 
times, must be taken into consideration. You can use a topology editor to enter the properties 
of the lines among the ports of the switches. STEP 7 uses this data and the other configuration 
data to calculate the optimized process of the IRT communication and the resulting updating 
time. 

IRT runs in parallel to real-time and TCP/IP communication
Apart from IRT communication, for which a defined bandwidth is reserved within the update 
time, RT communication and TCP/IP communication are also permitted within the update time. 

With RT communication (real-time communication), the cyclic data is transferred between I/O 
controller and I/O device, but without "best possible synchronism".

With non-synchronized I/O devices, data is exchanged automatically via RT communication. 

Due to the fact that TCP/IP communication is also possible, other data, e.g. non-real-time data, 
configuration data or diagnostic data, can be transported. 

PROFINET IO controller
Typically, the function of a PROFINET IO controller is taken on by controllers (e.g. SIMOTION 
C/P/D, SIMATIC S7 CPUs, ...).

The PROFINET IO controller takes on the master function for I/O data communication of the 
distributed field devices. The function is comparable to a PROFIBUS DP master class 1.

PROFINET IO device
Distributed field devices such as I/Os, drives (e.g. SINAMICS S120) or operator terminals are 
designated as IO devices. The function is comparable to a PROFIBUS DP slave. 
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Addressing
In the delivery condition, the onboard PROFINET IO interface does not have an IP address or 
a subnet mask.

Note

The IP addresses 192.168.215.240 to 192.168.215.255 are reserved for internal 
communication in the SIMOTION D410‑2 (subnet mask 255.255.255.240). When configuring 
the PROFINET interface (X150), make sure that the internal addresses are not located within 
the network of this interface. In IP, the network is defined as an AND link of IP address and 
subnet mask.

Media redundancy (MRP)
Requirement: SIMOTION V4.4.

It is possible to establish redundant networks via the Media Redundancy Protocol (MRP). 
Redundant transmission links (ring topology) ensure that an alternative communication path is 
made available when a transmission link fails. The PROFINET devices that are part of this 
redundant network form an MRP domain.

MRP guarantees media redundancy in the event of a problem in the ring. The switchover of the 
ring is performed by the Redundancy Manager. 

The switchover times depend on: 

● The actual topology

● The devices used and

● The network load in the relevant network

The typical reconfiguration time of the communication paths for TCP/IP and RT frames in the 
event of a fault is < 200 ms.

In most systems, the switchover time of MRP is far above the PROFINET update time for cyclic 
data, so that a failure for cyclic data is detected. The PROFINET connection therefore fails and 
is reestablished after the switchover by the Redundancy Manager. In this way, an error can be 
corrected in the network, while the system continues to run with bumps.

Note

During the interruption of the ring, as well as when correcting the interruption (e.g. repair of the 
defective cable), there is a brief failure of the communication.

Ring ports

A SIMOTION/SINAMICS device may only be inserted in an MRP ring as a node with MRP-
capable ports. For SIMOTION D, the first two ports of the PROFINET IO interfaces are 
designed as ring ports.
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These two ports are marked with an "R" in the module rack in HW Config.

Note

Only devices with MRP-capable ports may be inserted in an MRP ring. If MRP-capable ports 
are not used, the reconfiguration times can be in the seconds range.

Bumpless media redundancy (MRPD)
Requirement for SIMOTION D410-2: 

● SIMOTION SCOUT as of V4.4 

● SIMOTION SCOUT TIA as of V4.5

MRPD is a procedure for bumpless media redundancy for PROFINET IO with IRT. MRPD also 
requires MRP.

The combination of MRP with MRPD provides bumpless PROFINET operation for short cycle 
times in the event of a fault in the ring. MRPD is based on IRT and ensures bumpless operation 
by the provider sending the cyclic data in both directions which the consumers then receive 
twice. If the ring is interrupted at one position (e.g. through the failure of a ring node), receipt of 
the cyclic data via the problem-free side of the ring is still guaranteed.

Bumpless media redundancy MRPD always requires the activation of MRP in the individual 
rings. 

A maximum of two Ethernet nodes may be between the sync master and the redundant sync 
master. If the redundant sync master is used together with MRPD, it is recommended that the 
redundant sync master be connected directly to the sync master and the two nodes located in 
a shared cabinet so that the cable connection between both nodes is protected.

If there is an interruption in the link between the sync master and the redundant sync master, 
the system continues to run without bumps, but after switching off and on again faults can occur.

Too high a network load or too-rapid coming and going of faults can also result in unfavorable 
cases in the failure of the PROFINET connection with activated MRPD because of delayed or 
incomplete switchover actions of MRP/MRPD.

For example, with two consecutive faults at different points in the ring, bumpless operation is 
only ensured when there is approx. three seconds between the two faults.

Additional information
You will find additional information about media redundancy in the SIMOTION Communication 
System Manual. 
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6.5.2 Setting a send cycle clock and system cycle clocks

Requirement
The SIMOTION system cycle clocks (servo/IPO/IPO_2) are based on the 
SINAMICS Integrated DP cycle or the PROFINET send cycle clock, depending on the 
PROFINET real-time class and the type of data transfer. The cycle clock source can be 
generated "internally" by the SIMOTION D410‑2; otherwise, it is obtained "externally" from the 
clock signals received at the PROFINET interface.     

Table 6-5 Basis for the SIMOTION system cycle clocks/cycle clock source

Real-time class in which the 
PROFINET interface is oper‐
ated

Data transfer Basis for the SIMOTION system cy‐
cle clocks

Cycle clock source

DP cycle (Inte‐
grated)

PROFINET 
send cycle 

clock 1)

RT communication  X  Internal
IRT communication The D410‑2 DP/PN is the 

SYNC master in the I/O sys‐
tem; synchronized data traffic 
takes place 2)

 X Internal

The D410‑2 DP/PN is the 
SYNC slave in the I/O system; 
synchronized data traffic takes 
place 2)

 X External
Internal
(as substitute value)

No synchronized data traffic 2) X  Internal
1) If the PROFINET send cycle clock forms the basis for the SIMOTION system cycle clocks, the DP cycle (SINAMICS 
Integrated and external PROFIBUS interface) and the servo cycle clock must be the same.
2) Synchronized data traffic, e.g. by means of:
 - controller-controller slave-to-slave communication
 - IO device in its own IO system

Setting the DP cycle in HW Config
To set the DP cycle of the SINAMICS Integrated, double-click the SINAMICS block on the 
integrated PROFIBUS in HW Config.

The "DP Slave Properties" dialog box opens. You can adjust the DP cycle of the SINAMICS 
Integrated on the "Isochronous mode" tab. See also Setting DP Slave properties 
(Page 151).         

Table 6-6 SIMOTION D410‑2 DP/PN value range

 D410-2 DP/PN
DP cycle ≥ 0.5 ms (DP internal)

≥ 1.0 ms (DP external)
Grid 0.125 ms

(the use of a clock grid ≥ 0.250 ms is recommended)
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If, in addition to the drive on the SINAMICS Integrated, external drives are also to be connected 
via isochronous PROFIBUS, the DP cycle must be ≥ 1 ms.

Setting the send cycle clock in HW Config
The send cycle clock for PROFINET IO must be set in the "Domain Management" dialog 
in HW Config. To do this, select the "Edit" > "PROFINET IO" > "Domain management ..." menu 
command in HW Config and set the desired cycle clock.

The PROFINET interface can be operated with a send cycle clock in the range of: 0.25 ms ≤ 
send cycle clock ≤ 4 ms. The smallest configurable time base is 0.125 ms. 

Note
Information for version < V4.4

If there are IO devices with RT class "RT" in a sync domain, it is only possible to set the send 
cycle clocks 0.5 ms, 1 ms, 2 ms, and 4 ms.

Cycle clock scaling
The PROFIBUS cycle clock can be scaled down in relation to the servo cycle clock. The 
reduction ratio is only permitted when PROFINET IO with IRT has not been configured. A 
reduction ratio for the PROFINET send cycle clock to the PROFIBUS cycle clock is also 
possible.

Example:
PROFINET send cycle clock = 0.5 ms
PROFIBUS cycle clock = servo cycle clock = 1 ms

The PROFIBUS cycle clock can be operated relative to the PROFINET send cycle clock at a 
ratio of 1:1 to 16:1.

The table below shows which ratios you can set for the system cycle clocks of the 
SIMOTION D410‑2 DP/PN based on the DP cycle of SINAMICS Integrated or on the 
PROFINET send cycle clock.

Table 6-7 Ratios of system cycle clocks

Cycle clock name Settable factors Reference cycle clock
PROFIBUS DP 
bus cycle clock

1, 2, 3, 4, 6, 8, 10, 12, 14, 16 PROFINET IO send cycle clock

Servo1) 1, 2, 3, 4, 82) PROFIBUS DP bus cycle clock
IPO 1, 2, 3, 4, 5, 6 Servo
IPO_2 2, 3, 4, 5, …, 64 IPO

1) When using the TO axis and the integrated drive control, the minimum servo cycle clock is 1 ms.
2) Always "1", if PROFINET with IRT is configured.
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Setting the cycle clock ratios
The set bus cycle clock is displayed in SIMOTION SCOUT as the "Bus data cycle" in the 
"System Cycle Clocks - D410" dialog box. Select the SIMOTION D410-2 and then select the 
"Set system cycle clocks" option in the "Target system" > "Expert" menu.

Set the required cycle clock ratios for the servo, IPO, and IPO_2 in the "System Cycle Clocks 
- D410" dialog box.

Figure 6-7 System cycle clocks

Additional information
For further information, see the SIMOTION Communication System Manual.
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6.5.3 Properties of PROFINET

Properties
The onboard PROFINET IO interface supports the parallel operation of:

● IRT - isochronous real-time Ethernet

– Operation of IRT I/O (e.g. ET 200SP)

– Operation of a SINAMICS S120 as an IRT device

● RT - real-time Ethernet

– Operation of RT I/O (e.g. ET 200SP, ET 200pro, etc.)

– Operation of a SINAMICS S120 as an RT device

● TCP/IP, UDP, HTTP, … standard Ethernet services

Note

For mixed operation of IRT and RT, make sure that the IRT-compatible devices form what is 
referred to as an IRT domain; i.e. there must not be any non-IRT devices on the data 
transmission link between the IRT devices.

Additional references
You will find an overview of the specific properties of PROFINET IO on SIMOTION D in 
the SIMOTION Communication System Manual.

6.5.4 Configuration tasks
Configuration of PROFINET involves the following steps:

1. Insert the SIMOTION D410‑2 DP/PN.

2. Configure the onboard PROFINET IO interface in HW Config.

3. Create a topology: Here, you specify how the individual ports of the PROFINET IO devices 
are interconnected.

4. Configure the sync domain: Here, you specify which PROFINET nodes are sync masters 
(clock generators) and sync slaves.

5. Specify the send clock: Describes the time during which a PROFINET IO device exchanges 
user data with the PROFINET IO controller.

6. Configure the direct data exchange: The direct data exchange specifies which address 
areas are to be used for sending and receiving respectively.
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Additional references
You will find a detailed description of each configuration step in Section "Configuring 
PROFINET IO with SIMOTION" of the SIMOTION Communication System Manual.

6.5.5 Rules for cycle clock settings with SIMOTION D410-2 DP/PN
The rules for making SIMOTION D410‑2 DP/PN cycle clock settings are described below. 

For SIMOTION D410-2 DP, see Section Rules for cycle clock settings with SIMOTION D410-2 
DP (Page 100).

Rules for using the PROFINET send cycle
If the PROFINET send cycle clock is the basis for the cycle clocks, ensure that the DP cycle and 
the servo cycle clock are the same. This applies to PROFIBUS interface X21 and the 
PROFIBUS of the SINAMICS Integrated.     

The basis for the system clocks is generated internally if the PROFINET interface is not 
operated with RT class IRT or if IRT is set and no data is being transferred. This also applies 
if the PROFINET interface is operated as synchronization master with RT class IRT and data 
is being transferred. The SIMOTION device does not have to synchronize itself with an external 
cycle. 

The basis for system clocks is derived from the clock signals received at the PROFINET 
interface if this interface is operated as synchronization slave with RT class IRT. The 
SIMOTION device does not have to synchronize itself with this external clock.

A substitute clock of a duration equivalent to the configured clock is generated internally if the 
PROFINET interface has not received a clock signal.

The clock settings are included in the project download to the SIMOTION device and are 
adjusted according to specification.

Dependencies of SINAMICS cycle clocks
The rule for SIMOTION D410‑2 DP/PN in the case of synchronized data traffic is that the send 
cycle clock serves as the basic cycle clock for the task system. All SIMOTION clock cycles 
(servo, IPO, IPO_2, etc.) longer than this basic cycle clock must be an integer multiple of the 
basic cycle clock.

This rule also applies to SINAMICS cycles, if one of the successive cycles is longer than the 
basic clock:

● Speed controller p0115[1] (drive)

● Flow controller p0115[2] (drive)

● Setpoint channel p0115[3] (drive)

● Position controller p0115[4] (drive)

● Positioning p0115[5] (drive)

● Technology controller p0115[6] (drive)
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● Onboard I/O p0799[0…2] (Control Unit)

● Terminal module I/O p4099

The corresponding cycle must be an integer multiple of the basic clock.

If any change to the send cycle violates this rule you must also change the SINAMICS cycles. 
In order to change the cycles in the Expert list of SIMOTION SCOUT, select the "Control_Unit" 
or the "Drive" from "SINAMICS_Integrated" in the Project Navigator, and then open the "Expert 
List" by selecting the "Expert" command from the shortcut menu.

If p0115 sampling times are required which cannot be set using p0112 > 1, then you can directly 
set the sampling times using p0115. This requires that p0112 must be set to "0" (expert).
If p0115 is changed online, the values of the higher indices are adapted automatically.

Note

At the SINAMICS end, there are further rules for setting the sampling times. You will find these 
described in the SINAMICS S120 Function Manual, Section Rules for setting the sampling time.

Example
A default value of 4 ms is set for the SINAMICS setpoint channel p0115[3]. If the send cycle is 
to be set to 3 ms, the fact that an integer multiple value is required means that you will need to 
set 3 ms or 6 ms (for example) for the setpoint channel.

Incorrect cycle clock setting
If the SINAMICS cycle clocks are not set correctly, this can be seen by the following messages:

● A01223 CU: Sampling time inconsistent and/or

● A01902 PB/PN isochronous operation parameterization impermissible and/or

● F01043 severe error downloading project

● F01951 CU SYNC: Synchronization application cycle clock missing

In this case, check the cycle clock settings on all drive objects signaling this error. For F01951, 
check the DP Integrated cycle. In this case, use a DP Integrated cycle that is a multiple of 0.25 
ms or 0.5 ms.

Note

An overview of errors reported by the SINAMICS Integrated is provided in the SINAMICS S List 
Manual.
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Current controller cycle clock
With the SIMOTION D410‑2, the following current controller cycle clocks p115[0] can be 
configured for the SINAMICS Integrated:

● for servo: 125 μs (default) or 250 μs

● For vector and vector V/f:

– For blocksize Power Modules: 250 μs or 500 μs (default)

– For blocksize Power Modules: 375 μs.

See also
Using vector drives  (Page 153)

6.6 Configuring an Ethernet subnet

6.6.1 General information about communication via Ethernet

Properties of Ethernet
SIMOTION D410‑2 has an onboard Ethernet interface X127 P1 PN/IE.   

You can connect an Industrial Ethernet with a transmission rate of 10/100 Mbit/s to the 8-pin 
RJ45 socket X127 P1.

Note

The Ethernet interface supports PROFINET basic services. It therefore has the designation PN/
IE.

The Ethernet interface has autocrossing functionality.

Ethernet communication
SIMOTION D410‑2 offers the following functions via Industrial Ethernet:

● Communication with STEP 7, SIMOTION SCOUT and SIMATIC NET OPC via a PG/PC

● Communication via UDP (user datagram protocol) with other components, e.g. other 
D410‑2 devices

● Communication with other devices via TCP/IP

● Connection of SIMATIC HMI devices or PC-based HMIs

● IT communication (e.g. via SIMOTION IT OPC XML‑DA)
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● Communication based on OPC UA (Unified Architecture)

● PROFINET basic services (e.g. DCP, LLDP, SNMP).
These PROFINET basic services provide uniform functions for the address assignment and 
diagnostics, but do not provide PROFINET IO communication for the connection of drives 
or I/O modules, for example.

Routing
S7 routing is possible from the Ethernet interface to the PROFIBUS interfaces and the 
PROFIBUS Integrated.

You can find the MAC address on the rating plate located on the front of the SIMOTION D410-2.

For further information on routing, see the SIMOTION Communication System Manual.

Default Ethernet addresses
The following IP addresses are assigned by default for the Ethernet interface:

Table 6-8 IP address assignment for SIMOTION D410‑2

Interface Use case Default address
X127 P1 
PN/IE

Insert SIMOTION device or 
HW Config

IP address:
Subnet mask:
Router address:
Automatic private IP address

169.254.11.22
255.255.0.0 
0.0.0.0
 

SIMOTION D410‑2 in the de‐
livery condition

IP address:
Subnet mask:
Router address:
Automatic private IP address

169.254.11.22 
255.255.0.0 
0.0.0.0

Note

The IP addresses 192.168.215.240 to 192.168.215.255 are reserved for internal 
communication in the SIMOTION D410-2 (subnet mask 255.255.255.240). When configuring 
the external Ethernet interface (X127 P1), make sure that the internal addresses are not inside 
their network. In IP, the network is defined as an AND link of IP address and subnet mask.

Note

If you want to go online via Ethernet, you have to make sure that the connection from PG/PC 
to SIMOTION D410‑2 is active. You can check this in NetPro. You will find a description of how 
to reactivate the connection in Section Establishing a PG/PC assignment (Page 105).

Automatic Private IP Addressing
The Ethernet interface supports the automatic IP assignment according to the Automatic 
Private IP Addressing (APIPA) process. 
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Interface X127 P1 already has IP address 169.254.11.22 in the delivery condition.  Further 
information on Automatic Private IP Addressing can be found on the Internet, e.g. in 
WIKIPEDIA with the keywords APIPA or Zeroconf.

6.6.2 Configuring the Ethernet connection in HW Config
The Ethernet connection of the SIMOTION D410‑2 can be configured in HW Config.

Procedure
1. Open your project.

2. Open HW Config. Double-click the Ethernet port (X127 P1) to open the "Properties - PNxIE" 
dialog box.

3. You can configure the Ethernet connection in the "Options" tab.
Recommendation: Use the default setting "Automatic setting". With Automatic setting, the 
baud rate and duplex operating mode are automatically aligned with the connection partner. 
The autocrossing functionality is also available so that you can use crossed and uncrossed 
cables.
If transmission is to be set manually, not only must the connection (e.g. 10 Mbit/s half 
duplex) be set manually but autonegotiation must also be deactivated. 

4. Close the "Properties - PNxIE" dialog box with "OK".

5. Save and compile the modified hardware configuration.

6. Load the new hardware configuration to the SIMOTION D410‑2 via PROFIBUS DP/
Ethernet/PROFINET IO.

Shielded twisted pair cables are used for the networking. 4‑ and 8‑wire cables can be used for 
10/100 Mbit/s.

Note

The TCP/IP timeout parameters are configured in HW Config by double-clicking the D410 
module in the "Ethernet extended" tab.

Additional references
For additional information, see the SIMATIC NET, Industrial Twisted Pair, and Fiber Optic 
Networks Manual.

For further information about the cabling spectrum for Ethernet, see the Industrial 
Communication IK PI Catalog.
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6.6.3 Configuring Ethernet addresses in HW Config

Requirement
For configuration using Industrial Ethernet, SIMOTION D410‑2 must be provided with an IP 
address, the subnet mask and the router address.

Note

Only one router may be configured.

Procedure
To configure and transfer Ethernet addresses to the D410‑2, proceed as follows:   

1. Open your project.

2. Open HW Config. Double-click the interface to be configured (X127) to open the 
"Properties" dialog box.

3. On the "General" tab, click the "Properties" button of the Ethernet interface. The "Properties 
- Ethernet Interface" dialog is displayed.

4. Click the "New" button. The "New Industrial Ethernet" subnet dialog is displayed. In this 
dialog box, you can change the name of the new subnet or confirm the default setting with 
"OK".

5. The newly created Ethernet subnet is now displayed under "Subnet" in the "Properties - 
Ethernet Interface" dialog box and must be selected.

6. In this dialog box, enter the required addresses for "IP Address" and "Subnet". Under 
"Router", choose whether a router is to be used. If using a router, enter the router address.

7. Confirm this dialog box with "OK".

8. Close the "Properties" dialog by clicking "OK".

9. Save and compile the modified hardware configuration.

10.Load the new hardware configuration to the SIMOTION D410‑2.

Assigning the Ethernet address later
It is possible to assign the IP address later on (e.g. on modular machines). In this case, an IP 
address is not assigned in HW Config, but activated differently with the "Set IP address using 
different method" option. The address will then be assigned later on the machine, for example, 
by a the user program or by commissioning tools, such as PRONETA.

Further information on PRONETA can be found on the Internet:

● PRONETA: See Internet address (https://support.industry.siemens.com/cs/ww/en/view/
67460624)
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6.6.4 Reading out IP and MAC address

Requirement
To read out the IP and MAC addresses, the following requirements must be met:

● SIMOTION D410‑2 is wired.

● You have assigned the communication parameters.

● You are online.

Procedure
The IP address and MAC address of SIMOTION D410‑2 can be displayed as follows via 
SIMOTION SCOUT.

1. Right-click the module.

2. Select "Target device" > "Device diagnostics" in the context menu.

Example
The addresses are displayed as follows for SIMOTION D410‑2:

X127 (IE)

● Active MAC Address: 08-00-06-73-25-3E

● IP address: 169.254.11.22

● Subnet mask: 255.255.0.0

● Standard gateway: 0.0.0.0.

As an alternative, you can determine the IP address as follows: 

● By selecting "Project" > "Accessible nodes" in SIMOTION SCOUT

● By calling "Target system" > "Ethernet" > "Edit Ethernet node..." in HW Config and browsing 
to "Online accessible nodes"

● Using the system function _getIpConfig 

Note

The MAC address is listed on the nameplate on the front of the module.

Parameter assignment / addressing
6.6 Configuring an Ethernet subnet

SIMOTION D410-2
Commissioning and Hardware Installation Manual, 04/2019, A5E33446807B 121



Parameter assignment / addressing
6.6 Configuring an Ethernet subnet

SIMOTION D410-2
122 Commissioning and Hardware Installation Manual, 04/2019, A5E33446807B



Commissioning (software) 7
7.1 Overview of commissioning

7.1.1 Requirements for commissioning
The requirements for commissioning the SIMOTION D410-2 are as follows:     

● The system has been connected and wired.

● The SIMOTION D410-2 is switched on and powered up (STOP operating state).

● SIMOTION SCOUT (with integrated STARTER) has been installed and started on the PG/
PC.

● Communication between the SIMOTION D410-2 and the PG/PC is configured.

● You have created a project and installed a SIMOTION D410-2 in the project.

7.1.2 Symbolic assignment / adaptation

Symbolic assignment 
SIMOTION supports the symbolic assignment on SINAMICS drive objects (DOs) during the 
configuration of technology objects (TOs) and I/Os.   

This simplifies the configuration of the technological relationships including the communication 
between controller and drive.

With the symbolic assignment:

● Only suitable assignment partners are offered in an assignment dialog box.

● Communication between axis and drive is set up automatically by the engineering system 
and the required PROFIdrive axis telegrams as well as the used addresses set up.

● Telegrams are extended and interconnections created automatically in the drive depending 
on the selected TO technology (e.g. SINAMICS Safety Integrated).

● Axis and drive configuration are first performed independently.

● Communication connections are established automatically during the configuration of I/O 
variables on SINAMICS I/Os (telegrams are set up automatically, the I/Os interconnected to 
the telegram and the addresses set up).
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Apart from the symbolic assignment, no further configuration is required for the communication. 
As addresses no longer have to be configured, the connection is retained even with address 
offsets.

Note

During the configuration of drive objects (DO drive, DO encoder, ...) as well as in the Telegram 
Configuration dialog box (see Section Telegram configuration (Page 180)), you can deactivate 
the automatic telegram configuration and the automatic telegram adaptation.

A deactivation should only be performed in justified exceptional cases because many of the 
above mentioned benefits are lost.

The symbolic assignment enables an independent configuration of the axes on the SIMOTION 
side and the drives on the SINAMICS side. This allows the following:

● The PLC and motion control functions can be completely configured by a programmer even 
without drive know-how using technology objects (e.g. TO axis) and loaded to the device.

● The drives can be separately configured and optimized by a drive expert.

● The technology objects can be symbolically assigned later to the drive objects via an 
interconnection dialog box.

Note

The previous methods of drive, axis and I/O configuration are still available. Symbolic 
assignment must be deactivated for these methods.

For newly created projects, the symbolic assignment is used by default.

If projects < V4.2 are upgraded, the symbolic assignment is deactivated by default and must be 
activated when required.

Symbolic assignment can be activated or deactivated in SIMOTION SCOUT via the menu 
"Project" > "Use symbolic assignment." 

Activating symbolic assignment later
Symbolic assignment is recommended and is automatically activated.
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Conversion from upgraded projects to symbolic assignment is possible, but this requires post-
editing of the project, especially for free telegram configurations (e.g. for TM15 DI/DO, TM31).

Note

If the symbolic assignment is activated later, previously existing telegram settings and BICO 
interconnections for all SINAMICS telegrams that are set to Standard/Automatic 
(Communication -> Telegram configuration) are replaced at the next compilation. This may 
change telegrams and BICO interconnections and delete telegram extensions previously set 
up manually. 

For this reason, make a backup copy of your project before activating the symbolic assignment.

To retain the settings that have been made, after the selection of "Use symbolic assignment," 
the setting "User-defined" must be selected and the check box cleared for automatic telegram 
setting/address adaptation for the respective message before compilation.

For further details, see the SIMOTION Runtime Basic Functions Function Manual.

Assigning a drive later
You can create an axis in SIMOTION SCOUT and assign it to a drive later. You can thus load 
your user program to the controller and (with the exception of the non-existent drives) test it.

Compared to a procedure with temporarily created "virtual axes", "axes without assigned drive" 
have the advantage that the configuration data is completely available and do not require a 
"virtual axis -> real axis" reconfiguration.

Simulation of axes
You can also use the axis simulation to test the user program. You can find a script for switching 
the axis simulation on and off in SIMOTION Utilities & Applications, which is part of the scope 
of delivery of SIMOTION SCOUT.

Further details can be found in the TO Axis Electrical/Hydraulic, External Encoder Function 
Manual.

Adaptation   
In addition to the symbolic assignment, the automatic adaptation also facilitates the 
configuration of SINAMICS S120 data. When SIMOTION devices ramp up, reference 
variables, along with drive and encoder data for SINAMICS S120, are transferred automatically 
for the configuration data of the SIMOTION technology objects "Axis" and "External Encoder". 
This data no longer has to be entered in SIMOTION.

For additional information, see the following sources:

● SIMOTION Runtime Basic Functions Function Manual

● TO Axis Electrical/Hydraulic, External Encoder Function Manual
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Requirement
Symbolic assignment is supported by the TO axis, TO externalEncoder and the TO outputCam, 
TO camTrack and TO measuringInput. The onboard I/Os of a SIMOTION D, of a 
SINAMICS S110/S120 Control Unit, and selected Terminal Modules can be interconnected 
symbolically.

Module Supports symbolic assignment
SIMOTION D
● SIMOTION D410-2
● SIMOTION D410
● SIMOTION D4x5-2
● SIMOTION D4x5

 
● As of SIMOTION V4.3
● As of SIMOTION V4.2
● As of SIMOTION V4.2
● As of SIMOTION V4.2

Controller extension
● CX32-2
● CX32

As of SIMOTION V4.2

SINAMICS S110 CU305 As of SINAMICS V4.3
SINAMICS S120
● CU310-2
● CU310
● CU320-2
● CU320

 
● As of SINAMICS V4.4
● As of SINAMICS V2.6.2
● As of SINAMICS V4.3
● As of SINAMICS V2.6.2

See also
Only the drive configuration by means of symbolic assignment is described in this 
documentation. 

You will find the documentation of older SIMOTION versions on the Internet at the following 
address (https://support.industry.siemens.com/cs/ww/en/view/40211807).

For further information on the configuration of the TO axis and TO externalEncoder, see the TO 
Axis Electrical/Hydraulic, External Encoder Function Manual.
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7.1.3 Procedure when commissioning

Commissioning steps
This section shows you how to configure a system and test the configured drives and axes. The 
steps in commissioning are listed below in the order as recommended:     

1. Configuring SINAMICS Integrated
The integrated drive SINAMICS Integrated can be configured in offline or online mode:

– Performing an offline configuration (Page 128)
For offline configuration, all of the components and their article numbers must be known.

– Performing an online configuration (Page 145)
During online configuration, you can load all of the information from the connected 
DRIVE-CLiQ components to your user project.

2. Test the configured drive using the drive control panel (Page 168)

3. Create an axis with the axis wizard (Page 171)

4. Test a configured axis with the axis control panel (Page 178)

5. Set up addresses and telegrams (Page 180)

6. Link an additional encoder (optional) (Page 184)

7. Configure drive-related I/Os (with symbolic assignment) (Page 191)

8. Configure technology objects and I/O variables (Page 196)

9. Optimize the drive and controller (Page 205)

When carrying out this procedure, consult the relevant references.

This section also contains additional configuration information, e.g. for vector drives, Safety 
Integrated, etc.

7.1.4 Important functions for the project handling and for the commissioning
Below you will find an overview of the most important functions for project handling and for 
commissioning with the associated icons.     

Save project and compile changes
The entire project is saved and the project data (e.g. programs) compiled into an exe‐
cutable code.
Connect to selected target devices
The online connection is established to the selected target devices. Under "Target 
system" > "Select target devices", you can set which target devices are to go online.
Download project to target system
The programs are loaded to the SIMOTION device as well as the configuration for the 
SINAMICS Integrated.
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Download CPU / drive unit to target device
The configuration is only loaded to the device selected in the project tree which means 
that the function needs to be performed separately for each D410-2 and SINAMICS 
Integrated.
Load CPU / drive unit to PG
The unit's configuration is only loaded to the PG selected in the project tree which 
means that the function needs to be performed separately for each D410-2 and SI‐
NAMICS Integrated.
Copy RAM to ROM
Copying from RAM to ROM is only performed for the device selected in the project tree 
which means that the function needs to be performed separately for each D410-2 and 
SINAMICS Integrated.

Note
Tips for going online:

In online operation, SIMOTION SCOUT attempts to conduct online operation with all hardware 
components contained in the project. This means that the time needed for going online 
increases.

We recommend that you make settings for SIMOTION SCOUT so that online operation is made 
only with those components currently needed. The setting can be found at "Target system" > 
"Select target devices ..." in the menu. The selection and deselection of the devices in the online 
state can be made via the "Connect target device" context menu on the device.

This procedure is also advantageous when the configuration of the drive unit is completed. 
Without going completely offline, the connection can be simply deselected via the context menu 
on the drive unit.

7.2 Performing an offline configuration

7.2.1 Overview

Introduction
In the case of offline configuration, the project is created while not all of the hardware 
components (in particular drives) are available. In this way, a SIMOTION project in the office 
environment can be created up to a point where a basic project specification including a 
program exists. At a later time, the finished project can be loaded to the SIMOTION D410-2 and 
tested together with the drive.       
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Requirements
● For offline configuration, all of the components and their article numbers must be known.

● You have created a project in SIMOTION SCOUT and inserted a SIMOTION D410-2 in the 
project.

● You have configured the communication between the SIMOTION D410-2 and the PG/PC, 
see Section Creating a project and configuring the communication (Page 87).

Procedure
The offline configuration involves the following steps:

● Accessing the drive wizard (Page 129) 

● Configuring components (Page 130) 

● Downloading the project to SIMOTION D410-2, by means of the following options:

– Downloading to the target system (Page 141) 

– Downloading to the CF card (Page 142) 

– Downloading incl. sources and additional data (Page 143) 

– Archiving to the CF card (Page 144) 

Note

During offline configuration, you can configure Terminal Modules such as the TM15, for 
example.

7.2.2 Accessing the drive wizard

Integrated drive
SIMOTION D410-2 features an integrated SINAMICS S120 drive (control unit) which is 
automatically included when you insert the SIMOTION D410-2 in the project navigator. The 
integrated drive must be operated in isochronous mode using PROFIdrive-compliant telegram 
types.     

The drive wizard for the integrated STARTER in SIMOTION SCOUT is available for the 
purpose of configuring the integrated drive and its associated modules (SINAMICS S120 
Power Module, for example).

Note

Take note of all the necessary safety instructions and rules governing connections, which can 
be found in the latest SINAMICS S120 documentation on the SIMOTION SCOUT DVD.
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Procedure
Select the "SINAMICS_Integrated" > "Configure drive unit" drive element in the project 
navigator to open the drive wizard.

You can configure the following components:

● Power unit (e.g. SINAMICS S120 Power Module)

● Motor

● Encoder

7.2.3 Configuring components

Procedure

Note

An overview of permissible configurations, quantity structures and DRIVE-CLiQ topologies can 
be found in Section Quantity structures (Page 229) and in the SINAMICS S120 Commissioning 
Manual.

Failure to comply with the rules listed in this manual will result in errors that are not output until 
the download is performed, rather than at the configuration stage.
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1. Enter a drive name in the "Drive Properties" dialog box and select the drive type (servo or 
vector).    

Figure 7-1 Drive properties

2. In the "Control Structure" dialog, you can select the function modules and the control type.
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Figure 7-2 Control structure
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3. In the "Power Unit" dialog, use the article number to select your power unit from the list.

Figure 7-3 Selecting a power unit
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4. Select in the "Power Unit Supplementary Data" dialog the component added to the power 
unit.
The selection of the component depends on the construction type.

– SIMOTION D410‑2 DP or D410‑2 DP/PN: The SIMOTION D410‑2 is snapped directly 
onto the blocksize format Power Module.

– CUA31 or CUA32: The CUA3x is snapped directly onto the blocksize format Power 
Module. The SIMOTION D410-2 is mounted separately on a mounting plate. The 
SIMOTION D410‑2 is connected to the CUA3x using a DRIVE-CLiQ cable.

Figure 7-4 Selecting the mounting type

Note

If SIMOTION D410-2 is mounted separately (Power Module in blocksize format 
connected to SIMOTION D410-2 via CUA31/32), use of the Safety Integrated Extended 
and Advanced Functions via the onboard terminals (F-DI, F-DO) is not possible.
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5. In the next dialog, select the motor and, where applicable, the motor type:

– Either by selecting a standard motor from the list

– Or by entering the motor data

– Or by automatically identifying the motor (motor with DRIVE-CLiQ interface)

Figure 7-5 Selecting a motor

Note

Motors with DRIVE-CLiQ interface have an integrated encoder evaluation that is 
connected to the Power Module via a fully digital communication interface (DRIVE-
CLiQ).

In this way, motor encoder and temperature signals as well as electronic rating plate 
data, such as unique article numbers, rated data (voltage, current, torque) can be 
transferred directly to the Control Unit.
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6. Select a motor holding brake (if installed).

Figure 7-6 Selecting a motor holding brake
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7. If you are using a motor that is not equipped with a DRIVE‑CLiQ interface, select the 
encoder order number in the "Encoder Selection via Motor Order Number" dialog box.

Figure 7-7 Selecting a motor encoder (1)

Figure 7-8 Selecting a motor encoder (2)
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Note

If required, you can configure a second or third encoder in the "Encoder" dialog box. You can 
transmit a maximum of two encoder values to SIMOTION via the axis telegram. In the case 
of motors with a DRIVE-CLiQ interface, the motor encoder is identified automatically. It is 
not necessary to enter encoder data in such cases (the box for selecting Encoder 1 is grayed 
out and therefore inactive).
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8. The communication for the control of the SINAMICS drive is configured in the following 
dialog box. It is recommended that these settings be made automatically by the engineering 
system.

Figure 7-9 Configuring the process data exchange (standard)

You can also make the settings manually for the process data exchange by selecting "User-
defined".
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Figure 7-10 Configuring the process data exchange (user-defined)

Information about the manual setting options can be found in the online help and in the 
manuals for the SINAMICS S120 drive system.

9. After you have configured all of the settings in the drive wizard, the "Summary" dialog box 
displays a list of all settings. You can now choose to activate your settings by clicking 
"Finish", or to return to the component configuration for further editing.
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Figure 7-11 Finishing the drive

The configured drive is displayed in the project navigator. An overview of your configured 
SINAMICS components is available in the "SINAMICS_Integrated" > "Topology" dialog.

Additional references
If you configure the drive telegrams manually, you can find detailed information on the 
respective telegram types in the following:

● Motion Control, TO Axis Electric/Hydraulic, External Encoder Function Manual

● SINAMICS S120 Function Manual

7.2.4 Downloading the project to the target system

Procedure
1. Save and compile the project.

2. Go online with the SIMOTION D410-2.
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3. To load the project, perform "Download project to target system". 
The data must also be saved on the CompactFlash card to ensure that the project is retained 
in the event of a power failure. The following options are available:

– Perform the "Copy RAM to ROM..." function manually on the SIMOTION D410-2 and the 
drive (SINAMICS Integrated).

– In the "Download to Target System" dialog box, select the option "After loading, copy 
RAM to ROM". You can change the default setting for this dialog box in "Options" > 
"Settings" > "Download".

4. To save the parameter calculations of the drive in the project, perform "Target device" > 
"Load CPU / drive unit to PG" for the drive.

Result
The drive has been assigned parameters and commissioned. You can now test the drive using 
the drive control panel.   

Note

Online access to SINAMICS Integrated is not possible if HW Config is not loaded at the time you 
initially connect to the target system.

Download the data to HW Config in order to enable online access to SINAMICS Integrated.

Note

If you have deselected the "Drives" option under "Tools" > "Settings" > "Download" in 
SIMOTION SCOUT, you must download the configuration separately to each drive (SINAMICS 
Integrated).

To do this, select the drive (e.g. SINAMICS Integrated) in the project navigator and perform 
"Download CPU / drive unit to target device".
To work quickly, we recommend that drives be generally deselected and a download only be 
performed when required.

7.2.5 Loading a project created offline to the CompactFlash card

Procedure
You can use a card reader to write the entire project to the CF card, even in offline mode. In 
SIMOTION SCOUT, you can call the "Load to file system" function in the context menu of the 
SIMOTION device.       

1. Save and compile the project.

2. Switch off the SIMOTION D410-2.

3. Remove the CF card and insert it in a card adapter. The card adapter must be connected to 
a PG/PC.
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4. In the SCOUT project, select the SIMOTION D410-2 device that you want to download to 
the CF card.

5. Click "Load to file system" in the context menu. A dialog box opens.

6. In the "Load to File System" dialog box, select the "Save normally" option and click the 
"Select target" button.

7. Select the target drive.

8. Confirm your entries with "OK". The data is written to the CF card.

9. Remove the CF card and insert it into the slot on the SIMOTION D410-2.

10.Switch on the SIMOTION D410-2.

Note

With "Load to file system", the project data of the controller (including SINAMICS Integrated) 
is written directly to the CF card. Separate execution of "Load to file system" for the 
SINAMICS Integrated is not possible.

Result
The SIMOTION D410-2 ramps up with the loaded project.

Note

The components' firmware is automatically updated, depending on the firmware version on the 
SINAMICS components and on the CF card. During a firmware update, please take note of the 
messages and alarms in the SIMOTION SCOUT detail window. A FW update on the 
SIMOTION D410-2 is indicated by the RDY LED flashing yellow, while on the DRIVE-CLiQ 
components (TM, SMC, etc.) it is indicated by the RDY LED flashing red/green.
● FW update running: RDY LED flashes slowly (0.5 Hz)
● FW update complete: RDY LED flashes quickly (2 Hz), POWER ON required

Components that require a POWER ON after the firmware update will indicate this through a 
rapidly flashing RDY-LED. Go offline with SCOUT and switch the 24 V supply off/on (POWER 
ON) at the respective components for initialization.

7.2.6 Downloading the project incl. sources and additional data

Overview
It is possible to download additional data (e.g. sources) to the target device when saving a 
project to the CF card or downloading to the SIMOTION D410‑2.             

Commissioning (software)
7.2 Performing an offline configuration

SIMOTION D410-2
Commissioning and Hardware Installation Manual, 04/2019, A5E33446807B 143



These data are required for: 

● Online object comparison (e.g. additional properties)

● Various detailed comparisons (e.g. ST source file comparison)

● Synchronization with online objects.

In order to be able to load a project's sources and additional data to the PG, this must be 
specified in the project under "Options" > "Settings" > "Download" > "Store additional data on 
the target device". Alternatively, this setting can also be made when the data is loaded to the 
target device/target system.

You can, for example, perform a project comparison with the sources and additional data stored 
on the CF card (see example below).

Project comparison (example)
You intend to perform servicing work on a commissioned system and have placed a project on 
your PG/PC. This project is not consistent with the project on the SIMOTION D410‑2 cm the 
system. In order to analyze the differences, perform an object comparison via "Start object 
comparison".

You have the following options in terms of re-establishing consistency:

● In the object comparison, it is possible to establish consistency in sources and technology 
objects on an object-granular basis.

● Consistency can be established for the entire Control Unit by loading from the CF card with 
"Target system" > "Load" > "Load CPU / drive unit to PG...."

Additional references
Detailed information on loading data to the target device can be found in the SIMOTION 
Runtime Basic Functions Function Manual.

7.2.7 Archiving a project on the CompactFlash card (zip file)

Procedure
In SIMOTION SCOUT, you can save the project as a *.zip file to the CompactFlash card.   

Proceed as follows to archive the SIMOTION project on the CompactFlash card:

1. Open SIMOTION SCOUT and select the "Project" > "Archive" menu command.

2. In the "Archive" dialog box, select the SIMOTION project and save it to your drive (PG/PC).

3. Open the project.

4. Go online with the SIMOTION D410-2.
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5. In the project navigator, select the SIMOTION D410-2 and select the "Target system" > 
"Load" > "Save archived project to card..." menu command.

6. In the dialog that is displayed, select the project and click "Open". This saves the project to 
the CompactFlash card as Project.zip in the directory: USER\SIMOTION\HMI\PRJLOG.

Note

If you want to load the current project from the card, select the "Target system" > "Copy 
archived project from card to PG/PC..." menu command.

Prerequisite is that you have backed up the project with "Save archive project on card..." 
each time a change was made.

Additional references
Detailed information on loading data to the target device can be found in the SIMOTION 
Runtime Basic Functions Function Manual.

7.3 Performing an online configuration

7.3.1 Overview

Introduction
You can configure the plant in online mode after having completed its wiring. You can use the 
"Automatic configuration" function to load the SINAMICS components connected via DRIVE-
CLiQ to your PG/PC. However, this is only possible for initial commissioning.       

Note

Components without DRIVE-CLiQ connection must be edited in offline mode. You may need to 
edit DRIVE-CLiQ components which were detected in the course of automatic configuration 
(for example, adding encoder data if using SMC modules).

Prerequisites for online configuration
● You have created a project in SIMOTION SCOUT and inserted a SIMOTION D410-2 in the 

project.

● You have configured the communication between the SIMOTION D410-2 and the PG/PC.

● Your system has been installed and wired.
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Procedure
The online configuration involves the following steps:

● Establishing the online connection (Page 146) 

● Starting automatic configuration (Page 147) 

● Reconfiguring SINAMICS components (Page 149) 

● Downloading a project to the SIMOTION D410-2 (Page 150) 

7.3.2 Establishing the online connection

Procedure when commissioning the drive for the first time
To perform an online configuration, you must establish an online connection to the 
SIMOTION D410-2. In this case, no connection can yet be established to SINAMICS 
Integrated. An appropriate message is output. Once the hardware configuration has been 
loaded to the target device, an online connection to the SINAMICS Integrated is established 
automatically. Proceed as follows:   

1. Save and compile the project.

2. Establish an online connection.

3. Select the SIMOTION D410-2 device in the project navigator.

4. Use the "Download CPU / drive unit to target device" function to download the SIMOTION 
D410-2 device to the target device. The connection to SINAMICS Integrated is activated 
automatically.

You can now run automatic configuration on the SINAMICS Integrated. For details, see Section 
Starting automatic configuration (Page 147).

Additional references
Further information about establishing an online connection to the programming device/PC can 
be found in the following documentation:

● SIMOTION SCOUT Configuration Manual

● SIMOTION SCOUT Online Help

● In the FAQ for SIMOTION Utilities & Applications
SIMOTION Utilities & Applications is provided as part of the SIMOTION SCOUT scope of 
delivery.

● FAQOnline connection to SIMOTION (https://support.industry.siemens.com/cs/ww/en/
view/22016709)
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7.3.3 Starting automatic configuration

Requirement
You have established the online connection to SINAMICS Integrated.       

Procedure
1. In the project navigator, open the "Automatic Configuration" dialog with the 

"SINAMICS_Integrated" > "Automatic configuration" menu command.

Figure 7-12 Starting automatic configuration

2. Click the "Configure" button.

3. If the drive unit is not in the "First commissioning" state, the factory settings are restored 
after acknowledging a prompt.

4. The drive object types can now be selected via a further dialog box.

Figure 7-13 Selecting the drive object type

5. Select whether a servo- or vector-type drive object is to be used.
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6. Click "Create" to start the automatic configuration.
The configuration data is uploaded (Load to PG) automatically as soon as automatic 
configuration is completed.

Note

The components' firmware is automatically updated, depending on the firmware version on 
the SINAMICS components and on the CF card.

The update procedure can take several minutes and is indicated in the "Automatic 
Configuration" dialog box by the following message:

"State of the drive unit: Automatic FW update of DRIVE-CLiQ components".

A FW update on the SIMOTION D410-2 is indicated by the RDY LED flashing yellow, while 
on the DRIVE-CLiQ components (TM, SMC, etc.) it is indicated by the RDY LED flashing red/
green.
● FW update running: RDY LED flashes slowly (0.5 Hz)
● FW update complete: RDY LED flashes quickly (2 Hz), POWER ON required

Components requiring POWER ON following a firmware update signal this by means of the 
fast flashing RDY LED. Go offline with SCOUT and switch the 24 V supply to the relevant 
components off/on (POWER ON) to initialize.

Following the automatic configuration, a prompt appears as to whether you want to "Go 
offline" or "Remain online" with the drive unit.

7. Execute the "Copy RAM to ROM ..." function on the SIMOTION D410-2 and SINAMICS 
Integrated. This saves the project on the CF card so that it does not need to be reloaded after 
switching off and on.
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Result
The DRIVE-CLiQ components loaded to the user project by means of automatic configuration 
are displayed in the project navigator.

Figure 7-14 Project navigator with the downloaded DRIVE-CLiQ components

You must then 

● If required, reconfigure SINAMICS components (e.g. components without a DRIVE‑CLiQ 
interface, such as an encoder connected to the onboard encoder interface).

● Assign the "TO axis" to "Drive".

7.3.4 Reconfiguring SINAMICS components

Requirements
● You have uploaded all connected DRIVE-CLiQ components to the user project.

● You have shut down the connection to the target system (offline mode).

Procedure
Now go ahead and adapt your components to suit the application.   

Run through the wizard for all the DRIVE‑CLiQ components to be adapted and perform the 
required reconfigurations.
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This procedure corresponds to the description in Section Performing an offline configuration 
(Page 128).

The amount of editing work involved depends on the components used. For example, in the 
case of a motor with a DRIVE-CLiQ interface, the motor and encoder type are identified 
automatically.

7.3.5 Downloading the project to SIMOTION D410-2

Procedure
After you have performed the reconfigurations, you must download the configuration to the 
SINAMICS Integrated.     

1. Save and compile the project.

2. Go online with the SIMOTION D410-2.

3. To load the project, perform "Download project to target system".
The data must also be saved on the CompactFlash card to ensure that the project is retained 
in the event of a power failure. The following options are available:

– Perform the "Copy RAM to ROM..." function manually on the SIMOTION D410-2 and the 
drive (SINAMICS Integrated).

– In the "Download to Target System" dialog box, select the option "After loading, copy 
RAM to ROM". You can change the default setting for this dialog box in "Options" > 
"Settings" > "Download".

4. To save the parameter calculations of the drive in the project, perform "Target device" > 
"Load CPU / drive unit to PG" for the drive.

Result
The drive has been assigned parameters and commissioned. You can now test the drive using 
the drive control panel.

Note

Online access to SINAMICS Integrated is not possible if HW Config is not loaded at the time you 
initially connect to the target system.

Download the data to HW Config in order to enable online access to SINAMICS Integrated. 
During the "Download to target system" process, SIMOTION SCOUT automatically attempts to 
establish an online connection to SINAMICS Integrated.
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Note

If you have deselected the "Drives" option under "Tools" > "Settings" > "Download" in 
SIMOTION SCOUT, you must download the configuration separately to each drive (SINAMICS 
Integrated).

To do this, select the drive (e.g. SINAMICS Integrated) in the project navigator and perform 
"Download CPU / drive unit to target device".
To work quickly, we recommend that drives be generally deselected and a download only be 
performed when required.

7.4 Additional information on configuring the SINAMICS Integrated

7.4.1 Setting DP Slave properties

Settings in HW Config
Depending on the cycle clock ratios (bus cycle, servo cycle) and the drive used, it may be 
necessary to adapt the properties of the DP slave (SINAMICS Integrated) on the PROFIBUS 
Integrated.             

Open HW Config. Double-clicking the SINAMICS Integrated enables you to display and, if 
required, change the properties of the DP slave on the "Clock synchronization" tab. Possible 
changes include:

● Synchronize drive to the equidistant DP cycle
The SINAMICS Integrated of a SIMOTION D410-2 can only be operated isochronously. For 
this reason, this option cannot be deactivated.

● Changing the master application cycle (TMAPC)
The master application cycle must always be the same as the servo cycle clock set (setting: 
in context menu of the D410-2  > "Set system cycle clocks" in the project tree).
Provided that the DP cycle is not scaled down to the servo cycle, the master application 
cycle will always be the same as the DP cycle.

Note

The PROFIBUS cycle clock can be scaled down in relation to the servo cycle clock. Down-
scaling is only permitted if PROFINET IO with IRT has not been configured.
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● Changing the DP cycle (TDP)
Depending on the requirements in terms of the quantity structures and response times, the 
DP cycle may need to be changed. (See also SIMOTION Runtime Basic Functions Function 
Manual).
In addition, the minimum DP cycle for vector drives also depends on the speed controller 
cycle clock, which in turn depends on the used device type. This means that, particularly in 
the case of vector drives, the DP cycle must be checked and changed if necessary, see 
Section Using vector drives  (Page 153).

Note

After TDP has been changed on the PROFIBUS master, the drive system must be switched 
on (POWER ON).

● Changing the TI and TO times
A change to TI/TO is required in the case of vector drives, for example, where the TI/TO time 
for devices in chassis format depends on the type of device used.

Figure 7-15 HW Config setting

The times are modified by changing the value in the "Factor" field.
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SCOUT TIA
In order to parameterize the isochronous cycle clock for the PROFIBUS Integrated in the TIA 
Portal, proceed as follows: 

1. Select the PROFIBUS Integrated in the network view. 

2. Select the "General" tab in the Inspector window and click "Equidistance" to display the 
parameters for the isochronous PROFIBUS.  The "Activate isochronous bus cycle" setting 
is permanently selected and cannot be edited. 

The other parameters are set to default settings and can be edited.

Additional references
Additional information can be found

● In the SINAMICS S120 Function Manual

● SIMOTION Runtime Basic Functions Function Manual

● SIMOTION SCOUT TIA Configuration Manual

7.4.2 Using vector drives 
Changes need to be made in HW Config when SINAMICS vector drives are used. This means, 
for example, that the TI/TO time and the minimum DP cycle for drives in chassis format depend 
on the type of device used.     

Therefore, we recommend adopting the following procedure when using a vector drive with the 
SIMOTION D410-2.

Procedure
1. Open HW Config. By "double clicking" the SINAMICS Integrated, you can change the 

properties of the DP slave in the "Clock synchronization" tab.

2. For TI = TO =, enter an integer multiple of the current controller cycle. For the current 
controller cycle clock, use 375 µs for devices in chassis format and 250 µs or 500 µs for the 
blocksize devices (PM340, PM240-2).

3. For TDP, enter an integer multiple of the speed controller cycle. For a drive on the SINAMICS 
Integrated, TDP must be >= TO in all cases.

4. Enter TMAPC = TDP (exception: You are working with cycle reduction; i.e. servo cycle > DP 
cycle).

5. Use the "Target system" > "Load" > "Load project to target system" menu command to 
download the parameterization to the SIMOTION D410-2.
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6. After the download has successfully completed, you should determine the current and 
speed controller cycles of the drive from the drive's expert list, because the cycle clocks are 
set in the SINAMICS drive unit after a project has been downloaded.

– p0115[0] current controller cycle clock

– p0115[1] speed controller cycle clock

7. If the current and speed controller cycles from the expert list are different to the cycles used 
in steps 2 and 3, you will have to repeat the steps using the most up-to-date values for the 
current and speed controller cycles.

Note

The described procedure is also required for an online configuration with an automatic 
configuration.

Table 7-1 Vector drive

Example Settings
Vector drive (chassis format)
Current controller cycle = 375 µs
Speed controller cycle = 1.5 ms

TI = TO = at least 375 µs
TDP = 1.5 ms (... or 3 ms, or 6 ms ....)
TMAPC = TDP 
For the SIMOTION D410-2, a minimum of 1 ms is recom‐
mended for the servo cycle clock.
For this reason, set TMAPC = TDP = 3 ms or higher.

Vector drive (PM340/PM240-2)
Current controller cycle clock = 500 µs 
(default)
Speed controller cycle = 2 ms

TI = TO = at least 500 µs
TDP = 2 ms (… or 4 ms, 8 ms, …)
TMAPC = TDP

Blocksize Power Modules
Current controller cycle clock 500 µs (default)

The default current controller sampling time for SIMOTION D410‑2 with PM340/PM240‑2 is 
500 µs. This current controller cycle is set automatically following project download if p0112 = 
3 (default). The sampling times in p0115 are adapted automatically by the system following the 
download; therefore, they may deviate from the offline values. The system also sets p0112 = 
0 (expert) after the download. 

Current controller cycle clock 250 µs (manual setting required)

If the current controller cycle clock for SIMOTION D410‑2 is to be changed from 500 µs (default) 
to 250 µs, p0112 = 0 (expert) must be set.
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p0112 = 0 enables the individual sampling times to be adjusted in p0115. Moreover, with this 
setting, the system does not change the current controller sampling time automatically.

Note

SIMOTION D410‑2 is a single-processor system. CPU utilization is, therefore, dependent on 
the SIMOTION configuration (PLC and motion control) and the SINAMICS configuration (drive 
control).
For more performance on the SIMOTION side, we recommend not setting any unnecessary 
cycle clocks on the SINAMICS side.

400 µs current controller cycle clock
Vector drives in chassis format can also be operated with a current controller sampling time of 
400 µs (amongst other settings).

In the SIMOTION context, the following should be considered:

● A current controller sampling time of 400 µs is only possible if control is via a 
SINAMICS S120 Control Unit, which is not operated isochronously via PROFIBUS/
PROFINET on the SIMOTION D410-2.

● If the bus is operated isochronously, only cycle clocks with an integer multiple of 125 µs are 
possible (i.e. 375 µs or 500 µs instead of 400 µs, for example).

● The PROFIBUS Integrated of a SIMOTION D410‑2 is always isochronous! This means that 
a current controller sampling time of 400 µs is not possible.

● With CU parameter p0092 = 1, the sampling times are preassigned in a way that enables 
isochronous operation with a control system.

Output cams / measuring inputs with vector drives
In the case of devices in chassis format, the cycle clock ratios (current controller cycle clock, 
speed controller cycle clock, input/output sampling time, etc.) also depend on the type of device 
used.

Note the information in Section Current controller cycle clocks <> 125 µs / use of output cams 
and measuring inputs (Page 165).

Additional references
Additional information on quantity structures and cycle clock settings can be found in 
the SINAMICS S120 Function Manual.
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7.4.3 Setting the SIMOTION time of day

Time on SIMOTION (real-time clock)
SIMOTION D410-2 features an integrated real-time clock. All events on a module (alarms, 
messages, etc.) are "time-stamped" based on the time shown by this real-time clock.

Procedure
Various options are available to set the clock of the SIMOTION D410-2: 

● Setting the clock via the engineering system  

– SIMOTION SCOUT: Select the SIMOTION D410-2 in the project tree and then "Target 
system" > "Set time" in the menu.  

– SIMOTION SCOUT TIA: Call the "Set time" function at "Online & diagnostics" in the TIA 
Portal in the project tree. 

● Setting the clock using the "rtc" system function block 

● Synchronization of the local time with an NTP time server (as of V4.5) 

The status of the NTP time synchronization can be determined with the 
_getStateOfNTPClockSynchronisation system function.  

For further information on the NTP process, see the SIMOTION Communication System 
Manual and the SIMOTION SCOUT TIA Configuration Manual.      

7.4.4 Synchronizing the SINAMICS clock

SINAMICS system runtime (operating hours counter)
For SINAMICS S120 Control Units and the SINAMICS Integrated on a SIMOTION D410-2, 
faults and alarms are "time-stamped" on the basis of the system runtime. This means that 
events are recorded by default on the basis of operating hours rather than a particular time of 
day or date.

System runtime
The entire system runtime is displayed in CU parameter p2114. 

● r2114[0] indicates the system runtime in milliseconds. After reaching 86,400,000 ms (24 
hours), the value is reset.

● r2114[1] indicates the system runtime in days.

The counter value is saved when the power is switched off. After the drive unit has been 
switched on, the counter continues to run with the value stored when the power was last 
switched off.

As a result, the drive displays the system runtime from 00:00:00 on 01/01/1992 in both the 
alarm window in SIMOTION SCOUT and the diagnostic buffer for entries.
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If faults and alarms need to be "time-stamped" on the basis of a time of day, "Time-stamp 
operating hours" needs to be changed to "Time-stamp UTC format" as described below.

Requirements
A telegram 39x is required for the time synchronization. If the automatic PROFIdrive telegram 
setting is selected for the Control Unit, this telegram is used automatically (see 
Section Accessing the drive wizard (Page 129), Standard/Automatic setting).

If the telegrams are specified manually, telegram 39x must be set up. See Section Message 
frame configuration (Page 180) 

So that drive units can be synchronized with the SIMOTION time, they must support telegram 
39x and the UTC (coordinated universal time) time format.

For precise time synchronization, the drive unit must also be operated via an isochronous bus 
on SIMOTION.
The SINAMICS Integrated with SIMOTION D is always connected isochronously. 

The following Control Units support time synchronization:

● SINAMICS Integrated of the SIMOTION D410‑2

● SINAMICS S120 CU310, CU310‑2, CU320, CU320‑2 Control Units connected via 
PROFIBUS or PROFINET

● SINAMICS S110 Control Units CU305, connected via PROFIBUS or PROFINET
(precondition: as from SCOUT V4.4)

Procedure
Proceed as follows to convert the SINAMICS clock to UTC format and to synchronize this with 
the SIMOTION clock:     

1. In the project navigator, call the shortcut menu of the SIMOTION D410‑2.

2. Select the "Properties" entry in the context menu.

3. Select the "Perform time synchronization with SINAMICS drive units" option in the 
"Settings" tab of the "D410‑2 Properties" dialog box.

Note

This setting is activated automatically and applies to all drive units connected to the 
SIMOTION D410‑2. The SINAMICS clock is automatically synchronized with the 
SIMOTION clock for all drive units with configured telegram 39x.

The first time synchronization is performed after the SIMOTION D Control Unit has reached the 
RUN operating mode. 

To compensate for deviations between the SIMOTION and SINAMICS clocks, the time of day 
is automatically resynchronized at regular intervals.

The user program can use the _driveStates.allClocksSynchronized on the device to query 
whether automatic time synchronization is enabled (=YES) or disabled (=NO).

Before the first synchronization, alarms and messages are stored with the time stamp valid in 
the SINAMICS at this time, all subsequent alarms and messages with the synchronized time.
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The first time synchronization after switching on is entered with the status of the operating hours 
counter and the time (UTC time, synchronized with SIMOTION) in the diagnostic buffer of the 
drive (e.g. SINAMICS Integrated).

Figure 7-16 Diagnostic buffer entry, time synchronization

Error correction
If problems occur with time synchronization, this may be due to deactivated symbolic 
assignment to incorrect configuration information (Fast IO configuration).

For more information, see Section Message frame configuration (Page 180).

Compensation of runtime deviations 
To compensate for deviations between the SIMOTION and SINAMICS clocks, the time of day 
is automatically synchronized at regular intervals.   

The following behavior must be taken into consideration when setting the SIMOTION time:

● "Time/date to be set" is after "Time/date on SINAMICS": Time and date are corrected on the 
SINAMICS.

● "Time/date to be set" is before "Time/date on SINAMICS": The SINAMICS clock must be 
stopped until the SINAMICS "Time/date" has caught up with "Time/date to be set".

Adopting this procedure ensures that the sequence of SINAMICS diagnostic buffer entries 
remains the same, even when the runtime differences are aligned.

The SINAMICS clock operates with a resolution of 1 ms. A synchronization accuracy of 1 ms 
can be achieved for all bus cycle clocks that can be divided exactly by 1 ms (e.g. 1 ms, 2 ms, 
3 ms, etc.).

Due to system considerations, a slightly lower synchronization accuracy is achieved for all bus 
cycle clocks that cannot be divided exactly by 1 ms (e.g. 1.25 ms).

If the drive unit does not have an isochronous connection on SIMOTION, this can result in 
runtime differences of milliseconds (depending on the set cycle clock ratios).
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Resetting the time
Requirement:

● SIMOTION D410‑2: As of SIMOTION V4.3

● SINAMICS S120: As of SINAMICS V4.5

● SINAMICS S110: Not available

A threshold value is defined via parameter cu.p3109 and is effective as follows:

● In the case of negative time jumps less than the threshold value (p3109), the time is halted 
(for details, see "Compensation of runtime deviations")

● In the case of negative time jumps greater than the threshold value (p3109), the time is reset.
Default setting: cu.p3109 = 100 ms 
This means that in the case of negative time jumps greater than 100 ms, the time is reset. 
The default value is configured so that normal runtime deviations (drift of the quartzes) are 
below the threshold value.
If the SIMOTION clock is reset by more than 100 ms, this is interpreted as a "specific reset 
of the time" and the time of the drives is also immediately reset.

If the real-time clock is reset by more than 60 seconds, a diagnostic buffer entry is also made 
in the drive:

Time correction (reset) by <correction value> seconds

After a resynchronization (negative time jump greater than the threshold value) 

● cu.r3107[0..1] the UTC time after synchronization

● cu.r3107[2..3] the UTC time before synchronization

is displayed in the parameter, whereby [0] and [2] are milliseconds and [1] and [3] are days.

Note

The diagnostic buffer entries are not converted to the new time when the time is changed.

7.4.5 Backing up / restoring / deleting SINAMICS NVRAM data

Requirement
SIMOTION D410-2 as of SIMOTION V4.3

SINAMICS S120 CU310-2/CU320-2 as of SINAMICS V4.5

For other supported SINAMICS Control Units, refer to the SINAMICS manuals.
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Saving the NVRAM data   
The backup of the SINAMICS NVRAM data is performed by setting parameter p7775 to 1. The 
following applies:

● Parameter p7775 can also be set to 1 during pulse enable.

● A warm restart is not required.

Note

The consistent backup of the NVRAM data must be ensured by the application.

Make sure that there is no change of the NVRAM contents during the data backup. The greatest 
possible consistency is achieved when
● Backup is performed during pulse disable or
● The drives are run down to 0 Hz.

The data for the S120 Control Units and the SINAMICS Integrated is stored in the backup file 
"PMEMORY.ACX" in the folder " ... \USER\SINAMICS\NVRAM" on the CF card.

For the S120 Control Units, the data is stored on the CF card of the S120 Control Unit.

Similar to the non-volatile SIMOTION data, an already existing PMEMORY.ACX file is first 
renamed as PMEMORY.BAK and then the PMEMORY.ACX file is generated when you save 
the SINAMICS data.

If an error occurs during backup, the BAK file can be used to restore the data.

Parameter p7775 is set to 0 at the end of the backup.

Restoring the NVRAM data   
The SINAMICS NVRAM data can only be restored when none of the connected drives has a 
pulse enable.

When restoring, the PMEMORY.ACX file is accessed first. If this is available and is error-free, 
it is loaded. If no PMEMORY.ACX file is available or is corrupt, the PMEMORY.BAK file is 
loaded (if available and error-free).

Restoration of the NVRAM data can be performed manually and automatically.

Automatic restoration during module replacement
SINAMICS detects whether the Control Unit has been replaced on the basis of the serial 
number. In this case, the NVRAM of the used Control Unit is deleted first after POWER ON.

The following are not deleted:

● CU operating hours counter

● CU temperature and

● Safety logbook

● Crash diagnostic data

If there is an error-free PMEMORY.ACX or PMEMORY.BAK file on the CF card, the data is then 
loaded to the NVRAM.

Commissioning (software)
7.4 Additional information on configuring the SINAMICS Integrated

SIMOTION D410-2
160 Commissioning and Hardware Installation Manual, 04/2019, A5E33446807B



If no error-free backup file is available, ramp-up is as for SINAMICS < V4.5. A fault is not issued 
and any existing "corrupt" backup files are not deleted.

Manual restoration
The manual restoration of the NVRAM data is performed by setting parameter p7775 to 2.

If the backup file (ACX or BAK) is error-free is, a warm restart is performed. The contents of the 
NVRAM are deleted first and then the data is loaded from the backup file to the NVRAM.

The following are not loaded: 

● CU operating hours counter

● CU temperature

● Safety logbook

● Crash diagnostic data

Parameter p7775 is set to 0 at the end of the backup.

If the backup files are corrupt or no backup exists, the job is acknowledged with an error value 
in parameter p7775.

Deleting the NVRAM data   
The SINAMICS NVRAM data can only be deleted when none of the connected drives has a 
pulse enable.

The deletion of the NVRAM data is performed by setting parameter p7775 to 3.

A warm restart is then performed automatically.

During the subsequent ramp-up, all NVRAM data on the CU is first deleted.

The following are not deleted:

● CU operating hours counter

● CU temperature and

● Safety logbook

● Crash diagnostic data

At the end of the deletion, the initialization data of the applications is in the NVRAM, similar to 
after a device automatic commissioning (with the exception of the above-mentioned data).

Parameter p7775 is set to 0 at the end of the deletion.

Explanations for the parameter p7775
The following jobs can be set with the parameter p7775:

Value of the parameter p7775 Job
1 Backup NVRAM data (on CF card)
2 Restore NVRAM data (from CF card)
3 Delete NVRAM data on the Control Unit
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The acknowledgement of a parameter job is delayed.

● If the job cannot be executed, it is acknowledged negatively.

● If the job can be executed, it is acknowledged with the value 255.

Table 7-2 Acknowledgments of the parameter jobs

Acknowledge‐
ment

Description

17 Job cannot be executed because of the operating state
20 Illegal value
107 Write access is not permitted (cause: At least one DO has a pulse enable)

Because the SINAMICS must perform a warm restart when restoring and deleting the 
data, none of the connected drives may have a pulse enable.

132 Parameter change blocked (see p0300, p0400, p0922, p7760, macro being executed)
204 Write access not permitted
255 "OK": Job being executed

If an error is detected during the execution of a parameter job, the error cause is signaled via 
the parameter itself (no message via the fault buffer).

Table 7-3 Causes of error for parameter jobs

Error Cause
10 Error occurred while deleting
11 No backup possible: Memory card is not inserted
12 No backup possible: Memory card is full
13 Backup could not be completed (e.g. memory card removed during the backup)
14 Restoration not possible: Memory card is not inserted
15 Restoration not possible: Checksum of the NVRAM data backup file is faulty 
16 Restoration not possible: No backup available

Note

The memory card must always remain inserted for the SIMOTION D410-2. For information 
which SINAMICS Control Units permit the removal of the memory card, refer to the SINAMICS 
manuals.

Parameter p7775 is only reset automatically to 0 after the successful completion of a job.

Know-how and write protection 
Parameter p7775 is not part of the know-how protection. This allows the parameter to be read 
and written independent of the know-how protection.
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Parameter p7775 is part of the write protection. This means the parameter can only be written 
by the controller that configured a PZD cyclic communication with the SINAMICS when write 
protection is activated (p7761 = 1).

All other write jobs are acknowledged negatively, e.g.

● SIMOTION SCOUT / STARTER

● For SINAMICS BOP, IOP, AOP Control Units

● Other masters that only communicate acyclically with the SINAMICS

7.4.6 SINAMICS diagnostic buffer

Requirements
The SINAMICS Integrated diagnostic buffer can be displayed in SIMOTION SCOUT.   

Procedure
Select the SINAMICS Integrated in the project tree, and then "Target system" > "Device 
diagnostics" in the menu.

In addition, the SINAMICS diagnostic buffer entries are also displayed in the 
SIMOTION D410‑2 device diagnostics. All SIMOTION D410‑2 diagnostic buffer entries are 
displayed first, and then all diagnostic buffer entries of the the SINAMICS Integrated. The start 
of the SINAMICS Integrated diagnostic buffer entries is identified by the following entry:

>>>>>> Start of SINAMICS Integrated diagnostic buffer, station address = x <<<<<<

You also have the option of viewing the SIMOTION D410‑2 and SINAMICS Integrated 
diagnostic buffers via SIMOTION IT web server.

7.4.7 Acyclic communication with the drive

Overview
PROFIdrive drive units are supplied with control signals and setpoints by the controller and 
return status signals and actual values. These signals are normally transferred cyclically (i.e. 
continuously) between the controller and the drive.     

For SINAMICS S110/S120, configure the axis message frames for data exchange (refer to 
Performing an offline configuration (Page 128)).

In addition to cyclic data exchange, PROFIdrive drive units feature an acyclic communication 
channel. In particular, this is used for reading and writing drive parameters (e.g. error codes, 
warnings, controller parameters, motor data, etc.). 

As a result, data can be transferred on an acyclic as opposed to a cyclic basis when required. 
Acyclic reading and writing of parameters for PROFIdrive drives is based on the DP V1 services 
"read data set" and "write data set".
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The acyclic DP V1 services are transferred while cyclic communication is taking place via 
PROFIBUS or PROFINET. The PROFIdrive profile specifies precisely how these basic 
mechanisms are used for read/write access to parameters of a PROFIdrive-compliant drive.

The PROFIdrive standard states that "pipelining" of jobs on PROFIdrive drives is not supported.

● Only one "write/read data record" can be performed at any one time on a drive unit (e.g. 
SINAMICS S120 control unit or the SINAMICS Integrated of a SIMOTION D).

● However, if several PROFIdrive drive units are connected to a controller, a job can be 
processed for each of these drive units at the same time. In this case, the maximum total 
number of jobs will depend on the control system. (for SIMOTION, this is a maximum of 8 
jobs at a time).

In the case of acyclic data exchange with SINAMICS drives, this means you will have to 
coordinate the write/read jobs with one another (buffer management). An interlock must be set 
in order to prevent the application or different parts of the application from sending overlapping 
jobs to the same PROFIdrive drive unit.

Additional references
Additional information on how to use DP V1 services can be found in the SIMOTION 
Communication System Manual.

SIMOTION Utilities & Applications also has a DP V1 library with functions that are capable of 
undertaking coordination tasks commonly associated with acyclic communication. The library 
not only coordinates access to the system functions (_ReadRecord/_WriteRecord/
_readDriveParameter/_writeDriveParameter/ etc.), but also expands the range of functions for 
frequently required tasks, e.g. the reading of faults and alarms from the drive unit.

SIMOTION Utilities & Applications is provided as part of the SIMOTION SCOUT scope of 
delivery.

The functions available in the DP V1 library include:

● Buffer management (coordination of a number of parallel DP V1 services)

● StartUp (function for coordinating startup of the SINAMICS drive with SIMOTION)

● TimeSync (applicative time synchronization: Transfer of SIMOTION time of day to the 
SINAMICS drives)

● SetActIn (activating/deactivating objects in SIMOTION and SINAMICS)

● RwnPar (reading and writing of drive parameters)

● GetFault (reading errors and warnings from the drive)

7.4.8 Control properties and performance features
With a few exceptions, the integrated drive control of the SIMOTION D410‑2 has the same 
control properties and performance features as the SINAMICS S120 CU310‑2 control unit.     
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However, the following points must be particularly observed:

● The SINAMICS Integrated does not feature a basic positioner (EPOS). EPOS functionality 
is provided by SIMOTION technology functions.

● It is not possible to connect a BOP20 Basic Operator Panel to the SIMOTION D410-2.
The following alternative options are available:

– Use of SIMATIC HMI devices (e.g. TP177B, configurable with WinCC flexible)

– Use of the SIMOTION IT web server.
You can use a Web browser to access the Standard diagnostics pages of the 
SIMOTION D410‑2 (diagnostic and alarm buffer, watch table, SIMOTION variables and 
read/write drive parameters, access protection, trace function, ... ).
You also have the option of creating your own Web pages, for example, to visualize 
machine states and to permit service functions. The SIMOTION D410‑2 web pages can 
be accessed, for example, using a PC or PDA via Ethernet. Wireless access is also 
possible in conjunction with WLAN.

● Not all SINAMICS function modules are supported (e.g. the function modules free function 
blocks, spindle diagnostics, and CAN are not supported)

● The SINAMICS Integrated of the SIMOTION D410‑2 does not support a reset via parameter 
p0972. A reset via p0972, is only supported by SINAMICS Control Units.

7.4.9 Current controller cycle clocks <> 125 µs / use of output cams and measuring 
inputs

If current controller cycle clocks <> 125 µs are used, the parameter calculations of the drive 
must be transferred to the PG, in particular when using cam outputs on the TM15 / TM17 High 
Feature or for global measuring inputs, so as to regenerate the Fast IO configuration.   

A change of the current controller cycle clock will have effects on the sampling times of the I/Os 
on the drive side (e.g. TM15/TM17 High Feature, p4099 sampling time of I/Os). For the cam 
outputs and the measuring input inputs (only for global measuring inputs) to function correctly, 
the sampling times must be known to the engineering system.

Sampling times <> 125 µs occur in the following cases:

● For servo drives with manual change of the current controller sampling time (drive 
parameters p0112 and p0115[0])

● For vector drives.

Commissioning (software)
7.4 Additional information on configuring the SINAMICS Integrated

SIMOTION D410-2
Commissioning and Hardware Installation Manual, 04/2019, A5E33446807B 165



Table 7-4 Influence of the current controller cycle clock on the dead time compensation

 Current controller cycle clock 
has no effect on the function

Current controller cycle clock has an effect 
on the function

Cam outputs ● SIMOTION D 
● ET 200MP TM timer DIDQ 

16x24V
● ET 200SP TM timer DIDQ 

10x24V

TM15 / TM17 High Feature 

Measuring input inputs 
(global measuring in‐
puts)

● D4x5-2 (terminal X142)
● ET 200MP TM timer DIDQ 

16x24V
● ET 200SP TM timer DIDQ 

10x24V

● TM15 / TM17 High Feature
● SIMOTION D (except D4x5-2, terminal 

X142)
● SINAMICS S110/S120 Control Units

Measuring input inputs 
(local measuring in‐
puts)

- -

In order that the changed cycle clock ratios are taken into account by the engineering system, 
proceed as follows:

1. Go online and perform a project download. The SINAMICS performs parameter calculations 
once.

2. Perform an upload to the PG ("Target system" > "Load" > "Load CPU / drive unit to PG").

3. This transfers the parameter calculations of the drive to the PG. The cycle clock ratios are 
then known in the engineering system.

4. Go offline.

5. Generate the configuration information (Fast IO configuration) again. To do this, select the 
SIMOTION CPU in the project tree and right-click to open the context menu "Fast IO" > 
"Create new configuration".

6. Execute "Project" > "Save and compile all".

7. Go online and download the project to the target system.

8. Save the data on the CF card.

SIMOTION SCOUT uses the described procedure to calculate internal system data that is 
required for outputting/detecting signals with a high level of position accuracy.

Note

If the cycle clock ratios are not set correctly, an appropriate message is output in the diagnostic 
buffer.
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7.4.10 Licenses for the SINAMICS Integrated
The following SINAMICS functions are licensed via SIMOTION: 

● SINAMICS Safety Integrated Extended Functions for SIMOTION D 

● SINAMICS Safety Integrated Advanced Functions for SIMOTION D (as of V5.2)

● SINAMICS high output frequency for SIMOTION D

SINAMICS Integrated

SINAMICS Safety Integrated Extended Functions for SIMOTION D  
Highly effective protection of personnel and machinery can be implemented with SIMOTION D 
thanks to the integrated safety functions of SINAMICS S120. 

Whereas the Safety Integrated Basic Functions are license-free, the Safety Integrated 
Extended Functions and Advanced Functions require a license for the SINAMICS Integrated.

● SINAMICS Safety Integrated Extended Functions for SIMOTION D or 

● SINAMICS Safety Integrated Advanced Functions for SIMOTION D 

The Safety Integrated Extended and Advanced Functions are licensed for the SINAMICS 
Integrated of SIMOTION D410-2 Control Unit with the licenses. The Safety Integrated 
Advanced Functions include the Safety Integrated Extended Functions. 

SINAMICS high output frequency for SIMOTION D 
Because of legal specifications, the output frequency for converter systems is limited to 550 Hz 
per default. 

● SINAMICS S120 Control Units as of firmware V4.7 HF7 

● SIMOTION D Control Units as of firmware V4.4 HF6  

The SINAMICS high output frequency for SIMOTION D license allows users to cancel the 
output frequency limit if, as a result of the application, output frequencies of more than 550 Hz 
are required for drives. The license cancels the limitation for the SINAMICS Integrated of 
SIMOTION D410-2 Control Unit.

Note

The display of the Runtime licenses in the SCOUT Licensing dialog is updated after the power-
up of the SINAMICS Integrated. 

SINAMICS Control Units
SINAMICS Control Units connected via PROFINET or PROFIBUS (e.g. CU310-2, CU320-2) 
are licensed via the SINAMICS memory card. Licensing via SIMOTION is not possible. 
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Further information
● Changes to the EC Dual Use regulation and how it impacts SIMOTION

https://support.industry.siemens.com/cs/ww/en/view/104020777 

● SINAMICS S120/S150: Release for delivery, license for high output frequency
https://support.industry.siemens.com/cs/en/en/view/104020669

7.4.11 Support of motors with PT1000 temperature sensor
Because of the discontinuation of the KTY84-130 temperature sensor, SIMOTICS motors will 
be equipped with PT1000 temperature sensor in the future. 

● Motors with DRIVE-CLiQ interface remain compatible and can be operated on any SW 
version. 

● Motors without DRIVE-CLiQ interface require SIMOTION SCOUT as of V4.5 for the 
configuration of the PT1000 temperature sensor.

7.5 Testing the configured drive using the drive control panel
You can test a configured drive using the drive control panel where you can define a speed 
value by setting a scaling factor. The drive control panel should only be used for 
commissioning.       

Requirements
● The project has been downloaded to the target system.

● SIMOTION SCOUT is in online mode.

● The drive is not being used by a current project in RUN mode.

WARNING

Danger to life from unexpected movement of driven machine parts

Make sure this presents no hazard to personnel or property.
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Procedure
1. Change to the configured drive in the Project Navigator and open the drive control panel by 

selecting "Commissioning" > "Control panel". The drive control panel opens in the detail 
view.

Figure 7-17 Drive control panel

2. To display the control area and axis diagnostics, click the "Show/hide control area" and 
"Show/hide diagnostics area" buttons.

3. Click "Assume control priority". The "Assume Control Priority" dialog box is opened.

Figure 7-18 Assuming control priority

4. Read the notes and confirm these with "Accept."

5. Activate the "Enables" checkbox to enable the drive.
All enables are now set with the exception of ON/OFF1.
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6. Enter the desired setpoint in the entry field, and, as a safety setting, slide the scaling to 0%.

Figure 7-19 Entering a setpoint

7. Click the "Drive On" button. The green "Enable available" LED lights up. If you move the 
slider to the right, the drive rotates. The current motor speed is displayed in "Actual."

8. Click "Drive Off" to stop the drive after you completed the test.

9. Deactivate the enable and click the "Give up control priority" button to deactivate control 
from the PG/PC.

7.6 Creating and testing axes

7.6.1 Overview of SIMOTION Engineering

Performing engineering with SIMOTION SCOUT
The SIMOTION SCOUT engineering system can be used to insert axes in your project.   

1. First, run through the axis wizard to configure the axes and interconnect to the real drive 
(e.g. SINAMICS Integrated).

2. Provided you have completed the configuration at the drive end, we strongly recommend for 
faster working that the SINAMICS Integrated is deactivated via "Target system" > "Select 
target device".

3. Complete your SIMOTION application, for example, by creating axis functions and 
SIMOTION execution programs.

4. Compile the project and download it to the SIMOTION D410-2.
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7.6.2 Creating an axis with the axis wizard

Overview
The TO axis provides the user with the technological functionality and the interface to the drive/
actuator. The TO axis processes the motion control commands from the user program (e.g. 
MCC) and coordinates the interface to the drives. It executes control and motion commands 
and indicates statuses and actual values. 

The TO axis communicates with an actuator (drive or hydraulic valve) via a fieldbus system 
(PROFIBUS or PROFINET via PROFIdrive protocol) or via a direct setpoint interface (analog 
±10 V or pulse/direction).

When running through the axis wizard, the basic settings are made for the axis and the TO axis 
interconnected to a drive (e.g. SINAMICS Integrated). The following extended options are 
available when "Use symbolic assignment" has been activated:   

● A real axis is interconnected to an already configured drive

● A real axis including drive is created via the axis wizard and the drive interconnected to the 
axis

● A real axis is created without assigning this to a drive (assignment is made later)
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Inserting an axis
1. In the Project Navigator, double-click the entry "Axis" > "Insert Axis."

This will access the axis wizard. Set the required technology and then click "OK."

Figure 7-20 Inserting an axis

2. Set an axis type and, if required, configure the units.
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Figure 7-21 Defining the axis type

3. Create a new drive or make the assignment to an existing drive.
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Figure 7-22 Assigning a drive

The following setting options are available for the drive assignment:

● Assigning a drive
Assigning a previously configured drive.

● Define a subsequent assignment
The axis should not be assigned to a drive until a later point in time. Accordingly:

– The PLC and motion control functions to be completely configured by a programmer 
even without drive know-how using technology objects (e.g. TO axis) and loaded to the 
device.

– The drives to be separately configured and optimized by a drive expert.

– The technology objects to be symbolically assigned later to the drive objects via an 
interconnection dialog box.
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● Creating a drive
From the Assignment dialog box, a new drive can be created on an existing drive unit (e.g. 
SINAMICS Integrated) and assigned to the axis. This allows the axis, including the drive, to 
be created in one operation. It is not necessary to configure a drive before creating an axis.

● Setting up addresses
If "Use symbolic assignment" has been deactivated, the addresses must be set up 
manually. This is required, for example, for drive units that do not support symbolic 
assignment (e.g. SINAMICS S120 with FW version < 2.6.2, MASTERDRIVES, 
SIMODRIVE, etc.).

The address list in the "All Addresses" view provides an overview of the assignments to all 
interfaces of the TO axis. From this view, the assignments can also be changed via the 
Interconnection dialog box (  button).

Note

The symbolic assignment must be deactivated for the drive and axis configuration without 
symbolic assignment and adaptation.

Run through the wizard and enter the settings of your system. The required axis telegram as 
well as the addresses used are automatically determined by the engineering system. The 
telegram is also extended and interconnections in the drive created automatically depending 
on the selected TO technology (e.g. SINAMICS Safety Integrated).

Click Finish to confirm the "Summary" window.

The configured real axis is displayed in the project navigator.
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Figure 7-23 Axis wizard summary

Note

During system power-up, reference variables as well as drive and encoder data of the 
SINAMICS are automatically taken over for the SIMOTION configuration data of the 
SIMOTION technology objects "TO axis" and "TO externalEncoder".

Encoder assignment
With a position axis, encoder 1 is also created on the TO axis (motor encoder) and 
automatically assigned to the first encoder on the drive.

If encoder 2 (direct encoder) is created at the TO axis, it is assigned to the second encoder of 
the drive control.

Result
The configured axis will appear in the project navigator. 

Save and compile the project and download it to the target system.
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After running through the axis wizard, the symbolic drive assignment is displayed via 
"Configuration" of the axis as well as via the address list (All addresses view). 

The Assignment dialog box can be called again from these dialog boxes using the  button.

Instead of calling the Assignment dialog box, it is also possible to edit the input field 
 containing the symbolic name directly.

TBD, DSDB, and SIDB
In the "Configuration" dialog box of the TO axis, you can activate the following functions from 
"Functions" > "Change":

● Technology data block (TDB): for the cyclic exchange of technology data, e.g. actual torque 
value

● Drive Safety data block (DSDB), V4.4 and higher: to support the SINAMICS Safety 
Integrated Functions by means of the TO

● Safety Info Data Block (SIDB): Predecessor of the DSDB (for compatibility only)

The assignment is always made to the drive DO of the actuator of the axis. The system 
automatically generates a telegram extension and the BICO interconnection of the relevant 
SINAMICS parameters.

Note

The safety data blocks (DSDB or SIDB) are automatically configured by the engineering 
system and interconnected in the drive.

The PROFIsafe telegram must be configured by the user.

If the activation of the safety functions is to be made using PROFIsafe, configure the 
PROFIsafe communication to the higher-level SIMATIC F-CPU (see SINAMICS S120 Safety 
Integrated Function Manual).

I/O signals at the TO axis
For the assignment of I/O signals on the TO axis (e.g. the inputs for the homing output cam or 
hardware limit switches), call the assignment dialog box from the parameterization dialog 
boxes of the TOs created or from the address list (view of all addresses) by clicking the  
button.

Additional references
See Section Downloading the project to the target system (Page 141).

For further information about the symbolic assignment, see the SIMOTION Runtime Basic 
Functions Function Manual.
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7.6.3 Testing an axis with the axis control panel

Axis control panel
The axis control panel is used exclusively for testing axes.     

You can use the axis control panel for the following tasks, for example:

● Testing all system components before the axis movement is controlled by a program.

● Testing as to whether you can move the axis using the axis control panel if a fault is detected.

● Moving the axes for tuning purposes (controller tuning).

● Executing active homing.

● Setting and resetting the axis enable signal.

● Testing the axis that was created.

Requirements
The following requirements must be fulfilled for testing:

● The project has been downloaded to the target system.

● SIMOTION SCOUT is in online mode.

Axis test
1. Open the "AXES" folder in the Project Navigator and click the "Control panel" entry below 

the axis (for example, Axis_1).
The axis control panel is displayed.

Figure 7-24 Axis control panel

2. To display the control area and axis diagnostics, click the "Show/hide control area" and 
"Show/hide diagnostics area" buttons.
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3. Click "Assume control priority".

Note

In order to move the axis from the PG/PC, you must assume control priority. However, by 
pressing the SPACER bar, you can stop the axis at any time.

4. The further procedure depends on the CPU status:

– Case 1: CPU in the STOP/STOPU state
If the CPU is in the STOP state, a message will appear, indicating that the CPU has been 
put in the STOPU state.
A safety message appears in a further dialog box and must be accepted.
The activated service function is then displayed via the LEDs (RUN/STOP flashing 
yellow/green with 2 Hz).

– Case 2: CPU in the RUN state (as of SCOUT/Kernel V4.4)
Control priority can only be assumed if the axis is not in motion.
After accepting the safety message, a message is shown on the control panel that the 
CPU is in the RUN state, that the user program is running, and further axes may be 
moving. (LED display: RUN).
If the control priority for a TO is active, commands for the TO from the user program are 
rejected with an error code. Alarm 30009: reason 0x04 is output.

5. To enable the axis, click "Set/reset enables".
Confirm the "Switch Axis Enable" dialog box with "OK".

Note

If the control panel is operated in the RUN state, setting/canceling the axis enable can 
alternatively be controlled via the user program.

6. To traverse the axis, click the "Position-controlled traversing of the axis" button.

7. Enter a velocity and close the dialog box by clicking "OK".

8. Click the "Start movement" button. You can monitor the traversing motion under velocity and 
position. Use "Stop motion" to stop axis movement again.

9. Click "Set/reset enables" to remove the enable. Confirm the "Remove Axis Enable" dialog 
box with "OK".

10.Click the "Give up control priority" button to deactivate axis control from the PG/PC. In this 
operating state, the axes can no longer be controlled from the PG/PC.

Note

For commissioning kinematics transformations, a path control panel is available as of 
SIMOTION V4.4

See also
Please refer to the additional information in the SCOUT Online Help (Axis control panel index).
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7.7 Setting up addresses and message frames

Overview
After all SINAMICS components have been configured, addresses must be determined for the 
process data exchange between the drive and the controller.     

This procedure depends on whether symbolic assignments are used.

● With symbolic assignment, the addresses are determined automatically by the engineering 
system; refer to Section Setting up communication for symbolic assignment (Page 180).

● In the absence of symbolic assignment, addresses must be determined manually; refer to 
Section Message frame configuration (Page 180).

7.7.1 Setting up communication for symbolic assignment
The communication for the symbolic assignment can be set up with the following actions:     

● From the SCOUT menu
Call the "Project" > "Setup communication for symbolic assignment" menu.

● At "Download project to target system"

● At "Save project and compile changes"

When setting up the communication, the message frames, BICO interconnections and 
addresses are set up for the entire project.

7.7.2 Message frame configuration

Requirement
You have configured the drive unit.

On the basis of this configuration, one or more of the following actions should be performed:

● The automatic PROFIdrive telegram setting for a drive object should be activated/
deactivated.

● The automatic telegram extension for a drive object should be activated/deactivated.

● The automatic address adaptation for a drive object should be activated/deactivated.

● PROFIdrive telegrams should be configured for drive objects.

● The addresses should be set up.

● Telegrams should be extended manually.
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Procedure 
In the project navigator, open the "Communication" > "Telegram configuration" entry under 
"SINAMICS_Integrated."     

The "SINAMICS Integrated - Telegram Configuration" dialog box is displayed with the 
PROFIdrive PZD telegrams tab.

The dialog box lists all the available drive objects. The possible setting options are described 
in the following. 

Note

When using the symbolic assignment, the default setting does not have to be changed or 
configured.

Figure 7-25 Telegram configuration
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Table 7-5 Explanation of the figure

No. Meaning
① Selection of a telegram

● The drive telegrams (telegrams 1 ... 6 and telegram 1xx) are defined in accordance with the PROFIdrive 
specification and can be selected based on the required functional scope.

● You can transfer the signals of the I/Os or the global measuring inputs, for example, via the telegrams 39x. 
Telegram 39x is also required for the time synchronization between SIMOTION and SINAMICS.

● Free telegram configuration with BICO allows you to define your own telegram.
● Free telegram configuration with p0915/p0916 (for TM15/17).

② The "Standard/automatic" and "User-defined" settings are only visible if "Use symbolic assignment" is activated. Using 
the setting "Standard/automatic" is generally recommended.
The "User-defined" setting allows the automatic telegram setting, telegram extension, and address adaptation to be 
deactivated or activated.
● "Automatic PROFIdrive telegram setting" allows the telegram to be set by the system depending on the configured 

technology (telegram selection, e.g. for drive and control unit incl. onboard I/O).
● "Automatic telegram extension" allows the telegram to be extended by the system depending on the configured 

technology (e.g. if the technology data block is activated in the axis configuration).
● "Permit automatic address adaptation" allows addresses to be adapted by the system in the case of address 

offsets, for example. Address offsets can occur, for example, if a telegram is extended and the adjacent addresses 
are already occupied by other telegrams.

With TM15/TM17 High Feature, "Automatic PROFIdrive telegram setting", "Automatic telegram extension", and "Au‐
tomatic address adaptation" cannot be deactivated by design, since for these drive objects the telegram is always set 
up in accordance with the parameterized terminal functionality (DI, DO, output cam, measuring input) and cannot be 
extended. 
"Automatic PROFIdrive telegram setting" and "Automatic telegram extension" must be deactivated if the telegrams are 
to be configured manually for TM15 DI/DO and TM31 and interconnected with BICO.
See Section Setting up communication for symbolic assignment (Page 180).

③ Telegram status
(Meaning of the symbols, see table below)

④ Length: Displays the size of the telegram component.
Address: Addresses in HW Config The addresses will be displayed only if the addresses have been defined.

⑤ Displays the SIMOTION object that is interconnected to the SINAMICS object (e.g. axis or encoder).
⑥ Changing the telegram order

Note: Before the alignment, all drive objects without I/O addresses ("---..---") must be moved behind the objects with 
valid I/O addresses or those still to be aligned ("???..???").

⑦ "Manual" adaptation of the telegram configuration (e.g. when additional data, such as a motor temperature, is to be 
transferred via the telegram).

⑧ Display of the individual control and status words of the associated telegram.
⑨ Setting up the addresses (alignment of the addresses with HW Config)

Only the addresses for the respective drive unit are determined (no automatic determination of telegrams / BICO 
interconnections).
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Note

If symbolic assignment is deactivated, the following applies:

If the telegrams for drive objects (drives, Terminal Modules, etc.) change, you must set up the 
addresses again. The addresses are not updated automatically.

Telegram status
The icons in the status column show the following information:

The telegram differs from the configuration in HW Config. You must align the configu‐
ration with HW Config.
You are using a predefined standard telegram or a free BICO interconnection.

You are using an altered standard telegram that you have extended to include supple‐
mentary data.
You are using a telegram for which one of the two telegram lengths is too long. The 
drive project cannot process this entry.

Error correction (symbolic assignment deactivated)
Based on the 39x telegram, SIMOTION generates further configuration information (FastIO 
configuration) for the following functions:

● Time-of-day synchronization SIMOTION ⇔ SINAMICS

● Use of onboard I/Os of SIMOTION D, CU, or CX

● Use of cams and global measuring inputs

● System function _setDriveObjectSTW

If the telegrams are defined manually (symbolic assignment is deactivated), a telegram 39x 
must be set up in the telegram configuration. The telegram then has to be aligned with HW 
Config via "Set up addresses." 

If use of the functions stated above is not possible, generate the FastIO configuration anew. For 
this purpose select in the project tree the affected SIMOTION D Control Unit, the SINAMICS CU 
or Controller Extension CX and open the "FastIO" > "Create new configuration" shortcut menu 
with the right mouse button. Then compile the project and load it into the CPU. Perform a restart.

The FastIO configuration is also used for the telegram of the Terminal Modules TM15 and 
TM17 High Feature. Proceed in the same way if problems occur.
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7.8 Linking an additional encoder (optional)

7.8.1 General information
SIMOTION D410-2 features a DRIVE-CLiQ X100 interface for connecting an encoder. 
SIMOTION D410-2 provides the option of integrating and configuring further encoders in 
addition to the motor encoder.         

The following encoders are supported for operation with SIMOTION D410-2:

● Encoders with a DRIVE-CLiQ interface

● Encoders connected to SIMOTION D410-2 or CUA32 via the onboard encoder interface 
(X23)

● Encoders connected to SIMOTION D410-2 using an SMx module

● Encoders connected using PROFIBUS or PROFINET

Configuring additional encoders
The second encoder can be used at SIMOTION D410-2, for example, as:

● A machine encoder (second encoder = direct measuring system).
A direct measuring system measures the technological parameter directly, i.e. without the 
interference of influences such as torsion, backlash, slip, etc. This may enable improved 
smoothing of mechanical influences. If you use a second encoder as a machine encoder, 
you can work with the encoder changeover function.

● An external encoder.
You can use the external encoder for recording an external master value, for example.

● Encoder for hydraulic axes

● Encoders for the implementation of cam controllers

Configuring tasks
Encoders connected via PROFIBUS/PROFINET are only configured in SIMOTION.

Encoders connected using SMx, DRIVE-CLiQ or the onboard encoder interface must be 
configured on the drive side (SINAMICS Integrated) and in SIMOTION.

Configure this additional encoder on drive side (SINAMICS Integrated) and in SIMOTION:

1. Configuring additional encoders on the drive (Page 185)

2. Connecting additional encoders via PROFIBUS/PROFINET (Page 186)

These steps in configuring are described in the next section.
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7.8.2 Configuring additional encoders on the drive
The following options are available for configuring additional encoders on the drive:

● Configuration of a second encoder on the drive

● Configuration of an encoder as drive object (as of SINAMICS firmware V4.3)

Configuring a second encoder on the drive
The configuration of a second encoder on the drive is useful when the second encoder value 
is also to be used for this drive (e.g. motor or machine encoder). Note that a maximum of only 
two encoder values can be transferred via PROFIdrive message frames.   

In principle, the second encoder value can be freely used (e.g. for acquisition of an external 
master value), however the use of an encoder as a separate drive object (drive object 
DO encoder) is preferable because of the clear functional separation.

Figure 7-26 Configuration of a second encoder on the drive

Configuring an encoder as drive object
The configuration of an encoder as drive object (drive object DO encoder) has the advantage 
that this encoder can be used independently of a configured drive (e.g. for acquisition of a 
master value).

The configuration is performed by inserting an encoder via the project navigator.

Figure 7-27 Configuration of an encoder as drive object
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Note

In the same way as for axes, a "DO encoder" can also be symbolically interconnected to a "TO 
externalEncoder".

7.8.3 Connecting additional encoders via PROFIBUS/PROFINET

Options
With regard to encoder integration, further encoders can also be connected via PROFIBUS or 
PROFINET. The following options are available:   

● Encoder interconnection using a PROFIdrive message frame (encoder with message frame 
type 81 and 83)

● Encoder interface as a direct value in the I/O area.

Additional references
Detailed information is contained in the SIMOTION TO Axis, Electric/Hydraulic, External 
Encoder Function Manual
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7.9 Symbolic assignment of I/O variables

7.9.1 Assignment to the PROFIdrive message frame of the TO axis 
I/O variables which you require for purposes such as display and diagnostics can be assigned 
from the address list to individual components (status word, for example) via the assignment 
dialog of the PROFIdrive message frame. Only components suitable for the data type of the I/
O variable are displayed. If no data type is specified at the I/O variable, this is determined via 
the assignment partner after the selection.      

Figure 7-28 Assignment of I/O variables to the PROFIdrive message frame

7.9.2 Assignment to drive parameters
I/O variables from the address list can be assigned to drive parameters using the assignment 
dialog. Only parameters suitable for the data type of the I/O variable are displayed. If no data 
type is specified at the I/O variable, this is determined by the parameter selection.       

An extension of the standard message frame is created automatically for the transfer of the 
parameters to/from the drive.
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Procedure
1. Open the Assignment dialog box from the address list (view of all addresses).

The Assignment dialog opens with the corresponding assignment partners. 

2. Click the "..." button in the parameter selection line to open the parameter list.

Figure 7-29 Assignment dialog for drive parameters
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3. Select the desired signal source (e.g. DO drive). Then select the required parameter.

Figure 7-30 Dialog box for the DO and parameter selection

4. Click "OK" to accept the selection.
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5. The desired SINAMICS parameter is assigned to the I/O variable in the interconnection 
dialog box.

Figure 7-31 Assigned drive parameters

6. Click "OK" to accept the assignment.

The following table shows the possible types of assignment:

Name of the assignment Data type Direction Transferrable BICO parameters
BICO_IW.<parameter number> WORD Input All CO parameters (BICO source)
BICO_QW.<parameter number> WORD Output All CI parameters (BICO sink)
BICO_ID.<parameter number> DWORD Input All CO parameters (BICO source)
BICO_QD.<parameter number> DWORD Output All CI parameters (BICO sink)

Syntax of the assignment names
● A number of parameters (separated by periods) are specified for outputs (SINAMICS side 

= received data) which can be interconnected with a number of BICO sinks

● If the transferred parameter is on another drive object (DO), the DO name precedes the 
parameter. "#" is used as a separator between the DO name and the parameter.

● Individually transferred bits of a parameter appear in brackets [x]
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7.10 Configuring drive-related I/Os

7.10.1 Overview of the symbolic configuration of I/Os

Overview 
SIMOTION D410-2 as well as the SINAMICS S110/S120 control units and additional 
components (TMs) have I/Os that can be used by the drive unit and by SIMOTION.   

I/Os originally assigned to SINAMICS can be used by SIMOTION only when they have been 
interconnected to a message frame.

Symbolic assignment
SIMOTION SCOUT supports by default the symbolic configuration of I/Os, see 
Section Symbolic assignment / adaptation (Page 123).           

The symbolic assignment simplifies the configuration significantly:

Table 7-6 Comparison of configuration with/without symbolic assignment

Configuration With symbolic assignment Without symbolic assignment
Configuring message 
frames

So that SIMOTION can use SINAMICS I/Os, 
the required message frames are created au‐
tomatically

Message frames must be set manually (either 
predefined message frame (e.g. 39x) or free 
message frame configuration)

BICO interconnections The required BICO interconnections are per‐
formed automatically (I/Os are interconnec‐
ted to a message frame)

With predefined message frames (e.g. 39x), the 
BICO interconnections are made automatically 
With free message frame configuration with BI‐
CO, the interconnection must be made by the 
user

Parameterization of the 
I/O functionality (e.g. 
measuring input)

Parameterization via screen forms Parameterization via screen forms and partly via 
parameters in the expert list

Handling of I/O addresses Handling of addresses is not required be‐
cause of symbolic assignment

I/O addresses must be determined

Setting up addresses Addresses are set up automatically, refer al‐
so to Section Setting up communication for 
symbolic assignment (Page 180) 

Addresses must be set up manually, refer also to 
Section Message frame configuration 
(Page 180) 

Only the configuration with symbolic assignment is described in the following. For further 
information on the configuration of drive-related I/Os without symbolic assignment, see 
Appendix Configuring drive-related I/Os (without symbolic assignment) (Page 295).
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Procedure
The configuration of the I/Os is divided into two basic steps:

1. Configuring I/O terminals (Page 192)
The functionality of an I/O channel is configured (e.g. configuration of a DI/DO as digital 
output).

2. Configuring technology objects and I/O variables (Page 196)
The access of technology objects and I/O variables to I/Os is configured. The configuration 
is symbolical, whereby only "function-compatible" I/O channels are offered for selection.
Example:
For the TO measuringInput, only symbolic assignments of the type MI (measuring input) are 
offered for selection.

The engineering system automatically makes the required message frames and the 
interconnections to the configured I/Os.

7.10.2 Configuration options
The following table provides an overview of the configuration options for the I/O terminals of 
various modules.

Table 7-7 Configuration of the I/O terminals overview     

Module Use of the I/Os by Configuration of the I/O terminals Supports symbolic assign‐
mentSIMOTION SINAMICS

SIMOTION D410-2
● Terminal X120/X121
● Terminal X130/X131

X 1) X On the drive unit (CU) As of SIMOTION V4.3

SIMOTION D4x5-2
● Terminal X122/X132
● Terminal X142

 
X 1)

X

 
X
-

 
On the drive unit (CU)
On the D4x5‑2 (HW Config)

As of SIMOTION V4.2

SIMOTION D4x5 X 1) X On the drive unit (CU) As of SIMOTION V4.2
CX32-2, CX32 X 1) X On the drive unit (CU) As of SIMOTION V4.2
SINAMICS S110 CU305 X 1) X On the drive unit (CU) As of SINAMICS V4.3
SINAMICS S120 
● CU310
● CU310-2
● CU320
● CU320‑2

X 1) X On the drive unit (CU)  
● As of SINAMICS V2.6.2
● As of SINAMICS V4.4
● As of SINAMICS V2.6.2
● As of SINAMICS V4.3

TB30, TM15 DI/DO, TM31 X 1) X On the drive unit (TB30 or TM) Yes
TM41 2) X 1) X On the drive unit (TM41) Yes 2)
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Module Use of the I/Os by Configuration of the I/O terminals Supports symbolic assign‐
mentSIMOTION SINAMICS

TM15, TM17 High Feature X - On the drive unit 
(TM15 or TM17)

Yes

Time-based I/O 
● ET 200MP TM timer 

DIDQ 16x24V 
● ET 200SP TM timer 

DIDQ 10x24V

X - On the ET 200 I/O system As of SIMOTION V4.4 HF6

1) I/Os are originally assigned to a SINAMICS drive unit and can be assigned to SIMOTION via configuration
2) TM41 supports symbolic assignment only for encoder interfaces (not symbolic assignment for DI, DO and AI)

Note

The module hardware for TM15 and TM15 DI/DO is identical. A distinction is only made by the 
addition of the component in the SIMOTION SCOUT project navigator using "Insert input/
output component". 

I/Os that are originally assigned to the SINAMICS drive unit can also be used by SIMOTION via 
configuration.

● An output is always only exclusively available for the SINAMICS drive unit or SIMOTION.

● An input used by SIMOTION can also be interconnected on the drive side.

In the following sections describe in detail how to configure the I/O terminals.

7.10.3 SIMOTION D410-2 Configuring I/Os

Procedure
The onboard inputs/outputs of the SIMOTION D410-2 are assigned to SINAMICS Integrated. 
The configuration is therefore performed via the drive unit ("SINAMICS_Integrated" > 
"Control_Unit" > "Inputs/outputs").         

The properties of the I/O channel can be configured in the parameterization dialog box. With the 
bidirectional digital I/Os, for example, an I/O channel can be:

● Parameterized as input or output

● Inverted

● BICO-interconnected (use as drive I/O)

● Used as digital input for SIMOTION with "DI (SIMOTION)"

● Used as digital output for SIMOTION with "DO (SIMOTION)"
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● Used as a global measuring input input for SIMOTION with "Measuring input (SIMOTION)"

● Used as an output cam output for SIMOTION with "output cam (SIMOTION)"

Figure 7-32 Configuration of D410-2 I/Os (terminal X121)

24 V supply for DO
If no digital outputs are used, the SIMOTION D410-2 can be supplied via the Power Module. A 
24 V supply must be connected to terminal X124 for the digital outputs to be used. If a digital 
output is parameterized and the 24 V supply is not connected (or the level is too low), alarm 
A03506 is issued on the SINAMICS side (can also be parameterized as a fault).

Data transfer
If the D410‑2 onboard I/Os are interconnected using symbols (or if telegram 39x is used for the 
onboard I/Os), the status information of the DI and DO will be transmitted to cu.p2048 at the 
PROFIdrive PZD sampling rate. Sampling of the inputs and outputs is also performed in the 
sampling time parameterized according to cu.p0799.

The same applies if the I/Os are manually interconnected to a drive telegram via a BICO 
converter.

Transfer of the output values and feedback of the input values is therefore subject to dead times 
and jitter.

For time-critical applications, use of measuring probes or cams is recommended. Alternately, 
the isochronous I/Os, I/Os of TM15, TM17, or isochronous ET 200 I/Os can be used.
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7.10.4 Configuration of CU3xx/TMxx I/Os 

Overview
The configuration is performed in a similar way as for the onboard I/Os for the 
SIMOTION D410-2, i.e. the I/Os can be   

● BICO-interconnected (use as drive I/O)

● Used by SIMOTION

See also Section SIMOTION D410-2 Configuring I/Os (Page 193) 

Note

If symbolic assignment is subsequently activated for a project in which telegrams have already 
been configured and interconnected, this project can be changed together with the BICO 
interconnections!

For this reason, make a backup copy of your project before activating the symbolic assignment.

The TM15 DI/DO and the TM31 are particularly affected here (see Section Symbolic 
assignment / adaptation (Page 123)).

7.10.5 Configuration of the ET 200SP/MP timer DIDQ
The I/O terminals of the ET 200SP and ET 200MP timer DIDQ can be used as drive-related I/
Os for measuring input and output cam applications. 

The DI/DQ timers are configured via the hardware configuration of STEP 7 or TIA Portal. The 
properties of the I/O channel can be configured in the parameterization dialog box, for example 

● Timer DI for use of the I/O as measuring input input or  

● Timer DQ for use of the I/O as cam output

Note

For the technological use of the timer DIDQ, you must operate the I/O station isochronously on 
PROFINET: 
● ET 200SP timer DIDQ: With SCOUT or SCOUT TIA, IM 155-6 PN HF required 
● ET 200MP timer DIDQ: Only with SCOUT TIA, IM 155-5 PN ST or HF required 

Operation via PROFIBUS is not possible.

For detailed information on the configuration, see Technology Modules TM Timer DIDQ for 
SIMOTION SCOUT and SIMOTION SCOUT TIA Commissioning Manual
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7.11 Configuring technology objects and I/O variables

7.11.1 Configuring global measuring inputs

Overview 
The type of measuring input must be selected during the configuration of the TO measuring 
input, see following table.   

Table 7-8 Measuring input types

Measuring input types Explanation
Standard 
(global measuring in‐
put)

Compared with the drive-related local measuring inputs, global measuring inputs have extended 
functionality and also support a symbolic configuration. 
They are therefore set as standard.

Drive-related (local 
measuring input)

The drive-related local measuring inputs are configured via drive parameters, see Section Config‐
uring drive-related I/Os (without symbolic assignment) (Page 295) in the Appendix.

Listening measuring in‐
put

Through the configuration of a listening measuring input, measuring can be performed simultane‐
ously on several axes or external encoders with one measuring input. Detailed information can be 
found in the SIMOTION Motion Control Output Cams and Measuring Inputs Function Manual.

A detailed comparison of "local" and "global" measuring inputs as well as an overview of which 
modules support local or global measuring inputs can be found in Appendix Configuring drive-
related I/Os (without symbolic assignment) (Page 295).

Procedure 
If a global measuring input is selected, it must be assigned a hardware input.   

Click the "Assign" button  to open the Assignment dialog box and select a free (i.e. not yet 
used) I/O. 

Note

Only those I/Os are displayed that have the appropriate measuring input functionality (MI_xx 
[channel name, terminal number]). If no suitable I/Os are displayed, you must first configure the 
I/Os (I/O must be configured as "measuring input").
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Figure 7-33 Configuration of a global measuring input for SIMOTION D410-2

Additional references
Detailed information on the configuration of the TO measuring input can be found in 
the SIMOTION Output Cams and Measuring Inputs Function Manual.

7.11.2 Configuring local measuring inputs
Local measuring inputs are drive-related measuring inputs. The configuration is performed via 
drive parameters.  

For further details, see:

● Configuring drive-related I/Os (without symbolic assignment) (Page 295) In the Appendix

● SIMOTION Output Cams and Measuring Inputs Function Manual

7.11.3 Configuring output cams / cam tracks

Overview
The type of cam output must be selected during the configuration of the TO outputCam and 
TO camTrack.     
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The following output types are available:

Table 7-9 TO outputCam / TO camTrack output types

Cam output on... Explanation
Output cam output (CAM) The cam output is performed on the basis of an internal time stamp. The temporal resolution of 

the cam output depends on the hardware used.
Supported hardware:
● SIMOTION D4x5‑2 (terminal X142): Resolution 1 μs
● TM17 High Feature: Resolution 1 μs
● TM15: Typical resolution 125 μs (DRIVE‑CLiQ cycle clock)
● SIMOTION D410-2 (DI/DO 8 to 15): Typical resolution 125 μs
● ET 200MP TM timer DIDQ 16x24V: Resolution 1 μs 
● ET 200SP TM timer DIDQ 10x24V: Resolution 1 μs

High-speed digital output 
(DO)

The cam output is performed via onboard outputs of the SIMOTION CPU. The output is via a 
hardware timer and the cam output is achieved with a resolution with respect to time < servo 
cycle. 
Supported hardware:
● SIMOTION D410 (terminal X121)
● SIMOTION D4x5 (terminal X122, X132)
● SIMOTION C240, C240 PN (terminal X1)

Standard digital output 
(DO)

The output cam calculations are performed in the processing cycle (IPO or IPO2 cycle or in the 
servo cycle). 
Actual cam output is performed in servo cycles. The resolution with respect to time of the cam 
output is generally reduced by the output cycle of the I/O used.
The resolution is therefore dependent as follows:
● For the standard I/O (e.g. ET 200), on the cycle time of the bus system (PROFIBUS DP / 

PROFINET I/O)
● For the TM15 / TM17, on the cycle time of the bus system (PROFIBUS Integrated / 

PROFIBUS DP / PROFINET IO)
● For the TM15 DI/DO, TM31, TM41, TB30, on the configured sampling time:

– cu.p0799 (CU inputs/outputs sampling time) for the onboard outputs
– p4099 (TMxx inputs/outputs sampling time) for TB30, TM15 DI/DO, TM31, and TM41

Supported hardware:
● Onboard outputs (SIMOTION D, Controller Extension CX, SINAMICS Control Unit CU3xx)
● Centralized I/O (SIMOTION C)
● Distributed I/O via PROFIBUS DP / PROFINET IO (e.g. ET 200, etc.)
● Drive-related I/O (TM15, TM15 DI/DO, TM17 High Feature, TM31, TM41, TB30)

Procedure 
To achieve the best possible output cam resolution on the onboard I/Os of a SIMOTION 
D410-2, activate the output and select "Cam output on output cam output (CAM)."   
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Then assign a hardware output. For this purpose, click  ("assign") to open the Assignment 
dialog box and select a free (i.e. not yet used) I/O. 

Note

Only those I/Os that have the appropriate functionality (DO_xx [channel name, terminal 
number]) are displayed. If no suitable I/Os are displayed, you must first configure the I/Os (I/O 
must be configured as "output cam (CAM)")

Figure 7-34 Configuration of a cam for SIMOTION D410-2

A maximum of two edges can be output per processing cycle clock of TO outputCam or TO 
camTrack.

Additional references
Detailed information on configuring the output cam and cam track technology objects can be 
found in the SIMOTION Output Cams and Measuring Inputs Function Manual.

7.11.4 Configuring an I/O variable

Overview     
You have two ways to assign an I/O variable to I/O terminals:

● Assignment via preferred interconnection (e.g. DI_8 [DI/DO 8, X121.7])
To do this, you must use the SIMOTION preferred interconnection for the corresponding 
input/outputs of the SINAMICS DOs. The BICO interconnection is performed automatically.

● Assignment via PZD (e.g. via DI_0_15 or DO_0_15).
Note that for these signals a message frame of the appropriate length is generated, but the 
BICO interconnection is not performed.
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Interconnection via preferred interconnection
The I/O variables are configured via the address list. Components that support a symbolic 
assignment can be configured without I/O addresses.
Preferred interconnections are displayed as assignment targets in the Assignment dialog box 
(e.g. DI_8 [DI/DO 8, X127.7]). The assignment is made by direct selection of the corresponding 
terminal signal.

Components that do not support symbolic assignment (e.g. standard PROFIBUS I/O) are 
configured via I/O addresses. 

Figure 7-35 Address list

Interconnection via PZD
In principle, an assignment via the PZD is also possible (e.g. via DI_0_15 or DO_0_15). Note 
that for these signals a message frame of the appropriate length is generated, but the BICO 
interconnection is not performed.

For this purpose, switch to the "Communication" dialog box of the corresponding SINAMICS 
DO. You can now see the individual bits of the PZD (e.g. I_Digital or O_Digital) listed there. 
Interconnect the appropriate bit of the PZD with a signal. 

Alternatively, you can assign SIMOTION to an I/O channel during the terminal configuration 
(e.g. by selecting "DI (SIMOTION)", see Section SIMOTION D410-2 Configuring I/Os 
(Page 193)).

TO axis
The symbolic assignment of I/Os is also supported by the TO axis (e.g. for a HW limit switch).   
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Substitute values for I/O variables 
Substitute values cannot be specified for input variables of the BOOL data type. If you do 
require substitute values however, proceed as follows:   

1. Assign a digital input (e.g. SINAMICS_Integrated.Control_Unit.DI_8 [DI/DO 8, X121.7]) to 
an input variable of the BOOL type (e.g. sensor).

2. Create a global variable (e.g. all_inputs) (at least data type WORD, e.g. 
SINAMICS_Integrated.Control_Unit.DI_0_15).

3. Configure the substitute value
The corresponding bit of the substitute value must then contain the substitute value for the 
BOOL variables.
In the same way, you can assign a substitute value to a BICO parameter.

For various SINAMICS drive objects, higher-level types are available for the assignment of 
substitute values.

Figure 7-36 Configuration of substitute values

7.12 Creating a DMC20/DME20 DRIVE-CLiQ hub

7.12.1 Hub properties

DRIVE‑CLiQ hub characteristics 
The DMC20 and DME20 DRIVE‑CLiQ hub modules are used to implement point-to-point 
distribution of a DRIVE‑CLiQ line. With the DMC20/DME20, an axis grouping can be expanded 
with 4 DRIVE‑CLiQ sockets for additional subgroups.      

● DMC20 is the hub for the control cabinet configuration

● DME20 is the hub for use without a control cabinet (IP67 degree of protection).

The modules are especially suitable for applications which require DRIVE‑CLiQ nodes to be 
removed in groups, without interrupting the DRIVE‑CLiQ line and therefore the data exchange.
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Application examples
Encoder expansion and hot-plugging are typical applications implemented by means of a 
DRIVE-CLiQ hub.  

● In an encoder expansion, direct measuring systems are connected. For example, these are 
attached directly to the machine in the control cabinet. Several encoders can be connected 
to one hub in the cabinet.

Note

The SIMOTION D410-2 has just one DRIVE-CLiQ interface. You can use the DMC20/
DME20 to evaluate the motor encoder and an additional encoder by means of SMx. The 
DRIVE‑CLiQ hub must be directly connected to the Control Unit.

● Hot plugging is the option for changing motor components while in operation. These 
components are connected to a star topology using a DRIVE-CLiQ hub. This setup allows 
their deactivation without impairing downstream components.

Additional references
Additional information on the DMC20/DME20 DRIVE‑CLiQ hub is contained in the

● SIMOTION D410-2 Manual

● SINAMICS S120 Control Units and Supplementary System Components Manual

7.12.2 Creating a DRIVE-CLiQ hub

Introduction
You can directly insert a DMC20/DME20 in the project navigator. The hub is not wired when you 
insert the DMC20/DME20 and is displayed in the topology tree in the component storage. The 
hub has to be wired manually. Proceed as follows:          

Procedure
1. Right-click the "Topology" entry in the Project Navigator.

2. Select the "Insert new object" > "DRIVE-CLiQ Hub" command from the shortcut menu and 
confirm with "OK".

3. Double-click "Topology" to open the topology tree.
The hub is saved to the component storage of the topology tree. 

4. Drag-and-drop the hub to the required DRIVE-CLiQ interface.
The components connected to the hub are displayed in the topology tree.

Result
The hub you inserted is displayed as an icon at the "Topology" entry in the Project Navigator. 
All components connected to a hub are also displayed in the course of automatic configuration.
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7.13 Creating and programming TM41

7.13.1 TM41 properties
The TM41 terminal module can be used to expand the number of digital I/Os and analog inputs 
within a drive system. TM41 also returns TTL signals which emulate an incremental encoder, 
for example, for a master control system.       

The emulated encoder signal has the signal characteristic of an incremental TTL encoder (A 
track, B track, R track). The resolution of the encoder signal can be specified in the 
configuration.

Note

The digital I/Os and the analog input can be interconnected using the BICO configuration.

The TM41 encoder interface (incremental encoder representation) can

● Be interconnected with a Control Unit encoder signal (from sin/cos incremental encoders, 
for example), using parameterization. For detailed information, consult the SINAMICS 
manuals.

● From the SIMOTION viewpoint, be accessed as an axis. This allows you to make the axis 
position (a master value) available to a second controller as an encoder signal, for example.

Configuring the TM41 involves the following steps:

● Configuring TM41 at SINAMICS Integrated (Page 203)

● Configuring the TM41 using the axis wizard (Page 204)

7.13.2 Configuring TM41 at SINAMICS Integrated

Procedure
The TM41 can be configured after you completed the configuration of SINAMICS Integrated. 
Proceed as follows:   

1. Double-click "Insert input output component" at "Input/output component" in the Project 
Navigator.

2. Select the TM41 from the "Drive object type" field of the "Insert Input/Output Component" 
dialog box and assign a unique name to the module.

3. Confirm your entry with "OK".

Result
The TM41 is inserted in the Project Navigator by the name you entered.
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7.13.3 Configuring the TM41 using the axis wizard

Requirement
After configuring the TM41 for a SINAMICS Integrated device in the project navigator, you can 
interconnect it with an axis using the Axis Wizard. The Wizard implements the TM41 as drive 
device.   

Procedure
1. Open the Axis Wizard and create a positioning or synchronization axis (electrical).

2. Step the Axis Wizard forward until the "Drive Assignment" dialog box opens.

3. Select "SINAMICS_Integrated" as the drive device and "TM41" as the drive.
TM41 operates as setpoint sink of the axis with this setup.

Figure 7-37 Drive assignment

4. Work through the remainder of the Axis Wizard.
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Reference
Detailed information on configuring incremental encoder emulation with the TM41 can be found 
in:

● FAQs at the following 
Internet address (https://support.industry.siemens.com/cs/ww/en/view/27554028)

● SIMOTION Utilities & Applications
SIMOTION Utilities & Applications is part of the scope of delivery of SIMOTION SCOUT.

7.14 Optimizing the drive and controller

7.14.1 Overview of automatic controller setting

Overview
The SIMOTION SCOUT engineering system offers a wizard for the automatic controller setting 
for the controller optimization of the drive.

In the "Automatic Controller Setting" screen form, you can configure an automatic setting for the 
speed controller and the DSC (dynamic servo control) position controller for SINAMICS drive 
units. The necessary steps for this calculation can be controlled from this screen form. The 
calculated parameter values for the speed controller or position controller are displayed and 
can then be transferred online to the drive or axis on the controller.

The automatic control setting is made from the "Target system" > "Automatic control setting" 
menu.

A detailed description of the settable parameters can be found in the SIMOTION SCOUT 
Online Help.

Requirements
● You have configured a SINAMICS drive.

● The configured drive is operated in the "Servo" drive object type.

● Closed-loop control takes place with the motor encoder.

● There is an online connection to the relevant drive unit.

Procedure
Automatic controller setting involves the following steps:

1. Setting the speed controller (Page 206)

2. Setting the position controller (Page 207)
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Note

You can cancel the automatic controller setting by pressing the SPACEBAR.
● The step currently being executed is aborted.
● The drive enable is canceled.

Additional references
Information on the controller structure can be found in the SIMOTION TO Axis, Electric/
Hydraulic, External Encoder Function Manual.

In addition to the automatic controller setting, SIMOTION SCOUT also offers the option to 
optimize the drive and controller manually using the measuring functions, trace, and function 
generator.

See also
Measuring functions, trace, and function generator (Page 208)

Manual speed controller optimization (Page 210)

7.14.2 Automatic speed controller setting

Characteristics 
The automatic speed controller setting has the following features:  

● Damping of resonances in the speed-controlled system

● Automatic setting of the Kp gain factor and the Tn reset time of the speed controller

● The speed setpoint filter and the reference model are not changed.    

Procedure
To perform an automatic setting of the speed controller, proceed as follows:

1. Select the "Target system" > "Automatic controller setting" menu command.

2. Select the drive unit and the drive.

3. Select the "Speed controller" from the "Controller selection".

4. Click "Assume control priority" to assume control priority.

5. Click the "Drive on" button to enable the drive.
Perform these steps (1 to 4) in automatic mode or as individual steps.

6. Click "Transfer" to transfer the calculated parameter values for the speed controller to the 
drive. 

7. Disable the drive by clicking the "Drive off" button.
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8. Click "Give up control priority" to give up control priority of the PG/PC.

9. Save the online parameters.

You can now transfer the automatically set parameters to the project.

Backing up parameters
Proceed as follows to back up the parameters:

1. In the project navigator, select the SINAMICS unit with the drive for which you want to 
perform the automatic setting.

2. Select "Target device" > "Copy RAM to ROM" in the context menu.

3. Select "Target device" > "Load CPU / drive unit to PG" in the context menu.

If required, the automatic controller settings can be checked using the measuring functions. 

7.14.3 Automatic position controller setting

Introduction 
In the "Automatic Controller Setting" screen form, you can select the SINAMICS drive unit and 
the drive for which you want to carry out an automatic DSC position controller setting. The 
necessary steps for this calculation can be performed from this screen form. The calculated Kv 
value is displayed and can then be accepted online in the configuration data of the axis that is 
assigned to the drive.       

Requirements
In addition to the General requirements for the automatic controller setting, the following 
boundary conditions apply for setting the position controller:

● DSC is required for the position controller setting.
Tip: Activate the project setting "Use symbolic assignment" and select the Standard/
Automatic option for the axis-drive communication when configuring the drives. You 
automatically use DSC for the servo drives with these settings.

● The speed controller has already been configured (e.g. with the automatic speed controller 
setting).

● At least one axis is connected to the SINAMICS drive (servo).

● An online connection to the SIMOTION device must be established to transfer the results of 
the automatic position controller setting.

● The balancing filter is not changed.

● For operation without precontrol, the equivalent time constant of the position controller must 
be adjusted manually by the user (PositionTimeConstant = 1/Kv).

● Vibration on the load side is not taken into account for the position controller setting.
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Procedure
To perform an automatic setting of the position controller, proceed as follows: 

1. Select the "Target system" > "Automatic controller setting" menu command.

2. Select the drive unit and the drive (axis).

3. Select the "Position controller (DSC)" from "Controller selection".

4. Click "Assume control priority" to assume control priority.

5. Click the "Drive on" button to enable the drive.
Perform the steps either in automatic mode or as individual steps.

6. Select the axis data sets to which the Kv factor is to be transferred.

7. Click "Accept values" to transfer the calculated Kv factor to the axis data sets.

8. Disable the drive by clicking the "Drive off" button.

9. Give up the control priority of the PG/PC.

10.Save the online parameters.

You can now transfer the automatically set parameters to the project. 

Backing up parameters
Proceed as follows to back up the parameters: 

1. In the project navigator, select the SIMOTION unit with the axis for which you want to 
perform the automatic setting.

2. Select "Target device" > "Copy current data to RAM" in the context menu.

3. Select "Target device" > "Copy RAM to ROM" in the context menu.

4. Select "Target device" > "Load CPU / drive unit to PG" in the context menu.

If necessary, you can check the automatic controller settings using the measuring functions. 

7.14.4 Measuring functions, trace, and function generator

Drive optimization
Drive optimization is part of commissioning and can be performed with SIMOTION SCOUT.   

Note

Controller optimization may only be performed by skilled personnel with control engineering 
knowledge.
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Controller optimization 
Various measuring functions are available for controller optimization of the drive. These 
measuring functions enable the control of the higher-level control loop to be selectively 
switched off and the dynamic response of individual drives to be analyzed through simple 
parameter assignment. The function generator and the trace recorder are used.         

The control loop is supplied with the ramp-function generator signal at a specific point (e.g. 
speed setpoint), and the signal from the trace recorder is recorded at another point (e.g. speed 
actual value).

Figure 7-38 Optimizing a controller

Depending on the form of controller optimization to be performed, it is possible to define the 
quality (e.g. signal form, amplitude, transient recovery time) of the disabled signal, the 
measuring duration for step functions in the time range, or the bandwidth and number of 
averaging operations in the frequency range for the trace. The analytical and graphical 
evaluation can then be performed accordingly (FFT diagram, Bode diagram).

The following measuring functions are available:

● Setpoint jump at current controller

● Reference frequency response at current controller

● Setpoint jump at speed controller

● Disturbance variable jump at speed controller

● Reference frequency response at speed controller

● Disturbance frequency response at speed controller

● Speed-controlled system (input at current setpoint filter)

Additional references
For additional information about drive optimization, consult the SINAMICS S120 
Commissioning Manual.

Additional information on trace and measuring functions, as well as on the function generator, 
can be found in the SIMOTION SCOUT online help.
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7.14.5 Manual speed controller optimization

Requirement
You have already created a project and configured an axis and a drive. You can now optimize 
the speed controller.   

Procedure
1. Open the project and go to online mode.

2. Click  to call the "Measuring Functions" dialog.

3. Select the drive unit and the drive.

4. Select "Speed controller setpoint jump". 
You can change the values in the following fields: "Settling time", "Amplitude", "Offset", 
"Ramp-up time" and "Measuring time".

Figure 7-39 Speed controller measuring function

Four channels can be traced. Certain channels are preassigned, depending on the 
measuring function.

5. Download the changes to the drive by clicking  (Download parameter assignment).

Starting the measuring function   
1. Click "Assume control priority" to assume control priority.

Read the notice that appears and click "Accept" to confirm. The activated service function 
is displayed via the LEDs (RUN/STOP flashing yellow/green with 2 Hz).

2. Click the "Drive on" button to enable the drive.
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3. Click  (Start measuring function) to start the measuring function.
The axis is moved during the measurement. For this reason, a safety message that allows 
the process to be aborted is displayed.

4. The traced signals are represented on the "Time diagram" tab.

Figure 7-40 Time diagram before parameter change
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Adjusting the P-gain   
You can adjust the P-gain of the controller to optimize the transient response.

1. In the project navigator under the corresponding drive, for example, Servo_1, use the menu 
command "Open-loop/closed-loop control" > "Speed controller" to display the "Speed 
Controller with Encoder" dialog box.

2. Enter an appropriate value in the "P‑gain" field and the "Integral time" field.

Note

The values entered take immediate effect.

Figure 7-41 Entering P-gain
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3. For verification purposes, perform the measurement again.

4. With the modified parameters, the controller displays a much better transient response. If 
necessary, you can continue changing the value until the transient response is optimal.

Figure 7-42 Measurement with modified P-gain

7.15 Loading and saving SIMOTION user data

Overview
After commissioning the SIMOTION D410-2, we recommend that you back up the SIMOTION 
user data (programs, configuration data and parameter assignments) on the CF card.       

Loading user data
Use the "Target system" > "Load" > "Load to target system" command to transfer the following 
data from the SIMOTION SCOUT engineering system (ES) to the "non-volatile SIMOTION 
data" area of SIMOTION D410-2:

● Configuration data

● Programs

● Parameterization

● Technology packages
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The hardware configuration of the SIMOTION D410-2 and the retain variables are also stored 
in the "non-volatile SIMOTION data" area.

Note

Using the menu:
● "Target system" > "Load" > "Load project to target system" loads all of the project data to the 

target system.
● "Target system" > "Load" > "Load CPU / drive unit to target device" only loads the data of the 

selected device / drive element to the target device.

After the SIMOTION D410-2 is switched off, the contents of the "volatile SIMOTION data" area 
are lost.

Additional references
Additional information about the SIMOTION SCOUT engineering system can be found in 
the SIMOTION SCOUT Configuration Manual.

Saving user data
The "Copy RAM to ROM" function is used in SIMOTION SCOUT to save the following data from 
RAM to the CF card:

● Technology packages and user data (units, configuration data, parameter assignments, 
task configuration) from the "volatile SIMOTION data" area

● Current data values are copied to the "volatile SIMOTION data" area, depending on the 
settings in SIMOTION SCOUT.

Note

The "Copy RAM to ROM" command cannot be used to save the current values of retain 
variables to the CF card.

You have the following options for backing up the current values of retain variables to the CF 
card:

● User program
Use the "_savePersistentMemoryData" system function in the user program.

● Save with the service selector switch or the DIAG button on the SIMOTION D410-2 or
 using SIMOTION IT web server, see Section Diagnostic data and non-volatile SIMOTION 
data (Page 282)

The SCOUT functions "Save variables" and "Restore variables" also give you the option of 
backing up to your PC and restoring data that was changed during operation and only stored 
in the runtime system.

Execute the "Copy RAM to ROM" function separately for the SINAMICS Integrated. This 
requires that the drive element has been selected in the Project Navigator.

Commissioning (software)
7.15 Loading and saving SIMOTION user data

SIMOTION D410-2
214 Commissioning and Hardware Installation Manual, 04/2019, A5E33446807B



See also
Properties of the user memory (Page 72)

7.16 Deleting data

7.16.1 Overview of data deletion
The memory of the SIMOTION D410-2 described in the User memory concept (Page 71) can 
be deleted in various granualarities. That is, you can choose to delete all data or only specific 
parts.

You have the following means of deleting the SIMOTION D410-2 data:

● SIMOTION D410-2 memory reset (Page 215) 

● Deleting user data on CompactFlash card (Page 218) 

● Setting SINAMICS Integrated to the factory settings (Page 219) 

● Restoring the default settings for the SIMOTION D410-2 (Page 219) 

● Deleting/restoring non-volatile SIMOTION data (Page 288) 

● Backing up / restoring / deleting SINAMICS NVRAM data (Page 159) 

7.16.2 SIMOTION D410-2 memory reset

Introduction
During the memory reset, the memory of the SIMOTION D410-2 and the non-volatile 
SIMOTION data in the NVRAM with the exception of the communication configuration (baud 
rates, network addresses, etc.), are deleted. The data on the CF card is retained during the 
memory reset.     

Reset the memory on the SIMOTION D410-2 if

● If you want to undo changes made to user data (programs, configuration data, parameter 
assignments) which you have not backed up by means of the "Copy RAM to ROM" 
command.

● The RUN/STOP LED is flashing (slowly flashing yellow) to indicate that the 
SIMOTION D410-2 is requesting a memory reset.

● If the non-volatile SIMOTION data with the project on the CF card do not match and an error 
occurs (diagnostic buffer entry).

You can perform a memory reset either in offline mode using the mode switch of the 
SIMOTION D410-2 or in online mode using the SIMOTION SCOUT.
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Data deleted on memory reset   
The following data are deleted during a memory reset:

● User data (units, configuration data, parameter settings, task configuration)

● Technology packages

● Retain TO (absolute encoder adjustment)

● Retain variables
Retain variables are variables in the interface or implementation section of a UNIT that are 
declared with VAR_GLOBAL RETAIN, or global device variables with the RETAIN attribute.

Note

Absolute encoder data are deleted during a memory reset and must therefore be readjusted 
after the memory reset.

Data retained during memory reset   
The following data are retained during a memory reset:

● TCP/IP and DP parameters

● Diagnostic buffer

● Data that was saved with the _savePersistentMemoryData, _saveUnitDataSet or 
_exportUnitDataSet commands and with the "Copy RAM to ROM" function.
If backup files (PMEMORY.XML/PMEMORY.BAK) have been created with 
_savePersistentMemoryData, the data in these files will be backed up again to the non-
volatile SIMOTION data after the memory reset. Users can therefore force the restoration of 
non-volatile SIMOTION data by means of memory reset. This also includes the absolute 
encoder position.

● Licenses

● SINAMICS NVRAM data

The technology packages and user data (configuration data, programs, parameter 
assignments) that were previously backed up on the CF card using the "Copy RAM to ROM" 
menu command will be transferred to the "non-volatile SIMOTION data" area of the 
SIMOTION D410-2 during the next power-up. Thus, an existing configuration on the CF card 
is loaded to the SIMOTION device following the memory reset.
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Memory reset by means of SIMOTION SCOUT
The SIMOTION device for which overall reset is to be performed must be online.

1. Open the "Control Operating State" dialog box in SIMOTION SCOUT. Select the "Target 
system" > "Control operating state" menu command. Or click on "Control Operating State" 
on the toolbar.

2. Switch the SIMOTION device for which memory reset is to be performed to STOP in the 
"Control Operating State" dialog box.

3. Select the SIMOTION device under "Memory reset (MRES)." Click the "Run" button. 
Confirm the command by clicking "Yes." 
The memory reset will now be performed.

Memory reset with the mode switch 
You can perform a memory reset with the mode switch when you are offline with the 
SIMOTION D410‑2.     

NOTICE

Damage from electrostatic discharge

The rotary switch can be destroyed by static electricity.

Operate the rotary switch only with an insulated screwdriver.

Comply with the ESD rules.

Proceed as follows to reset the memory:

1. Place the mode switch in the STOP position (selector setting 2).

2. When the RUN/STOP LED is steadily yellow, turn the switch to the MRES position (switch 
position 3).

The RUN/STOP LED starts to flash slowly (slow yellow flashing).
Wait until the RUN/STOP LED stops flashing.

3. Turn the selector back to the STOP setting.
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4. You must turn the selector back to the MRES position again within 3 seconds.

The memory reset will now be performed.
The SIMOTION D410-2 has completed the memory reset when the RUN/STOP LED is 
steadily yellow.

Note

Memory reset is canceled if you do not return the mode switch to MRES as specified within 
3 seconds. Repeat the procedure in this case.

5. Now move the mode switch back to the required operating mode.

NOTICE

Unintentional restoration of the default settings instead of memory reset

Note that the MRES position (switch setting 3) during power-up causes the default settings to 
be restored. See Section Restoring the default settings for the SIMOTION D410-2 (Page 219).

Make sure you do not accidentally switch the power supply OFF/ON in the MRES selector 
setting, as this restores the default settings instead of performing the desired memory reset. 

7.16.3 Deleting user data on CompactFlash card

Overview
Deletion of the user data from the CompactFlash card is necessary, for instance, if you wish to 
load another (new) project to the CompactFlash card and therefore find it necessary to delete 
the existing user data for an "old project" (e.g. unit data sets) from the CompactFlash card.

You can delete the user data with SIMOTION SCOUT. The SIMOTION D410-2 must be 
operating in online mode. The following data is deleted:       

● User data from the "volatile data" area

● Non-volatile data, with the exception of IP and DP parameters

● User data on the CompactFlash card (user directories), including the SINAMICS 
configuration

You can still go online to SIMOTION D410-2 at your PG/PC. The licenses on the CompactFlash 
card are retained.
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Procedure
1. Open the project you want to edit in SIMOTION SCOUT.

2. Go online with the SIMOTION D410-2.

3. Select SIMOTION D410-2 in the Project Navigator and then select the "Delete user data on 
card" option from the "Target system" menu.

4. Confirm the "Delete user data on card" prompt with "OK".
The user data is deleted. SINAMICS Integrated goes into offline mode.

7.16.4 Setting SINAMICS Integrated to the factory settings

Requirement
You must be online to SINAMICS Integrated in order to restore its default settings.     

Procedure
1. Right-click "SINAMICS_Integrated" in the Project Navigator.

2. Select the "Target device > Restore default settings" command from the shortcut menu.

This restores the delivery state of SINAMICS Integrated.

7.16.5 Restoring the default settings for the SIMOTION D410-2

Overview
SIMOTION D410-2 is supplied with default parameters such as the transmission rate or 
PROFIBUS addresses. You can restore the factory settings with the mode selector switch. The 
following data is deleted:     

● Non-volatile SIMOTION data in the SIMOTION device

● The backup copy of non-volatile SIMOTION data on the CompactFlash card 
(PMEMORY.XML/PMEMORY.BAK)

● User data in the "volatile SIMOTION data" area and on the CompactFlash card

● The communication configuration (IP and DP parameters) on the CompactFlash card is set 
to the factory settings.

All licenses on the CompactFlash card are retained.
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Restoring factory settings with the mode selector switch
1. The power supply is switched off.

2. Set the mode selector switch on the SIMOTION D410-2 to MRES (switch position 3).

3. Switch on the power supply.
The NVRAM and the user data is deleted. The factory settings are loaded. 
SIMOTION D410-2 remains in the STOP operating state.

4. Now use the mode selector switch to change to the desired operating state.

Note

The default communications parameters are now restored. You must re-configure the 
communication parameters of SIMOTION D410-2.

7.17 System shutdown
All axes and system components must be in safe state before you shut down the system. You 
can set up this safe state by providing a separate motion task, for example.

You can shut down the power supply after the system has reached a standstill state.

Note

You must observe the safety notices for SINAMICS components, which you can find in the 
corresponding SINAMICS manuals.

7.18 Configuring Safety Integrated functions

7.18.1 Overview

Integrated safety functions   
When used in conjunction with SIMOTION D, the integrated safety functions of 
SINAMICS S120 provide highly effective practical protection for personnel and machinery. 

● Safety Integrated Basic Functions

● Safety Integrated Extended Functions

● Safety Integrated Advanced Functions
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Note

As of SIMOTION V5.2 / SINAMICS Integrated V5.1, a distinction is made between Safety 
Integrated Extended and Advanced Functions. The Safety Integrated Advanced Functions also 
include the Safety Integrated Extended Functions.

The safety functions listed here conform to:

● Safety Integrity Level (SIL) 2 according to IEC 61508

● Category 3 according to DIN EN ISO 13849-1

● Performance Level (PL) d according to DIN EN ISO 13849-1

The safety functions correspond to the functions according to DIN EN 61800-5-2 (if they are 
defined there).

Übersicht der Safety Integrated Functions
If motors without a (safety-capable) encoder are being used, not all Safety Integrated Functions 
can be used.

Note
Definition: "Without encoder"

When "without encoder" is used in this manual, then this always means that either no encoder 
or no safety-capable encoder is being used.

In operation without encoder, the actual velocity values are calculated from the measured 
electrical actual values. Therefore, velocity monitoring is also possible during operation without 
encoder.

Table 7-10 Overview of the Safety Integrated Functions

 Functions Abbrevia‐
tion

With en‐
coder

Without 
encoder

Brief description

Basic Func‐
tions

Safe Torque Off STO Yes Yes Safe torque off
Safe Stop 1 SS1 1) Yes Yes Safe stop according to stop category 1
Safe Brake Control SBC 2) Yes Yes Safe brake control
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 Functions Abbrevia‐
tion

With en‐
coder

Without 
encoder

Brief description

Extended 
Functions

Safe Torque Off STO Yes Yes4) Safe torque off
Safe Stop 1 SS11) Yes Yes4) Safe stop according to stop category 1
Safe Brake Control SBC Yes Yes4) Safe brake control
Safe Operating 
Stop 

SOS Yes No Safe monitoring of the standstill position

Safe Stop 2 SS2 Yes No Safe stop according to stop category 2
Safely-Limited 
Speed 

SLS Yes Yes5)6) Safe monitoring of the maximum velocity

Safe Speed Monitor SSM Yes Yes5)4) Safe monitoring of the minimum velocity
Safe Direction SDI Yes Yes5)4) Safe monitoring of the direction of motion
Sicheres Referen‐
zieren 

SR Yes No Safe homing

Safe Acceleration 
Monitor 

SAM Yes Yes4) Safe monitoring of the drive acceleration

Safe Brake Ramp SBR Yes Yes4) Safe braking ramp
Safe gear change – Yes No –
Safely-Limited Ac‐
celeration

SLA3) Yes No Safely-limited acceleration

Safe Brake Test SBT Yes5) No Safe test of the required holding torque of a brake
Advanced 
Functions

Safely-Limited Posi‐
tion 

SLP Yes5) No Safely-limited position

Transfer of safe po‐
sition values

SP Yes5) Yes4) Transfer of safe position values

Safe Cam SCA3) Yes No Safe cams
1) Incl. SS1E (SS1 with external brake). In this variant of SS1, SIMOTION is responsible for the stop response.
2) For SBC, you also need a Safe Brake Relay for SIMOTION D410‑2 in conjunction with a Power Module in blocksize format 

(PM340, PM240‑2). A Safe Brake Adapter is required for Power Modules in chassis format.
3) As of SIMOTION V5.2 / SINAMICS Integrated V5.1
4) The use of this safety function without encoder is permitted only for induction motors or synchronous motors of the 

SIMOTICS A-1FU (previously: SIEMOSYN).
5) As of SIMOTION V4.4 / SINAMICS Integrated V4.7. (SBT: As of V4.4 HF4)

Note

Details on the Safety Integrated Functions, such as information on the configuration of safety 
functions as well as operating conditions for the encoderless operation can be found in 
the SINAMICS S120 Safety Integrated Function Manual.

Notes
Parameterize the desired Safety Integrated functions and the monitoring with or without 
encoder and activate them in the safety screen forms of the SIMOTION SCOUT engineering 
system.
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If motors are used without an encoder or with an encoder that is not suitable for Safety 
Integrated Extended/Advanced Functions, not all Safety Integrated Functions can be used 
(see previous table, "Without encoder" column).

The safe speed monitoring without encoder also functions at standstill as long as the drive is 
switched on.

PROFIsafe telegrams
SIMOTION D410‑2 supports PROFIsafe telegrams 30, 31, 901, 902 and 903. (902 as of 
SIMOTION V4.4; only in conjunction with the TIA Portal; 903 as of SIMOTION V5.1 for Safe 
Cam, SCA).

Telegrams 31, 901, 902 and 903 enable the states of the F‑DIs to be routed through to an 
F‑CPU via PROFIsafe. Telegrams 901 and 902 enable you to apply a factor to SLS limit value 
1 that has been set in the drive, allowing the SLS monitoring limit to be changed during 
operation. Moreover, in telegrams 901 and 902, the safe position actual values communicated 
in the SINAMICS S120 are transferred via PROFIsafe to the F‑CPU (function SP).

With telegram 903, the state of up to 30 cams can be transferred.

Direct fail-safe data exchange via telegram 901 is supported as of SIMOTION V4.3 SP1 HF9.

The "Transfer safe position values via PROFIsafe" function is supported as of SIMOTION V4.4.

7.18.2 Activate Safety Integrated functions 

Control
The Safety Integrated functions are fully integrated in the drive system. They can be activated 
as follows:   

● Via the onboard terminals (F-DI, F-DO) on the Control Unit

● Via a PROFIsafe telegram using PROFIBUS or PROFINET

● Via the terminals of a connected TM54F

● As of SIMOTION V4.5, the Safety Integrated Basic Functions STO, SS1 and SBC can also 
be controlled license-free via the TM54F. (Requirement: STARTER V4.4 SP1; STARTER 
V4.4 SP1 is not part of SCOUT V4.4 - the functionality is therefore only available as of 
SCOUT V4.5)

● The SLS and SDI functions can also be activated permanently via parameter assignment.

● The SLA Extended Function can only be activated via PROFIsafe.

The Safety Integrated functions are implemented electronically and therefore offer short 
response times compared to solutions with externally implemented monitoring functions.
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The output signals of the SCA Advanced Function can only be output via PROFIsafe.

Note

Although SIMOTION does not contain any safety-related functionality, it provides support for 
SINAMICS drives that can perform safety-related functions.

The purpose of this support that SIMOTION offers for the safety-related monitoring functions is 
to prevent fault reactions at the drive end by ensuring that the drive does not exit the operating 
state being monitored.

Further information about support of the SINAMICS Integrated functions on the TO axis can be 
found in the TO Axis Electric/Hydraulic, External Encoder Function Manual.

The Safety Integrated Basic Functions via the onboard terminals (F‑DI 0) and the 
Safety Integrated Extended/Advanced Functions (via TM54F or PROFIsafe) can be used 
simultaneously.

Note

Safety Integrated Extended and Advanced Functions can be controlled via:
● The onboard terminals of the Control Unit or
● PROFIsafe or
● TM54F

Mixed operation is not permitted.

Note

If SIMOTION D410-2 is mounted separately (Power Module in blocksize format connected to 
SIMOTION D410-2 via CUA31/32), use of the Safety Integrated Extended and Advanced 
Functions via the onboard terminals (F-DI, F-DO) is not possible.

F-DI and F-DO as standard I/Os
Unused F‑DI and F‑DO can be used as standard I/Os (one F‑DI as two standard inputs, the 
F‑DO as a standard output).

Using F-DI through F-CPU 
Prerequisite for use of the F‑DI by F‑CPU:

● With encoder as of SIMOTION V4.3 SP1 HF3

● Without encoder as of SIMOTION V4.4

The onboard F‑DIs can be used as F‑DI for the F‑CPU if these are not used by 
SIMOTION D410‑2.

In "Extended Functions via PROFIsafe and Basic Functions via onboard terminal" mode, the 
Basic Functions STO or SS1 (with or without SBC) can be controlled locally. At the same time 
the routing of F‑DI 1 and F‑DI 2 for the F-CPU is possible.
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Filter setting F‑DI
The F‑DIs of SIMOTION D410‑2 have a parameterizable input filter (drive parameter p10017, 
debouncing time for digital inputs).

With this input filter, unwanted signals (e.g. fault signals or test pulses of F-DO) can be filtered 
out so that these do not cause any faults.
Failsafe output modules (e.g. ET 200S F-DO) test the outputs at regular intervals. To achieve 
this, the F-DO modules switch test signals to their outputs in the form of bit patterns to detect 
a short-circuit, short-circuit to frame, or a short-circuit to ground.
If the filter time of the F-DI is set too small, these test pulses will result in unwanted triggering 
of the safety function in the case of D410-2.

For setting the input filter, the following rules must therefore be complied with:

● Debouncing time p10017 ≥ 3 x sampling time inputs/outputs p0799

● If 3 x p0799 < 1 ms, then: Debouncing time p10017 = N x 1 ms (N = 1, 2, 3, …)

● Debouncing time p10017 >> fault pulse time

Unwanted triggering of the safety function can indicate incorrect settings.
Note that the settings also impact the response time of the system.

Example

ET 200S I/O system with F‑DO modules
Because of the test pulses, the debouncing time p10017 must be at least 4 ms.

This results in the following setting options, for example:

● p10017 = 12 ms; p0799 = 4 ms or

● p10017 = 4 ms; p0799 = 1 ms

You will find additional information on ET 200S test pulses in Internet (https://
support.industry.siemens.com/cs/ww/en/view/44452714).

SI monitoring cycle clock
The response times of the various safety functions are derived from the Safety Integrated 
monitoring cycle clock (r9780). 

The value of the Safety Integrated monitoring cycle clock (r9780) is determined automatically 
- you therefore only see it when you are connected online to the drive. With the SINAMICS 
Integrated of a SIMOTION D410-2, different values can be determined as for a SINAMICS 
S120 CU310-2 connected to SIMOTION D410-2 because of the architecture. 

The Safety Integrated monitoring cycle can be calculated as follows for the SINAMICS 
Integrated:

x = 32 x p0115[0] (p0115[0] = current controller cycle clock; for D410-2, typically 125 µs for 
servo drives)

Case A: For PROFIBUS Integrated cycle clock > x: r9780 = x

Case B: For PROFIBUS Integrated cycle clock ≤ x: r9780 = (rounded up (x/Tdp))* Tdp

For drives connected via CU310-2, case A applies generally. 
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Example:
Servo drive with current controller cycle clock (p115[0] = 125 µs)

PROFIBUS Integrated cycle clock: Tdp = 3 ms

x = 32 x 125 µs = 4 ms ⇒ case B

r9780 = (rounded up (4 ms / 3ms))*3 ms = 6 ms 

For detailed information about Safety Integrated response times, see the SINAMICS S120 
Safety Integrated Function Manual.

SI monitoring cycle clock
The response times of the various safety functions are derived from the Safety Integrated 
monitoring cycle clock (r9780). 

The value of the Safety Integrated monitoring cycle clock (r9780) is determined automatically 
- you therefore only see it when you are connected online to the drive. 

With the SINAMICS Integrated of a SIMOTION D410-2, different values can be determined as 
for a SINAMICS S120 CU310-2 connected to SIMOTION D410-2 because of the architecture. 

The Safety Integrated monitoring cycle can be calculated as follows for the SINAMICS 
Integrated: 

x = 32 x p0115[0] (p0115[0] = current controller cycle clock; for D410-2, typically 125 µs for 
servo drives) 

Case A: For PROFIBUS Integrated cycle clock > x: r9780 = x 

Case B: For PROFIBUS Integrated cycle clock ≤ x: r9780 = (rounded up (x/Tdp))* Tdp 

For drives connected via CU310-2, case A applies generally.

Example:

Servo drive with current controller cycle clock (p115[0] = 125 µs)

PROFIBUS Integrated cycle clock: Tdp = 3 ms 

x = 32 x 125 µs = 4 ms ⇒ case B 

r9780 = (rounded up (4 ms / 3ms))*3 ms = 6 ms 

For detailed information about Safety Integrated response times, see the SINAMICS S120 
Safety Integrated Function Manual.

Required hardware
Controlling the safety functions requires at least the following hardware versions:

Table 7-11 Required hardware versions

Module Article number Required product version
SIMOTION D410‑2 DP 6AU1410-2AA00-0AA0 C
SIMOTION D410‑2 DP/PN 6AU1410-2AD00-0AA0 B
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The hardware requirements of the drive components can be found in the SINAMICS S120 
Safety Integrated Function Manual.

Safety Integrated functions with PROFIsafe (PROFINET example)
Safety Integrated functions are activated via "PROFIsafe on PROFINET" safe communication. 
Control (F logic) is via a SIMATIC F‑CPU which is connected to PROFIsafe via PROFINET, e.g. 
a SIMATIC S7-1500 F-CPU.

Figure 7-43 SIMOTION D, control of F functions via PROFINET with PROFIsafe

Topologies (F proxy)
The F proxy functionality enables transparent routing of safety telegrams from the SIMOTION 
I-device (or slave) to the SIMOTION controller (or master).
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The topologies that may be used with the SIMOTION D410-2 are listed below. In each case, the 
description specifies whether the control of Safety Integrated functions is routed through to the 
drives.   

● SIMATIC F CPU (master), connected via PROFIBUS with PROFIsafe to SIMOTION 
D410-2 (I-slave).
Note: PROFIBUS not possible configuration via SCOUT TIA

– Routing to the SINAMICS Integrated drive of SIMOTION D410-2.

– Routing to drives of CUs that are connected to SIMOTION D410‑2. 
The CUs are connected as slaves via PROFIBUS to the DP master interface of the 
SIMOTION D410‑2.

● SIMATIC F‑CPU (controller), connected via PROFINET with PROFIsafe to SIMOTION 
D410‑2 DP/PN (I-device)

– Routing to the SINAMICS Integrated drive of the D410‑2 DP/PN.

– Routing to the drives of a SINAMICS S110/S120 CU connected to the D410‑2 DP/PN.
The CU is connected as a device via PROFINET to the PROFINET interface of the 
D410‑2 DP/PN (= controller) or the CU is connected as a slave via PROFIBUS to the DP 
master interface of the D410‑2 DP/PN.

● The SIMOTION D410‑2 is the PROFIBUS master for a direct fail-safe slave-to-slave 
communication, e.g. between a SIMATIC F‑CPU and a SINAMICS S110/S120 CU.
Direct fail-safe slave-to-slave communication with telegram 901: As of V4.3 SP1 HF9.
Not for SCOUT TIA (SIMOTION in the TIA Portal)
See also application example at the following Internet address (https://
support.industry.siemens.com/cs/ww/en/view/38701812).

Note

Control for the Safety Integrated functions cannot be routed through to the SINAMICS 
Integrated of the SIMOTION D410‑2 in this configuration.

Topologies (Shared Device)
With the Shared Device functionality, you can configure access to an IO device with several IO 
controllers using PROFINET. This enables channels/modules to be flexibly assigned to 
different IO controllers. This option is available for inputs and outputs. You can use this 
mechanism to access the fail-safe data of a drive configured below a SIMOTION CPU via the 
F-CPU (e.g. access of an S7-1500 F-CPU to a SINAMICS S120 CU310-2 which is subordinate 
to a SIMOTION D410-2). 

Requirement:  

SIMOTION SCOUT (not possible with SCOUT TIA)

Note

When configuring PROFIsafe, it is recommended that you use the I-device F proxy functionality 
instead of the Shared Device.
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Additional references
Additional information on configuring Safety Integrated functions can be found in the

● SINAMICS S120 Safety Integrated Function Manual

● TO Axis Electric/Hydraulic, External Encoder Function Manual

● SIMOTION Communication System Manual

● Internet at the following Internet address (https://www.automation.siemens.com/safety)

7.19 Hot plugging
SIMOTION D410-2 is capable of hot plugging, i.e. SIMOTION D410-2 can be unplugged or 
plugged in again to the PM340/PM240‑2 energized. 

The following scenarios are therefore possible:

● SIMOTION D410-2 is supplied with power via X124, Power Module is de-energized

● SIMOTION D410-2 is de-energized, Power Module is energized

● SIMOTION D410-2 is supplied with power via X124, Power Module is energized

Unplugging and plugging of a SIMOTION D410-2 is only permitted on one and the same Power 
Module. If the SIMOTION D410-2 is plugged into a different Power Module (power, type, article 
number, serial number), then alarm 30074 is issued on the drive side.

SIMOTION D410-2 must always be supplied via X124 for operation. There is no warm restart 
when plugged in again.

If the SIMOTION D410-2 is unplugged from the Power Module, a drive connected to the Power 
Module stops.

7.20 Quantity structures
With SIMOTION D, the SIMOTION PLC and motion control functionalities as well as the 
SINAMICS S 120 drive software run on a shared control hardware. The IEC 61131‑3-compliant 
PLC integrated in SIMOTION D means that the system is not just capable of controlling 
sequences of motions, but the entire machine as well.   

The scaling of the PLC and motion control functionality is performed via Control Units of various 
performance classes for SIMOTION D

● SIMOTION D410-2 for single-axis solutions and small multi-axis solution with typically 2 to 
3 axes

● SIMOTION D425‑2 (BASIC performance) for up to 16 axes

● SIMOTION D435‑2 (STANDARD performance) for up to 32 axes

● SIMOTION D445‑2 (HIGH performance) for up to 64 axes

● SIMOTION D455‑2 (ULTRA‑HIGH performance) for up to 128 axes or applications with very 
short control cycle clocks
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The possible axis quantity structures depend on the required servo and interpolator cycle 
clocks and apply for electric, hydraulic and virtual axes. 

The scaling of the drive computing performance is performed via SINAMICS drive controls for 
the SIMOTION D410‑2. The drive control of a CU310‑2 is already integrated (SINAMICS 
Integrated) for the SIMOTION D410‑2. This can be extended with SINAMICS S110/S120 
Control Units connected via PROFIBUS or PROFINET.

SIZER
With the SIZER configuration tool, you can easily configure the SINAMICS S110/S120 drive 
family including SIMOTION. It provides you with support for selecting and dimensioning the 
components required for a Motion Control task. 

● Dimensioning of the PLC and motion control functionality --> selection of the SIMOTION D 
Control Unit

● Dimensioning of the drive computing performance and the required drive components.

Depending on your performance requirements, SIZER determines the possible number of axes 
and the resulting utilization on the SIMOTION and SINAMICS side. 

Quantity structure of DRIVE-CLiQ components
The following maximum number of DRIVE-CLiQ components can be connected to the 
SIMOTION D410-2:

● Max. 8 Terminal Modules, of these max.

– 3 TM15, TM17, TM41

– 8 TM15 DI/DO, TM31, TM120, TM150

– 1 TM54F

● Max. 5 encoder systems
(SMx Sensor Modules or encoders/motors with DRIVE-CLiQ interface)

● Max. 1 DMC20/DME20

You require a DRIVE-CLiQ hub module (DMC20/DME20) or a CUA32 to connect more than 
one encoder system via DRIVE-CLiQ.

7.21 Migration from SIMOTION D410 to SIMOTION D410-2

7.21.1 Upgrade from SIMOTION D410 to SIMOTION D410-2
SIMOTION D410-2 differs both in the structure and in the functionality of a SIMOTION D410.

This has effects that must be taken into account during a changeover.
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Change from D410 to D410-2 (upgrade)   
The change from SIMOTION D410 to SIMOTION D410‑2 is performed with a module 
replacement in HW Config. The procedure when changing is similar to that when changing, for 
example, from SIMOTION D445-2 DP/PN to SIMOTION D455-2 DP/PN.

The module replacement is started by dragging the new module to the frame of the module rack 
with the existing module in HW Config, see Section Device replacement in HW Config 
(Page 255).

The module replacement is performed automatically. During this operation, the technology 
packages and the device versions are updated. Existing configurations of the SIMOTION D410 
are transferred to the SIMOTION D410‑2 during the module replacement.

Information on where project adaptations are required or not required when changing from a 
SIMOTION D410 to a SIMOTION D410‑2 can be found in the following sections (see Table 
"Transfer of existing SIMOTION D410 projects to SIMOTION D410‑2").

For further information on generally required measures for project adaptations, see Section 
Service and maintenance (Page 239).

Change from D410‑2 to D410 (downgrade)
As a SINAMICS drive cannot be downgraded, a module replacement of a SIMOTION D410‑2 
(SINAMICS Integrated firmware V4.x/V5.x) with a SIMOTION D410 (SINAMICS Integrated 
firmware V2.x) is not possible.

However, project data can be transferred by means of an XML export/import. 

Transfer of existing projects
Existing configurations of the SIMOTION D410 are transferred to the SIMOTION D410‑2 
during the module replacement.

The following table provides information on where project adaptations are required or not 
required: 

Table 7-12 Transfer of existing SIMOTION D410 projects to SIMOTION D410‑2

Keyword Explanation
PROFIBUS interfaces The configuration on the PROFIBUS interfaces including any existing PG/PC assignment is re‐

tained.
Figure: SIMOTION D410 to SIMOTION‑ D410-2: 
X21 DP/MPI → X21 DP/MPI
One of the differences of SIMOTION D410‑2 DP compared to D410 DP is that it has an additional 
(second) PROFIBUS interface (X24).
A key difference of SIMOTION D410‑2 DP/PN compared to D410 PN is that it also has a PROFI‐
BUS interface (X21).

PROFINET interface The configuration on the PROFINET interface, including any existing PG/PC assignment, is re‐
tained.
Figure: SIMOTION D410 PN to SIMOTION D410‑2 DP/PN:
X200 → X150 P1
X201 → X150 P2
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Keyword Explanation
Message frame configu‐
rations

The message frame configurations on the PROFIBUS or PROFINET interface are retained. The 
same applies for the addresses of the slots/subslots.

SINAMICS Integrated The SINAMICS Integrated is to be replaced with the new type and its corresponding version. The 
drive configuration and the assignment of the DRIVE‑CLiQ interface are retained.

PG/PC connection / 
Ethernet interface

In contrast to SIMOTION D410, SIMOTION D410-2 has an Ethernet interface.
Due to the significantly improved engineering performance, we recommend that you connect a PG/
PC via the Ethernet interface of the SIMOTION D410-2 instead of via PROFIBUS.

Configuration of the on‐
board I/Os

The configuration of the onboard I/Os (4 DI, 4 DI/DO) is retained. The new features mean the 
functionality, quantity structures and terminal designations for the onboard I/Os differ for the SI‐
MOTION D410-2 compared with the SIMOTION D410.
The number of onboard I/Os has more than doubled so that previously required terminal modules / 
I/O modules may no longer be necessary.

Safety SIMOTION D410-2 has 3 F-DI and 1 F-DO for Safety Integrated Extended/Advanced Functions so 
that a TM54F used for SIMOTION D410 may be omitted.

CompactFlash card / 
firmware

SIMOTION D410 and SIMOTION D410‑2 have different CompactFlash cards and different card 
mappers (firmware).
A CompactFlash card of the SIMOTION D410/D4x5-x must not be inserted into a SIMOTION 
D410-2 and vice-versa!
1 GB CompactFlash cards of the SIMOTION D410/D4x5-x can also be used for the SIMOTION 
D410-2 when a new boot loader is loaded. For details, see Section Boot loader on the Compact‐
Flash card (Page 271).

Connectable drive com‐
ponents

Like the SINAMICS S120 CU310-2, the SIMOTION D410-2 also no longer supports some older 
drive components.
For details, see Section Permissible combinations (Page 233) 
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Keyword Explanation
User program Although, in principle, a SIMOTION D410 user program can run on a SIMOTION D410‑2, modifi‐

cations may be required because of innovations in the hardware. Examples: 
● The runtime behavior of the SIMOTION D410‑2 changes because of the increased 

performance. As long as the user program does not contain any "runtime-dependent code", 
adaptations should not be necessary.

● Fan faults for the SIMOTION D410-2 are signaled via a diagnostic buffer entry 
PeripheralFaultTask and a system variable (fanWarning). For the SIMOTION D410, fan faults 
were signaled by a warning on the drive side (A1009).

● The following additional functions are available for the SIMOTION D410-2:
– Backup of the non-volatile SINAMICS data (NVRAM data) via CU parameter p7775 
– Automatic detection of a module replacement on the basis of the serial number of the 

Control Unit
Hardware Due to the innovative hardware, the following changes have been made for the SIMOTION D410-2 

compared with the SIMOTION D410:
● The control elements of the SIMOTION D410-2 have been standardized with the SIMOTION 

D4x5-2 (rotary switch instead of DIP switch for SIMOTION D410, DIAG button, etc.).
● The interfaces on the top of the module are positioned differently.
● Changed I/O terminals:

– Spring-loaded terminals instead of screw terminals
– Fitting for the 24 V terminal block
– The SIMOTION D410 connector X120 must be re-wired
– The wiring of the SIMOTION D410 connector X121 can be taken over exactly for the new 

connector of the SIMOTION D410-2 (the terminal designation for the reference ground DI 
0 - DI 3 changes from M1 to M2)

SIMOTION D410-2 has the following additional interfaces:
● Additional Ethernet interface
● Additional PROFIBUS interface
The mounting depth of the SIMOTION D410-2 has been reduced by approx. 15% compared to the 
SIMOTION D410.

See also
Operations and their effect on the user memory (Page 74)

7.21.2 Permissible combinations
Some "older" DRIVE‑CLiQ components can no longer be used with the SIMOTION D410‑2.     

Table 7-13 DRIVE-CLiQ components not supported with SIMOTION D410‑2   

DRIVE-CLiQ components Article number suffix
SMC30 Sensor Module Cabinet < 2
TM31/TM41 Terminal Modules < 1
SME20/25 Sensor Modules External < 3
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DRIVE-CLiQ components Article number suffix
CUA31 Control Unit Adapter < 1
Power Modules (chassis) < 3

A detailed, regularly updated list of the DRIVE-CLiQ components approved for use with 
SIMOTION, as well as notes on their use, can be found on the Internet (https://
support.industry.siemens.com/cs/ww/en/view/11886029).

If incorrect components are used, a topology error is signaled 
F01360 Topology: Actual topology not permitted. 

7.21.3 CompactFlash card and license combinations

CF card
A CF card with D410 firmware / drive software cannot run on a D410‑2. The same applies for 
the reverse situation.

In the event of a fault all 4 LED displays light up yellow.

SIMOTION D410-2 licensing
SIMOTION D410-2 is a compact Control Unit predestined for single-axis applications. 
SIMOTION D410-2 has an integrated drive control for either a servo, a vector or a V/f axis. One 
real axis can be used without requiring a license for a SIMOTION D410-2. Speed-controlled 
axes and virtual axes never require a license.     

SIMOTION D410-2 can be extended with additional SINAMICS S110/S120 Control Units (e.g. 
CU305) and so can also be used for smaller multi-axis applications (e.g. with 2 - 3 axes). These 
additional axes must be licensed with the single-axis licenses or the "D410‑2 MultiAxes 
Package." See Section "CompactFlash card" in the SIMOTION D410‑2 Manual.

If you need to license one POS axis, use the POS single-axis license; in the case of GEAR/CAM 
or if you require more than one POS licenses, it is better to use the D410‑2 MultiAxes Package,

Note

If you use more than one real axis with SIMOTION D410-2, you must license these additional 
axes. The axis license with the highest functionality is covered by the inclusive license (a real 
axis). The functionality has the following granularity: CAM > GEAR > POS.

Example:

You use 2 real axes: 1 POS, 1 CAM.
Because the CAM license has a higher value, and so inclusive, you only need to purchase a 
POS license.
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Licenses are required for runtime functions such as SIMOTION IT Virtual Machine. These can 
be pre-installed on a CompactFlash card (CF card) or ordered separately.

Note

Path interpolation is supported as of V4.4.

7.22 Special functions SIMOTION D410-2

7.22.1 Automatic restart after FAULT state

Overview
A SIMOTION D410‑2 can perform a restart automatically after the FAULT operating state has 
occurred via the system variable _automaticRestart available as of V4.4. 

The system variable _automaticRestart is intended for applications in which an automatic 
restart is mandatory after a crash caused by an extreme situation, e.g. wind generators after a 
lightning strike.

The automatic restart causes the device with the project to boot automatically from the CF card.

Note

System variable _automaticRestart is visible on all SIMOTION CPUs, but the functionality is 
only supported by SIMOTION D410‑2.

Note

Restart cannot be ensured in all cases, for example, if a hardware fault occurs.

Programming

Table 7-14 System variable _automaticRestart

Value Response
16#00000000 Automatic restart after FAULT state is not active 

(default).
16#00000000 < n < 16#FFFFFFFF Automatic restart after FAULT state is active until 

the value 0 is reached. 
On a restart after FAULT state, the value is decre‐
mented by 1.

16#FFFFFFFF Automatic restart after FAULT state. The value re‐
mains unchanged.
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The system variable can be set to the desired value and decrementing monitored in the user 
program.

Alternately, the start value can be set manually in the SIMOTION SCOUT symbol browser 
under "force variable." To ensure the manually set start value remains effective, note the 
following:

● The start value must be set in the offline project and loaded onto the device by project 
download.

● The value that is loaded onto the device must differ from the start value that was last loaded 
onto the device by project download.
This ensures that the current value of the system variable _automaticRestart in the runtime 
system is not reset on every project download (crash history is not deleted).

The system variable is retentive, its content and therefore the "automatic restart after FAULT 
state" function is retained after an interruption in the power supply.

An automatic restart after FAULT state that has occurred can be diagnosed by the diagnostic 
buffer entry Automatic restart of the CPU performed after FAULT operating state.

System variable _automaticRestart is not backed up with _savePersistentMemoryData:

● Because an automatic restart can be caused by hardware problems and this cause is not to 
be transferred to the new module if a module is replaced.

● Because the user program will decide for itself under what condition system 
variable _automaticRestart will be set to a certain value.

If an error occurs after the automatic restart, there is not special error handling for this case. If 
this error prevents startup, the SIMOTION device cannot enter the RUN state. An error during 
startup does not trigger an automatic restart.

7.22.2 Triggering a restart with a user program
A user program of the SIMOTION device can trigger restart of the device via the system 
function _restart available as of V4.4.

This system function, like the system variable _automaticRestart, described in Section 
Automatic restart after FAULT state (Page 235) is intended for applications in which an 
automatic restart is mandatory after a crash caused by an extreme situation, e.g. wind 
generators after a lightning strike.
The system function _restart enables a response to non-acknowledgeable drive errors with a 
OFF2 reaction, which result in the inability of the drive to move. These drive errors can only be 
exited via a restart or by power off/on. 

Note

The system function _restart is provided for all SIMOTION devices, but restart itself is only 
performed for the D410‑2 device.

The restart causes the device with the project to boot from the CF card.

So that, after a restart has been performed, the SIMOTION device enters the RUN state again, 
the system variable _startUpData.operationMode must be on RUN.
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The system function _restart only supports synchronous command processing. 

Return values:

● 16#00000000: Function performed without errors.

● 16#FFFF8091: Functionality is not supported for the device.

If the restart was triggered by the system function _restart, the following entry is made in the 
diagnostic buffer: The SIMOTION device has been switched to STOP and restarted by the user 
program using the _restart system function.

The user program must ensure that, when the D410‑2 restarts, no axis movements or other 
unwanted influences on the machine by the user program occur.

If an error occurs after the automatic restart, there is not special error handling for this case. If 
this error prevents startup, the SIMOTION device cannot enter the RUN state. An error during 
startup does not trigger an automatic restart.
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Service and maintenance 8
8.1 Overview

Introduction
It is possible to distinguish between the following scenarios when replacing and updating 
components:     

● Replacing modules (spare part scenario)

– Spare parts replacement for SIMOTION D410-2 (Page 243) 

– Removing and replacing the SIMOTION D410-2 (Page 243) 

– Replacing DRIVE-CLiQ components (Page 245) 

– Replacing the fan (Page 247) 

– Replacing the CompactFlash card (Page 249) 

● Adapting a project (new device type / new device version) 
The project needs to be adapted if you want to change the type (e.g. D410 DP -> 
D410-2 DP) or version of the SIMOTION device in your existing project.

– Creating backup copies (project/CF) (Page 249) 

– Backing up user data (back up variables) (Page 250) 

– Upgrading a user project to the new SCOUT version (Page 251) 

– Platform replacement via XML export/import (Page 252) 

– Preparing the device replacement (Page 254) 

– Device replacement in HW Config (Page 255) 

– Upgrading technology packages (Page 256) 

– Upgrading the device version of SINAMICS S120 Control Units (Page 258) 

– Upgrade the libraries (Page 259) 

– Save project, compile and check consistency (Page 260) 

● Performing a firmware and project update

– Upgrading the boot loader on the CompactFlash card (Page 260) 

– Update - preparatory measures (Page 261) 

– Update via SIMOTION IT web server (Page 262) 

– Upgrade via device update tool (upgrading SIMOTION devices) (Page 262) 
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– Update via CF card
Backup of CompactFlash card data (Page 265) 
Firmware update using a CompactFlash Card (Page 266) 
Upgrading SINAMICS (Page 267) 
Download project to target system (Page 268) 

Note

Upgrading using the device update tool offers a number of advantages (keeping retain 
data, option of downgrading, no license key handling, etc.). We would, therefore, 
recommend using this method for firmware and project updates.

Please also observe the information on handling the CompactFlash card.

● Changing the CompactFlash card (Page 269) 

● Writing to a CompactFlash card (Page 270) 

● Formatting the CompactFlash card (Page 271) 

● Boot loader on the CompactFlash card (Page 271) 

● Recommended method of handling CompactFlash cards (Page 272) 

● Card reader for CompactFlash cards (Page 273) 

Note

This document uses the following terms:
● Upgrade: Denotes upgrading to a higher version of a component/software
● Downgrade: Denotes reverting to a previous version of a component/software
● Update: In general terms, denotes the act of bringing a component/software up-to-date 

(in isolated cases, this may see an upgrade or downgrade)

Upgrade options
The exact procedure when replacing or updating components depends on various factors.

If a project is upgraded, the procedure depends on the scope of change of the versions. 

● Change of the SIMOTION main version

● Change of the SIMOTION service pack or hotfix version

● Change of the PROFINET version

● Change of the SINAMICS version 
(There are SIMOTION versions that contain several SINAMICS versions for a device.)

If a different SIMOTION controller is to be used, the procedure depends on whether a device 
or a platform replacement is required.

Examples of upgrade scenarios are listed in the following overview table. They are shown in the 
columns. The lines list the principle measures that have to be performed. Whether the measure 
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has to be performed in a specific case, must be decided project-specifically. 
Grayed-out cells mean that a measure is not required.     

Note

If the version is changed and the SIMOTION controller replaced at the same time, then all 
measures apply; the measures must be performed in the TOP-DOWN sequence according to 
the table.
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1) Alternative: Load the project to the CF card using a card reader
2) Refer to the compatibility list (https://support.industry.siemens.com/cs/ww/en/view/18857317) 
3) The versions of SINAMICS Integrated and Controller Extensions are upgraded automatically in the HW Config during 

device replacement
4) The technology packages are automatically upgraded. The user can directly specify a TP
5) SINAMICS components are upgraded/downgraded to the component version of the CF card. Observe the LED codes! 

After the upgrade it is necessary to switch the device off and on.
Figure 8-1 Overview of upgrade options
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8.2 Replacing modules

8.2.1 Spare parts replacement for SIMOTION D410-2
A replaced module is detected by the controller on the basis of the serial number. This 
automatically deletes the non-volatile data and transfers the data saved on the CF card to the 
controller. See Section Replacing modules in the spare part scenario (Page 81).

8.2.2 Removing and replacing the SIMOTION D410-2

Overview
The following describes the procedure for replacing a module (spare part). In principle, it is also 
possible to replace the SIMOTION D410-2 when the PM340/PM240‑2 is energized.

You will find more information on this in Section Hot plugging (Page 229).

WARNING

Danger to life through electric shock

Note that Power Modules with FSB performance rating or higher still carry a residual 
intermediate voltage after shutdown. 

Wait 10 minutes before you remove any screws.

For further information, see the  SINAMICS S120 AC Drive Manual.

Removing a defective module
How to remove the SIMOTION D410-2 module:     

1. Switch off the power supply to terminal X124.

2. Remove the CF card from the card slot.

3. Remove the connections for the power supply (X124).

4. Disconnect the communication interface connectors from the device:

– DRIVE-CLiQ interface (X100)

– PROFIBUS DP interface (X21)

– PROFIBUS DP interface (X24; D410‑2 DP only) 

– PROFINET interface (X150 P1 and P2; D410‑2 DP/PN only)

– Ethernet interface (X127)

5. If necessary, disconnect the plug-in connectors to the digital inputs/outputs of the interfaces 
(X120, X121, X130, X131).
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6. Disconnect the plug of any encoder connected to the X23 encoder interface.

7. Depending on the mounting method, disassemble the SIMOTION D410-2 from the Power 
Module or remove the SIMOTION D410-2 from the mounting plate (see Section Mounting 
(Page 29)).

Installing a new module
How to install the new SIMOTION D410-2 module:

Note

Observe the information for installation (Page 29), wiring and connecting (Page 35) the 
SIMOTION D410-2.

1. Install the new SIMOTION D410-2 on the Power Module or on the mounting plate.

2. Connect all previously removed connectors.

3. Terminate the load voltage supply cables at the terminal block.

4. Rewire the shielding of all cables.

5. Insert the original CF card into the card slot of the new SIMOTION D410-2.

6. Switch on the power supply. The new SIMOTION D410-2 is immediately ready for operation.

Replacing SIMOTION D410-2 modules without PG/PC
To enable a module replacement without a PG/PC, you must back up the current non-volatile 
SIMOTION and SINAMICS data on the CF card during operation.

NOTICE

Loss of data due to failure to make backup copies

Non-backed-up non-volatile SIMOTION data can be lost on hardware replacement (module 
defect), for example, if the current value of the retain variables have not been backed up and 
replaced by their initial values again.

Back up the non-volatile SIMOTION data on the CF card.

NOTICE

Repeat referencing necessary after absolute encoder overflow

If an absolute encoder overflow occurs after _savePersistentMemoryData, the actual position 
value is no longer correct after the non-volatile SIMOTION data are restored. 

In this case, homing (absolute encoder adjustment) must be repeated.
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See also
Hot plugging (Page 229)

Spare parts replacement for SIMOTION D410-2 (Page 243)

Operations and their effect on the user memory (Page 74)

Replacing modules in the spare part scenario (Page 81)

8.2.3 Replacing DRIVE-CLiQ components

Requirement
DRIVE-CLiQ components not only support replacement in the switched-off state of the 
machine/system (Power Off), but also replacement during operation. For this, the component 
to be replaced must be at the end of the DRIVE-CLiQ line.       

Removing DRIVE-CLiQ components
1. Deactivate the affected component or drive object.

2. Remove the DRIVE-CLiQ connector.

3. Remove the supply voltage of the component and uninstall the component.

Installing DRIVE-CLiQ components
1. Mount the component and reconnect the supply voltage.

2. Reconnect the DRIVE-CLiQ cable at the same location (port). The cable must have the 
same length as the old one.

3. Activate the affected component or drive object.

Parameters for topology comparator and component replacement
In the expert list, you can use CU parameter p9906 to specify how the electronic rating plates 
are compared for all the components of a Control Unit. The type of comparison can be changed 
subsequently for each individual component by using p9907/p9908 or right-clicking in the 
topology. All data on the electronic rating plate is compared by default.

● When p9909 = 1, the serial number and the hardware version of the new replacement 
component are automatically transferred from the actual topology to the target topology, 
and then saved in the non-volatile memory.

● When p9909 = 0, serial numbers and hardware versions are not automatically transferred.

The setting p9901 = 1 enables the spare parts / components replacement without tool support 
to be carried out. The new serial number of the spare part is automatically transferred from the 
actual topology to the target topology and saved in non-volatile memory. In order for this to 
occur, the components that have been replaced must be of the same type and have the same 
article number, such as "6SL3055-0AA0-5BA0". The last or last two digits of the article number 
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(depending on the component type) are not checked, as the HW version, for example, is coded 
in these. This mechanism is also applied when several components are replaced.

Modified wiring following module replacement
In the default setting for the topology comparator, modified wiring configurations of the DRIVE-
CLiQ components (e.g. a cross-exchange) are not accepted for safety reasons and are 
generated by a fault. 

If a cross-exchange of components is required (i.e. existing components are replaced with 
other existing components, and no spare parts are used), e.g. for troubleshooting purposes, the 
topology comparator must be reduced via parameter p9906 or preferably via p9907/p9908; or 
as an alternative, by right-clicking in the topology.

Note

In this case, incorrect insertion of components is no longer monitored.

Automatic upgrading/downgrading (firmware update)
During the startup, the system automatically upgrades or downgrades all DRIVE-CLiQ 
components to the version of the component firmware on the CF card. Components that cannot 
be downgraded to the component firmware version of the CF card (e.g. old firmware on the CF 
card and new components to which the old firmware cannot be loaded) retain their firmware 
version. The resulting firmware version combinations are always functional.           

The CONTENT.TXT file in the main directory of the CF card contains the component version.

Note

During an automatic FW update, please take note of the messages and alarms in the 
SIMOTION SCOUT detail window. 

A firmware update on the SIMOTION D410-2 is signaled by the RDY LED flashing yellow, while 
on the DRIVE-CLiQ components (TM, SMC, etc.) it is signaled by the RDY LED flashing red/
green.
● FW update running: RDY LED flashes slowly (0.5 Hz)
● FW update complete: RDY LED flashes quickly (2 Hz), POWER ON required

Components requiring POWER ON following a firmware update signal this by means of the fast 
flashing RDY LED. Go offline with SCOUT and switch the 24 V supply to the relevant 
components off/on (POWER ON) to initialize.

The update function can be deactivated using CU parameter p7826 in the expert list.

Additional references
For more information on this topic, see the following references:

● SINAMICS S120 Commissioning Manual

● SINAMICS S120 Function Manual
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8.2.4 Replacing the fan

Overview
The SIMOTION D410-2 fan switches on depending on the internal module temperature. 

Fan faults are signaled by a diagnostic buffer entry, system variable and PeripheralFaultTask, 
see section Fan (Page 83).

The SIMOTION D410‑2 does not have to be removed from the Power Module in blocksize 
format to replace the fan. A defective fan can also be replaced when the SIMOTION D410‑2 is 
switched on.

Note

The fan/battery module should preferably be replaced when the power is switched off and only 
when the CPU is in the STOP state. Otherwise you risk an unintentional failure of the machine/
system, e.g. through accidental disconnection of cables.

Replacing the fan
The fan is available as a spare part. For the article number, see section "Spare parts and 
accessories" in the SIMOTION D410‑2 Manual.   

NOTICE

Damage to device electronics caused by electric fields or electrostatic discharge

The fan on the SIMOTION D410-2 may only be replaced by qualified skilled personnel and 
strictly in accordance with ESD guidelines (Page 303).

1) Release the snap hooks on the left and right side of the fan 
by pressing them inwards.

2) Pull the fan forwards and out of the SIMOTION D410-2 
housing.
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3) Locate the centering frame of the replacement fan on the 
mounting lug of the SIMOTION D410-2.

4) Slide the replacement fan on the mounting lug into the 
Control Unit.
Make sure that the fan connector fits into the centering frame 
of the the printed circuit board.
Engage both snap hooks on the fan in the housing of the 
Control Unit.

Fan service life
Fans are parts subject to wear. The fan is monitored for SIMOTION D410-2. A failure is 
signaled in the diagnostic buffer and can be evaluated by the user program (e.g. via the 
PeripheralFaultTask).

Contamination is the main cause of fan failure. A visual inspection should be made as a first 
criterion for replacement. If the fan is highly contaminated, it must be replaced.
If no contamination is present, we recommend that the service period is used as criterion. 
Because the service life of the fans depends greatly on the operating conditions (temperature, 
humidity, number of operating hours per day, contamination caused by dust, etc.), no fixed 
limits for all applications are can be specified.
In the field, under average industrial conditions, a replacement interval of 5 to 7 years has 
proven itself. 
We recommend that the maintenance intervals are adapted for the specific application based 
on empirical values.
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8.2.5 Replacing the CompactFlash card
If spare parts are used, you must contact the Technical Support Center to transfer the license 
key of the defective CompactFlash card to the new CompactFlash card.

Proceed as follows to write your project to the new CompactFlash card:   

● Changing the CompactFlash card (Page 269)

● Writing to a CompactFlash card (Page 270)

Detailed information about licensing can be found: 

● In the SIMOTION SCOUT Configuration Manual

● In the FAQs on the Internet (https://support.industry.siemens.com/cs/ww/en/view/
73501913)

8.3 Customizing the project

8.3.1 Overview

Overview
The project needs to be adapted if you want to replace the type (e.g. D410‑2 DP ⇒ D410‑2 DP/
PN) or version of the SIMOTION device in your existing project.  

Procedure
The exact procedure for project adaptations depends on the scope of the target hardware and 
version changes.

An overview can be found in the Upgrade options overview (Page 242) figure.

8.3.2 Creating backup copies (project/CF)

Requirement
Before adapting the project, it is essential that you create the following backup copies:   

● A backup copy of the project and

● A backup copy of the CF card contents, see Saving CF card data (Page 265).

See also
Update - preparatory measures (Page 261)
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8.3.3 Backing up user data (back up variables)

Overview
With the SCOUT functions "Save variables" and "Restore variables", you have the option of 
backing up and restoring data that were changed during operation and only stored in the 
runtime system. This is necessary if a SIMOTION platform is changed or a version upgraded, 
for example.         

The "Save variables" function creates XML files that can be saved in any folder.

The following types of data can be backed up:

● Remanent global device variables and unit variables, as well as TO retain data located in the 
NVRAM of the controller

● Data saved with _saveUnitDataSet or _exportUnitDataSet and located on the CF card

Note

During an upgrade, this function is only required for the purpose of backing up and restoring 
unit data records created with _saveUnitDataSet.

Retain and unit data (saved with _exportUnitDataSet) remain valid even after a version 
upgrade.

SIMOTION retain data can also be backed up to a memory card without the use of 
SIMOTION SCOUT. For this purpose, use: 
● The _savePersistentMemoryData function or
● The service selector switch or the DIAG pushbutton or SIMOTION IT web server,

see Section Non-volatile SIMOTION data (retain data) (Page 283).

Procedure
The user data must be saved before the SCOUT project is upgraded. This can be done 
regardless of whether the version upgrade is performed with the "old" or the "new" SCOUT 
version.

The procedure is described below based on the example of a new SCOUT version.

1. Open the project. 
When you open the project, a window appears with a message that the project you are 
opening was created with a different SCOUT version, as well as a query asking whether you 
want to perform an upgrade.

Figure 8-2 "Convert project" message

2. Confirm the prompt with "OK". The project will be converted to the current version.
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3. A dialog then appears with a prompt asking whether the project should be opened write-
protected.

Figure 8-3 Prompt for write-protected opening

4. Confirm this prompt with "Yes" (open write-protected).

5. Set the SIMOTION D410-2 to the STOP operating state.

6. Set the SIMOTION D410-2 to online mode and perform the SCOUT Save variables function.
The retain variables (interface and implementation) and the user files (with 
_saveUnitDataSet or _exportUnitDataSet) are saved to the PG/PC.

7. Then close the project.

Note

An online connection is possible only when the PG/PC is configured for the controller.

Update the PG/PC assignment using .

Online connection is now possible. 

Additional references
For further information, see the SIMOTION SCOUT Configuration Manual.

See also
Diagnostic data and non-volatile SIMOTION data (Page 282)

8.3.4 Upgrading a user project to the new SCOUT version

Requirement
It is essential that a backup copy be made of the original project before the upgrade, because 
the data storage of the project is also upgraded during the upgrade. This ensures that you can 
always return to the original project if the upgrade fails (power interruptions, unexpected faults, 
incorrect operation, etc.).
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Procedure
1. Open the project. A window appears with a message that the project to be opened was 

created with another SCOUT version as well as a prompt as to whether the upgrade should 
be performed.

Figure 8-4 "Convert project" message

2. Confirm the prompt with "OK". The project will be converted to the current version.

3. A dialog then appears with a prompt asking whether the project should be opened write-
protected.

Figure 8-5 Prompt for write-protected opening

4. When upgrading the version, click "No" (open not write-protected).

Note

A project that was last edited with a higher SCOUT version cannot be opened by a SCOUT 
with a lower version.

Remedy:
Convert the project beforehand with the more recent SCOUT version to the required 
software version ("Project" > "Old project format" > "Save in old project format"). The project 
can then be opened with the lower SCOUT version.

8.3.5 Platform replacement via XML export/import

Overview
A platform replacement is always required when an existing project is to be used for another 
SIMOTION platform. The platform replacement is always performed via an XML export/import.   
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The following devices can be interchanged via a platform replacement:

● Replacement between SIMOTION C, P and D (e.g. C240 ⇒ D445‑2 DP/PN)

● Replacement between D410/D410-2 and D4x5/D4x5‑2 (e.g. D410‑2 DP/PN ⇒ D445‑2 DP/
PN)

● Replacement between SIMOTION D (SINAMICS S120 Integrated) ⇒ SIMOTION D 
(SINAMICS SM150 Integrated)

Platform replacement during project downgrades:

It is not possible to downgrade to a lower SINAMICS version. However, it is possible to transfer 
project data by means of an XML export/import.

Preparations
Before the platform replacement can be performed, preliminary work may be necessary in the 
existing project.

If a SIMOTION D4x5-2 is to be imported into a SIMOTION D410-2, then only the permitted 
quantity structure of the D410-2 may be configured in the D4x5-2. This applies for all 
components, e.g. not only an infeed, but also the permissible power units. 

A SIMOTION D4x5-2 with CU adapter and Power Module in blocksize format can be imported 
into a SIMOTION D410-2 when the CU adapter is connected to port 0. Otherwise, the topology 
will be destroyed.

Generally, the success of an import always also depends on the specific configurations of the 
drive units, and whether the configuration is possible for the device to which the import is to be 
performed. Also note any error messages that may occur.

Procedure
Proceed as follows:

1. In the project navigator of SIMOTION SCOUT, right-click the SIMOTION controller that is to 
be replaced.
Select "Expert" > "Save project and export object" in the context menu. 
"Save project and export object" exports selected data of the selected object in XML format. 
This data export can then be reimported into other projects. The entire project is not 
exported, only the data of the selected object (e.g. only the D410‑2 or only the SINAMICS 
Integrated).

2. Specify the desired path and start the XML export.

3. When the export has been performed error-free, delete the device from the project and 
confirm the prompt.

4. Insert the desired platform as new device in the project navigator of SIMOTION SCOUT. 
With the selection of the device, you also define the SIMOTION version, and with a 
SIMOTION D, also the SINAMICS version.

5. Import the data of the original platform into the new device. To do this, right-click the new 
device and select "Expert" > "Import object" in the context menu.

6. Select the location where the XML export data is to be stored and start the import. Confirm 
the prompt to continue with the import.
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Confirm the message with regard to the import of a "non-compatible type" with "OK".

8.3.6 Preparing the device replacement

Overview
In contrast to the platform replacement, project data can be particularly easily transferred when 
a device is replaced. The device replacement is performed via HW Config, whereas 
an XML export/import is required for a platform replacement.     

A device replacement is only possible within SIMOTION D.

The following devices can be interchanged:

● Replacement between generations (D410 ⇒ D410‑2)

● Replacement between variants of the generations (D410‑2 DP ⇒ D410‑2 DP/PN)

● Replacement of SIMOTION, SINAMICS and/or PROFINET version (e.g. 
D410 V4.1 - PN V2.1 SINAMICS S120 V2.5 ⇒ D410 V4.2 - PN V2.2 SINAMICS S120 
V2.6.2).

Note

When replacing a device, note that the SINAMICS version of the new SIMOTION device 
must be the same or higher.

A downgrade to a lower SINAMICS version (e.g. SIMOTION D410‑2 with SINAMICS V4.x 
to SIMOTION D410 with SINAMICS V2.x) is not possible.

When carrying out a "D410‑2 DP/PN ⇒ D410‑2 DP" device replacement, the PROFINET IO 
system is omitted and the bus interface changes. You must reconfigure this after the device 
replacement. Any existing PROFINET field devices on the PROFINET interface must be 
replaced with PROFIBUS field devices on the PROFIBUS interface.

Migration D410 ⇒ D410-2
If a SIMOTION D410 is replaced with a SIMOTION D410-2, the SINAMICS Integrated is also 
automatically changed to a new type and the corresponding version.
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8.3.7 Device replacement in HW Config

Procedure
1. Double-click the SIMOTION device to be replaced in the project navigator in 

SIMOTION SCOUT. HW Config opens.        

2. Open the "SIMOTION Drive Based" folder in the hardware catalog.

Note

SIMOTION D is modeled as a compact device in HW Config. When replacing a module, you 
must drag the new module to the header of the displayed module rack and not to slot 2. 
Ensure that you do not delete the D410-2 rack!

3. Drag-and-drop the new module to the header of the module rack.
The old module is replaced.
Alternatively, you can:

– Select the rack header and double-click the new module in the module catalog to replace 
the previous module, or:

– Right-click the rack header and select the "Replace object" option.

Figure 8-6 HW Config module replacement

4. Confirm the dialog box that appears with "Yes" to replace the SIMOTION device. The 
module is replaced.
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5. Accept the changes made to the hardware configuration with "Station" > "Save and 
compile".

6. Close HW Config.

Note

The engineering system automatically performs the following actions when replacing a 
module (if necessary):
● Update of the technology packages (TPs)
● Automatic upgrade of the SINAMICS Integrated

The updated data is transferred to the project and the entire project saved.

8.3.8 Upgrading technology packages

Overview
The SIMOTION technology packages (e.g. TP CAM, DCBlib) are available in various versions. 

You can only use the functions of the technology objects selected if the technology objects are 
available in the target system. You can select the technology packages and their version for 
each SIMOTION device. Each version of SIMOTION SCOUT has a kernel (FW version) for the 
SIMOTION CPU and an appropriate technology package.     

TPs during upgrades
Device replacement (in HW Config), platform replacement (XML export/import), or even 
upgrades may cause versions of SIMOTION technology packages (TPs), which are assigned 
to individual technology objects (TOs), to change.

● The TP version may change if the main version changes.
The TP version depends on the relevant main version in all cases; it may, however, remain 
unchanged through a number of main versions.

● If service packs and hotfixes are installed, there may even be a selection of TP product 
versions available for the same TP version.

During device replacement (in HW Config) the TP version is automatically updated. If the TP 
version is changed and more than one version of the new TP version is available, the latest 
version is automatically installed. If another product version is preferred, this must be set 
manually (e.g. selection of V4.1.5.3).

During platform replacement (XML Export/Import) , however, the required technology package 
including the TP version and, if necessary, the product version must be selected manually after 
the import. 

When a SIMOTION CPU is inserted, the TP CAM (latest TP version and product version) is 
preset by default.
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Special displays in the "version" field:

● "Select" means that no TP product version has been selected; this state occurs when older 
projects, in which the selection of a specific product version was not supported, are 
upgraded. If the project is loaded to the CPU without having previously made a selection, 
then the latest available technology package is loaded automatically.

● "---" means that no version can be determined (e.g. for the TP DCBlib or for older CPU 
versions < V4.1). If no version can be determined, you must select "---".

Selecting the TP product version
The desired technology package is selected with fine granularity in SIMOTION SCOUT at 
"Target device" > "Select technology packages ...".

Figure 8-7 Selecting technology packages (based on the example of the D410-2)

Note

Device diagnostics can provide information on which technology package product version has 
been loaded to a CPU. 
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Loading technology packages to the target device
Technology packages are only loaded to the target device if no technology package has been 
loaded so far or if "Load to file system" is executed.

If a technology package version changes, the technology package must be explicitly reloaded 
to the target device. To do this, proceed as follows:

1. Select "Download project to target system" in SIMOTION SCOUT.

2. Select the "Replace product versions of the technology packages" option at "Additional CPU 
options" and confirm with "OK".

For further information, please see the online help for SIMOTION SCOUT.

8.3.9 Upgrading the device version of SINAMICS S120 Control Units

Overview
You can upgrade the device versions of SINAMICS S120 Control Units that are connected to 
the SIMOTION D via PROFIBUS or PROFINET in the SIMOTION SCOUT. The SINAMICS 
version can only ever be upgraded in a project; it cannot be downgraded.   

Note

During device replacement in HW Config, the SINAMICS version of the SINAMICS Integrated 
of the SIMOTION D410-2 is automatically upgraded.

During module replacement in HW Config, the selection of a SIMOTION D410-2 module 
always defines the SIMOTION and the SINAMICS version. 

If a SINAMICS S120 Control Unit is connected via PROFIBUS or PROFINET, the SINAMICS 
version can be selected independently of the SINAMICS Integrated version.
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Procedure
To upgrade a SINAMICS drive unit, proceed as follows:

1. Right-click the relevant device, e.g. the SINAMICS S120 CU310‑2 DP.

2. Select "Target device" > "Upgrade Device Version/Characteristic" in the context menu.
The "Upgrade Device Version/Characteristic" dialog box is displayed. It lists all available 
firmware versions. 

Figure 8-8 Upgrading the device version

3. Select the desired device version/characteristic and click "Upgrade".
This upgrades the SINAMICS S120 Control Unit. 

8.3.10 Upgrade the libraries
Depending on the configured properties of the libraries used in the project (device-dependent 
or device-independent), an upgrade of the libraries may be required if the SIMOTION device or 
the device version changes.     

1. Open the LIBRARIES directory in the project navigator.

2. Select a library, right-click to open the context menu, and select "Properties...."

3. Select the "TPs/TOs" tab in the "Properties" window.

4. Select the SIMOTION device and the technology packages for which the library is to be 
valid.

5. Close the dialog box with "OK".

Note

Please also observe the notes on device-dependencies in the SIMOTION SCOUT online 
help.
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8.3.11 Save project, compile and check consistency

Procedure
1. Save and compile the project from the "Project" > "Save and recompile all" menu.

2. Then perform a consistency check with the "Project" > "Check consistency" menu.

If error messages occur, correct these and repeat the operation.

Note

Note the difference between 
● "Save and recompile all" and
● "Save and compile changes"

Save and recompile all
All sources of the entire project are recompiled with this command.

The command is suitable if you are quite sure that all the old data from older SCOUT versions 
should be removed and replaced with new compilation results. 

Use this command if you specifically want to convert a project from an earlier SCOUT version 
to a newer version. In this way, you take over all error corrections and optimizations. 

Save and compile changes
On this command, the whole project is searched for changes. Therefore only the changes are 
compiled. Use this command for day-to-day operations within a SCOUT version.

8.4 Performing a firmware and project update

8.4.1 Upgrading the boot loader on the CompactFlash card
The boot loader may have to be upgraded in the following cases:

● Upgrade of the SIMOTION D

● If a D4x5‑2 CF card is to be used for a D410‑2 (or vice versa).

● Error corrections and optimizations

Generally, we recommend using the latest boot loader available for the respective CF card.

Upgrading the SIMOTION D410‑2 may also render it necessary to upgrade the boot loader of 
the CF card.     

Detailed information on the CF card, boot loader version, SIMOTION D410-2 hardware, and 
SIMOTION firmware version compatibility relationships can be found in the software 
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compatibility list at Internet address (https://support.industry.siemens.com/cs/ww/en/view/
18857317).

8.4.2 Update - preparatory measures

Upgrading the SIMOTION D410‑2
The actions described in this section also apply to downgrading to an older version.     

Various options are available for performing a firmware and/or project update on the 
SIMOTION D410‑2:

● Update via CompactFlash card (Page 265)

● Update via SIMOTION IT web server (Page 262)

● Firmware and project update using the device update tool (Page 262)

Note

Upgrading using the device upgrade tool offers a number of advantages (keeping retain 
data, option of downgrading, no license key handling, etc.).

We therefore recommend using this method for firmware and/or project updates.

Requirement (firmware update)
The current firmware for SIMOTION D can be found on the Internet at Internet address (https://
support.industry.siemens.com/cs/ww/en/view/31045047).

Upgrading the SIMOTION D410‑2 automatically upgrades the firmware of all connected 
SINAMICS DRIVE-CLiQ components.       

Note

Observe the information in the the Read Me files and the upgrade instructions included in the 
scope of delivery of new SIMOTION versions.

Use only CF cards that have been approved for use with the SIMOTION D410‑2 and whose 
boot loader version is correct.

You can find the compatibility relationships in the software compatibility list at Internet address 
(https://support.industry.siemens.com/cs/ww/en/view/18857317).

NOTICE

The upgrade operation deletes all project data and parameters from the CF card!

Back up the data before starting an upgrade.
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Requirement (project update)
You have updated your project and, if necessary, adapted the device type and device version. 
See section Customizing the project (Page 249).   

8.4.3 Update via SIMOTION IT web server
SIMOTION D410-2 has an integrated web server.       

In addition to customized web pages and comprehensive device/diagnostic information, 
SIMOTION IT web server also allows you to update the firmware and project using a standard 
PC with a web browser. 

You will find detailed information in the SIMOTION IT Diagnostics and Configuration 
Diagnostics Manual.

8.4.4 Upgrade via device update tool (upgrading SIMOTION devices)

Overview
SIMOTION D Control Units and projects can be upgraded using previously created upgrade 
data.

Performing an upgrade using upgrade data has the following advantages:

● User-friendly creation of upgrade data via SIMOTION SCOUT with the aid of a wizard (at the 
machine manufacturer's site)

● SIMOTION devices can be upgraded by the machine operator without the SIMOTION 
SCOUT engineering system

● The machine manufacturer can conveniently send upgrade data via e-mail or post to the 
machine operator

● There is no need to use license keys, as licenses are retained

● Retain data and unit data is retained when upgrades are performed, even across versions

● An upgrade which has been imported can be discarded again, and the previous 
configuration restored

● You can upgrade either a single SIMOTION device or multiple devices from one or more 
SIMOTION projects.

● It is possible to upgrade parts of a configuration only, e.g. Technology Packages only, 
firmware only, project only, etc.
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Handling
Upgrade data is created by the application engineer at the machine manufacturer's premises 
using SIMOTION SCOUT. The upgrade data can then be handled flexibly depending on both 
the SIMOTION device in question (SIMOTION C, D, or P) and the customer requirements:

● Creating upgrade data and then copying it to a storage or upgrade medium:

– CF card

– USB stick (D4x5/D4x5-2 only; not for D410‑2)

– Upgrade file for the SIMOTION IT web server

● Alternatively, the upgrade data can be created and stored in an archive on the PC, with a 
view to importing it to an upgrade medium suitable for SIMOTION devices at a later point.

● The process of importing the data to an upgrade medium can be performed at the machine 
manufacturer's premises; alternatively, if the upgrade archive has been transferred to the 
machine operator, the service engineer can do this on site.

● The service engineer imports the upgrade data on an operator-guided basis (without any 
involvement by the application engineer) to the SIMOTION device(s), and upgrades the 
SIMOTION devices in the process (SIMOTION SCOUT is not required on site).

Note

If a SIMOTION D410-2 is upgraded with an upgrade archive of a SIMOTION D4x5-2, the 
upgrade and the later downgrade fail. In this case, a correct card image (firmware incl. project) 
must be loaded to the CF card. 

Upgrading with a CF card
1. Switch off the SIMOTION D410‑2 to be updated.

2. Insert the CF card into the SIMOTION D410‑2.

3. Switch on the SIMOTION D410‑2 again. The SIMOTION D410‑2 starts to process the 
upgrade data.
The SF/BF LED flashes green (0.5 Hz) during the upgrade.

4. Monitor the green flashing of the SF/BF LED.

– As soon as the upgrade has been completed successfully, the SF LED goes out.
An automatic power-up with the upgraded configuration is then performed 
(SF/BF LED display then depends on the associated operating state of the device).

– If the upgrade was not successful, the SF/BF LED flickers red.
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Downgrading
If the upgrade has not been successful (for example, the machine is not behaving as desired), 
the upgrade can be undone as follows:

1. Switch off the SIMOTION D410‑2.

2. Set the service selector switch to the switch position B (service mode: downgrade).

Figure 8-9 Service selector switch, switch position for downgrading

3. Switch the D410‑2 on again.
The flickering green SF/BF LED indicates that restoration is requested.

4. Set the service selector switch back to position "0."
The system restores the data saved during the upgrade. The data from the upgrade will be 
deleted.

The downgrade is indicated by a green flashing SF LED (0.5 Hz) and can take several minutes. 
After successful restoration, the module starts up automatically. (SF/BF LED display will then 
depend on the respective operating state of the device).
If the restore was not successful, the SF/BF LED will flicker red.

Note

For SIMOTION < V4.4, restoration will start when the module is switched on (step 3). For this, 
the service selection switch must be rotated to position "0" immediately when the flashing code 
is displayed (SF/BF LED flashes green with 0.5 Hz).
If the service selector switch is not reset or not reset in good time to "0," this results in fault state 
"Service selector switch is still set to restore" (SF/BF LED flickers red).
In this case, switch the D410‑2 off, reset the service selector switch and switch the D410‑2 on 
again. If the restoration was otherwise successful, the D410‑2 boots up with the restored 
configuration.

Note

The components' firmware is automatically updated, depending on the firmware version on the 
SINAMICS components and on the CF card. During a firmware update, please heed the 
messages and alarms in the SIMOTION SCOUT detail window. A firmware update on the 
SIMOTION D410‑2 is signaled by the RDY LED flashing yellow, while on the DRIVE-CLiQ 
components (TM, SMC, etc.) it is signaled by the RDY LED flashing red/green.
● FW update running: RDY LED flashes slowly (0.5 Hz)
● FW update complete: RDY LED flashes quickly (2 Hz), POWER ON required

Components that require a POWER ON after the firmware update will indicate this through a 
rapidly flashing RDY-LED. Go offline with SCOUT and switch the 24 V supply off/on (POWER 
ON) at the respective components for initialization.
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Additional references
You will find detailed information for the device upgrade in the Upgrading SIMOTION Devices 
Operating Instructions.

8.4.5 Update via CompactFlash card

8.4.5.1 Backup of CompactFlash card data

Backing up licenses, retain data, and user data
Prior to upgrading/downgrading firmware, as a precaution we would generally recommend 
backing up the entire content of the CF card to the PG/PC using the card adapter and Windows 
Explorer.

How you should proceed to back up and subsequently restore data on the CF card depends on 
whether the CF data contains any licenses and/or other retain data and user data which will be 
required again in the future.     

Case 1: The CF card contains no licenses and no retain or user data that is still required
You do not need to take any steps in this case. Delete the contents of the CF card and install 
the firmware as described.

Case 2: The CF card contains licenses (e.g. axis licenses)
Before loading the new firmware, back up the "KEYS" directory to your PC. This can then be 
copied back to the CF card once you have installed the new firmware.

Note

The license key is stored in the "KEYS" directory on the CF card. When the SIMOTION device 
starts up for the first time, the license key is saved in the boot sector of the CF card. 

A license key saved in the boot sector cannot be deleted by means of a user operation; nor can 
it be deleted by formatting the CF card or rewriting the boot loader.

If the Keys.txt file is no longer present on the CF card (because the "KEYS" directory has been 
deleted, for example), it will be written again from the boot sector to the "KEYS" directory while 
the SIMOTION device is starting up. The license key can be changed at any time (by 
relicensing, for example). When the device is next started up, the license key will be saved in 
the boot sector again.

If you lose the license key, you can get it back via the Web License Manager on the Internet, 
at Internet address (http://www.siemens.com/automation/license). You require the hardware 
serial number printed on the CF card to do this. In the Web License Manager, you have the 
option of displaying the associated license key.
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Case 3: The CF card contains retain data / user data that is still required in the future
If you are using your application to back up data to the CF card, you must back this up before 
upgrading the new firmware.

Example: 

● Backing up retain data (non-volatile data saved using _savePersistentMemoryData):

– user\simotion\pmemory.xml

● Backing up SIMOTION IT user files, settings (e.g. trace.xml), task trace data, log files, and 
Java files (classes, archives, user data system, etc.), stored in the following directories:

– user\simotion\hmicfg

– user\simotion\hmi

● Backing up configuration data for modular machines in conjunction with the 
_activateConfiguration system function, stored in the following directory:

– install\simotion

● Backing up unit data (data saved on the CF card using _saveUnitDataSet/
_exportUnitDataSet), stored in the following directory:

– user\simotion\user dir\<unitname>

Note

When a version is changed, you must use the "Save variables" function to back up data 
saved using _saveUnitDataSet or _exportUnitDataSet in a way that is not dependent on 
the version. You then have the option of restoring them using "Restore variables."

During an upgrade, the two functions are required only for the backup and restore of unit 
data records created with _saveUnitDataSet.

Retain and unit data (saved with _exportUnitDataSet) remain valid even after a version 
upgrade.

8.4.5.2 Firmware update using a CompactFlash Card

Procedure
Proceed as follows to perform the upgrade:

1. Switch off the power to the SIMOTION D410‑2.

2. Remove the CF card from the SIMOTION D410‑2 and insert it into the CF card adaptor of 
your PC.

3. Open Windows Explorer. The CF card must be visible as a removable data carrier in the 
Windows Explorer under an arbitrary drive letter.

4. If necessary, back up the licenses, retain data and user data on the CF card to your PC 
(see Backup of CompactFlash card data (Page 265)).

5. Delete all the data from the CF card.
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6. Unzip the firmware file to the CF card using a ZIP file utility such as WinZip. Always maintain 
the file structure when setting up the unpacking tool.

7. Copy the data saved in step 4 back to the appropriate folder structure on the CF card.

8. Remove the CF card from the CF card adapter on your PG/PC.

9. Insert the CF card into the SIMOTION D410‑2.

10.Switch on the power supply for the SIMOTION D410‑2. The new firmware is loaded from the 
CF card to the SIMOTION D410‑2 module.

8.4.5.3 Upgrading SINAMICS
Depending on the settings, the SINAMICS components are also automatically upgraded to the 
component version of the CF card with a firmware update of the SIMOTION D.

In order for a FW update to be performed for all components, the components must be correctly 
connected in accordance with the configured topology.

The CONTENT.TXT file in the main directory of the CF card contains the component version.

Upgrading the firmware of SINAMICS components automatically
When starting up, the system automatically upgrades or downgrades all DRIVE-CLiQ 
components to the version of the component firmware on the CF card. Components that cannot 
be downgraded to the component firmware version on the CF card (for example, old firmware 
on the CF card and new components to which the old firmware cannot be loaded) retain their 
firmware version. The resulting firmware version combinations are always functional.   

Note

The components' firmware is automatically updated, depending on the firmware version on the 
SINAMICS components and on the CF card. During an FW update, please take note of the 
messages and alarms in the SIMOTION SCOUT detail window. A firmware update on the 
SIMOTION D410-2 is signaled by the RDY LED flashing yellow, while on the DRIVE-CLiQ 
components (TM, SMC, etc.) it is signaled by the RDY LED flashing red/green.
● FW update running: RDY LED flashes slowly (0.5 Hz)
● FW update complete: RDY LED flashes quickly (2 Hz), POWER ON required

Components requiring POWER ON following a firmware update signal this by means of the fast 
flashing RDY LED. Go offline with SCOUT and switch the 24 V supply to the relevant 
components off/on (POWER ON) to initialize.
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Updating the firmware of the SINAMICS components
The SINAMICS components' firmware is updated automatically, depending on the setting of 
parameter p7826.   

● p7826 = 0: Upgrade/downgrade deactivated

● p7826 = 1: Upgrade and downgrade (factory setting)

● p7826 = 2: Upgrade only

Note

The automatic FW update via p7826 = 1 (upgrade and downgrade) must not be deactivated 
when Safety Integrated is used.

If you are updating the firmware manually, proceed as follows:     

1. Select the SINAMICS component in the Project Navigator, e.g. SINAMICS Integrated.

2. Double-click "Overview" in the Project Navigator.
The "SINAMICS_Integrated - Overview" dialog box opens with a list of available drive 
objects.

3. Click "Version overview" to open the list of connected SINAMICS components.

4. Go online and select the devices whose firmware you wish to update.
The list displays the current firmware version of the devices.

5. Click "Firmware update" to download the new firmware to the devices. To do so, you must 
select all components whose firmware is to be updated.

6. When the firmware update is complete, switch the 24 V power supply off and back on again. 
The device is now ready for operation.

Note

The SINAMICS components must be configured for a firmware update to take place. The 
firmware cannot be updated if the components have not been configured.

You can also update the firmware using the expert list. See the SINAMICS S120 
Commissioning Manual for a description of how to do this.

8.4.5.4 Download project to target system
Once all the changes required for upgrading your project have been made, you must download 
the project to the SIMOTION D410-2.     

Requirement
The firmware required is located on the CompactFlash card; for information, refer to the section 
titled Firmware update using a CompactFlash Card (Page 266).

You have recompiled the project and checked it for consistency. See Section Save project, 
compile and check consistency (Page 260).
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Procedure
1. Save and compile the project.

2. Click "Connect to selected target systems" to establish a connection to the target system.

3. Execute "Download project to target system" and then "Copy RAM to ROM" to download the 
upgraded project to the CompactFlash card as well.

4. Because of the automatic follow-up configuration in the SINAMICS Integrated drive, you 
must now execute "Load CPU / drive unit to PG".

5. Save the project.

Note

When upgrading SINAMICS drive units (e.g. SINAMICS Integrated) only the p parameters 
(setting parameters) are loaded into the upgraded project. The r parameters (monitoring 
parameters) are not loaded.

The r parameters in the drive unit are derived or calculated from an automatic subsequent 
parameterization and must therefore be uploaded to the project.

To do this, execute "Load CPU/drive unit to PG".

If the upload cannot be performed, this can lead to inconsistencies in the drive parameterization 
dialog boxes.

8.5 SIMOTION CompactFlash card

8.5.1 Changing the CompactFlash card

Requirement

NOTICE

Damage to the CompactFlash card from electrical fields or electrostatic discharge

The CompactFlash card is an ESD-sensitive component.

De-energize the SIMOTION D410‑2 device before inserting or removing the CompactFlash 
card. The SIMOTION D410‑2 is in a de-energized state when all the LEDs are OFF.

Comply with the ESD rules.
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Procedure
To change the CF card, proceed as follows:     

1. Switch off the power supply.

2. Remove the CF card from the plug-in slot on the SIMOTION D410-2.
To do this, grasp the gripping cavity between your thumb and forefinger and pull the card out.

3. Gently insert the new CF card into the empty plug-in slot until it clicks into place. The 
direction of insertion of the CF card is indicated by an arrow located on both the plug-in slot 
and the CF card.
The properly inserted card does not protrude from the SIMOTION D410-2 housing.

4. Switch the power supply on again.

8.5.2 Writing to a CompactFlash card

Overview
You have the following options of writing data to a CompactFlash card:

● Writing to a CompactFlash card that is inserted in a SIMOTION D
The PG/PC must be online to SIMOTION D410-2 in order to execute this function.

● Writing to a CompactFlash card without a SIMOTION D module
This function requires a CompactFlash card adapter.     

Note

CompactFlash cards are always shipped in formatted state. It contains the 
SIMOTION Kernel (SIMOTION D firmware).

Trouble-free operation of the CompactFlash card can only be guaranteed if you do not 
modify its partitioning.

Writing to a CompactFlash card that is inserted in the SIMOTION D
The CompactFlash card can be used as storage volume for technology and user data 
(programs, configuration data and parameters) from the "volatile data" area. Proceed as 
follows:

1. Establish the connection between the SIMOTION D410-2 and the PG/PC (see 
Section Creating a project and configuring the communication (Page 87)).

2. Select the "Copy RAM to ROM" command in SIMOTION SCOUT to write the data to your 
CompactFlash card.    
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Writing to a CompactFlash card without a SIMOTION D module
A CompactFlash card adapter must be installed on the PG/PC and can be used to write data 
to the CompactFlash card. Always save your project data to CompactFlash card using the PG/
PC before you update the SIMOTION firmware, for example.     

Note

Do not use any of the onboard tools in Windows to modify or delete files which were written to 
the CompactFlash cardCompactFlash card using the "Copy RAM to ROM" function in 
SIMOTION SCOUT. Such actions may irrevocably destroy your project.

8.5.3 Formatting the CompactFlash card
You can format a faulty CF card, for example.

Before formatting the CF card, please observe the notes in Section Backup of CompactFlash 
card data (Page 265).

Proceed as follows to format the CF card:       

1. Insert the CF card into a CF card adapter connected to your PG/PC.

2. Format the CF card in Windows (FAT, FAT16 or FAT32 file system).
The CF card is formatted.

3. If the CF card boot loader is also defective, you will have to rewrite it.

Note

The CF card may not formatted with NTFS.

The following formats are permitted: FAT, FAT16 and FAT32.

Because of the improved memory utilization on the CF card, FAT32 formatting is preferable. 
SIMOTION D410-2 CF cards are supplied as standard with FAT32 formatting.

8.5.4 Boot loader on the CompactFlash card

Writing a boot loader
A boot loader may need to be written in the following situations:   

● A new boot loader is required for the used SIMOTION D410‑2 firmware version.

● A new boot loader is required for the used SIMOTION D410‑2 hardware.

● The boot loader is defective.

● A D4x5‑2 CF card is to be used for SIMOTION D410‑2.

The boot loader version can be fetched using SIMOTION SCOUT device diagnostics. If this is 
not possible, the boot loader version may be incorrect.

Service and maintenance
8.5 SIMOTION CompactFlash card

SIMOTION D410-2
Commissioning and Hardware Installation Manual, 04/2019, A5E33446807B 271



A potential fault description could be as follows:
The SIMOTION D410‑2 does not power up, the RDY LED flashes red at 0.5 Hz and the RUN/
STOP LED lights up red, or all the LEDs remain off.
In this case, replace the boot loader version with the current version.

Use the "Options > Write boot sector..." function to write the boot loader version in SIMOTION 
SCOUT to the CF card.

Note

You require PG/PC administrator rights to write to the boot sector. If you do not have 
administrator rights on your PG/PC, an administrator can enter an administrator login for you 
to use this function at "Options" > "Settings" > "Rights."

Detailed information on the CF card, boot loader version, SIMOTION D410-2 hardware, and 
SIMOTION firmware version compatibility relationships can be found in the software 
compatibility list at Internet address (https://support.industry.siemens.com/cs/ww/en/view/
18857317).

Note

Note that the CF cards for SIMOTION D4x5‑2 and D410 can have a different boot loader!

8.5.5 Recommended method of handling CompactFlash cards

Handling CF cards correctly
Note the following points when working with the CF card:     

● The CF card may only be inserted or removed when the system is de-energized.

NOTICE

Damage to the CompactFlash card from electrical fields or electrostatic discharge

The CompactFlash card is an ESD-sensitive component.

De-energize the SIMOTION D410‑2 device before inserting or removing the 
CompactFlash card. The SIMOTION D410‑2 is in a de-energized state when all the LEDs 
are OFF.

Comply with the ESD rules.

● CF cards are not designed to be rewritten as many times as the user wishes.
With this in mind, you should avoid writing user data from the application to the CF card 
cyclically. Depending on the system, a write operation from the application may trigger one 
or more write operations on the CF card.
We therefore recommend that the user program does not make more than 100,000 write 
accesses over the estimated service life of the application.
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● Never switch off the SIMOTION D Control Unit during write accesses to the CF card. If the 
SIMOTION D Control Unit is switched off during write accesses, this can result in destruction 
of the data and, in the worst case, to damage to the file system (FAT Table = directory) on 
the CF card. 
If the FAT table is destroyed, the CF card will have to be reformatted and the firmware/user 
data reloaded. During this process the licenses remain on the CF card.
The FAT table can be destroyed if updating the FAT table is interrupted by switching off the 
SIMOTION D Control Unit. The FAT table is updated, for example, by functions such 
as _exportUnitDataSet, copy RAM to ROM, or save SINAMICS NVRAM data via p7775.
The FAT table can also be destroyed if you pull a CF card out of a CF card adapter while 
Windows is accessing the CF card. 

● The following functions do not update the FAT table:

– _saveUnitDataSet (writing the data to an existing file)

– savePersistentMemoryData (as of V4.4: writing the data to an existing file) 

Once the backup files have been created with _saveUnitDataSet / 
savePersistentMemoryData, this also results in updating the FAT table. 

8.5.6 Card reader for CompactFlash cards
Because of the quickly changing market and the large differences in the quality of card readers, 
no specific recommendation can be made (except for the following card reader). 

If problems occur identifying the CF card, this may be due to an incorrect power up of the card 
reader.

Designation and ordering data

Card reader for CF/SD memory media 
with USB connection
Article number: 6FC5 335-0AA00-0AA0

8.5.7 License key on the CF card
Depending on the type and number of runtime functions used in the project, licenses must be 
purchased as part of the licensing procedure for SIMOTION.  

For further information on the licensing of runtime functions, see (https://
support.industry.siemens.com/cs/en/en/view/42014324) 

The licenses required for SIMOTION D are assigned to an individual license key for the CF card 
(license key cannot be transferred to another CF card).  

The license key must be stored in the \KEYS\SIMOTION directory in the keys.txt file on the CF 
card.
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Backup in the boot sector 
The license key is stored in the "KEYS" directory on the CF card. When the SIMOTION D 
Control Unit is ramped up for the first time, the license key is backed up in the boot sector of the 
CF card. 

A license key saved in the boot sector cannot be deleted by means of a user operation; nor can 
it be deleted by formatting the CF card or rewriting the boot loader. 

If the keys.txt file is no longer present on the CF card (e.g. because the "KEYS" directory has 
been deleted), it will be written again from the boot sector to the "KEYS" directory while the 
SIMOTION D Control Unit is ramping up. The license key can be changed at any time (e.g. 
through relicensing). At the next power-up, the license key is backed up in the boot sector again.

Loss of the license key
In the event of the loss of a license key, a copy can be obtained via the Web License Manager 
at the following Internet address (http://www.siemens.com/automation/license). You require 
the hardware serial number printed on the CF card to do this. You can display the associated 
license key in the Web License Manager. The license file (Keys.txt) is also offered as download.

Notes for Keys.txt 
● If a firmware card image is unpacked on the CF card, a KEYS directory is not available per 

default.

● If the CF card ramps-up without a KEYS directory in a controller, an empty file structure 
(\KEYS\SIMOTION) is created. 

● The keys.txt must be stored in this directory (\KEYS\SIMOTION\keys.txt). 

● If the directory contains a keys.txt with an invalid license key, this is deleted from the keys.txt 
when the controller ramps up, i.e. the keys.txt file exists, but is empty. 

● If the directory contains a keys.txt with a valid license key, this is also stored in the boot 
sector of the CF card as backup when the controller ramps up.  

● The keys.txt can be written online via SCOUT, with a CF card reader, or via a set up remote 
access (FTP). 

● When licensing via the Web License Manager, you receive a keys.txt that you must store on 
the CF card under \KEYS\SIMOTION 

● It is also possible to create this text file yourself (without formatting) with a text editor (e.g. 
Notepad). In this case, make sure that only the license key and a line break (CR/LF) is 
contained in the file.  

● If the SF LED flashes slowly in red (0.5 Hz) after the control has ramped up, then either the 
keys.txt file is faulty (error in the license key, formatting or file/directory name) or the 
licensing is not adequate for the used objects that require a license.
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Diagnostics 9
9.1 Diagnostics via LED displays

Overview
The status LEDs display the operating states or fault states of SIMOTION D410-2. They do so 
by illuminating, flashing, or flickering in different colors.

Arrangement of LED displays
The front side of the SIMOTION D410-2 has four LED displays arranged vertically one above 
the other.

Figure 9-1 LED displays: D410‑2 DP (pictured on the left), D410‑2 DP/PN (pictured on the right)

Legend of the LED states
The LED displays can assume the following illumination states.

Table 9-1 Table with explanation of the LED states

Symbol Meaning
1 LED static ON
0 LED off
0.5/1 LED flashes at 0.5 Hz:
2/1 LED flashes at 2 Hz:
Λ LED flickers
x Any LED state
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LED displays
The two tables below provide an overview of all relevant LED display combinations. Every LED 
can illuminate in yellow, red, or green. The color which corresponds with the LED signal state 
is also defined.

Table 9-2 SIMOTION D410‑2 DP and D410‑2 DP/PN: Diagnostics by means of LED display     

Meaning Display 
priority 1)

RDY RUN/STOP OUT>5V
OUT>5V/SY 2)

SF/BF:

States during power-up
Hardware reset
Power-up of the D410‑2 without a 
CF card or power-up with a CF card 
(CF card with incorrect / missing / 
faulty boot loader or without a valid 
operating system)

1 1
(yellow)

1
(yellow)

1
(yellow)

1
(yellow)

Firmware error
● No or incorrect firmware on the 

CF card
● File system of the CF card is 

destroyed (e.g through power 
off during writing operation)

x 3) 2/1
(red)

0 0 2/1
(red)

Firmware checked (checksum in‐
correct)

x 3) 0.5/1
(red)

0 0 0.5/1
(red)

Firmware being loaded x 3) Λ
(yellow)

0 0 1
(red)

SIMOTION states
Write/read SIMOTION access to 
CF card

1 Λ
(yellow)

x x x

"FAULT" state (F state)
Fault to which the user program 
(SIMOTION) cannot respond (e.g. 
overtemperature).
The following actions may be re‐
quired to rectify the fault:
● Power OFF/ON
● Check of the CF card
● Re-commissioning
● Replace the SIMOTION D410-2

2 Λ 
(red)

Λ 
(red)

Λ 
(red)

Λ 
(red)
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Meaning Display 
priority 1)

RDY RUN/STOP OUT>5V
OUT>5V/SY 2)

SF/BF:

DCP flashing (for interface X150, 
X127)
This function is used to check the 
correct assignment to a module 
and its interfaces. 
DCP flashing of the module is acti‐
vated in HW Config under "Target 
system" > "Ethernet" > "Edit Ether‐
net node" > "Browse" button > 
"Flashing" button

3 x x x 2/1
(green)

PROFIBUS DP interface bus error
● PROFIBUS master: At least 

one slave is missing
● PROFIBUS slave: No 

parameter assignment master 
available

4 x x x 2/1
(red)

Communication error PROFINET 7) 4 x x x 2/1
(red)

An interrupt that can be acknowl‐
edged (alarm, message, note) is 
pending

5 x x x 1
(red)

Underlicensing of 
technology/option objects

6 x x x 0.5/1
(red)

SIMOTION ready for operation 6 x Static/flashing
(green or yel‐

low)

x x

RUN 6 x 1
(green)

x x

Transition from STOP/STOPU to 
RUN

6 x 2/1
(green)

x x

STOP/STOPU 6 x 1
(yellow)

x x

Transition 
● from RUN to STOP/STOPU
● STOP to STOPU
● STOPU to STOP

6 x 2/1
(yellow)

x x

Service operating state 
(axis control panel in the STOPU/
measuring function)

5 x 2/1
(yellow/green)

x x

General reset requested by SIMO‐
TION D410‑2 or with the mode 
switch

5 x 0.5/1
(yellow)

x x

General reset in progress 5 x 0 x 0
General reset stopped (STOP) 6 x 1

(yellow)
x x

States of the SINAMICS Integrated (LED RDY)

Diagnostics
9.1 Diagnostics via LED displays

SIMOTION D410-2
Commissioning and Hardware Installation Manual, 04/2019, A5E33446807B 277



Meaning Display 
priority 1)

RDY RUN/STOP OUT>5V
OUT>5V/SY 2)

SF/BF:

Updating the firmware of the 
DRIVE-CLiQ components

6 0.5/1
(yellow)

x x x

Firmware update of the connected 
DRIVE-CLiQ components has 
been completed (Power OFF/ON 
of the upgraded/downgraded devi‐
ces is required)

6 2/1
(yellow)

x x x

Detection of the components via 
LED
Note: The displayed color combi‐
nation depends on the p0124[0] pa‐
rameter 
=1 yellow/green flashing
=0 yellow/red flashing

6 2/1
(yellow/green)
(yellow/red)

x x x

Commissioning/reset 6 0.5/1
(green)

x x x

Write/read SINAMICS access to 
CF card

6 Λ
(yellow)

x x x

SINAMICS Integrated ready for op‐
eration

6 1
(green)

x x x

SINAMICS Integrated in fault state
(Check parameterization/configu‐
ration)

6 2/1
(red)

x x x

Underlicensing 
SINAMICS functions 6)

6 x x x 0.5/1
(red)

SIMOTION IT service mode / 
switch position 8 for 120 minutes.

6 x x x 0.5/1
(red)

Backing up and restoring diagnostic data and non-volatile SIMOTION data
Backing up diagnostic data and 
non-volatile SIMOTION data (back‐
up running)

4 x Λ
(yellow)

x x

Backing up diagnostic data and 
non-volatile SIMOTION data (back‐
up completed)

4 x Λ
(green)

x x

Request: "Restore non-volatile da‐
ta" (with switch position "A")

4 x x x Λ
(green)

Upgrading SIMOTION devices (device update tool)
Restoration requested  x x x Λ

(green)
Upgrade/downgrade running  x x x 0.5/1

(green)
Upgrade/downgrade completed 
with error

 x x x Λ 
(red)

Upgrade/downgrade completed 
without error 

 x x x 0 4)
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Meaning Display 
priority 1)

RDY RUN/STOP OUT>5V
OUT>5V/SY 2)

SF/BF:

Encoder power supply 5)

The electronics power supply is 
missing or outside the permissible 
tolerance range. Power supply 
≤ 5 V. Use of an encoder with 5 V 
power supply.

 x x D410‑2 DP:
0

x

D410‑2 DP/PN:
0
1

2/1
(green)

Electronics power supply for meas‐
uring system available. Power sup‐
ply >5 V.
Notice: Always ensure that you can 
operate the connected encoder on 
a 24 V power supply (e.g. HTL en‐
coder). Operation of a 5 V encoder 
on the 24 V encoder supply may 
result in the destruction of its elec‐
tronic components! This setting 
can be selected in the expert list of 
the drive in parameter p0405.1.

 x x D410‑2 DP:
1

(yellow)

x

D410‑2 DP/PN:
0.5/1

1
2/1

(yellow)

1) Priority of the displays: The displays always visualize the state assigned the highest priority. "1" has the highest priority. The 
state of the next lower priority class is displayed after the cause of the previous signal state was eliminated. If a state does 
not have any specified priority, no other state other than the associated state can occur.

2) Labeling of LEDs:
D410‑2 DP: OUT>5V
D410‑2 DP/PN: OUT>5V/SY

3) States occur in succession during power-up.
4) The upgrade or downgrade has been completed when the SF/BF LED goes out. The device then powers up automatically 

in the upgraded or downgraded configuration (the SF/BF LED display then depends on the operating state of the device).
5) The "OUT>5V" or "OUT>5V/SY" LED display indicates whether the encoder supply level is > 5 V. In the case of SIMOTION 

D410‑2 DP/PN, not only is the configured encoder supply indicated, but also the state of PROFINET interface 
synchronization to the send cycle clock. See the following table.

6) In the case of SINAMICS licenses (e.g. SINAMICS DCB Extension), underlicensing of SINAMICS Integrated via the flashing 
SF‑LED is indicated on the SIMOTION D Control Unit. An entry is also made in the diagnostic buffer and the underlicensing 
is displayed in the license dialog box of SIMOTION SCOUT. The licensing is effected (like for SIMOTION licenses) via 
SIMOTION SCOUT or via the SIMOTION license key on the CF card.

7) PROFINET communication error
As IO controller:
- Failure of a connected I/O device
- At least one of the assigned I/O devices cannot be addressed
- Incorrect or no configuration
As I‑Device:
The LED flashes until at least one controller has correctly established communication with this I‑Device.
Possible causes:
- IP address is incorrect
- Incorrect configuration / parameterization
- IO controller not available / switched off, but Ethernet connection is established.
- In Shared IDevice operation: All configured IO controllers are not available / switched off, but Ethernet connection is 
established (link established to a neighboring device)
- Incorrect or missing device name
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- The response monitoring interval has elapsed
- The CPU is I‑Device and the communication to the higher-level controller fails

Table 9-3 SIMOTION D410‑2 DP/PN: SYNC state of the PROFINET IO interface diagnosed via the OUT>5V/SY LED 
display 

Meaning SYNC state LED display1)

Encoder supply ≤ 5V Encoder supply > 5V
The PROFINET interface has not synchronized yet to the send 
cycle clock of PROFINET IO with IRT, or PROFINET IO with 
IRT has not been configured (e.g. only PROFINET IO with RT 
or TCP/IP communication).
If IRT data has been configured for SIMOTION, the PROFINET 
interface generates a local substitute cycle clock as long as 
there is no synchronization to the send cycle clock of PROFI‐
NET IO with IRT:
SIMOTION task system has synchronized to the local substi‐
tute cycle clock of the PROFINET interface. SINAMICS Inte‐
grated and the external isochronous DP interface are 
synchronized to the local substitute cycle clock of the PROFI‐
NET interface.

0 0.5/1
(yellow)

The PROFINET interface has synchronized to the send cycle 
clock of PROFINET IO with IRT.
If isochronous IRT data has been configured for SIMOTION, 
then the following applies: 
The task system of SIMOTION has synchronized to the send 
cycle clock of PROFINET IO with IRT. 
SINAMICS Integrated and the external isochronous DP inter‐
face are synchronized to the send cycle clock of PROFINET IO 
with IRT.
If no isochronous IRT data has been configured for SIMO‐
TION, this state indicates that only the PROFINET interface is 
synchronized to the send cycle clock of PROFINET IO with 
IRT. The PROFINET interface is then used to forward the IRT 
data.

1
(green)

1
(yellow)

The PROFINET interface has synchronized to the send cycle 
clock of PROFINET IO with IRT
If IRT data has been configured for SIMOTION, then the fol‐
lowing applies: 
The task system of SIMOTION has synchronized to the send 
cycle clock of PROFINET IO with IRT. 
SINAMICS Integrated and the external isochronous DP inter‐
face are not yet synchronized to the send cycle clock of PRO‐
FINET IO with IRT.

2/1
(green)

2/1
(yellow)

1) How the colors are assigned differs from the SYNC color code used for other SIMOTION devices.

Additional references
You will find detailed information in the Upgrading SIMOTION Devices Operating Instructions.
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LED displays of the PROFINET interface

The PROFINET ports X150 P1 and P2 have 2 integrated LEDs each for displaying link and 
activity.

Figure 9-2 PROFINET ports of the D410-2 DP/PN

Table 9-4 State of the Link and Activity LEDs

LED State Meaning
LINK OFF No or faulty connection

Lights up green Transfer rate 10 or 100 Mbit/s:
A different device is connected to port x and a physical connection exists

ACT OFF No data exchange
Flickers yellow Data exchange:

Data is being received or sent at port x.
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9.2 Diagnostic data and non-volatile SIMOTION data

9.2.1 Overview
On the basis of simple operations (e.g. by setting the switch position) and without the need for 
the SIMOTION SCOUT engineering system, you can   

● Back up diagnostic data, including non-volatile SIMOTION data (retain data) on a CF card:

– Save diagnostic data during running operation (Page 283)

– Save diagnostic data during the startup (Page 284)

● Back up HTML pages (including the most up-to-date content) to the CF card for diagnostic 
purposes; for information, see Section Diagnostics via HTML pages (Page 287).

● Restore backed-up non-volatile SIMOTION data (retain data); for information, see 
Section Delete/restore non-volatile SIMOTION data (Page 288).

9.2.2 Backup of diagnostic data and non-volatile SIMOTION data

9.2.2.1 Diagnostics data
Following a fault on a SIMOTION device, diagnostic data (e.g. diagnostic buffer content, up-to-
date content of HTML pages, etc.) can provide important information on the cause of the fault. 
For this purpose, data can be backed up to the CF card with a "simple operator action" (e.g. via 
service selector switch or DIAG button on the SIMOTION D410-2).   

You then have the following options for the diagnostic data:

● Fetching them from the CF card using a card reader

● You can load it with the SIMOTION IT web server or by FTP

You can also use them for diagnostic purposes or provide Technical Support with them for 
evaluation purposes.

Various options are available to you for backing up diagnostic data:

● Backup during operation (in STOP/STOPU/RUN operating state)

– with SIMOTION IT web server;
The web server also offers the possibility of fetching the diagnostic data online.

– Via the DIAG button

– Via the service selector switch

● Backup during the module startup

– Via the DIAG button

– Via the service selector switch

– Controlling diagnostic data creation using an INI file stored on the CF card
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9.2.2.2 Non-volatile SIMOTION data (retain data)
In addition to the diagnostic data, non-volatile SIMOTION data (retain data) is also saved on the 
CompactFlash card. Use the function when the non-volatile SIMOTION data has not been 
saved on the CompactFlash card using the _savePersistentMemoryData system function but 
you wish to restore the non-volatile SIMOTION data after a CPU has been replaced.     

Note

While the non-volatile SIMOTION data is stored as a "PMEMORY.XML" backup file in the 
"...USER\SIMOTION" directory using the _savePersistentMemoryData system function, 
backing up diagnostic data and non-volatile data stores the data in the "...\USER\SIMOTION
\HMI\SYSLOG\DIAG" directory.

9.2.3 Save diagnostic data during running operation

Options
The advantage of backing up diagnostic data and non-volatile SIMOTION data during 
operation is that enhanced diagnostic information via HTML pages and TO alarm information 
is available.   

Data are backed up:

● Using "Diagnostics > Diagnostics Files" in SIMOTION IT web server; see Section Back up 
diagnostic data and non-volatile SIMOTION data via the web server (Page 290) 

● Via the DIAG button

● Via the service selector switch

Backup of the data via the DIAG pushbutton (preferred solution)
The diagnostic data and non-volatile SIMOTION data can be created in the STOP, STOPU, 
and RUN operating states.

1. Press the DIAG pushbutton.
The diagnostic data and non-volatile SIMOTION data are backed up to the CF card.
The backup task progress is displayed by the RUN/STOP LED flickering yellow.

2. The backup is finished when the RUN/STOP LED flickers green.
Switch off the SIMOTION D410-2.

3. Remove the CF card.

Backup of the data using the service selector switch (alternative)
The positions of the mode switch are not relevant, i.e. the set operating mode remains 
unchanged.
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The diagnostic data and non-volatile SIMOTION data can be created in the STOP, STOPU, 
and RUN operating states.

1. Set the service selector switch to "Diagnostics" ("D" position).

Figure 9-3 Service selector switch (position D)

The diagnostic data and non-volatile SIMOTION data are backed up to the CF card.
The backup task progress is displayed by the RUN/STOP LED flickering yellow.

2. The backup is finished when the RUN/STOP LED flickers green.
Switch off the SIMOTION D410-2.

3. Remove the CF card and reset the service selector switch to its original setting.

9.2.4 Save diagnostic data during the startup

Options
Backing up diagnostic data and non-volatile SIMOTION data during power-up provides you 
with diagnostic information without HTML pages / TO alarm information.

"Backing up during startup" is particularly advisable for SIMOTION devices that cannot run or 
have crashed.   

Diagnostic data and non-volatile SIMOTION data are backed up

● Via the service selector switch

● Via the DIAG button

● Using an INI file saved on the CF card.

Backup of the data using the service selector switch (alternative)
The positions of the mode switch are not relevant, i.e. the set operating mode remains 
unchanged.

1. Set the service selector switch to "Diagnostics" ("D" position).

Figure 9-4 Service selector switch (position D)

2. Switch the SIMOTION D410-2 off and on again.
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3. Wait for the device to ramp up.
The diagnostic data and non-volatile SIMOTION data are backed up to the CF card during 
power-up provided this is still possible and is not prevented by hardware defects, etc.
The backup task progress is displayed by the RUN/STOP LED flickering yellow.

4. The backup is finished when the RUN/STOP LED flickers green.
Switch off the SIMOTION D410-2.

5. Remove the CF card and reset the service selector switch to its original setting.

Backup of the data via the DIAG pushbutton (alternative)
1. Switch off the SIMOTION D410-2.

2. Press the DIAG button and hold it down. Switch on the SIMOTION D410‑2 again.

3. Wait for the device to ramp up.
The diagnostic data and non-volatile SIMOTION data are backed up to the CF card during 
power-up provided this is still possible and is not prevented by hardware defects, etc.
The backup task progress is displayed by the RUN/STOP LED flickering yellow.

4. The backup is finished when the RUN/STOP LED flickers green.
Release the DIAG pushbutton and switch the SIMOTION D410‑2 off.

5. Remove the CF card.

Note

When backing up data during power-up, the DIAG button must be held down until the backup 
is completed. As this can easily take 20‑30 seconds, it is better to use the service selector 
switch with switch position "D" for a backup during power-up.

INI file in the main directory of the CF card
1. Use a text editor (such as Notepad) to create a file called simotion.ini

2. Add the following text: DIAG_FILES=1
You must use a text editor and may not use any formatting in the text.

3. Copy the simotion.ini file to the main directory of the CF card.

4. Insert the CF card into the module, which is switched off.

5. Switch the SIMOTION D410-2 on and allow the SIMOTION device to start up.
The diagnostic data and non-volatile SIMOTION data are backed up to the data medium 
during startup provided this is still possible and is not prevented by hardware faults, etc.
The backup task progress is displayed by the RUN/STOP LED flickering yellow.

6. The backup is finished when the RUN/STOP LED flickers green.
Switch off the SIMOTION D410-2.

7. Remove the CF card.
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Note

To suppress startup in diagnostics mode again, you must delete the simotion.ini file from the 
CF card.

9.2.5 Storing the diagnostic data and non-volatile SIMOTION data
You can find diagnostic data and non-volatile SIMOTION data on the CF card in the \USER
\SIMOTION\HMI\SYSLOG\DIAG directory.     

Copy these data and transfer them to Technical Support when requested to do so. A standard 
card reader can be used to transfer the diagnostic data from the CF card via standard 
SIMOTION IT web server pages or via FTP.

The following data are stored:

Table 9-5 Diagnostic data on the CF card

File Application
DIAGBUF.TXT Diagnostic buffer in a simple text format:

Numerical values; no specific plain text. A text editor is used for evaluation purpo‐
ses.

PMEMORY.XML Non-volatile SIMOTION data (retain data)
An operator action can be used to restore the backed up non-volatile SIMOTION 
data after a CPU has been replaced
See Delete/restore non-volatile SIMOTION data (Page 288) 

TOALARMS.TXT Text file containing the pending TO alarms. Only TO IDs, alarm numbers, and 
associated HEX values.
Note: The TO alarms are only created if diagnostic data has been created during 
operation (STOP/STOPU/RUN).

HTML page If the diagnostic data are backed up, the URLs are requested from the text file 
(DIAGURLS.TXT) and stored as HTML pages together with their content.
See Diagnostics via HTML pages (Page 287)
Note: The HTML pages are only stored if diagnostic data are created during oper‐
ation (STOP/STOPU/RUN).

Other files All other files stored in the directory are only of relevance to Technical Support.

Note

Use HTML pages if you wish to back up diagnostic data in plain-text format. HTML pages 
enable user-friendly diagnostics. In addition to the standard SIMOTION IT web server pages, 
you have the option of creating your own HTML pages (e.g. for the axis status or for machine 
diagnostics). Customized diagnostics pages are particularly suitable for application problems, 
as you can define the contents yourself.
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9.2.6 Diagnostics via websites
In the "DIAGURLS.TXT" text file, located in the ...\USER\SIMOTION\HMI\SYSLOG\DIAG 
directory, you can specify HTML files whose state will be stored on the CF card when diagnostic 
data is created during operation. For example, "devinfo.mwsl" must be entered for the 
"devinfo.mwsl" website.   

Since the pages in question are stored together with their most up-to-date contents, this 
enables the latest status information regarding the SIMOTION device, as well as the machine/
system, from the point at which diagnostic data was created (e.g. when the service selector 
switch was activated) to be archived.

In addition to the standard SIMOTION IT web server pages, it is possible to store customized 
pages. Information on creating pages of this type can be found in, for example, an FAQ of the 
Utilities & Applications.

A tutorial on the creation of user-defined websites is also contained on the Utilities & 
Applications-DVD.

Figure 9-5 Diagnostic buffer at the point when diagnostic data was created

The following points must be noted for the DIAGURLS.TXT file:

● A DIAGURLS.TXT file containing the standard websites is automatically created if you have 
not stored your own DIAGURLS.TXT file.

● Standard websites are entered "without" specifying a path (e.g. "devinfo.mwsl" for the 
standard website "devinfo.mwsl").

● User websites (such as "user.mwsl") in the \USER\SIMOTION\HMI\FILES directory on the 
CF card must contain the FILES/ path specification.

● If you have created subfolders (e.g. "myfolder" in the FILES directory), these must also 
appear in the path.

● Only one file name may be used per line.
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● Empty lines are not permitted (an empty line will be interpreted as the end of the list).

● No distinction is made between upper-case and lower-case letters.

● It does not matter whether you use "\" or "/" in the path name.

Figure 9-6 Depiction of DIAGURLS.TXT editor

Additional references
You will find detailed information on SIMOTION IT in the SIMOTION IT Diagnostics and 
Configuration Diagnostics Manual.

9.2.7 Delete/restore non-volatile SIMOTION data

9.2.7.1 Overview

Requirement
The non-volatile SIMOTION data have been backed up on the CF card by one of the following 
methods:

● by system function (_savePersistentMemoryData), see also Section Operations and their 
effect on the user memory (Page 74)

● manually by service selector switch / Web server / DIAG button, see Section Backup of 
diagnostic data and non-volatile SIMOTION data (Page 282).

Procedure
The non-volatile SIMOTION data is restored automatically during a module replacement, see 
Section Replacing modules in the spare part scenario (Page 81). The non-volatile data can also 
be restored manually (by manual operation).
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The CF card may contain backups of non-volatile SIMOTION data in various storage locations:

● data backed up with the system function _savePersistentMemoryData
Storage location on CF card:

– /USER/SIMOTION/PMEMORY.XML

– /USER/SIMOTION/PMEMORY.BAK (backup file)

● manually by service selector switch / Web server / DIAG button, backed-up data
Storage location on CF card:

– /USER/SIMOTION/HMI/SYSLOG/DIAG/PMEMORY.XML

On manual restoration, the position of the service selector switch defines which of these data 
will be preferably restored.

During restoration, the non-volatile SIMOTION data is first deleted and then the non-volatile 
SIMOTION data is restored via the PMEMORY backup file.

If restoration is not possible (e.g. file does not exist or corrupt), the next file in the priority list is 
accessed.

Table 9-6 Restoration of the non-volatile SIMOTION data

Position of the service selector 
switch

Use case Priority sequence for use of the data backups

1 The data backed up with the system 
function _savePersistentMemoryDa‐
ta is preferably restored

1. /USER/SIMOTION/PMEMORY.XML
2. /USER/SIMOTION/PMEMORY.BAK
3. /USER/SIMOTION/HMI/SYSLOG/DIAG/

PMEMORY.XML
A (as of V4.4) The data backed up by service se‐

lector switch position "D" / Web serv‐
er / DIAG pushbutton are preferably 
restored

1. /USER/SIMOTION/HMI/SYSLOG/DIAG/
PMEMORY.XML

2. /USER/SIMOTION/PMEMORY.XML
3. /USER/SIMOTION/PMEMORY.BAK

For how to proceed, see Section Restoring data with switch position "1" or "A" (Page 290).

Note
Firmware / kernel < V4.4

Because switch position "A" is only supported as of V4.4, for < V4.4, restoration must be 
performed with switch position "1." To force restoration of the data backed up by service 
selector switch position "D" / Web server / DIAG button, it may be necessary to delete existing 
files PMEMORY.XML and PMEMORY.BAK in the directory /USER/SIMOTION/ on the CF card.

Note

If the data has been restored once via switch setting "A", this advantage is retained, even when 
the data should be restored later with "1".
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9.2.7.2 Restoring data with switch position "1" or "A"

Procedure
To restore the non-volatile SIMOTION data, proceed as follows:

Step Switch position "1" Switch position "A" (as of V4.4)
1. Insert the CF card into the new SIMOTION D410‑2. The SIMOTION D410‑2 must be switched off!
2. Set the service selector switch to "1."

The position of the mode switch is not relevant, i.e. the 
set operating mode remains unchanged. 

Service selector switch (position 1)

Set the service selector switch to "A."
The position of the mode switch is not relevant, i.e. the 
set operating mode remains unchanged. 

Service selector switch (position A)
3. Switch on the SIMOTION D410‑2. Switch on the SIMOTION D410‑2.

The flickering green SF LED indicates that restoration is 
requested via position "A."

4. Restoration is started automatically. Turn the service selector switch to "1" to start restoration.
5. Once restoration has been completed, the module will start up automatically.
6. Switch the module off and turn the service selector switch back to "0."
7. Switch on the SIMOTION D410‑2 again

9.2.8 Back up diagnostic data and non-volatile SIMOTION data via the web server
SIMOTION devices provide a web server with already prepared standard web pages. These 
pages can be displayed via Ethernet using a commercially available browser. Additionally, you 
have the option of creating your own HTML pages and incorporating service and diagnostic 
information.

Diagnostic data and non-volatile SIMOTION data can be backed up via the web server. The 
home page of the web server is opened by entering the IP address of the SIMOTION device in 
the address line of the browser; e.g. http://169.254.11.22

This opens the home page of the web server. To back up diagnostic data and non-volatile data, 
call the "Diagnostic files" page from the "Diagnostics" menu.
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Figure 9-7 SIMOTION IT web server

Table 9-7 Functions on the "Diagnostic files" HTML page

Button Function
Create general dia‐
gfiles

The diagnostic data and non-volatile SIMOTION data are backed up in the ...\USER\SIMOTION\HMI
\SYSLOG\DIAG directory. HTML files used for diagnostics purposes are not saved.

Create html diagfiles The diagnostic websites are saved on the data medium. Note that only those sites listed in the DIA‐
GURLS.TXT file in the ...\USER\SIMOTION\HMI\SYSLOG\DIAG are saved, see Section Diagnostics 
via websites (Page 287).

Zip all diagfiles The diagnostic files are compressed and stored with their original folder structure in the DIAGARCH‐
IVE.ZIP ZIP file in the ...\USER\SIMOTION\HMI\SYSLOG\DIAG directory.

Get diagarchive The ZIP file is saved on a connected PG/PC.
Delete all diagfiles This button is used to delete all data stored in the ...\USER\SIMOTION\HMI\SYSLOG\DIAG directory; 

the directory itself is not removed, however.

The diagnostic data and non-volatile SIMOTION data can be found on the CF card in directory: 
\USER\SIMOTION\HMI\SYSLOG\DIAG

Additional references
You will find detailed information in the SIMOTION IT Diagnostics and Configuration 
Diagnostics Manual.
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9.2.9 Storing diagnostics data and trace on the CF card
As of V4.5, the following data can be saved to the CF card with 
the _saveTraceAndDiagnosticFiles system function:  

● Diagnostics data (same data as when the DIAG button is actuated) 

● TO trace  

● Device trace 

The function can be used, for example, to collect diagnostic information (e.g. in the event of a 
fault) locally on the machine and without backing up SCOUT. The function saves the available 
data in a ZIP file, whereby the file name and the archive directory can be specified. 

The packed data can be accessed, for example, via the web server.

9.3 Additional service and diagnostics options

9.3.1 SIMOTION Task Profiler application
The SIMOTION Task Profiler is a dedicated application installed parallel to SIMOTION SCOUT 
during SIMOTION SCOUT setup. The Task Profiler can be called in online mode using device 
diagnostics in SIMOTION SCOUT or the Windows application. In the event of a malfunction or 
error, the Task Trace data can be written to a directory or the CompactFlash card. It can then 
be processed using the Task Trace Viewer.       

Additional references
For detailed information, refer to the SIMOTION Task Trace Function Manual.

9.3.2 Diagnostics via the SIMOTION IT web server
SIMOTION D410-2 has an integrated web server. Use is not subject to a license.     

In addition to customized websites and the option of performing firmware and project updates, 
SIMOTION IT web server provides comprehensive device and diagnostic information that can 
be called using a standard PC with a web browser.

Security concept of HTTP/S, FTP, and Telnet access on the web server
As of version V4.4, access to the SIMOTION IT web server is protected by a multi-level security 
concept.

The security state of the web server is indicated by the security level on the website. This 
security level can have three different stages: Low, normal, high.

Security Level Low
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The device is supplied with an empty user database. No projects exist yet. The security level 
is low to allow configuration of the device.

● In this state, access to the web server as an anonymous user is possible to enable use of 
functions such as the project and firmware update or OPC XML.

● Access to the FTP and Telnet is also possible.

● New users can be entered in the empty user database.

In this state, series commissioning is possible via the web server.

NOTICE

Protecting the device

Security level low should only be used for commissioning and service as otherwise the device 
is not adequately access protected.

Security Level Normal

The controller has a user database. There is a project on the controller; HTTP, HTTPS, FTP, 
and Telnet have been activated in the HW Config.

User password authentication is mandatory for access to websites with sensitive content (e.g. 
firmware update watch table, ...), FTP, and Telnet.

Security Level High

High security with maximum access protection:

HTTP, HTTPS, FTP, and Telnet have been deactivated via HW Config. Access to the Ethernet 
via the various ports of the services is then no longer possible.

State transition from security level low to normal

After taking delivery of the device, the user creates a project and loads it onto the device. This 
can be done by using the download functions of the SCOUT, by loading it directly onto the 
memory card (e.g. also via FTP), or via the Manage Config website, Device update tab.

Whichever method is used, the act of loading a project onto the device corresponds to a 
transition from security level low to security level normal from the point of view of the web server.

Resetting the security level from normal to low

If the user forgets to edit the UserDataBase.xml during initial commissioning, it will no longer be 
possible to access FTP, web services, or access-protected pages during use.

If there is no mechanical access to the memory card or the device, this can be achieved with 
the SCOUT function "Delete user data on card". After setting up the user administration, the 
project must be downloaded again.

Alternatives without SCOUT:
Setting the service selector switch to position "8" restores security level low (SIMOTION IT 
service mode). Using this method, the device can always be reset to security level low by 
hardware means. 
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The following behavior must be taken into account:

●  The "Service mode" is activated by turning the SVC switch to position "8". 

● If the switch is already set to "8" at ramp-up, it is ignored (protection against forgetfulness). 

● The service mode stops immediately when position "8" is exited. 

● The service mode stops automatically after 120 minutes. 

● It is possible to retrigger 120 minute timeout at any time by turning the switch briefly from "8" 
to "7" and back, for example. 

● The service mode is indicated (as for underlicensing) through slow red flashing of the SF 
LED.

Note

As an alternative to switch position "8," security level low can also be activated via a simotion.ini 
file in the main directory of the CF card.

To achieve this, use a text editor (such as Notepad) to create a file called simotion.ini Add the 
following text: SERVICE_SELECTOR_MODE=8

You must use a text editor and may not use any formatting in the text.

To exit security level low again, undo the changes you have made.

Additional references
You will find detailed information in the SIMOTION IT Diagnostics and Configuration 
Diagnostics Manual.
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Configuring drive-related I/Os (without symbolic 
assignment) A
A.1 Overview

The configuration of local measuring inputs is fundamentally different to the configuration 
of global measuring inputs. 

The assignment of the local measuring inputs is permanently related to the hardware of the 
control unit and is performed 

● On the drive side via the drive expert list and

● During the configuration of the TO measuringInput via the measuring input number.

Local and global measuring inputs have different properties. Detailed information concerning 
the differences can be found in Section Local and global measuring inputs (Page 295).

Information about the configuration can be found

● for global measuring inputs (with symbolic assignment) in Section Configuring global 
measuring inputs (Page 196)

● for local measuring inputs in the appendix, in Section Configuring local measuring inputs 
(Page 297).

Additional references
Further information and programming examples for configuring drive-related I/Os without 
symbolic assignment can be found

● at Internet address (https://support.industry.siemens.com/cs/ww/en/view/29063656)

● in the SIMOTION Utilities & Applications

SIMOTION Utilities & Applications is part of the scope of delivery of SIMOTION SCOUT. 

A.2 Local and global measuring inputs

Local and global measuring inputs
Depending on the used hardware platform, the following local and global measuring inputs are 
available for the measuring tasks:           

● Local measuring inputs are axis-related and implemented in the SINAMICS drive. The 
measurement records the actual position value.

● Global measuring inputs can be freely assigned to the axes and add an internal time stamp 
to the measurement result for more precise determination of the axis positions.
The term "central measuring input" is also used within the context of drives.   

SIMOTION D410-2
Commissioning and Hardware Installation Manual, 04/2019, A5E33446807B 295

https://support.industry.siemens.com/cs/ww/en/view/29063656


Table A-1 Comparison of local and global measuring inputs

 Local measuring input Global measuring input
Hardware supported D410, D410-2, D4x5, D4x5‑2 (terminal 

X122/X132), CX32, CX32‑2, CU310, 
CU310-2, CU320, CU320‑2

TM15, TM17 High Feature, D410, D410‑2, 
D4x5, D4x5‑2 (terminal X122, X132, X142), 
CX32, CX32‑2, CU310, CU310-2,CU320, 
CU320‑2, ET 200SP/MP timer DIDQ

Measurement procedure With a signal edge at the relevant input, the 
current actual values of an encoder con‐
nected to a Control Unit are measured with 
positioning accuracy to determine lengths 
and distances.

With a signal edge at the relevant input, the 
current actual values of one or more encod‐
ers are measured using time stamp function‐
ality with positioning accuracy in order to 
provide information for determining lengths 
and distances (possible with any encoders 
included in the project).

Configuration of the TO measur‐
ingInput in SIMOTION SCOUT

The assignment of inputs is always perma‐
nent depending on the hardware of the 
Control Unit and is performed during the 
configuration of the TO measuringInput us‐
ing the measuring input number.

The assignment of inputs is not fixed de‐
pending on the hardware and is performed 
during the configuration of the TO measur‐
ingInput by means of symbolic assignment 
or the hardware address.

TO measuringInput setting: 
Single measurement 1)

Yes Yes

TO measuringInput setting: 
Cyclic measurement 2)

No Yes
D410, D410-2, D4x5, D4x5‑2 (terminal 
X122, X132), CX32, CX32‑2, CU310, 
CU310-2, CU320, CU320‑2:
The minimum interval between 2 measure‐
ments is 3 servo cycle clocks (max. 2 edges 
per measurement).
D4x5‑2 (terminalX142), TM17 High Feature, 
ET 200SP/MP timer DIDQ:
The minimum interval between 2 measure‐
ments is 1 servo cycle (max. 2 edges per 
measurement).
TM15:
No cyclic measurement available

Use of multiple TO measuringIn‐
puts on one axis/encoder. They 
can be active concurrently

No Yes

Listening TO measuringInput No Yes
Measuring on virtual axes No Yes
Measuring on axes attached to a 
different drive unit

No Yes

1) Measurement jobs must be issued individually for each measurement. Several interpolation cycle clocks lie between two 
measurements.

2) The measuring is activated just once and runs cyclically until deactivated.

SIMOTION Utilities & Applications includes, for example, a tool with the following functions:

● Estimate of the time between initiating a measurement job to the time at which the 
measuring input job in the drive acts

● Estimate of the minimum time between two measurement jobs.
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SIMOTION Utilities & Applications is part of the scope of delivery of SIMOTION SCOUT.

Table A-2 Measuring inputs - Overview of quantity structures and functionality

Functionality/device Max. number of 
measuring input inputs

As local measuring input 
configurable

As global measuring input 
configurable

D410-2, CU310-2 8 x x
D4x5‑2 
● X122/X132
● X142

  
● 8
● 8

  
● 8
● 0

  
● 8
● 8

CX32‑2 4 x x
D410, CU310, CX32 3 x x
D4x5, CU320 6 x x
TM15 24 - x
TM17 High Feature 16 - x
ET 200SP TM timer DIDQ 
10x24V

4 - x

ET 200MP TM timer DIDQ 
16x24V

8 - x

A.3 Configuring local measuring inputs

Properties
Local measuring inputs are always permanently assigned to an axis (drive). They are 
configured separately for each drive. The drive and the measuring input must always be located 
on the same control unit. The measurement results are transferred using the axis message 
frame in accordance with the PROFIdrive profile. Message frame 39x does not need to be 
configured for local measuring inputs.   

The settings for the use of the local measuring inputs must be made in the expert list.

Procedure
To use an I/O terminal on the SIMOTION D410-2 or SINAMICS Control Unit as a measuring 
input, proceed as follows:

1. Double-click the "Inputs/outputs" entry below the control unit in the project navigator.

2. Configure the desired I/O terminal as input in the "Bidirectional digital I/Os" tab. The 
configuration can also be set channel-granular on the p0728 parameter using the expert list 
of the control unit.
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The specification of the measuring input terminal must be performed at the local measuring 
inputs in the expert list of the respective drive (refer to the following table).

Table A-3 Local measuring inputs, required settings in the expert list of the drive

Parameters in the expert list of the drive Parameterization as
D410-2, CU310-2 D4x5-2, CU320-2

p0488[0] 
(measuring input 1 input terminal, encoder 1)

DI/DO 8 or 
DI/DO 9 or 
DI/DO 10 or
DI/DO 11 or
DI/DO 13 or
DI/DO 14 or 
DI/DO 15

DI/DO 8 or 
DI/DO 9 or 
DI/DO 10 or
DI/DO 11 or
DI/DO 13 or
DI/DO 14 or 
DI/DO 15

p0488[1] 
(measuring input 1 input terminal, encoder 2)
p0488[2] 
(measuring input 1 input terminal, encoder 3)
p0489[0] 
(measuring input 2 input terminal, encoder 1)
p0489[1] 
(measuring input 2 input terminal, encoder 2)
p0489[2] 
(measuring input 2 input terminal, encoder 3)

Since a maximum of three encoders can be assigned to a drive, the index [0...2] specifies 
whether the measurement applies to encoder 1, 2, or 3.

The following must be taken into account:

● Two TO measuring inputs can be configured per TO axis or TO external encoder.

● Only one TO measuringInput can be active on a TO axis or TO externalEncoder.

Table A-4 Local measuring inputs, configuration of the Measuring Input TO

Axis measuring sys‐
tem no.

Under axis measuring system number, enter the number of the used encoder 
system (namely, encoder 1, 2 or 3). Encoder system 1 is the default setting.

Drive-related (local 
measuring input)

Activate the checkbox when a local measuring input is used.

Measuring input num‐
ber

Enter here which measuring input is used (namely, 1 or 2). Input 1 is the 
default setting.

Detailed information can be found in the SIMOTION Motion Control Output Cams and 
Measuring Inputs Function Manual.

Configuring drive-related I/Os (without symbolic assignment)
A.3 Configuring local measuring inputs
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Standards and approvals B
B.1 General rules

CE marking

Our products satisfy the requirements and protection objectives of the EC Directives and comply with 
the harmonized European standards (EN).   

Electromagnetic compatibility
Standards for EMC are satisfied if the EMC Installation Guideline is observed.   

SIMOTION products are designed for industrial use in accordance with product standard DIN 
EN 61800‑3, Category C2.   

cULus approval

Listed component mark for United States and the Canada Underwriters Laboratories (UL) according to 
Standard UL 508, File E164110, File E115352, File E85972.      

You can find further information on the respective device on the Internet at http://
database.ul.com/cgi-bin/XYV/template/LISEXT/1FRAME/index.htm Enter the first seven 
characters of the article number at Keyword. Then click Search.

Korea certification

KC registration number: KCC-REM-S49-SIMOTION
Note that this device complies with limit class A with regard to the emission of radio frequency interference. 
This device can be used in all areas except residential areas.

Declaration of conformity
The current Declaration of conformity is available on the Internet at Declaration of conformity 
(https://support.industry.siemens.com/cs/ww/en/ps/14506/cert).   
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Marking for Australia and New Zealand

SIMOTION D410-2 satisfies the requirement of the standard AS/NZS CISPR 16.

or
Marking with RCM (Regulatory Compliance Mark) or C-Tick with older components.

Marking for the Eurasian customs union

EAC (Eurasian Conformity) 
Customs union of Russia, Belarus and Kazakhstan 
Declaration of conformity in accordance with the technical regulations of the customs union (TR 
CU).

Standards that are not relevant

China Compulsory Certification
SIMOTON D does not belong to the validity area of the China Compulsory Certification (CCC).

Standards and approvals
B.1 General rules
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B.2 Device-specific information

Note regarding SIMOTION D 

Note

The product standard EN 61800-3 describes the EMC requirements placed on "Variable-speed 
drive systems". As such, it defines different limits depending on the location of the drive system. 

SINAMICS S120 power units are designed for use in the second environment. The term second 
environment refers to all locations outside residential areas. These are basically industrial 
areas which are supplied from the medium-voltage line supply via their own transformers.

It is essential to follow the installation instructions in the SINAMICS S120 Manuals in order to 
ensure compliance with emitted interference and immunity values.

The same installation instructions apply for the SIMOTION D410-2 Control Unit as for the 
SINAMICS S120 CU310-2 Control Unit with regard to EMC.

For further information on this topic also refer to the SIMOTION PM 21 Catalog as well as the 
SINAMICS Function Manuals. 

Standards and approvals
B.2 Device-specific information
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Standards and approvals
B.2 Device-specific information
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ESD guidelines C
C.1 ESD definition

What does ESD mean? 
Electrostatic sensitive devices (ESDs) are individual components, integrated circuits, modules 
or devices that may be damaged by either electrostatic fields or electrostatic discharge. 

NOTICE

Damage caused by electric fields or electrostatic discharge

Electric fields or electrostatic discharge can result in malfunctions as a result of damaged 
individual parts, integrated circuits, modules or devices.
● Only pack, store, transport and send electronic components, modules or devices in their 

original packaging or in other suitable materials, e.g conductive foam rubber or aluminum 
foil.

● Only touch components, modules and devices if you are first grounded by applying one of 
the following measures:
– Wearing an ESD wrist strap
– Wearing ESD shoes or ESD grounding straps in ESD areas with conductive flooring

● Only place electronic components, modules or devices on conductive surfaces (table with 
ESD surface, conductive ESD foam, ESD packaging, ESD transport container).

C.2 Electrostatic charging of individuals
Any person who is not conductively connected to the electrical potential of the environment can 
accumulate an electrostatic charge.

This figure indicates the maximum electrostatic charges that can accumulate on an operator 
when he comes into contact with the indicated materials. These values comply with the 
specifications in IEC 801-2.
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Figure C-1 Electrostatic voltage that can accumulate on operating personnel

C.3 Basic measures for protection against discharge of static electricity

Ensure sufficient grounding
When working with electrostatic sensitive devices, make sure that the you, your workstation, 
and the packaging are properly grounded. This prevents the accumulation of static electricity.

Avoid direct contact
You should only touch ESD components if unavoidable (for example, during maintenance 
work). When you touch modules, make sure that you do not touch either the pins on the 
modules or the printed conductors. If you follow these instructions, electrostatic discharge 
cannot reach or damage sensitive components.

If you have to take measurements on a module, make sure that you first discharge any static 
that may have accumulated in your body. To do this, touch a grounded metal object. Only use 
grounded measuring instruments.

ESD guidelines
C.3 Basic measures for protection against discharge of static electricity
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A
Active setting

PG/PC, 105
Acyclic communication

Overview, 163
Adaptation, 125
Additional data

Loading, 143
Addresses

Calculating, 180
Automatic commissioning, 147
Automatic configuration, 147
Automatic controller setting

Position controller, 207
Speed controller, 206

Automatic downgrading, 246
Automatic position controller setting, 207
Automatic speed controller setting, 206
Automatic upgrading, 246
Axis

Creating with axis wizard, 171
Testing, 178

Axis control panel
Axis test, 178

B
Backup copy

Creating, 249
Boot loader

Upgrading, 260
Writing, 260, 271

Bus connector, 52
MPI, 57
Setting the terminating resistor, 54

C
Cam output

SIMOTION D410-2, 197
CE marking, 299
CF card

Content, 73
Correct handling, 272
Formatting, 271

CF card
Changing, 270

Clock
Runtime deviations, 158
Synchronizing, 157

Combinations
Licenses, 234
Of different generations, 233

Commissioning
Acyclic communication, 163
Automatic configuration, 147
Comparing a project, 143
Configuring a second encoder, 184
Configuring components, 131
Configuring the TM41, 203
Control properties, 164
Creating a DMC20, 202
Creating a DME20, 202
Download project to target system, 142, 150
Downloading additional data, 143
Downloading project to CF card, 142
Downloading sources, 143
Editing components, 149
Inserting another encoder, 184
Load to file system, 142
Loading SIMOTION user data, 213
Offline configuration, 129
Online configuration, 145
Overview, 128
Performance features, 164
SIMOTION D410-2, 87, 127
SIMOTION D410-2, 123
SINAMICS Integrated, 151
Supplementary information, 151
Testing the drive, 168
TM41, 203
Vector drive, 153

Communication
symbolic assignment, 180

CompactFlash card
Changing, 249, 270
Characteristics, 67
Correct handling, 272
Deleting, 218
Formatting, 271
Inserting, 68
Saving user data, 270
Writing data using the PG/PC, 271
Writing to, 270
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Component
on DRIVE-CLiQ, 25
on Ethernet, 24
on PROFIBUS, 22
on PROFINET, 23, 58
Replacing, 245

Components
Configuring, 131

Configuration
Global D410-2 measuring inputs, 295
I/O terminals, 192
I/O variables, 199
Inserting another encoder, 184
Local D410-2 measuring inputs, 295
Measuring inputs on D410-2, 295

Connection
Power supply, 47

Controller optimization, 209
Automatic position controller setting, 207
Automatic speed controller setting, 206
Function generator, 209
Measuring functions, 209
Trace, 209

Creating a subnet
PROFIBUS DP, 104

cULus approval, 299
Current controller cycle clock, 165
Cycle clock scaling

external/internal PROFIBUS, 102

D
Data storage

Diagnostic data, 286
DCP flashing, 277
Declaration of conformity, 299
Diagnostic buffer, 78

SINAMICS, 163
Diagnostic data

Backing up, 282, 290
Backing up during operation, 283
Backing up during startup, 284
Backing up via web server, 290
Data storage, 286

Diagnostics, 275
LED display, 276
SIMOTION Task Profiler, 292
Via HTML, 287
Web server, 292

Disassembly, 31

DMC20
Creating, 202
DRIVE-CLiQ Hub, 201

DME20
Creating, 202
DRIVE-CLiQ Hub, 201

Downgrading
D410-2 device update tool, 262
DRIVE-CLiQ components, 246

Downgrading devices
D410-2, 261

DP cycle, 100
PROFIBUS DP, 98
PROFINET, 111

Drive
Testing, 168

Drive control panel
Testing the drive, 168

Drive optimization, 208
DRIVE-CLiQ

Connecting components, 48
Create a hub, 202
Hub, 201
Versions that can be combined with D410-2, 233
Wiring, 48

DRIVE-CLiQ component
Replacing, 245

E
Electromagnetic compatibility, 299
EMC directives, 46, 299
Encoder

Inserting, 184
Engineering system

Create axes., 170
ESD guideline, 303
Ethernet

Configuring addresses, 120
Interface, 91
PG/PC interface, 91
Properties, 117

External encoder
Connecting, 65

F
Fan

Replacing, 247
fanexisting, 84
fannecessary, 84
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Firmware
Updating automatically, 267
Updating manually, 268
Upgrading, 261

Firmware downgrade, 268
Firmware update

D410-2 device update tool, 262
Performing, 261
Web server, 262

Formatting
CF card, 271

Functions
Project handling, 127

Further encoders, 185
via PROFIBUS, 186
Via PROFINET, 186

FW update
Automatic, 246
Performing, 261

G
Global D410-2 measuring inputs, 295
Guideline

ESD, 303

H
Hardware components, 20
Hot plugging, 202, 229
HW Config

Replacing the module, 255
Settings, 151

I
I/O

Configuration, 191
Configuration with symbolic assignment, 191
Configuration without symbolic assignment, 191
CU3xx, 195
symbolic assignment, 191
Terminal X120, 193
Terminal X121, 193
Terminal X130, 193
Terminal X131, 193

I/O systems
PROFINET, 23, 24

I/O terminals
Configuration, 192

I/O variables
Configuration, 199
Substitute values, 201
symbolic assignment, 187

Installation
Installing on the Power Module, 30
on mounting plate, 32

Installing, 30, 32
Integrated drive, 129
Interface

PG/PC, 91
PROFIBUS DP, 96

Interfaces
Arrangement on the device, 36, 37
MPI, 106
Overview of connections, 38
PG/PC, 89
PROFIBUS DP, 22, 90, 106
PROFINET, 23

Isochronous operation, 151

L
LED

Diagnostics, 276
Display, 275

Library
Upgrading, 259

Licenses
Backing up, 265

Licensing, 234
Load power supply, 47
Loading

To file system, 142
To the target system, 268

Local D410-2 measuring inputs, 295
Parameter, 297

M
Maintenance

Overview, 239
Master application cycle, 100
Measuring input

Globals for D410-2, 196
Local, 197

Measuring input types, 196
Measuring inputs on D410-2

Local/global measuring inputs, 295
Memory model, 71
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Memory reset, 215
Data deleted on memory reset, 216
Data retained during memory reset, 216
Using the mode switch, 217
With SIMOTION SCOUT, 217

Migration
D410 to D410-2, 231

Mode selector switch
Restoring the factory settings, 219

Mode switch
Memory reset, 217

Module
Replacing in HW Config, 255

Module replacement
SIMOTION, 81
SINAMICS, 83

Modules
Permissible combinations, 233

MPI, 96, 106
MPI bus

Bus connector, 57
Connection rules, 57
Parameter, 106

Multi-Point Interface, 106

N
Non-volatile data

Saving to CF card, 73
Non-volatile SIMOTION data

Backing up, 76, 283
Backing up via web server, 290
Diagnostics, 78
Power-up, 78
Restoring, 77, 288

Non-volatile SINAMICS data
Restoring, 77

NVRAM data
Backing up, 160
Deleting, 161
Restoring, 160

O
Offline configuration

SIMOTION D410-2, 128
Onboard I/Os of the SIMOTION D410-2

Configuring, 191
Online configuration, 145

Overview, 145
Operating hours counter, 156

Operating state, 275
Output cam

Configuring the SIMOTION D410-2, 198
Overview

Diagnostic data, 282
Upgrading and downgrading, 261

Overview of connections, 38

P
PG/PC

Establishing the online connection, 146
Interface, 91

PG/PC connection
enabling the active setting, 105

PG/PC interface
Configuring, 89
Inserting a device, 91

Platform replacement, 252
Possible applications, 20
Power failure, 78
Power supply, 47

Safety rules, 46
Switching on, 69

Power-up
Control Unit, 69

Process data exchange
Determining addresses, 180

PROFIBUS address
Assign, 98

PROFIBUS cable
Baud rate, 52
Cable length, 52
Connecting, 53
Properties, 51
removing, 54
Rules for cabling, 53

PROFIBUS DP
Configure interface, 90
Configuring, 94
Creating a subnet, 104
Definition, 94
DP cycle, 98
Interface, 96

PROFINET
Cable types, 59
Cabling, 58
Configuring, 107
Connector types, 59
Definitions, 107
Diagnostics via LED displays, 275
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DP cycle, 111
Send cycle clock, 115

Project
Adapting, 249
Archiving to the CompactFlash card, 144
Comparing, 143
creating, 87
Downloading to the target system, 150
Loading, 268

Project handling
Functions, 127

Project update
D410-2 device update tool, 262
Performing, 262
Web server, 262

Q
Quantity structure

D410-2, 229

R
Real-time clock

Setting, 156
References, 4
Replace module

DRIVE-CLiQ component, 245
Replacing the device

SIMOTION D410-2, 254, 255
Restoring

Non-volatile SIMOTION data, 288
Restoring the factory settings

SIMOTION D410-2, 219
SINAMICS Integrated, 219

Retain data
Backing up, 250, 283

Retain data and user data
Backing up, 265

Rules
PROFIBUS system clocks, 100
PROFINET send cycle, 115

S
Safety instructions, 16
Safety Integrated

Advanced Functions, 221
Basic Functions, 221
Configuration, 220
Controlling, 223

Extended Functions, 221
Topology, 228
With PROFIsafe, 227

Send cycle clock, 111
Service, 275
Servicing

Overview, 239
Shield connection

Using, 50
SIMOTION D410-2

Commissioning, 127
Memory reset, 215
Removing modules, 243
Replace module, 243
Upgrade options, 241

SIMOTION Task Profiler, 292
SIMOTION user data

Loading, 213
Saving, 213

SIMOTION D410-2
Cam output, 197
Commissioning, 87, 123
Offline configuration, 128
Replacing a device in HW Config, 255
Replacing the device, 254
Time of day, 156
User memory concept, 71

SIMOTION SCOUT
Documentation, 27
Inserting a SIMOTION D410-2, 87

SINAMICS clock
Synchronizing, 157

SINAMICS Integrated
Isochronous operation, 151
Restoring the factory settings, 219
Supplementary information, 151
Telegram configuration, 181

Software components, 21
Sources

Loading, 143
Speed controller

Adjusting the P-gain, 212
Optimizing, 210
Starting the measuring function, 210

Standard IE cable types, 59
Subnet

Connection components, 51
Connection rules, 55
Segment, 51
Terminating resistor, 51

Switching on
Requirement, 67
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Symbolic assignment, 123
Communication, 180
I/O configuration, 191
I/O variables, 187
I/O variables to the drive parameters, 187
I/O variables to the PROFIdrive message 
frame, 187

System cycle clock
DP cycle, 111
IPO cycle clock, 111
Ratio, 99
Rules, 100
Setting, 98, 111

System function
_savePersistentMemoryData, 77

System runtime, 156
System variable

fanexisting, 84
fannecessary, 84

T
Task Profiler, 292
Technology packages

Upgrading, 256
Telegram

Configuring, 181
Terminal Module

TM41, 203
Terminating resistor, 51
Time of day

Setting, 156
SIMOTION D410-2, 156
SINAMICS, 156

TM41
Configuring, 204
Overview, 203

TO axis
Configuring I/O variables, 200

U
UL certification, 299
Unit data

Backing up, 250
Upgrading

Automatic, 246
D410-2 device update tool, 262
Library, 259
Overview, 241

SINAMICS components, 258
Technology packages, 256

Upgrading firmware, 268
User data

Deleting from the CompactFlash card, 218
User memory concept, 71

Non-volatile data, 72
Volatile SIMOTION data, 74

V
Variables

Backing up, 250
Restoring, 250

Vector drive
Use, 153

Volatile SIMOTION data, 74

W
Web server

Diagnostics, 292
FW update, 262
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